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About help
The Administration guide was written to help you get familiar with ESET Security Management Center and
provides instructions to use it.
For consistency and to help prevent confusion, the terminology used throughout this guide is based on the ESET
Security Management Center parameter names. We also use a set of symbols to highlight topics of particular
interest or significance.

Note
Notes can provide valuable information, such as specific features or a link to a related topic.

Important
This requires your attention and it should not be skipped. Usually, it provides non-critical but
significant information.

Warning
Critical information you should treat with increased caution. Warnings are placed specifically to
deter you from committing potentially harmful mistakes. Please read and understand text placed in
warning brackets, as it references highly sensitive system settings or something risky.

Example
Example scenario that describes a user case relevant for the topic where it is included. Examples are
used to explain more complicated topics.
Convention
Bold type
Italic type

Meaning
Names of interface items such as boxes and option buttons.
Placeholders for information you provide. For example, file name or path means you type the
actual path or a name of file.
Courier New Code samples or commands
Hyperlink
Provides quick and easy access to cross-referenced topics or external web location. Hyperlinks
are highlighted in blue and may be underlined.
%ProgramFiles% The Windows system directory which stores installed programs of Windows and others.
• Online Help is the primary source of help content. The latest version of Online Help will automatically be
displayed when you have a working internet connection. The ESET Security Management Center online help
pages include four active tabs at the top navigation header: Installation/Upgrade, Administration, VA
Deployment and SMB guide.
• Topics in this guide are divided into several chapters and sub-chapters. You can find relevant information
by using the search field at the top.

Important
Once you open a User Guide from the navigation bar at the top of the page, search will be limited to
the contents of that guide. For example, if you open the Administrator guide, topics from the
Installation/Upgrade and VA Deployment guides will not be included in search results.

1

• The ESET Knowledgebase contains answers to the most frequently asked questions, as well as
recommended solutions for various issues. Regularly updated by ESET technical specialists, the
Knowledgebase is the most powerful tool for resolving various types of problems.
• The ESET Forum provides ESET users with an easy way to get help and to help others. You can post any
problem or question related to your ESET products.
• You can post your rating and/or provide a feedback on a particular topic in help: Click the Was this
information helpful? link underneath the help page.

Icon legend
This is a collection of icons used throughout ESMC Web Console with their description. Some of the icons depict
actions, item types or current status. Most icons are displayed in one of three colors to denote the accessibility of
an element:
Default icon - available action
Blue icon - highlighted element when you hover with mouse pointer
Gray icon - action not available
Status icon

Descriptions
Show Details - detailed information about the client device.
Add New - add new devices.
New Task - add new task.
New Notification - add new notification.
New Static/Dynamic Groups - add new groups.
Edit - you can edit your created tasks, notifications, reports template, groups, policies, etc.
Duplicate - lets you create a new policy based on the existing policy you have selected, a new name is
required for the duplicate.
Move - computers, policies, Static or Dynamic Groups.
Access Group - Move the item to a different Static Group.
Delete - removes the selected client, group, etc completely.
Rename multiple items - if you select multiple items you can rename them one by one in a list or use
Regex search and replace multiple items at once.
Scan - using this option will run the On Demand Scan task on the client that reported the detection.
Update Modules - using this option will run the Modules Update task (triggers an update manually).
Run Task for mobile devices.
Re-enroll - opens Add mobile device via email window.
Unlock - device will be unlocked.
Lock - device will be locked when suspicious activity is detected or the device is marked as missing.
Find - if you want to request the GPS coordinates of your mobile device.
Siren - triggers a loud siren remotely, the siren will start even if your device is set to mute.
Wipe - all data stored in your device will be permanently erased.
Reboot - if you select a computer and press Reboot the device will be rebooted.
Restore - restore quarantined file to its original location.
Shutdown - if you select a computer and click Reboot > Shutdown the device will be shut down.
Deactivate Products
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Status icon

Descriptions
Run Task - select a task and configure trigger and throttling (optional) for this task. The task will be
queued according to the task settings. This option immediately triggers an existing task that you
select from a list of available tasks.
Last used tasks - shows last used tasks. You can click task to execute it again.
Assign User - assign user to a device. You can manage users in Computer Users.
Manage Policies - a policy can also be assigned directly to a client (multiple clients), not just a group.
Select this option to assign the policy to selected client(s).
Send Wake-Up Call - ESMC Server runs instant replication of the ESET Management Agent on a client
machine via EPNS. This is useful when you do not want to wait for the regular interval when the ESET
Management Agent connects to the ESMC Server. For example when you want a Client Task to be run
immediately on client(s) or if you want a Policy to be applied right away.
Deploy Agent - with this option, you can create a new Server Task.
Connect - generate and download a .rdp file that will let you connect to target device via Remote
Desktop Protocol.
Mute - if you select a computer and press Mute, the Agent on this client stops reporting to ESMC; it
will only aggregate the information. A muted icon
will be displayed next to a computer name in
the Muted column.
Once muting is disabled by clicking Un-mute, the muted computer will report again and
communication between ESMC and the client is restored.
Disable - disable or remove a setting or selection.
Assign - assign a Policy to client or groups.
Import - select Reports / Policies / Public key you want to import.
Export - select Reports / Policies / Peer Certificate you want to export.
Tags - Edit tags (assign, unassign, create, delete).
Static Group
Dynamic Group
Not apply policy flag
Apply policy flag
Force policy flag
Desktop
Virtual Machine (Agentless)
Mobile
Server
File Server
Mail Server
Gateway Server
Collaboration Server
Agent
Mobile Device Connector
Rogue Detection Sensor
Virtual Agent Host
ERA 6.x Proxy
ESMC Server
Shared Local Cache
Virtual Security Appliance
Enterprise Inspector Agent
Enterprise Inspector Server
ESET Full Disk Encryption
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Offline help
Offline help for ESET Security Management Center is not installed by default. If you need ESET Security
Management Center help that you can use while you are offline (in case you do not have an internet access at
times, or all the time), perform the steps below to add Offline help.
Click the language code to download Offline help for ESET Security Management Center in desired language. You
even can have Offline help can be installed for multiple languages.
Offline help setup instructions for Windows
1.Download a .zip file by clicking a language code in the table below to download Offline help for your ESET
Security Management Center in your desired language.
2.Save the .zip file (for example to a USB flash drive).
3.Create a new folder named help on your server that runs ESMC Web Console within the following location:
%ProgramFiles%\Apache Software Foundation\[ Tomcat folder ]\webapps\era\webconsole\ and Copy the .zip
file to the help folder.
4.Extract the contents of the .zip file, for example en-US.zip, to a folder with the same name, in this case enUS so that the folder structure looks like this: %ProgramFiles%\Apache Software Foundation\[ Tomcat folder
]\webapps\era\webconsole\help\en-US
You can now open your ESMC Web Console, select the language and log in. When you press the
right corner, an Offline help page will be displayed.

icon in the top

To update Offline Help after migrating from a previous version (for example, ERA 6.5), delete the existing help
folder (...webapps\era\webconsole\help) and create a new one in the same place during step 3 of the
procedure shown above. Continue as normal after replacing the folder.

Note
You can add Offline help in multiple languages if required by following the same steps as above.

Important
If your computer, or a mobile device you access ESMC Web Console from, does not have an internet
connection, you will need to change your setting in ESMC Web Console to force ESMC Offline help
to open by default (instead of Online Help). To do so, follow the instructions below the table.
Offline help setup instructions for Linux
1.Download a .tar file by clicking a language code in the table below to download Offline help for your ESET
Security Management Center in desired language.
2.Save the .tar file (for example to a USB flash drive).
3.Open terminal and navigate to /usr/share/tomcat/webapps/era/webconsole
4.Create new folder named help by running mkdir help command.
5.Copy the .tar file to the help folder and extract it, for example by running tar -xvf en-US.tar
command.
4

You can now open your ESMC Web Console, select the language and log in. When you press the
right corner, an Offline help page will be displayed.

icon in the top

To update Offline Help after migrating from a previous version (for example ERA 6.5), delete the existing help
folder (...webapps\era\webconsole\help) and create a new one in the same place during step 3 of the
procedure shown above. Continue as normal after replacing the folder.

Note
You can add Offline help in multiple languages if required by following the same steps as above.

Important
If your computer, or a mobile device you access ESMC Web Console from, does not have an internet
connection, you will need to change your setting in ESMC Web Console to force ESMC Offline help
to open by default (instead of Online Help). To do so, follow the instructions below the table.
Supported Language Offline HTML Help
.zip
English
en-US.zip
Arabic
ar-EG.zip
Chinese Simplified zh-CN.zip
Chinese Traditional zh-TW.zip
Croatian
hr-HR.zip
Czech
cs-CZ.zip
French
fr-FR.zip
French Canadian
fr-CA.zip
German
de-DE.zip
Greek
el-GR.zip
Italian
it-IT.zip
Japanese
ja-JP.zip
Korean
ko-KR.zip
Polish
pl-PL.zip
Portuguese Brazilian pt-BR.zip
Russian
ru-RU.zip
Spanish
es-ES.zip
Spanish Latin
es-CL.zip
Slovak
sk-SK.zip
Turkish
tr-TR.zip
Ukraininan
uk-UA.zip

Offline HTML Help
.tar
en-US.tar
ar-EG.tar
zh-CN.tar
zh-TW.tar
hr-HR.tar
cs-CZ.tar
fr-FR.tar
fr-CA.tar
de-DE.tar
el-GR.tar
it-IT.tar
ja-JP.tar
ko-KR.tar
pl-PL.tar
pt-BR.tar
ru-RU.tar
es-ES.tar
es-CL.tar
sk-SK.tar
tr-TR.tar
uk-UA.tar

Force Offline help on Windows
1.Open C:\Program Files\Apache Software Foundation\[ Tomcat folder
]\webapps\era\WEBINF\classes\sk\eset\era\g2webconsole\server\modules\config\EraWebServerConfig.prop
erties in a text editor.

2.Locate the line help_show_online=true, change this setting's value to false and save changes.
3.Restart Tomcat service within services or via command line.
ESMC Offline help will open whenever you click the
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icon in the top right corner of ESMC Web Console or

navigate to the bottom of the pane on the left and click Help.
Force Offline help on Linux
1.Open /usr/share/tomcat/webapps/era/WEBINF/classes/sk/eset/era/g2webconsole/server/modules/config/EraWebServerConfig.prop
erties configuration file in a text editor (for example nano).

2.Locate the line help_show_online=true, change this setting's value to false and save changes.
3.Stop tomcat service, Run the tomcat stop command.
4.Start tomcat service, Run the tomcat start command.
ESMC Offline help will open when you click the
icon in the top right corner of ESMC Web Console or navigate
to the bottom of the pane on the left and click Help.

Introduction to ESET Security Management Center
Welcome to ESET Security Management Center (ESMC) version 7.2. ESET Security Management Center allows you
to manage ESET products on workstations, servers and mobile devices in a networked environment from one
central location. Using the ESET Security Management Center Web Console (ESMC Web Console), you can deploy
ESET solutions, manage tasks, enforce security policies, monitor system status and quickly respond to problems or
detections on remote computers. See also ESMC architecture and infrastructure elements overview, Getting
started with ESMC Web Console, and Supported Desktop Provisioning Environments.
ESMC is made up of the following components:
• ESMC Server - ESMC Server can be installed on Windows as well as Linux servers and also comes as a Virtual
Appliance. It handles communication with Agents and collects and stores application data in the database.
• ESMC Web Console - ESMC Web Console replaces ERA Console in older (v5) versions, and is the primary
interface that allows you to manage client computers in your environment. It displays an overview of the status
of clients on your network and allows you to deploy ESET solutions to unmanaged computers remotely. After
you install ESET Security Management Center Server (ESMC Server), you can access the Web Console using your
web browser. If you choose to make the web server available via the Internet, you can use ESMC from any place
or device with an Internet connection. You can install the ESMC Web Console on a different computer than the
computer where the ESMC Server is installed.
• ESET Management Agent - The ESET Management Agent facilitates communication between the ESMC Server
and client computers. The Agent must be installed on client computer to establish communication between
that computer and the ESMC Server. Because it is located on the client computer and can store multiple
security scenarios, use of the ESET Management Agent significantly lowers reaction time to new detections.
Using ESMC Web Console, you can deploy the ESET Management Agent to unmanaged computers identified by
Active Directory or ESET RD Sensor. You can also manually install the ESET Management Agent on client
computers if necessary.
• Rogue Detection Sensor - The ESMC Rogue Detection (RD) Sensor detects unmanaged computers present on
your network and sends their information to the ESMC Server. This allows you to add new client computers to
your secured network easily. The RD Sensor remembers computers that have been discovered and will not send
the same information twice.
• Apache HTTP Proxy - Is a service that can be used in combination with ESET Security Management Center to:
6

oDistribute updates to client computers and installation packages to the ESET Management Agent.
oForward communication from ESET Management Agents to the ESMC Server.
• Mobile Device Connector - Is a component that allows for Mobile Device Management with ESET Security
Management Center, permitting you to manage mobile devices (Android and iOS) and administer ESET
Endpoint Security for Android.
• ESMC Virtual Appliance - The ESMC VA is intended for users who want to run ESET Security Management
Center (ESMC) in a virtualized environment.
• ESET Security Management Center Virtual Agent Host - A component of the ESET Security Management
Center that virtualizes agent entities to allow for the management of agent-less virtual machines. This solution
enables automation, dynamic group utilization and the same level of task management as ESET Management
Agent on physical computers. The Virtual Agent collects information from virtual machines and sends it to the
ESMC Server.
• Mirror Tool - The Mirror Tool is necessary for offline module updates. If your client computers do not have an
internet connection, you can use the Mirror Tool to download update files from ESET update servers and store
them locally.
• Migration Assistant - The Migration Assistant is designed to help you migrate from ERA 5 to ESMC 7. The
Assistant is a standalone application that uses a wizard to provide straightforward migration of ERA 5.x data
into an intermediate database that can then be imported into ESMC 7.
• ESET Remote Deployment Tool - This tool serves to deploy All-in-one packages created in the ESMC Web
Console. It is a convenient way to distribute ESET Management Agent with an ESET product on computers over
a network.
• ESET Business Account - The new licensing portal for ESET business products allows you to manage licenses.
See the ESET Business Account section of this document for instructions to activate your product, or see the
ESET Business Account User Guide for more information about using the ESET Business Account. If you already
have an ESET-issued Username and Password that you want to convert to a License Key, visit the Convert legacy
license credentials section.
• ESET Enterprise Inspector - A comprehensive Endpoint Detection and Response system that includes features
such as: incident detection, incident management and response, data collection, indicators of compromise
detection, anomaly detection, behavior detection and policy violations.

Supported Web browsers, ESET security products and
languages
The following Operating Systems are supported by ESET Security Management Center:
• Windows, Linux and macOS

The ESET Security Management Center Web Console can be run in the following web browsers:
Web browser
Mozilla Firefox
Microsoft Edge
Google Chrome
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Web browser
Safari
Opera
Internet Explorer is not supported starting the version 7.1 of ESET Security Management Center.

Note
For the best experience with the ESMC Web Console we recommend that you keep Web browsers
up to date.

Latest versions of ESET products manageable via ESET Security
Management Center 7.2
Product
Product version
ESET Endpoint Security for Windows*
5.x, 6.5+, 7.x, 8.x**
ESET Endpoint Antivirus for Windows*
5.x, 6.5+, 7.x, 8.x**
ESET Endpoint Security for macOS
6.x
ESET Endpoint Antivirus for macOS
6.x
ESET Endpoint Security for Android
2.x
ESET File Security for Windows Server*
6.5, 7.x
ESET File Security for Microsoft Azure*
6.5
ESET Mail Security for Microsoft Exchange Server* 6.5, 7.x
ESET Security for Microsoft SharePoint Server*
6.5, 7.x
ESET Mail Security for IBM Domino Server*
6.5, 7.x
ESET File Security for Linux
7.x
ESET Security for Kerio
6.5
ESET Endpoint Antivirus for Linux
7.x
ESET Virtualization Security
1.x
ESET Dynamic Threat Defense
ESET Enterprise Inspector
1.x
ESET Full Disk Encryption
* Visit our Knowledgebase article regarding compatibility with ESET Endpoint and Server Security products version
6.0-6.4.
**The latest management options for ESET Endpoint 8 (for example, exclusions for firewall IDS rules) are available
only in ESET PROTECT.

Note
• We do not guarantee management support for later ESET security product versions than listed in
the table above (some management features may not work). We recommend upgrading to the
latest ESET PROTECT version for the best compatibility with the latest ESET security products.
• ESET Windows Server product versions earlier than those shown in the table above are not
currently manageable using ESET Security Management Center 7.
• Also see End of Life policy for ESET business products.
• It is not possible to manage ESET Server Security and ESET Endpoint version 6.4 and older from
ESET Security Management Center 7.2.
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Older versions of ESET products manageable via ESET Security
Management Center 7.2
Product
Product version
ESET File Security for Microsoft Windows Server
4.5.x
ESET NOD32 Antivirus 4 Business Edition for OS X
4.x*
ESET NOD32 Antivirus 4 Business Edition for Linux Desktop 4.x
ESET Mail Security for Microsoft Exchange Server
4.5.x
ESET Mail Security for IBM Lotus Domino
4.5.x
ESET Security for Microsoft Windows Server Core
4.5.x
ESET Security for Microsoft SharePoint Server
4.5.x
ESET Security for Kerio
4.5.x
ESET Mail Security for Linux/FreeBSD
4.5.x
ESET File Security for Linux/FreeBSD
4.5.x
ESET Gateway Security for Linux/FreeBSD
4.5.x
ESET NOD32 Antivirus Business Edition
4.2.76 *
ESET Smart Security Business Edition
4.2.76 *
* compatibility with ESMC is not guaranteed

Products supporting activation via Subscription license
ESET Product
Available since version
ESET Endpoint Antivirus/Security for Windows 7.0
ESET Endpoint Antivirus/Security for macOS
6.6.x
ESET Endpoint Security for Android
2.0.158
ESET Mobile Device Management for Apple iOS 7.0
ESET Virtualization Security for VMware
1.7
ESET File Security for Microsoft Windows Server 7.0
ESET Security Management Center
7.0
ESET Mail Security for Microsoft Exchange
7.0
ESET File Security for Windows Server
7.0
ESET Mail Security for IBM Domino
7.0
ESET Security for Microsoft SharePoint Server 7.0
ESET File Security for Linux
7.0
ESET Endpoint Antivirus for Linux
7.x

Supported languages
Language
English (United States)
Arabic (Egypt)
Chinese Simplified
Chinese Traditional
Croatian (Croatia)
Czech (Czech Republic)
French (France)
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Code
en-US
ar-EG
zh-CN
zh-TW
hr-HR
cs-CZ
fr-FR

French (Canada)
fr-CA
German (Germany)
de-DE
Greek (Greece)
el-GR
Hungarian (Hungary)* hu-HU
Indonesian (Indonesia)* id-ID
Italian (Italy)
it-IT
Japanese (Japan)
ja-JP
Korean (Korea)
ko-KR
Polish (Poland)
pl-PL
Portuguese (Brazil)
pt-BR
Russian (Russia)
ru-RU
Spanish (Chile)
es-CL
Spanish (Spain)
es-ES
Slovak (Slovakia)
sk-SK
Turkish (Turkey)
tr-TR
Ukrainian (Ukraine)
uk-UA
* Only the product is available in this language; Online Help is not available.

Getting started with ESET Security Management Center
ESET Security Management Center can be configured and managed via the ESMC Web Console. After you have
successfully installed ESET Security Management Center or deployed ESMC VA, you can connect to your ESMC
Server using ESMC Web Console.
After you have successfully installed ESET Security Management Center, you can begin setting up your
configuration. Our guide will lead you through the recommended steps for an optimal setup experience.

First steps after ESMC Server deployment
1.Open ESMC Web Console in your web browser and log in.
2.Add your license(s) to ESET Security Management Center.
3.Add client computers, servers, and mobile devices on your network to the ESMC structure.
4.Assign the built-in policy Application reporting - Report all installed applications to all computers.
5.Create a Dynamic Group for computers with ESET home products.
6.Remove third party antivirus applications using the Software Uninstall task.
7.Install the ESET security products using the Software Install task (unless you have installed the Agent
using the All-in-one installer).
8.Assign a policy with recommended settings to each machine with installed ESET security products. For
example, for Windows machines with ESET Endpoint, assign the Built-in policy Antivirus - Maximum
security - Recommended. See also How to manage Endpoint products from ESET Security Management
Center.
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Additional recommended steps
• Get to know the ESMC Web Console, since it is the interface you will use to manage the ESET security
products.
• During installation, you created the default administrator account. We recommend that you save the
Administrator account credentials in a safe place and create a new account to manage clients and configure
their permissions.

Important
We do not recommend that you use the default ESMC Administrator account as a normal user
account. It serves as a backup in case something happens to normal user accounts or if you get
locked out. You can log in with the Administrator account to fix such issues.
• Use notifications and reports to monitor the status of client computers in your environment. For example,
if you want to be notified that a certain event occurred or want to view or download a report.
• Back up your database regularly to prevent loss of data.
• We recommend that you export the Server Certification Authority and Peer Certificates. In case you need
to reinstall the ESMC Server, you can use the CA and Peer Certificates from the original ESMC Server and
you do not need to reinstall ESET Management Agents on the client computers.

After upgrading from an earlier version of ERA
If you have upgraded from ERA 6.5, you must review your network users, permissions and server settings to
comply with the improved security model in ESET Security Management Center. Objects are not only computers
but also all tasks, notifications, policies, certificates, installers or permission sets. See the list of permissions for
more information on access rights.
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Note
After upgrading ESMC, we recommend that you delete the web browser cache and cookies before
logging into the upgraded Web Console.

Users and permission sets
The administrator should review all users and permission sets. The new security model is dependent on static
groups, so we recommend that you plan the structure of your groups and create permission sets afterward. The
administrator can also create new native users.

Important
Do not forget to assign each user a home group and permission set that will give the user
permissions over that group. All objects created by the user are always automatically contained in
that users' home group.
After an upgrade, users are divided into two categories:
• Users who were not assigned a permission set for the All group in the older version of ERA will not have a
home group in the new ESMC. These users will not have permissions for Groups and Computers and
therefore will not be able to see any devices.
• Users who were assigned a permission set for the All group in the older version of ERA will keep their
permissions for the All group. Additionally, these users will gain a new permission for the Groups and
Computers functionality.

Tasks and triggers
Client Tasks and Server Tasks are merged under Tasks.
Since ERA 6.5, only one trigger for each Server task is allowed. The number of server task triggers is automatically
adjusted after an upgrade to match the number of server tasks. From Tasks > Server Tasks, select a task to see
details about its trigger.

Reports, templates and all other objects
After an upgrade, all objects are contained in the static group All. The administrator can share objects among
users in the following ways:
• Duplicate objects to make them available to non-admin users
• Move objects to shared groups where more users can access them
• Users can be assigned other permission sets that would grant them limited rights for certain objects (for
example, Policies) over the All group

Static and dynamic groups
Static groups are essential for the security model in ESMC 7. Each object is located in one static group. After an
upgrade, the structure of static and dynamic groups remains the same. Users must be assigned proper
permissions for their group so that they can see and interact with other group members.
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Opening the ESMC Web Console
ESET Security Management Center Web Console is the main interface used to communicate with ESMC Server.
You can think of it as a control panel, a central place from which you can manage all ESET security solutions. It is a
web-based interface that can be accessed using a browser from any place and any device with internet access.
You can install the ESMC Web Console on a different computer than the computer where the ESMC Server is
installed.
There are multiple ways to open the ESMC Web Console:
• On your local server (the machine hosting your Web Console) type this URL into the web browser:
https://localhost/era/
• From any place with internet access to your web server, type the URL in following format:
https://yourservername/era/
Replace "yourservername" with the actual name or IP address of your web server.
▪To log into the ESMC Virtual appliance, use following URL:
https://[IP address]/
Replace "[IP address]" with the IP address of your ESMC VM.
▪On your local server (the machine hosting your Web Console), click Start > All Programs > ESET > ESET
Security Management Center > ESET Security Management Center Web Console - a login screen will open
in your default web browser. This does not apply to the ESMC Virtual appliance.
When web server (that runs ESMC Web Console) is up, the following login screen is displayed.

If this is your first login, please provide the credentials you entered during the Installation process. For more
details about this screen, see Web Console login screen.
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Note
If you experience problems logging in or receive error messages while trying to log in, see Web
Console Troubleshooting.

Using the Startup Wizard
When you log into the Web Console for the first time, a Startup Wizard for ESET Security Management Center will
appear. This wizard will give a basic explanation of important ESMC Web Console sections, the ESET Management
Agent and ESET security products. You will read about Computers, Tasks, Policies and the ESET Management
Agent.
The last step of the Startup Wizard called Deployment helps you create an all-in-one installer package (containing
the ESET Management Agent and ESET security product).

Important
The installer package comes as an .exe file and is valid for Windows only.
If you do not want to use the wizard, click Close Startup Wizard. The ESMC Web Console will open. The wizard
will not show up the next time you log into the ESMC Web Console. You can view the Startup wizard again by
clicking
Help > Startup Wizard.
You can also create an all-in-one Agent installer without using the wizard by clicking Other Deployment Options
in the Quick Links section.

Important
If you want to create an installer package, your user account must have the Agent Deployment
permission assigned. If a user account does not have this permission, the Startup Wizard will be
displayed without the Deployment step and the user will not have the option to create an installer
package.
Follow the steps below to create an installer package:
1.Language - Select the language version of the ESET security product installer.
2.Product - Select an ESET security product that will be installed together with ESET Management Agent.

Note
If you do not see any product installation files, make sure you have the repository set to
AUTOSELECT. For more information, see the Advanced settings section of Server settings.
3.Select the check box I accept the terms of the application End User License Agreement and
acknowledge the Privacy Policy. See License Management or EULA for more information.
4.Deselect the check box Participate in product improvement program if you do not agree to send crash
reports and telemetry data to ESET. If the check box is left selected, telemetry data and crash reports will
be sent to ESET.
5.License (Optional) - you can add a license using one of the methods described in License Management. If
you already have existing licenses in License Management, simply choose the license that will be used to
activate the ESET security product during the installation. If you do not choose a license, you can create an
installer without it and activate the product later. Addition/removal of a license is only allowed to be done
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by the Administrator whose home group is set to All and who has Write permission on licenses in that
group.
6.If you select the Show advanced settings check box, you can:
• ESET AV Remover - Select the check box to uninstall or completely remove other antivirus programs
on the target device.
• Select an Agent certificate and enter Certificate passphrase if needed. For example, if you have
specified the passphrase during the installation of your ESMC, or if you are using Custom certificate with
a passphrase. Otherwise, leave the Certificate passphrase field blank.

Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.
• Select the check box Enable HTTP Proxy settings and specify the Proxy settings (Server, Port, Login
and Password) to set ESET Management Agent connection to Proxy to enable communication
forwarding between ESET Management Agent and ESMC Server. The Server field is the address of the
machine where the HTTP Proxy is running. HTTP Proxy uses the port 3128 by default. You can set a
different port if needed. Make sure to set the same port also in the HTTP Proxy configuration.

Important
The communication protocol between Agent and ESMC Server does not support authentication. Any
proxy solution used for forwarding Agent communication to ESMC Server that requires
authentication will not work.
oWhen you select Enable fallback, ESET Management Agent will use a direct connection to ESMC Server if
HTTP Proxy is not available.
7.Full Disk Encryption - Encryption option is visible only with active ESET Full Disk Encryption license.

8.Click Create Installer. All-in-one installation package files will be generated for 32-bit and 64-bit operating
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systems. Click the desired version to start downloading it. Once the download completes you will be
prompted to specify a location where to store the file (for example, ESMC_Installer_x86_en_US.exe or
ESMC_Installer_x64_en_US.exe). Click Save file.
9.Run the installation package file on a client computer. It will install the ESET Management Agent and the
ESET Security product on the device and connect the device to ESMC. For step-by-step instructions, see the
setup wizard.

Note
After the first login to ESMC Web Console, we recommend that you run the Operating System
Update Client Task on the computer where ESET Security Management Center is installed.

ESMC Web Console
ESMC Web Console is the main interface used to communicate with ESMC Server. You can think of it as a control
panel, a central place where you can manage all of your ESET security solutions. It is a web-based interface that
can be accessed using a browser (see Supported Web browsers) from any place and any device with internet
access. When you log into the Web Console the first time, a Startup Wizard will appear.
In the ESMC Web Console standard layout:
• The current user is always shown in the upper right, where the timeout for his/her session counts down.
You can click Logout to log out at any time. When a session times out (because of user inactivity), a user
must log in again.
• To change User Settings, click your username in top right corner of ESMC Web Console.
• You can click the
icon at the top of any screen to open the Help menu. The first link in this menu always
links to Online Help for the current screen.
• The Menu is accessible on the left at all times except when using a wizard. Click the
to expand the
menu on the left side of the screen; you can collapse it by clicking
Collapse menu.
• The
icon always denotes a context menu.
• Click
Refresh to reload/refresh displayed information.
• Click the ESET Security Management Center logo to open the Dashboard screen.
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Status Overview shows you how to get the most out of ESET Security Management Center. This will guide you
through the recommended steps.

Screens with trees have specific controls. The tree itself is on the left with actions below. Click an item from the
tree to display options for that item.
Tables allow you to manage units from rows individually, or in a group (when more rows are selected). Click a row
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to display options for units in that row. Data in tables can be filtered and sorted.

Objects in ESMC can be edited using wizards. All wizards share the following behaviors:
• Steps are vertically oriented from top to bottom.
• You can return to any step at any time.
• Invalid input data is marked when you move your cursor to a new field. The wizard step containing invalid
input data is marked as well.
• Finish is not available until all input data is correct.
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How to manage Endpoint products from ESET Security
Management Center
Before you can start managing ESET Business Solutions you need to perform initial configuration. We recommend
that you use Status overview, especially if you have skipped the Startup Wizard. Administrator can perform
variety of tasks from the ESMC Web Console in order to install products and control client computers.

Installation of ESET Management Agent and Endpoint security products
ESET Security Management Center requires that theESET Management Agent to be installed on each managed
client computer. The ESET Management Agent can be installed in combination with your Endpoint security
product. Before installation, we recommend that you import your license into ESET Security Management Center
so it can be used for your consequent installations. There are two methods to install your Endpoint product:
• Use the Agent and ESET security product installer or ESET Remote Deployment Tool to install your
Endpoint product and ESET Management Agent at the same time.
• Install your ESET Endpoint product on clients where you have already installed ESET Management Agent
using a Client Task.

Managing the Endpoint security product from ESET Security Management
Center
All Endpoint security products can be managed from ESMC Web Console. Policies are used to apply settings to
single computers or groups. For example, you can create a policy to block access to certain web localities, change
scanner settings detection sensitivity (available in Endpoint 7.2), or change all other ESET security settings.
Policies can be merged, as shown in our example. Policies set using ESMC cannot be overwritten by a user on a
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client machine. However, the administrator can use the override feature to allow a user to make changes on a
client temporarily. When you are finished making changes, you can request the final configuration from the client
and save it as a new policy.
Tasks can also be used to manage clients. Tasks are deployed from the Web Console and executed on the client
by the ESET Management Agent. The most common Client Tasks for Windows Endpoints are:
• Update modules (also updates the virus database)
• Run On-Demand scan
• Run custom command
• Request the computer and product configuration

Reporting the computer status and getting information from clients to
ESET Security Management Center
Each client computer is connected to ESET Security Management Center through ESET Management Agent. The
Agent reports all requested information about the client machine and its software to the ESMC Server. The
connection between the agent and server is set by default to 1 minute, but it can be changed in your ESET
Management Agent policy. All logs from Endpoints or other ESET security products are sent to the ESMC Server.
Information about installed ESET products and other basic information about a client's OS and status can be found
in Computers. Select a client and click Show Details. In the
Configuration section of this window, a user can
look up older configurations or request current configuration. In the SysInspector section, a user can request logs
(from Windows computers only).
Web Console also allows you to access a list of all detections (navigate to Detections) from client devices.
Detections from a single device can be viewed in Computers. Select a client and click Show Details > Detections
and Quarantine. If the client computer runs ESET Enterprise Inspector, you can view and manage Enterprise
Inspector detections.
You can generate custom reports on-demand or using a scheduled task to view data about clients in your
network. Pre-defined report templates offer a quick way to gather important data, or you can create your own
new templates. Examples of reports include aggregated information about computers, detections, quarantine and
necessary updates.

Important
A user can only use report templates for which he has sufficient permissions. By default, all
templates are stored in the group All. A report can only include information about computers and
events within that user's permission scope. Even if a report template is shared among more users,
each user's report will only contain information about devices for which that user has permission.
See the list of permissions for more information on access rights.

ESET Push Notification Service
ESET Push Notification Service (EPNS) serves for receiving messages from the ESMC Server, if the server has a
notification for the client. The connection is running so that ESMC can send a (push) notification to a client
immediately. When the connection is broken, client tries to reconnect. The main reason for the permanent
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connection is to make clients available to receive messages.
A Web Console user can send Wake-Up calls via EPNS between the ESMC Server and ESET Management version
7.x Agents. Each Wake-Up call also sends a Wake on LAN call. You can set up multicast addresses for Wake on
LAN in Server Settings.

Connection details
To configure your local network to allow communication with EPNS, both the ESET Management Agent and the
ESMC Server need to be able to connect to the EPNS server. If you cannot establish a connection with EPNS for
your Agents, only Wake-Up calls are affected.
Connection details
Transport security SSL
Protocol
MQTT (machine-to-machine connectivity protocol)
Port
• primary: 8883
• fallback: 443 and the proxy port set by the ESET Management Agent policy
Port 8883 is preferred, as it is an MQTT port. The 443 is only a fallback port and it is shared
with other services. Also, a firewall can abort the connection on port 443 because of
inactivity or maximum opened connections limit for the HTTP Proxy server.
epns.eset.com
Host address
Proxy compatibility If you use HTTP Proxy for forwarding communication, Wake-Up calls are also sent through
HTTP Proxy. Authentication is not supported. Make sure to configure HTTP Proxy in Agent
policy on computers where you want to send the Wake-up calls. In case HTTP Proxy is not
working, Wake-up calls are sent directly.

Compatibility with ERA 6.x
• ERA 6.x Agents cannot receive Wake-Up calls from ESMC 7 and later. ERA 6.x Agents can receive only
Wake on LAN signal, which wakes up computers on the same network. Wake on LAN does not enforce the
replication of ESET Management Agent.
• ESET Management Agents can receive Wake-Up calls only via EPNS, not from ERA 6.x Server.

Agents are therefore not cross-compatible with newer or older versions of ESET Security Management Center
server.

Troubleshooting
• Make sure your firewall is set to allow the connection to EPNS (see the details above).
• Make sure both Agent and Server can connect directly to the EPNS server.

VDI, cloning and hardware detection
ESET Security Management Center supports VDI environments, cloning of machines and non-persistent storage
systems. This feature is necessary to set up a flag for the master computer or resolve a question which appears
after cloning or a change of hardware.
• Until the question is resolved, the client machine is unable to replicate to the ESMC Server. Client only
checks if the question is resolved.
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• Disabling hardware detection is irreversible, use it with the highest caution and only on physical machines!
• When resolving multiple questions, use the Status Overview - Questions tile.

Which OSs and hypervisors are supported?
Warning
Before you start using VDI with ESMC, read more about supported and unsupported features of
various VDI environments in our Knowledgebase article.
• Only Windows operating systems from Windows XP SP2 x64 and later are supported.
• ESET Virtual Agent Hosts are not supported.
• ESET Full Disk Encryption is not supported.
• Mobile devices managed via MDM are not supported.
• Linked clones in Virtual Box can not be distinguished from one another.
• In very rare cases, detection can be switched off automatically by the ESMC. This happens when ESMC is
not able to reliably analyze the hardware.
• See the list of supported configurations:
oCitrix PVS 7.0+ with physical machines
oCitrix PVS 7.0+ with virtual machines in Citrix XenServer 7+
oCitrix PVS 7.0+ and Citrix XenDesktop with Citrix XenServer 7+
oCitrix Machine Creation Services
o(without PVS) Citrix XenDesktop with Citrix XenServer 7+
oVMWare Horizon 7.x with VMWare ESXi (instant clones are not supported)
oMicrosoft SCCM (for re-imaging)

VDI environments
You can use Master machine with ESET Management Agent for a VDI pool. There is no VDI connector needed; all
communication is handled via ESET Management Agent. ESET Management Agent 7 must be installed on the
Master machine before the VDI pool (machine catalog) is set up.
• If you want to create a VDI pool, flag the Master computer in Computer details - Hardware before creating
the pool. Select Mark as Master for Cloning (Match with existing computer).
• If the Master computer is removed from the ESMC, recovery of its identity (cloning) is forbidden. New
machines from the pool would get a new identity each time (new machine entry is created in the Web
Console).
• When a machine from the VDI pool connects for the first time, it has a mandatory 1 minute connection
interval. After the first few replications the connection interval is inherited from the master.
• Never disable hardware detection when using the VDI pool.
• You can have the master machine running along with the cloned computers, so you can keep it updated.
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Cloning machines on hypervisor
You can create a clone of a regular machine. Just wait for the Question to appear and resolve it by selecting
Create new computer only this time.

Imaging of systems to physical machines
You can use a Master image with ESET Management Agent installed and deploy it on physical computers. There
are two ways to accomplish this:
1.System creates a new machine in ESMC after each image deployment.
• Resolve each new computer manually in Questions and select Create a new computer every time.
• Flag the Master machine before cloning. Select Mark as Master for Cloning (Create a new computer).
2.System creates a new machine in ESMC after the image is deployed on a new machine. If the image is redeployed on a machine with previous history in ESMC (that already had ESET Management Agent v7
deployed), this machine is connected to its previous identity in ESMC.
• Resolve each new computer manually in Questions and select Match with an existing computer every
time.
• Flag the master machine before cloning. Select Mark as Master for Cloning (Match with existing
computer).
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Warning
If you have an image (or a template) of your master computer, make sure to keep it updated.
Always update the image after upgrade or re-installation of any ESET components on the master
machine.

Parallel replication
ESMC Server can recognize and resolve parallel replication of multiple machines to a single identity in ESMC. Such
an event is reported to Computer details - Alerts ('Multiple connections with identical Agent ID'). There are two
ways to resolve this issue:
• Use the one-click action available on the alert. Computers are divided, and their hardware detection is
permanently turned off.
• In rare cases, even computers with switched-off hardware detection can conflict. In such cases the Reset
cloned agent task is the only option.
• Run the Reset cloned agent task on the machine. This keeps you from having to disable hardware
detection.

Resolving cloning questions
Every time a machine connects to the ESMC Server, an entry is created based on two fingerprints:
• an ESET Management Agent UUID (universally unique identifier) - It changes after the ESET Management
Agent is re-installed on a machine (see Double Agent situation).
• a machine hardware fingerprint - It changes if the machine is cloned or redeployed.
A question is displayed if the ESMC Server detects one of the following:
• a cloned device connecting
• a change of hardware in an existing device with ESET Management Agent installed
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Important
Hardware fingerprint detection is not supported on:
• Linux, macOS, Android, iOS
• systems managed via ESET Virtual Agent Hosts (ESET Virtualization Security)
• machines without ESET Management Agent 7
Click the question and select Resolve question to open a menu with the following options:
New computers are being cloned or imaged from this computer
Match with the existing
Select this option when:
KB article
computer every time
• You use the computer as a master and all its images
should connect to the existing computer entry in ESMC.
• You use the computer as a master to set up a VDI
environment and the computer is in VDI pool and is
expected to recover its identity based on a hardware
fingerprint ID.
Create a new computer every
Select this option when you use this computer as a
KB article
time
master image and you want ESMC to automatically
recognize all clones of this computer as new computers.
Do not use with VDI environments.
Create a new computer this time Computer is cloned only once. Select to create a new
KB article
only
instance for the cloned device.

No computers are cloned from this computer, but its hardware has changed
Accept changed hardware every Disable the hardware detection permanently for this device. Use only if nontime
existent hardware changes are reported.

Warning
This action is irreversible!
If you disable the hardware detection, both Agent and Server
store this setting. Re-deployment of the Agent does not restore
the disabled HW detection. Machines with disabled hardware
detection are not suitable for the VDI scenarios in ESMC.
Accept changed hardware only
this time

Select to renew the hardware fingerprint of the device. Use this option after
the hardware of the client computer is changed. Future hardware
modifications will be reported again.

Click Resolve to submit the selected option.
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Double Agent situation
If an ESET Management Agent is uninstalled (but computer is not removed from Web Console) on the client
machine and installed again, there are two same computers in the Web Console. One is connecting to the Server
and the other one is not. This situation is not handled by the Questions dialog window. Such a situation is the
result of incorrect agent removal procedure. The only solution is to manually
remove the not connecting
computer from the Web Console. The history and logs created before the re-installation will be lost afterward.

Using the Delete not connecting computers task
If you have a VDI pool of computers and you did not resolve the question (see above) correctly, the Web console
creates a new computer instance after reloading of the computer from the pool. Computer instances stack up in
the Web Console and licenses can get overused. We do not recommend to solve it by setting up a task for
deleting not connecting computers. Such a procedure removes the history (logs) for deleted computers and
licenses can also be overused.

Overused licenses
When a client computer with installed ESET Management Agent and activated ESET security product gets cloned,
each cloned machine can claim another license seat. This process can overuse your licenses. In VDI environments,
use an offline license file for the activation of ESET products and contact ESET to modify your license.

Notifications for cloned computers
There are three prepared notifications user can use for cloning-related actions, change of hardware or user can
create a new custom notification using cloning-related events. To set up a notification navigate to
Notifications menu in the Web Console.
• New Computer Enrolled – Notify if a computer is connected for the first time to the selected static group
(the group All is selected by default). This works with ESET Management Agents version 7.x only.
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• Computer Identity Recovered – Notify if a computer was identified based on its hardware. The computer
was cloned from a Master machine or other known source.
• Potential Computer Cloning Detected – Notify about a significant hardware modification or cloning if the
source machine was not flagged as a Master before.

Hardware identification
ESMC is gathering hardware details about each managed device and tries to identify it. Every device connected to
ESMC belongs to one of the following categories, displayed in the column Hardware identification, in the
Computers window.
• Hardware detection enabled – detection is enabled and working fine.
• Hardware detection disabled – detection was disabled by the user or automatically by ESMC Server.
• No hardware information – no hardware information is available, either the client device is running
unsupported OS or old version of Agent.
• Hardware detection unreliable – the detection is reported by the user to be unreliable, and it is going to
be disabled. This status can occur only during the single replication interval before the detection is disabled.

ESET Management Agent Deployment
This section describes all available methods you can use to deploy ESET Management Agent on the client
computers in your network. It is very important because ESET security solutions running on client computers
communicate with ESMC Server exclusively through the Agent.

Add client computers to ESMC structure
Before you can start managing client computers in your network, you need to add them to ESET Security
Management Center. Use one of the methods below to add them:
• Active Directory synchronization
• RD Sensor
• Add new devices manually

ESET Management Agent deployment
ESET Management Agent deployment can be performed in a few different ways. You can deploy the Agent locally
or remotely:
• Local deployment - Install ESET Management Agent and ESET security product locally on a client computer.

Note
We recommend that you only use local deployment if you have a small network (up to 50
computers). For larger networks, you can Deploy ESET Management Agent using GPO or SCCM.
• Remote deployment - we recommend that you use this method to deploy ESET Management Agent on large
number of client computers.
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Add computers using Active Directory synchronization
AD synchronization is performed by running the Static Group Synchronization server task. It is a pre-defined
default task that you can choose to execute automatically during ESET Security Management Center installation. If
the computer is in a domain, synchronization will be performed and computers from the AD will be listed in the
default group All.
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To start the synchronization process, click the task and choose Run now. If you need to create a new AD
synchronization task, select a group to which you want to add new computers from the AD. Also select objects in
the AD you want to synchronize from and what to do with duplicates. Enter your AD server connection settings
and set the Synchronization mode to Active Directory/Open Directory/LDAP. Follow step-by-step instructions in
this ESET Knowledgebase article.

Add new devices manually
This feature allows you to manually add Computers or Mobile devices that are not found or added automatically.
The Computers or Group tab allows you to add new computers or mobile devices.
1.To add a new computer, click Computers > Add New and then select Computers (alternatively click the
gear icon
next to existing Static group and then click Add New).
2.Add Computers - you can use several options:
oType the IP address or hostname of a machine you want to add and ESET Security Management Center
will search for it on the network. Optionally, you can enter a Description of the computers.
o+ Add Device to add additional devices. If you want to delete a computer from the list of devices, click
the Trashcan icon
or click Remove All.
oImport CSV to upload a .csv file containing a list of computers to add. For more information, see Import
CSV upload.
oCopy & Paste a custom list of computers separated with custom delimiters. The feature works similarly
to importing a CSV.
3.Click Select tags to assign tags.
4.Parent group - select an existing Parent group and then click OK.
5.Use FQDN resolution:
oSelect the check box and the ESMC Server translates the provided IP address or computer hostname to a
fully qualified domain name.
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oUnselect the check box to import the provided computer names. This option makes the batch import of
computers quicker with names in FQDN format (for example, import from a .csv).
6.Use the Conflict Resolution drop-down menu to select the action to take if a computer you are adding
already exists in ESMC:
• Ask when detected: When a conflict is detected, the program will ask you to select an action (see
the options below).
• Skip duplicate devices: Duplicate computers will not be added.
• Create duplicate devices: New computers will be added, but with different names.
• Move duplicate devices into group... : Conflicting computers will be moved into Parent Group.
7.Click Add when you are finished making changes.

Note
Adding multiple computers may take a longer time (reverse DNS lookup may be preformed - see
Use FQDN resolution above).
8.A pop-up window will open with a list of devices to be added. You can click OK or Deploy Agent.
9.If you have clicked Deploy Agent, choose the deployment type you want to perform:
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Add computers using RD Sensor
If you are not using AD synchronization, the easiest way to find an unmanaged computer in your network
structure is to use RD Sensor. RD Sensor monitors the network in which it is deployed and when a new device
without an Agent connects to the network it reports this information to the ESMC.
In Reports, go to section Computers and click the Rogue computers report.
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The Rogue computers report lists computers found by the RD Sensor. You can adjust the information reported by
RD Sensor with the RD Sensor policy. You can add computers by clicking the computer you want to Add, or you
can Add all displayed items.

If you are adding a single computer, you can use a preset name or specify your own (this is a display name that
will be used in ESMC Web Console only, not an actual hostname). You can also add a description if you want to. If
this computer already exists in your ESMC directory, you will be notified and can decide what to do with the
duplicate. The available options are: Deploy Agent, Skip, Retry, Move, Duplicate or Cancel. Once the computer is
added, a pop-up window will open with an option to Deploy Agent.
If you click Add all displayed items a list of computers to be added will be displayed. Click
next to the name of
a specific computer if you do not want to include it in your ESMC directory at this time. When you are finished
removing computers from the list, click Add. After clicking Add, select the action to take when a duplicate is found
(allow for a slight delay depending on the number of computers in your list): Skip, Retry, Move, Duplicate or
Cancel. Once you have selected an option, a pop-up window opens with an option to Deploy Agents on those
computers.
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The results of the RD Sensor scan are written to a log file called detectedMachines.log. It contains a list of
discovered computers on your network. You can find the detectedMachines.log file here:
• Windows
C:\ProgramData\ESET\Rogue Detection Sensor\Logs\detectedMachines.log
• Linux
/var/log/eset/RogueDetectionSensor/detectedMachines.log

ESET Rogue Detection Sensor policy settings
It is possible to change the behavior of ESET RD Sensor using a policy. This is mostly used to change the filtering of
addresses. You can, for example, include certain addresses in the blacklist so they are not detected.
Click Policies and expand Custom Policies to edit an existing policy or create a new one.

Filters
IPv4 Filter
Enable IPv4 address filtering - By enabling filtering, only computers whose IP addresses are part of the
Whitelist in the IPv4 filter list will be detected, or only those that are not part of the Blacklist.
Filters - Specify whether the list will be a Whitelist or Blacklist.
IPv4 address list - Click Edit IPv4 list to add or remove addresses from the list.
MAC address prefix filter
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Enable MAC address prefix filtering - By enabling filtering, only computers whose MAC address prefix (xx:xx:xx)
addresses are part of the MAC address list will be detected, or only those that are not part of the Blacklist.
Filtering mode - Specify whether the list will be a Whitelist or Blacklist.
MAC address prefix list - Click Edit MAC prefix list to add or remove a prefix from the list.
Detection
Active detection - Enabling this option will allow the RD Sensor to search the local network for computers
actively. This can improve search results but it can also trigger firewall warnings on some machines.
OS detection ports - RD Sensor uses a pre-configured list of ports to search the local network for computers. You
can edit the port list.
Advanced Settings
Diagnostics - Enable or disable the submission of anonymous crash report statistics to ESET for the improvement
of customer experience.
Assign
Specify the clients that will receive this policy. Click Assign to display all Static and Dynamic Groups and their
members. Select the computer that you want to apply a policy on and click OK.

Summary
Review the settings for this policy and click Finish.

Local deployment
This deployment method is intended for on-premises installations. Create or download an installation package
and allow access to it via via a shared folder, flash drive or email. The installer package must be installed by an
Administrator or a user with Administrator privileges.

Note
We recommend that you only use local deployment if you have a small network (up to 50
computers). For larger networks, you can Deploy ESET Management Agent using GPO or SCCM.
Local deployment can be performed in three ways:
Create Agent installer (Windows only)
Create Agent Live Installer
Download Agent from ESET website (Windows, Linux, macOS)

Local Deployment and permission
For more information on how to allow a user to deploy ESET Management Agent locally, follow the instructions in
this example.
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Note
Keep in mind that the user will be able to work with Certificates when creating installers. A user
must have Use permission for Certificates with access to the static group where certificates are
contained. If a user wants to deploy ESET Management Agent, it is necessary to be assigned Use
permission for Certification Authority that the actual server certificate is signed. For information on
how to divide access to Certificates and Certification Authority, read this example. See the list of
permissions for more information on access rights.

Create Agent (and ESET security product) installer
The procedure of creating an all-in-one installer (including ESET Management Agent and an ESET product)
package is similar to a Startup Wizard; however the all-in-one installer allows for advanced configuration options.

Important
The installer package is an .exe file and is valid for Microsoft Windows operating systems only.
Click Other Deployment Options in the Quick Links section of the menu bar. In the Deploy Agent window, click
Create installer under Create all-in-one Installer (Windows only). The Create all-in-one installer window will
open.

Basic
Deselect the check box Participate in product improvement program if you do not agree to send crash reports
and telemetry data to ESET. If the check box is left selected, telemetry data and crash reports will be sent to ESET.
Package contents - Select the check box(es) from the following options:
• Management Agent - Include only the ESET Management Agent. Select this option if you want to install
the ESET Security product on the client computer later, or if the client computer already has an ESET security
product installed.
• Security Product - Include the ESET Security product with the ESET Management Agent. Select this option
if the client computer does not have any ESET Security product installed and you want to install it with the
ESET Management Agent.
• Full Disk Encryption - Encryption option is visible only with active ESET Full Disk Encryption license.

Security Product
• License (Optional) - you can add a license using one of the methods described in License Management. If
you already have existing licenses in License Management, simply choose the license that will be used to
activate the ESET security product during the installation. If you do not choose a license, you can create an
installer without it and activate the product later. Addition/removal of a license is only allowed to be done
by the Administrator whose home group is set to All and who has Write permission on licenses in that
group.
• Product - Select an ESET security product that will be installed together with ESET Management Agent.

Note
If you do not see any product installation files, make sure you have the repository set to
AUTOSELECT. For more information, see the Advanced settings section of Server settings.
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• Language - Select the language version of the ESET security product installer.
• Optionally, you can select a Policy that will be applied on the ESET Security product during its installation.
• Select the check box I accept the terms of the application End User License Agreement and acknowledge
the Privacy Policy. See License Management or EULA for more information.

Certificate
A Peer Certificate and ESMC Certification Authority are chosen automatically based on the available certificates. If
you want to use a different certificate than the one automatically selected, click ESMC Certificate to see a list of
available certificates and then select the one you want to use. If you want to use your own Custom certificate,
click the radio button and upload a .pfx certificate file. See Custom certificates with ESMC for further
instructions.
Enter your Certificate passphrase if needed. For example, if you have specified the passphrase during the
installation of ESMC, or if you are using a Custom certificate with a passphrase. Otherwise, leave the Certificate
passphrase field blank.

Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.

Important
Be aware that it is possible to extract the Certificate passphrase because it is embedded in the
.exe file.

Advanced
In this section, you can customize the all-in-one installer package:
• Optionally, you can change the Name and enter a Description for the package installer.
• Click Select tags to assign tags.
• Parent group (optional) - Select the Parent group where the computer will be placed after installation.
You can select an existing static group or create a new static group to which the device will be assigned after
the installer is deployed.
• ESET AV Remover - Select the check box to uninstall or completely remove other antivirus programs on
the target device.
• Initial installer configuration (Optional) - Use this option if you want to apply configuration policy to ESET
Management Agent. Click Select under Agent configuration (optional) and choose from the list of available
policies. If none of the predefined policies are suitable, you can create a new policy or customize the existing
ones.
• Server hostname - Type the ESMC Server IP address. If necessary, you can specify the Port number
(default is 2222).
• Select the check box Enable HTTP Proxy settings and specify the Proxy settings (Server, Port, Login and
Password) to set ESET Management Agent connection to Proxy to enable communication forwarding
between ESET Management Agent and ESMC Server. The Server field is the address of the machine where
the HTTP Proxy is running. HTTP Proxy uses the port 3128 by default. You can set a different port if needed.
Make sure to set the same port also in the HTTP Proxy configuration.
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Important
The communication protocol between Agent and ESMC Server does not support authentication. Any
proxy solution used for forwarding Agent communication to ESMC Server that requires
authentication will not work.
oWhen you select Enable fallback, ESET Management Agent will use a direct connection to ESMC Server if
HTTP Proxy is not available.
• Click Finish. All-in-one installation package files will be generated for 32-bit and 64-bit operating systems.
Click the desired version to start downloading it. Once the download completes you will be prompted to
choose the location where the file is stored (for example, ESMC_Installer_x86_en_US.exe or
ESMC_Installer_x64_en_US.exe). Click Save file.
Run the installation package file on a client computer. It will install the ESET Management Agent and the ESET
Security product on the device and connect the device to ESMC. For step-by-step instructions, see the setup
wizard.

Create Agent Live Installer - Windows/Linux/macOS
This type of Agent deployment is useful when the remote and local deployment options do not work in your
environment. In such cases, you can distribute the Agent Live Installer via email and let the user deploy it. You can
also run the Agent Live Installer from removable media (a USB flash drive, for example).

Important
• The client machine needs to have an internet connection to download the Agent installation
package.
• Make sure that the client machine has an internet connection and can connect to the ESMC
Server.
In the Quick Links section of the menu bar, click Other Deployment Options. In the Deploy Agent window, click
Create installer button under Create Agent Live Installer. The Agent Live installers window will open.

Package creation
Deselect the check box Participate in product improvement program if you do not agree to send crash reports
and telemetry data to ESET. If the check box is left selected, telemetry data and crash reports will be sent to ESET.
Certificate - A Peer Certificate and ESMC Certification Authority is chosen automatically based on the available
certificates. If you want to use a different certificate than the one automatically selected, click the ESMC
Certificate description to select from a list of available certificates. If you want to use a Custom certificate, click
the radio button and upload a .pfx certificate file. See Custom certificates with ESMC for further details.
Enter a Certificate passphrase if needed. For example, if you have specified the passphrase during the installation
of ESMC, or if you are using a custom certificate with a passphrase. Otherwise, leave the Certificate passphrase
field blank.
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Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.
Configuration - In this section, you can customize the following settings for the Agent Live installer package:
1.Optionally, you can change the Name and enter a Description for your package installer.
2.Click Select tags to assign tags.
3.Agent configuration (optional) - Use this option if you want to apply a configuration policy to the ESET
Management Agent. Click Select and choose from the list of available policies.
4.Server hostname - Type the ESMC Server IP address. If necessary, you can specify the Port number
(default is 2222).
5.Parent group (optional) - Select the Parent group where the computer will be placed after installation.
You can select an existing static group or create a new static group to which the device will be assigned
after the installer is deployed.
6.Select the check box Enable HTTP Proxy settings and specify the Proxy settings (Server, Port, Login and
Password) to download the installer via Proxy and set ESET Management Agent connection to Proxy to
enable communication forwarding between ESET Management Agent and ESMC Server. Read more about
Proxy here.

Important
The communication protocol between Agent and ESMC Server does not support authentication. Any
proxy solution used for forwarding Agent communication to ESMC Server that requires
authentication will not work.
oWhen you select Enable fallback, ESET Management Agent will use a direct connection to ESMC Server if
HTTP Proxy is not available.
7.Click Finish to generate links for Windows, Linux and macOS Agent installer files.

8.Click Download under the installer file(s) that you want to download and save the zip file. Unzip the file
on the client computer where you want to deploy ESET Management Agent and run
ESMCAgentInstaller.bat (Windows) or ESMCAgentInstaller.sh script (Linux and macOS) to run
the installer. For instructions on how to deploy the ESET Management Agent on a client using the Agent
Live Installer, see our KB article.
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Note
If you are running the script on Windows XP SP2, you need to install Microsoft Windows Server
2003 Administration Tools Pack. Otherwise, the Agent Live Installer won't run properly. Once you
have installed the Administration Pack, you can run the Agent Live Installer script.

Note
Check the status log on the client machine
C:\ProgramData\ESET\RemoteAdministrator\Agent\Logs\status.html to make sure ESET
Management Agent is working properly. If there are problems with the Agent (for example, it is not
connecting to the ESMC Server), see troubleshooting.

Deployment from custom remote location
To deploy the Agent from a location other than the ESET repository, modify the install script to specify the new
URL where the Agent package is located. You can also use the IP address of the new package.
Find and modify following lines:

Windows:
set
url=http://repository.eset.com/v1/com/eset/apps/business/era/agent/v7.../agent_x64.m
si
set
url=http://repository.eset.com/v1/com/eset/apps/business/era/agent/v7.../agent_x86.m
si

Linux:
eraa_installer_url=http://repository.eset.com/v1/com/eset/apps/business/era/agent/v7
.../agent-linux-i386.sh
eraa_installer_url=http://repository.eset.com/v1/com/eset/apps/business/era/agent/v7
.../agent-linux-x86_64.sh

macOS:
eraa_installer_url=http://repository.eset.com/v1/com/eset/apps/business/era/agent/v7
.../agent-macosx-x86_64.dmg

Deployment from local shared folder
To deploy the ESET Management Agent using Agent Live Installer from your local shared folder without the ESET
Repository Download Server, follow these steps:
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Windows:
1.Edit the ESMCAgentInstaller.bat file.
2.Copy the .msi agent installer to a local directory used by the ESMCAgentInstaller.bat file by adding a
command copy /y \\server\share\agent_x64.msi %installDirectory% before line set
url=%installDirectory%\agent_x64.msi and a command copy /y
\\server\share\agent_x86.msi %installDirectory% before line set
url=%installDirectory%\agent_x86.msi and change lines set
url=%installDirectory%\agent_x64.msi and set url=%installDirectory%\agent_x86.msi
to point to the correct local download files.
The original file looks like:

See the updated file below. Use your own URL (local shared folder), but do not change the
%installDirectory%:

Note
Agent Live Installer verifies integrity of installation files based on their checksum. This is a unique
string generated for each file. In case the file changes, its checksum changes as well.

Important
Make sure that the user account under which the installation package is executed has write
permission to the local shared folder. The path can contain spaces, for example
\\server\share\Agent_x64.msi (do not use quotation marks "").
3.Edit line 81 to replace " echo.packageLocation = DownloadUsingHTTPProxy^("!url!",
"!http_proxy_hostname!", "!http_proxy_port!", "!http_proxy_username!", "!http_proxy_password!"^) "

with echo.packageLocation = "!url!"
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4.Save the file.

macOS:
1.Open the ESMCAgentInstaller.sh script in a text editor.
2.Delete lines: 62-69 and 73-86.

3.Replace lines 171-190 with the path to your local installer. See the highlighted area in the image. Use
your own URL (local shared folder), instead of the one shown below.
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4.Save the file.

Linux:
1.Open the ESMCAgentInstaller.sh script in a text editor.
2.Delete lines: 38 and 39:

3.Insert the following line with the paths to your local installer.

1.Replace lines 42 - 60 with the path to your local x86_64 installer. See the highlighted area in the image.
Use your own URL (local shared folder), instead of the one shown below.
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5.Delete lines 54 - 75.

6.Save the file.

Download Agent from ESET website
Download the ESET Management Agent installation package from the ESET website. Select the appropriate
package depending on the client computer's OS:
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• Linux server-assisted and offline installation
• macOS
• Windows
oServer assisted installation - using the Agent installation package, this method downloads certificates from
the ESMC Server automatically (recommended for local deployment).

Note
If you decide to allow Server assisted installation by another user, make sure the following
permissions are set:
• The user must have Use permission for the Certification Authority that signed the server 's
peer certificate and Use permission for at least one peer certificate. If no such certificate exists,
the user will need Write permission to create a new one.
• Write permission for the static group where the user wants to add the computer.
oOffline installation - using the Agent installation package. You must manually export certificates and apply
them in this deployment method.
Check the status log on the client machine (located at
C:\ProgramData\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs\status.html or C:\Documents
and Settings\All Users\Application
Data\Eset\RemoteAdministrator\Agent\EraAgentApplicationData\Logs\status.hmtl) to ensure ESET Management
Agent is working properly.

Note
If there are problems with the Agent (for example, it is not connecting to the ESMC Server), see
section Troubleshooting - Agent deployment.

Remote deployment
Important
For remote deployments, verify all client computers have an internet connection.
Remote deployment can be performed in the following ways:
• ESET Remote Deployment Tool - this tool allows you to deploy the ESET Management Agent (and ESET
security product) installer packages created in the ESMC Web Console.
• Group Policy Object (GPO) and System Center Configuration Manager (SCCM) - we recommend this
method for mass deployment of the ESET Management Agent on client computers.
• Server task Agent deployment - an alternative to GPO and SCCM.
Should you experience problems when deploying the ESET Management Agent remotely (the Server task Agent
deployment fails), see the following:
• Troubleshooting - Agent deployment
• Troubleshooting - Agent connection
• Example scenarios of ESET Management Agent deployment
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Remote deployment and permissions
If you want to allow user to create GPO installers or SCCM scripts, set their permissions to match our example.
The following permissions are necessary for Server task Agent deployment:
• Write permission for Groups & Computers where the deployment is executed
• Use permission for Certificates with access to static group where certificates are contained
• Use permission for Agent deployment in Server Tasks & Triggers section

Agent deployment using GPO and SCCM
Apart from local deployment, you can also use management tools such as Group Policy Object (GPO), System
Center Configuration Manager (SCCM), Symantec Altiris or Puppet for remote deployment of Agent.

Important
For remote deployments, verify all client computers have an internet connection.
Follow the steps below to deploy the ESET Management Agent to clients using GPO or SCCM:
Download the Agent installer .msi file from ESET download page - Standalone installers section.
Click Other Deployment Options in the Quick Links section of the menu bar, pop-up window will open where you
can choose Use GPO or SCCM for deployment, click the button Create Script.

Certificate
Deselect the check box Participate in product improvement program if you do not agree to send crash reports
and telemetry data to ESET. If the check box is left selected, telemetry data and crash reports will be sent to ESET.
A Peer Certificate and ESMC Certification Authority are chosen automatically based on the available certificates. If
you want to use a different certificate than the one automatically selected, click ESMC certificate description to
see a list of available certificates and choose the one you want to use. If you want to use your Custom certificate
click the radio button and upload a .pfx certificate file. See Custom certificates with ESMC for further details.
Enter Certificate passphrase if needed. For example if you have specified the passphrase during the installation of
your ESMC, or if you are using Custom certificate with a passphrase. Otherwise, leave the Certificate passphrase
field blank.

Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.

Advanced
You can customize the ESET Management Agent installation package:
1.Enter the Name and Description (optional) of the installation package.
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2.Click Select tags to assign tags.
3.Parent group (optional) - Select the Parent group where the computer will be placed after installation.
You can select an existing static group or create a new static group to which the device will be assigned
after the installer is deployed.
4.Initial installer configuration (Optional) - Use this option if you want to apply configuration policy to
ESET Management Agent. Click Select under Agent configuration (optional) and choose from the list of
available policies. If none of the predefined policies are suitable, you can create a new policy or customize
the existing ones.
5.Server hostname - Type the ESMC Server IP address. If necessary, you can specify the Port number
(default is 2222).
6.Select the check box Enable HTTP Proxy settings and specify the Proxy settings (Server, Port, Login and
Password) to download the installer via Proxy and set ESET Management Agent connection to Proxy to
enable communication forwarding between ESET Management Agent and ESMC Server. Read more about
Proxy here.

Important
The communication protocol between Agent and ESMC Server does not support authentication. Any
proxy solution used for forwarding Agent communication to ESMC Server that requires
authentication will not work.
oWhen you select Enable fallback, ESET Management Agent will use a direct connection to ESMC Server if
HTTP Proxy is not available.
7.Click Finish and when a new popup window with install_config.ini file opens, click Save file.
Click the appropriate link below to view step-by-step instructions for two popular ESET Management Agent
deployment methods:
1.Deployment of ESET Management Agent using Group Policy Object (GPO) - This Knowledgebase article
may not be available in your language.
2.Deployment of ESET Management Agent using System Center Configuration Manager (SCCM)

Deployment steps - SCCM
To deploy ESET Management Agent using SCCM, continue with the following steps:
1.Put the ESET Management Agent installer .msi files and install_config.ini file on a shared folder.
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Important
Client computers will require read/execute access to this shared folder.
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2.Open SCCM console and click Software Library. In Application Management right-click Applications and
choose Create Application. Choose Windows Installer (*.msi file).
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3.Specify all required information about the application and click Next.
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4.Right-click the ESET Management Agent Application, click the Deployment Types tab, select the only
deployment there and then click Edit.
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5. Click the Requirements tab and then click Add. Select Operating system from the Condition drop-down
menu, select One of from the Operator drop-down menu and then specify the operating systems you will
install to by selecting the appropriate check box(es). Click OK when you are finished and then click OK to
close any remaining windows and save your changes.
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6. In the System Center Software Library, right-click your new application and select Distribute Content
from the context menu. Follow the prompts in the Deploy Software Wizard to complete deployment of the
application.
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7. Right-click the application and choose Deploy. Follow the wizard and choose the collection and
destination where you want to deploy the agent.
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ESET Remote Deployment Tool
The ESET Remote Deployment Tool is a convenient way to distribute the installer package created by ESMC to
deploy ESET Management Agent and ESET security products remotely on computers over a network.
The ESET Remote Deployment Tool is available for free on the ESET website as a standalone ESMC Component.
The deployment tool is meant mainly for deployment on small to medium networks and is executed under admin
privileges.

Note
The ESET Remote Deployment Tool is dedicated to deploy ESET Management Agent to client
computers with Microsoft Windows operating systems only.
To deploy the ESET Management Agent and ESET security product using this method, follow the steps below:
1.Download the ESET Remote Deployment Tool from ESET website.
2.Make sure all prerequisites are met.
3.Run the ESET Remote Deployment Tool on client computer.
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4.Select one of the following deployment options:
• Active Directory - You will need to provide Active Directory credentials. This option includes an export of
the Active Directory structure for subsequent import to ESMC.
• Scan Network - You will need to provide IP ranges to scan computers in the network.
• Import list - You will need to provide list of hostnames or IP addresses.
• Add computers manually - You will need to provide list of hostnames or IP addresses manually.

Note
The deployment may fail due to a number of reasons. In case of any problems with deployment,
read the Troubleshooting chapter or verified example scenarios of ESET Management Agent
deployment.

ESET Remote Deployment Tool prerequisites
Important
For remote deployments, verify all client computers have an internet connection.
The following prerequisites must be met to use ESET Remote Deployment Tool on Windows:
• ESMC Server and the ESMC Web Console must be installed (on a Server computer).
• Appropriate ports must be opened. See ports used for remote deployment of ESET Management Agent to
a target computer with Windows OS.
• The names of installation packages must include string "x86" or "x64". Otherwise the deployment will not
work.
• A bundle (all-in-one) installer package must be created and downloaded to your local drive.
• It is necessary to have permissions to create All-in-one installer.

Note
The deployment may fail due to a number of reasons. In case of any problems with deployment,
read the Troubleshooting chapter or verified example scenarios of ESET Management Agent
deployment.

Select computers from Active Directory
To continue ESET Management Agent and ESET security product deployment from the previous chapter:
1.Read and Accept the End User License Agreement and click Next.
2.Enter the Active Directory Server with IP address or hostname and Port you want to connect to.
3.Enter Username and Password to log into the Active Directory Server. If you select the check box next to
Use current user credentials, login credentials will be automatically completed.
4.Optionally, select the check box next to Export computer list for Security Management Center if you want
to export the Active Directory structure for subsequent import to ESMC.
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Note
If a computer is in Active Directory, click Next and automatic login into the default Domain
Controller will take place.
5.Select the check box next to the computers you want to add and click Next. Select the check box Include
subgroups to list all computers inside a selected group.
6.Selected computers for remote deployment will be displayed. Make sure all computers are added and then
click Next.

Important
Make sure that all selected computers have the same platform (64-bit or 32-bit operating systems).
7.Click Browse and select the bundle installer package you created in ESMC or ECA Web Console. You can also
select Use ESET offline install package (.dat file) created from the ECA Live Installer. If you do not have any
additional security applications installed on your local computer, deselect the check box next to Use ESET AV
Remover. ESET AV Remover can remove certain applications.
8.Enter login credentials for the target computers. If computers are members of a domain, enter domain
administrator credentials. If you log in with local administration credentials, it is necessary to disable remote
UAC on the target computers. Optionally, you can select the check box next to Use current user credentials
and login credentials will be automatically completed.
9.Deployment method is used to execute programs on remote machines. Built-in method is a default setting
which supports Windows error messages. PsExec is a third-party tool and it is an alternative to the built-in
method. Select one of these options and click Next.
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Important
If you have selected PsExec, the deployment will fail, because the tool is unable to accept the
PsExec EULA. For a successful deployment, open the command line and run the PsExec command
manually.
10. When the installation is started, "Success" will be displayed. Click Finish to complete the deployment. If
deployment fails, you can export a list of failed computers. Click Browse next the Export failed computers
field, select a .txt file to which you want to save the list and then click Export failed computer.

You can check the status log (C:\ProgramData\ESET\RemoteAdministrator\Agent\Logs\status.html) on the client
machine to make sure ESET Management Agent is working properly.

Note
The deployment may fail due to a number of reasons. In case of any problems with deployment,
read the Troubleshooting chapter or verified example scenarios of ESET Management Agent
deployment.

Scan the local network for computers
To continue ESET Management Agent and ESET security product deployment from the previous chapter:
1.Read and Accept the End User License Agreement and click Next.
2.Enter IP Ranges of the network in the form 10.100.100.10-10.100.100.250.
3.Select one of the following Scan methods:
• Ping scan - Looks for client computers with command ping.

Note
Some client computers in this network do not have to send a response to command ping
because of firewall blocking the connection.
• Port scan - Uses port numbers to scan the network. See supported ports used for remote deployment of
ESET Management Agents. Default port number is 445.
4.To find computers in the network, click Start scan.
5.Select the check box next to the computers you want to add and click Next.
6.Selected computers for remote deployment will be displayed. Make sure all computers are added and then
click Next.
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Important
Make sure that all selected computers have the same platform (64-bit or 32-bit operating systems).
7.Click Browse and select the bundle installer package you created in ESMC or ECA Web Console. You can also
select Use ESET offline install package (.dat file) created from the ECA Live Installer. If you do not have any
additional security applications installed on your local computer, deselect the check box next to Use ESET AV
Remover. ESET AV Remover can remove certain applications.
8.Enter login credentials for the target computers. If computers are members of a domain, enter domain
administrator credentials. If you log in with local administration credentials, it is necessary to disable remote
UAC on the target computers. Optionally, you can select the check box next to Use current user credentials
and login credentials will be automatically completed.
9.Deployment method is used to execute programs on remote machines. Built-in method is a default setting
which supports Windows error messages. PsExec is a third-party tool and it is an alternative to the built-in
method. Select one of these options and click Next.

Important
If you have selected PsExec, the deployment will fail, because the tool is unable to accept the
PsExec EULA. For a successful deployment, open the command line and run the PsExec command
manually.
10. When the installation is started, "Success" will be displayed. Click Finish to complete the deployment. If
deployment fails, you can export a list of failed computers. Click Browse next the Export failed computers
field, select a .txt file to which you want to save the list and then click Export failed computer.

67

You can check the status log (C:\ProgramData\ESET\RemoteAdministrator\Agent\Logs\status.html) on the client
machine to make sure ESET Management Agent is working properly.

Note
The deployment may fail due to a number of reasons. In case of any problems with deployment,
read the Troubleshooting chapter or verified example scenarios of ESET Management Agent
deployment.

Import a list of computers
To continue ESET Management Agent and ESET security product deployment from the previous chapter:
1.Read and Accept the End User License Agreement and click Next.
2.Select one of the following options:
• Text file (one computer per line): A file with hostnames or IP addresses. Each IP address or hostname
must be on a separate line.
• ESMC export: A file with hostnames or IP addresses exported from ESMC Web Console.
3.Click Browse and select the file you would like to upload and then click Next.
4.Selected computers for remote deployment will be displayed. Make sure all computers are added and then
click Next.

Important
Make sure that all selected computers have the same platform (64-bit or 32-bit operating systems).
5.Click Browse and select the bundle installer package you created in ESMC or ECA Web Console. You can also
select Use ESET offline install package (.dat file) created from the ECA Live Installer. If you do not have any
additional security applications installed on your local computer, deselect the check box next to Use ESET AV
Remover. ESET AV Remover can remove certain applications.
6.Enter login credentials for the target computers. If computers are members of a domain, enter domain
administrator credentials. If you log in with local administration credentials, it is necessary to disable remote
UAC on the target computers. Optionally, you can select the check box next to Use current user credentials
and login credentials will be automatically completed.
7.Deployment method is used to execute programs on remote machines. Built-in method is a default setting
which supports Windows error messages. PsExec is a third-party tool and it is an alternative to the built-in
method. Select one of these options and click Next.
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Important
If you have selected PsExec, the deployment will fail, because the tool is unable to accept the
PsExec EULA. For a successful deployment, open the command line and run the PsExec command
manually.
8.When the installation is started, "Success" will be displayed. Click Finish to complete the deployment. If
deployment fails, you can export a list of failed computers. Click Browse next the Export failed computers
field, select a .txt file to which you want to save the list and then click Export failed computer.

You can check the status log (C:\ProgramData\ESET\RemoteAdministrator\Agent\Logs\status.html) on the client
machine to make sure ESET Management Agent is working properly.

Note
The deployment may fail due to a number of reasons. In case of any problems with deployment,
read the Troubleshooting chapter or verified example scenarios of ESET Management Agent
deployment.
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Add computers manually
To continue ESET Management Agent and ESET security product deployment from the previous chapter:
1.Read and Accept the End User License Agreement and click Next.
2.Enter the hostnames or IP addresses manually and then click Next. Each IP address or hostname must be on
a new line.

Important
Make sure that all selected computers have the same platform (64-bit or 32-bit operating systems).
3.Selected computers for remote deployment will be displayed. Make sure all computers are added and then
click Next.
4.Click Browse and select the bundle installer package you created in ESMC or ECA Web Console. You can also
select Use ESET offline install package (.dat file) created from the ECA Live Installer. If you do not have any
additional security applications installed on your local computer, deselect the check box next to Use ESET AV
Remover. ESET AV Remover can remove certain applications.
5.Enter login credentials for the target computers. If computers are members of a domain, enter domain
administrator credentials. If you log in with local administration credentials, it is necessary to disable remote
UAC on the target computers. Optionally, you can select the check box next to Use current user credentials
and login credentials will be automatically completed.
6.Deployment method is used to execute programs on remote machines. Built-in method is a default setting
which supports Windows error messages. PsExec is a third-party tool and it is an alternative to the built-in
method. Select one of these options and click Next.
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Important
If you have selected PsExec, the deployment will fail, because the tool is unable to accept the
PsExec EULA. For a successful deployment, open the command line and run the PsExec command
manually.
7.When the installation is started, "Success" will be displayed. Click Finish to complete the deployment. If
deployment fails, you can export a list of failed computers. Click Browse next the Export failed computers
field, select a .txt file to which you want to save the list and then click Export failed computer.

You can check the status log (C:\ProgramData\ESET\RemoteAdministrator\Agent\Logs\status.html) on the client
machine to make sure ESET Management Agent is working properly.

Note
The deployment may fail due to a number of reasons. In case of any problems with deployment,
read the Troubleshooting chapter or verified example scenarios of ESET Management Agent
deployment.

ESET Remote Deployment Tool - troubleshooting
The deployment may fail with several error messages and due to a number of reasons listed in the table below:
Error message

Possible causes
• Client is not reachable on the network, firewall blocks communication
The network path was not
• Inbound ports 135, 137, 138, 139 and 445 are not open in firewall on the client
found (error code 0x35)
or Windows Firewall: Allow inbound file and printer sharing exception is not
used
• Client's host name could not be resolved, use valid FQDN computer names
• When deploying from a server joined to a domain to a client joined to the
domain, use credentials of a user that is member of Domain Admin group in
format Domain\DomainAdmin
• When deploying from a server to a client that is not in the same domain,
disable remote UAC filtering on target computer.
Access is denied (error code
• When deploying from a server to a client that is not in the same domain, use
0x5)
The user name or password is credentials of a local user that is member of Administrators group in format
Admin. Target computer name will be automatically prepended to the login.
incorrect (error code 0x52e)
• No password set for administrator account
• Insufficient access rights
• ADMIN$ administrative share is not available
• IPC$ administrative share is not available
• Use simple file sharing is enabled
71

Error message
Possible causes
The installation package is not The installation package is not supported on this platform. Create and download
supported by this processor
the installation package with the correct platform (64-bit or 32-bit operating
type (error code 1633)
system) in ESMC Web Console.
The semaphore timeout period Client cannot access the network share with deployment package because SMB
has expired
1.0 is disabled on the share.
Follow the appropriate troubleshooting steps according to the possible cause:
Possible cause
Client is not reachable on
the network
Firewall blocks
communication

Client's host name could
not be resolved

No password set for
administrator account

Troubleshooting steps
Ping the client from the ESMC Server; if you get a response, try to log on to the
client machine remotely (for example, via remote desktop).
Check the firewall settings on both the server and the client, as well as any other
firewall that exists between these two machines (if applicable).
After successful deployment, ports 2222 and 2223 are not open in firewall. Make
sure that these ports are open on all firewalls between the two machines (client
and server).
Possible solutions to DNS issues can include but are not limited to:
• Using the nslookup command of the IP address and hostname of the server
and/or the clients having Agent deployment issues. The results should match the
information from the machine. For instance, an nslookup of a hostname should
resolve to the IP address that an ipconfig command shows on the host in
question. The nslookup command will need to be run on the clients and the
server.
• Manually examining DNS records for duplicates.
Set a proper password for the administrator account (do not use a blank password).

Try using the Domain Administrator's credentials when creating an Agent
deployment task. If the client machine is in a Workgroup, use the local
Administrator account on that particular machine.
For Windows 7 and later, the Administrator user account must be activated in order
Insufficient access rights
to run the Agent deployment task. You can create a local user that is a member of
Administrators group or to enable built-in local Administrator account.
To activate the Administrator user account:
1.Open an administrative command prompt
2.Enter the following command: net user administrator /active:yes
The client machine must have the shared resource ADMIN$ activated. Make sure it
ADMIN$ administrative
is present among the other shares (Start > Control Panel > Administrative Tools >
share is not available
Computer Management > Shared Folders > Shares).
Verify that the server can access IPC$ by issuing the following from a command
IPC$ administrative share is prompt on the server:
not available
net use \\clientname\IPC$ where clientname is the name of the target
computer.
If you are getting the Access denied error message and your environment is mixed
(contains both a Domain and Workgroup), disable Use simple file sharing or Use
Sharing Wizard on all machines that are having problems with Agent deployment.
Use simple file sharing is
For example, in Windows 7 do the following:
enabled
• Click Start, type folder into the Search box, and then click Folder Options. Click
the View tab and in the Advanced settings box, scroll down the list and deselect the
check box next to Use Sharing Wizard.
SMB 1.0 is disabled When deploying to older operating systems (Windows XP/Server 2003), turn on
deployment to Windows
SMB 1.0/CIFS File Sharing Support feature on the computer with the deployment
XP/Server 2003
package.
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Agent protection
The ESET Management Agent is protected by a built-in self-defense mechanism. This feature provides the
following:
oProtection against modification of ESET Management Agent registry entries (HIPS)
oFiles that belong to ESET Management Agent cannot be modified, replaced, deleted or altered (HIPS)
oESET Management Agent process cannot be killed
oThe ESET Management Agent Service cannot be stopped, paused, disabled, uninstalled or otherwise
compromised
Some of the protection is covered by the HIPS feature included in your ESET product.

Note
To ensure full protection of the ESET Management Agent, HIPS must be enabled on a client
computer.

Password-protected setup
In addition to self-defense, you can password-protect access to the ESET Management Agent (available for
Windows only). When password-protection is configured, the ESET Management Agent cannot be uninstalled or
repaired unless the correct password is provided. To set an ESET Management Agent password, you need to
create the appropriate policy for ESET Management Agent.

ESET Management Agent settings
You can configure specific settings for ESET Management Agent using a ESET Management Agent policy. There are
predefined policies for the ESET Management Agent. For example, Connection - Connect every (Agent connection
interval) or Application reporting - Report all installed applications (not only ESET applications). For more
information on how to enforce location-based policy, read the example.
Click Policies and expand Built-in Policies > ESET Management Agent to edit an existing policy or create a new
one.

Connection
• Servers to connect to - To add ESMC Server connection details (hostname/IP and a port number), click Edit
server list. Multiple ESMC Servers can be specified. This can be useful if, for example, you've changed the IP
address of your ESMC Server or are doing a migration.
• Data limit - Choose the maximum number of bytes for sending data.
• Connection interval - Choose Regular interval and specify a time value for the connection interval (or you
can use a CRON expression).
• Certificate - You can manage Peer certificates for ESET Management Agent. Click Change certificate and
select which ESET Management Agent certificate should be used by ESET Management Agent. For more
information, see Peer Certificates.
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Updates
• Update interval - Interval at which updates will be received. Select a Regular interval and configure the
settings (or you can use a CRON expression).
• Update server - Update server from which the ESET Management Agent receives module updates.
• Update type - Select the type of updates you want to receive. Choose either Regular, Pre-release or
Delayed update. We do not recommend that you select Pre-release updates for production systems, as this
is a risk.

Advanced Settings
• HTTP Proxy - Use a proxy server to facilitate internet traffic to clients on your network and Agent
replication to ESMC Server.
oProxy Configuration Type
▪Global Proxy - Use one proxy server for Agent replication and for caching of ESET services (for
example, updates).
▪Different Proxy Per Service - Use one proxy for Agent replication and another for caching of ESET
services (for example, updates).
oGlobal Proxy - This option is only available if you select it in Proxy Configuration Type. Click Edit and set
up your proxy settings.
The two options below are only available if you select Different Proxy Per Service. You can also use only one of
the proxy settings, for example set up only ESET Services and leave Replication off. Enable Use direct connection
if HTTP proxy is not available if you want to allow this fallback option.
oReplication (to ESMC Server) - Configure connection settings for a proxy that connects Agent to Server.
oESET Services - Configure connection settings for a proxy that will cache ESET services.
• Wake-Up Call - ESMC Server can run instant replication of the ESET Management Agent on a client
machine via EPNS. This is useful when you do not want to wait for the regular interval when the ESET
Management Agent connects to the ESMC Server. For example when you want a Task to be run immediately
on client(s) or if you want a Policy to be applied right away.
• Compatibility - In order to allow for management of ESET products version 5 or earlier by ESET
Management Agent, a specific listening port must be set. Also, ESET products need to be configured to
report to this port and the ESET Security Management Center Server address must be set to localhost.
• Operating System - Use the switches to report certain information or issues on the client computer.
• Repository - Location of the repository where all installation files are stored.

Note
The default repository is AUTOSELECT.

• Product Improvement Program - Enable or disable transmission of crash reports and anonymous
telemetry data to ESET.
• Logging - Set the log verbosity to determine the level of information that will be collected and logged,
from Trace (informational) to Fatal (most important critical information). The latest ESET Management
Agent log file can be found on a client computer here:
C:\ProgramData\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs or C:\Documents and
Settings\All Users\Application Data\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs
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• Setup - Password protected setup is a protection feature of ESET Management Agent (Windows only). Set
password to enable ESET Management Agent Password protection. Once the policy is applied, ESET
Management Agent cannot be uninstalled or repaired unless a password is provided.

Important
If you forget this password, you will not be able to uninstall ESET Management Agent from the
target machine.

Assign
Specify the clients that will receive this policy. Click Assign to display all Static and Dynamic Groups and their
members. Select the computer that you want to apply a policy on and click OK.

Summary
Review the settings for this policy and click Finish.

Create a Policy for ESET Management Agent connection
interval
In this example, we are going to create a new policy for the ESET Management Agent connection interval. This
value should be adjusted based on the size of your infrastructure by using policies after you install ESET Security
Management Center and deploy ESET Management Agents and ESET endpoint products to client machines.
Create a New Static Group. Add a new policy by clicking Policies. Click Actions at the bottom and select New.
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Basic
Enter a Name for the new policy (for example, "Agent Connection Interval"). The Description field is optional.

Settings
Select ESET Management Agent from the Product drop-down menu.

Connection
Click Change interval.
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In the Regular interval field, change the value to your preferred interval time (60 seconds is the default
replication interval of the ESET Management Agent) and click Save.

Assign
Specify the clients (individual computers/mobile devices or whole groups) that are the recipients of this policy.
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Click Assign to display all Static and Dynamic Groups and their members. Select your desired clients and click OK.
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Summary
Review the settings for this policy and click Finish. The policy gets applied on the targets after their next
connection to ESMC Server (depending on the Agent connection interval).

Note
To apply the policy immediately, you can run the Send Wake-up Call action on targets in
Computers.

Create a Policy for ESET Management Agent to connect
to the new ESMC Server
This policy lets you change the behavior of ESET Management Agent by modifying its settings. The following is
especially useful when migrating client machines to a new ESMC Server.
Create new policy to set new ESMC Server IP address and assign the policy to all client computers. Select Policies
> create New.

Basic
Enter a Name for your policy. The Description field is optional.

Settings
Select ESET Management Agent from the drop-down menu, expand Connection and click Edit server list next to
Servers to connect to.
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A window will open with a list of ESMC Server addresses the ESET Management Agent can connect to. Click Add
and type the IP address of your new ESMC Server into the Host field. If you are using a different port than the
default ESMC Server port 2222, specify your custom port number.
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Use the arrow buttons to change the priority of ESMC Servers in case you have multiple entries in the list. Make
sure your new ESMC Server is at the top by clicking double-up arrow button and then click Save.

Assign
Specify the clients (individual computers/mobile devices or whole groups) that are the recipients of this policy.
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Click Assign to display all Static and Dynamic Groups and their members. Select your desired clients and click OK.
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Summary
Review the settings for this policy and click Finish. The policy gets applied on the targets after their next
connection to ESMC Server (depending on the Agent connection interval).

Note
To apply the policy immediately, you can run the Send Wake-up Call action on targets in
Computers.

Create a Policy to enable ESET Management Agent
Password protection
Follow the steps below to create a new policy that will enforce a password to protect the ESET Management
Agent. When Password protected setup is used, ESET Management Agent cannot be uninstalled or repaired
unless a password is provided. See Agent protection for more details.

Basic
Enter a Name for this policy. The Description field is optional.

Settings
Select ESET Management Agent from the drop-down list, expand Advanced settings, navigate to Setup and type
the password into the Password protected setup field. This password will be required if someone is trying to
uninstall or repair ESET Management Agent on a client computer.

Important
Make sure to record this password in a safe place, it is essential to enter the password to allow ESET
Management Agent uninstallation from the client computer. There is no other regular way of
uninstalling ESET Management Agent without a correct password once Password protected setup
policy is in place.

Assign
Specify the clients (individual computers/mobile devices or whole groups) that are the recipients of this policy.
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Click Assign to display all Static and Dynamic Groups and their members. Select your desired clients and click OK.
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Summary
Review the settings for this policy and click Finish. The policy gets applied on the targets after their next
connection to ESMC Server (depending on the Agent connection interval).

Note
To apply the policy immediately, you can run the Send Wake-up Call action on targets in
Computers.

Troubleshooting - Agent connection
When a client computer does not appear to be connecting to your ESMC Server, we recommend that you perform
ESET Management Agent troubleshooting locally on the client machine.
By default, the ESET Management Agent synchronizes with ESMC Server every minute. You can change this
setting by creating a new policy for the ESET Management Agent Connection Interval.
Check the latest ESET Management Agent log file. You can find it here:

Windows
Linux
macOS

C:\ProgramData\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs
C:\Documents and Settings\All Users\Application
Data\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs
/var/log/eset/RemoteAdministrator/Agent/
/var/log/eset/RemoteAdministrator/EraAgentInstaller.log
/Library/Application Support/com.eset.remoteadministrator.agent/Logs/
/Users/%user%/Library/Logs/EraAgentInstaller.log

• last-error.html – protocol (table) that displays the last error recorded while the ESET Management Agent
is running.
• software-install.log – text protocol of the last remote installation task performed by the ESET
Management Agent.
• status.html – a table showing the current state of communication (synchronization) of ESET Management
Agent with ESMC Server. The log also contains HTTP Proxy configuration, a list of applied policies, and a list
Dynamic groups to which the device belongs.
• trace.log – a detailed report of all ESET Management Agent activity including any errors that have been
recorded.

Note
To enable full logging, create a dummy file named traceAll without an extension in the same folder
as a trace.log and then restart the ESET Management Agent service. This will enable full logging in
the trace.log file.
The most common issues that can prevent the ESET Management Agent from connecting to the ESMC Server are:
• Your Internal network is not configured properly. Make sure that the computer where ESMC Server is
installed can communicate with client computers where ESET Management Agent is installed.
• Your ESMC server is not configured to listen on port 2222.
• DNS is not working properly, or ports are blocked by a firewall - check our list of ports used by ESET
Security Management Center, or see our KB article What addresses and ports on my third-party firewall
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should I open to allow full functionality for my ESET product?.
• An erroneously generated certificate containing false or limited features that do not match the public key
of ESMC Server Certification Authority is in place - create a new ESET Management Agent certificate to
resolve this.

Troubleshooting - Agent deployment
You may encounter problems with ESET Management Agent deployment. If deployment fails, there are a number
of things that might be the cause. This section will help you:
oFind out what caused ESET Management Agent deployment to fail
oCheck for possible causes according to the table below
oResolve the issue and perform a successful deployment

Windows
1. To find out why Agent deployment failed, navigate to Reports > Automation, select Agent Deployment task
information in last 30 days and click Generate now.
A table will displayed deployment information. The Progress column displays error messages about why Agent
deployment failed.
If you need even more details, you can change the verbosity of the ESMC Server trace log. Navigate to More >
Server Settings > Advanced Settings > Logging and select Error from the drop-down menu. Run the Agent
deployment again and when it fails check the ESMC Server trace log file for the latest log entries at the bottom of
the file. The report will include suggestions about how to resolve the issue.
The latest file can be found here:
ESMC Server C:\ProgramData\ESET\RemoteAdministrator\Server\EraServerApplicationData\Logs\trace.log
log
ESET
C:\ProgramData\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs
Management C:\Documents and Settings\All Users\Application
Agent log
Data\ESET\RemoteAdministrator\Agent\EraAgentApplicationData\Logs

Note
• To enable full logging, create a dummy file named traceAll without an extension in the same
folder as a trace.log and then restart the ESET Management Agent service. This will enable full
logging in the trace.log file.
• In case of ESET Management Agent connection problems, see Troubleshooting - Agent connection
for more information.
• If the installation failed with error 1603, check ra-agent-install.log file. It can be found here:
C:\Users\%user%\AppData\Local\Temp\ra-agent-install.log on the target computer.
2. The table below contains several reasons Agent deployment can fail:
Error message
Could not connect
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Possible cause(s)
• Client is not reachable on the network, firewall blocks communication
• Inbound ports 135, 137, 138, 139 and 445 are not open in firewall on the client or
Windows Firewall: Allow inbound file and printer sharing exception is not used
• Client's hostname could not be resolved, use valid FQDN computer names

Error message

Possible cause(s)
• When deploying from a server joined to a domain, to a client joined to the domain, use
the credentials of a user that is member of Domain Admin group in format:
Domain\DomainAdmin
• When deploying from a server joined to a domain, to a client joined to the domain, you
can temporarily elevate ESMC Server service from network service to run under domain
administrator account.
• When deploying from a server to a client that are not in a same domain, disable remote
UAC filtering on target computer.
Access denied
• When deploying from a server to a client in a different domain, use the credentials of a
local user that is member of the Administrators group in format: Admin. Target computer
name will be automatically prepended to the login.
• No password set for administrator account
• Insufficient access rights
• ADMIN$ administrative share is not available
• IPC$ administrative share is not available
• Use simple file sharing is enabled
• Link to the repository is incorrect
Package not found in
• Repository is unavailable
repository
• Repository does not contain required package
3. Follow the appropriate troubleshooting steps according to the possible cause:
• Client is not reachable on the network - ping the client from the ESMC Server, if you get a response, try to
log on to the client machine remotely (for example, via remote desktop).
• Firewall blocks communication - check the firewall settings on both the server and the client, as well as
any other firewall that exists between these two machines (if applicable).
• Client's hostname could not be resolved - possible solutions to DNS issues can include but are not limited
to:
oUsing the nslookup command of the IP address and hostname of the server and/or the clients having
Agent deployment issues. The results should match the information from the machine. For instance, an
nslookup of a hostname should resolve to the IP address an ipconfig command shows on the host in
question. The nslookup command will need to be run on the clients and the server.
oManually examining DNS records for duplicates.
• Ports 2222 and 2223 are not open in firewall - same as above, make sure that these ports are open on all
firewalls between the two machines (client and server).
• No password set for administrator account - set a proper password for the administrator account (do not
use a blank password)
• Insufficient access rights - try using the Domain Administrator's credentials when creating an Agent
deployment task. If the client machine is in a Workgroup, use the local Administrator account on that
particular machine.

Note
After successful deployment, ports 2222 and 2223 are not open in firewall. Make sure that these
ports are open on all firewalls between the two machines (client and server).
• To activate the Administrator user account:
1.Open an administrative command prompt
2.Enter the following command:
net user administrator /active:yes

• ADMIN$ administrative share is not available - The client machine must have the shared resource
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ADMIN$ activated, make sure it is present among the other shares (Start > Control Panel > Administrative
Tools > Computer Management > Shared Folders > Shares).
• IPC$ administrative share is not available - verify that the server can access IPC$ by issuing the following
from a command prompt on the server:
net use \\clientname\IPC$ where clientname is the name of the target computer

• Use simple file sharing is enabled - if you are getting the Access denied error message and your
environment is mixed (contains both a Domain and Workgroup), disable Use simple file sharing or Use
Sharing Wizard on all machines that are having problems with Agent deployment. For example, in Windows
7 do the following:
oClick Start, type folder into the Search box, and then click Folder Options. Click the View tab and in
the Advanced settings box, scroll down the list and deselect the check box next to Use Sharing Wizard.
• Link to the repository is incorrect - In ESMC Web Console, navigate to More > Server Settings, click
Advanced settings > Repository and make sure the URL of the repository is correct.
• Package not found in repository - this error message usually appears when there is no connection to the
ESMC repository. Check your Internet connection.

Linux and macOS
If Agent deployment does not work on Linux or macOS, the issue is usually related to SSH. Check the client
computer and make sure SSH daemon is running. Once fixed, run Agent deployment again.

Example scenarios of ESET Management Agent
deployment
This section contains four verified scenarios for ESMC deployment.
1.Deployment from ESMC Server Appliance or Linux ESMC Server to Windows targets not joined to a
domain.
2.Deployment from Windows ESMC Server from Windows source not joined to a domain to Windows
targets not joined to the domain.
3.Deployment from ESMC Server Appliance or Linux ESMC Server to Windows targets joined to a domain.
4.Deployment from Windows ESMC Server from Windows source joined to a domain to Windows targets
joined to the domain.

Example scenarios of ESET Management Agent
deployment to targets not joined to domain
1.Deployment from ESMC Server Appliance or Linux ESMC Server to Windows targets not joined to a
domain.
2.Deployment from Windows ESMC Server from Windows source not joined to a domain to Windows
targets not joined to the domain.
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Preconditions:
• Same local network.
• Working FQDN names, e.g.: desktop-win7.test.local maps to 192.168.1.20 and vice versa.
• Installed clean operating system from MSDN with defaults.

Targets:
Windows 10 Enterprise
Windows 8.1 Enterprise
Windows 7 Enterprise
1.Create a user with password that is member of Administrators group, e.g.: "Admin". Open Microsoft
Management Console by opening the Run console and typing the "mmc" into the field and clicking OK.
2.Add the Local Users and groups Snap-in from the File -> Add/Remove Snap-in. Add a new user into the
Users folder and fill in the required information into the fields (do not forget to fill in the password). In the
Groups section open the Properties of the Administrators group and add the new created user into the
group by clicking the Add button. Fill in the login name of the new created user into the Enter the object
names to select and verify it by clicking on the Check Names button.
3.In the Network and Sharing Center change the network setting from Public network to Private network
by clicking on the Public network in the left side of the View your active networks section.
4.Disable Windows Firewall for Private Network by clicking on the Turn Windows Firewall on or off and
selecting Turn off Windows Firewall in the Home or Work network location settings.
5.Check that File and printer sharing is enabled for Private network by clicking on the Change advanced
sharing settings in the Network and Sharing center.
6.Open Registry editor by typing "regedit" into the Run console and locate
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System

7.In the System file create a new DWORD Value with the name "LocalAccountTokenFilterPolicy", than
open the created file and set the Value data to "1".
8.In the ESET Security Management Center Web Console create "Agent Deployment" Server task assigned
to FQDN name of the machine (you can find the FQDN name of the machine by right clicking in the
Computer and selecting Properties. The FQDN name appears next to the Full computer name).
9.Set optional Server hostname to point to FQDN name or IP address of the ESMC server.
10. Set username to just "Admin" (no domain name or computer name prefix) and his password.
11. Select Agent's certificate.
12. Execute the task.

For Windows XP Professional
1.Create a user with password that is member of Administrators group, e.g.: "Admin". Open Microsoft
Management Console by opening the Run console and typing the "mmc" into the field and clicking OK.
2.Add the Local Users and groups Snap-in from the File -> Add/Remove Snap-in. Add a new user into the
Users folder and fill in the required information into the fields (do not forget to fill in the password). In the
Groups section open the Properties of the Administrators group and add the new created user into the
group by clicking the Add button. Fill in the login name of the new created user into the Enter the object
names to select and verify it by clicking on the Check Names button.
3.Disable Windows Firewall by selecting Off in the Windows Firewall -> General tab.
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4.Check that File and printer sharing is enabled in Windows Firewall -> Exceptions tab.
5.Open the Run console and type in "secpol.msc" and press OK to open the Local Security Settings.
6.Select Local Policies -> Security Options -> Network access: Sharing and security model for local
accounts and right-click to open Properties.
7.Set selected policy to Classic - local users authenticate as themselves.
8.In the ESET Security Management Center Web Console create new "Agent Deployment" Server task
assigned to FQDN name of the machine (you can find the FQDN name of the machine by right clicking in
the Computer and selecting Properties. The FQDN name appears next to the Full computer name).
9.Set optional Server hostname to point to FQDN name or IP address of the ESMC server.
10. Set username to just "Admin" (no domain name or computer name prefix) and his password.
11. Select Agent's certificate.
12. Execute the task.

Example scenarios of ESET Management Agent
deployment to targets joined to domain
1.Deployment from ESMC Server Appliance or Linux ESMC Server to Windows targets joined to a domain.
2.Deployment from Windows ESMC Server from Windows source joined to a domain to Windows targets
joined to the domain.

Preconditions:
• Same local network.
• Working FQDN names, e.g.: desktop-win10.esmc.local maps to 10.0.0.2 and vice versa.
• Installed clean operating system from MSDN with defaults.
• Created domain "esmc.local" with netbios name "ESMC".
• Created user "DomainAdmin" that is member of "Domain Admins" security group in domain controller.
• Each machine joined domain "esmc.local" with user "DomainAdmin" and this user is Administrator
(Windows 10, 8.1, 7) or Standard user (power user on Windows XP).
• "DomainAdmin" is able to log into each machine and perform local administration tasks.
• Windows ESMC Server service is temporarily running under "ESMC\DomainAdmin" credentials. After
deployment "Network Service" is enough. (no changes necessary in the appliance or Linux).

Targets:
Windows 10 Enterprise
Windows 8.1 Enterprise
Windows 7 Enterprise

1.Open Network and Sharing Center.
2.Check that network is Domain network in the View your active networks section.
3.Disable Windows Firewall for Domain Network by clicking the Turn Windows Firewall on or off and
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selecting Turn off Windows Firewall in the Domain network location settings.
4.Check that File and printer sharing in enabled for Domain network by clicking on the Change advanced
sharing settings in the Network and Sharing Center.
5.In the ESET Security Management Center Web Console create new "Agent deployment" Server task
assigned to FQDN name of the machine (you can find the FQDN name of the machine by right clicking in
the Computer and selecting Properties. The FQDN name appears next to the Full computer name).
6.Set optional Server hostname to point to FQDN name or IP address of the ESMC server.
7.Set username to "ESMC\DomainAdmin" (it is important to include the whole domain) and his password.
8.Select Agent's certificate.
9.Execute the task.

For Windows XP Professional
1.Disable Windows Firewall by selecting Off in the Windows Firewall -> General tab.
2.Check that File and printer sharing is enabled in the Windows Firewall -> Exceptions tab.
3.In the ESET Security Management Center Web Console create new "Agent deployment" Server task
assigned to FQDN name of the machine (you can find the FQDN name of the machine by right clicking in
the Computer and selecting Properties. The FQDN name appears next to the Full computer name).
4.Set optional Server hostname to point to FQDN name or IP address of the ESMC server.
5.Set username to "ESMC\DomainAdmin" (it is important to include whole domain) and his password.
6.Select Agent's certificate.
7.Execute the task.

ESMC User Interface
All clients are managed through the ESMC Web Console. You can access the ESMC Web Console from any device
using a compatible browser. The ESMC Web Console is divided into main sections:
1.At the top of the ESMC Web Console, you can use the Quick Search tool. Click the icon to select a search
target:
oComputer Name, Description and IP Address - Type a Client name, Computer description, IPv4/IPv6
Address, or Group name and press Enter. You will be redirected to the Computers section where the
results will be displayed.
oDetection Name - You will be redirected to the Detections section where the results will be displayed.
oUser Name - You can search for imported AD users, results will be displayed in the Computer Users
section.
2.Click the Quick Links button to view the menu:
Quick links
Set up Computers
• Add Computer
• Add Mobile Device
• Other Deployment Options
• Add Computer User
Manage Computers
• Create Client Task
• Create New Policy
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• Assign Policy
Review Status
• Generate Report
3.The menu on the left contains the main ESMC sections and the following items:
oDashboard
oComputers
oDetections
oReports
oTasks
oInstallers
oPolicies
oComputer Users
oNotifications
oStatus Overview
oMore
4.Buttons on the bottom of the page are unique for each section and function, and are described in detail
in their respective chapters.

General rules
• Required (mandatory) settings are always marked with a red exclamation mark next to the section and the
respective settings.
• If you need help when working with ESET Security Management Center, click the
icon in the top right
corner and click <Current topic> - Help. The respective help window for the current page will be displayed.

Login screen
A user needs login credentials (username and password) to log into the Web Console. It is also possible to log in
as a domain user by selecting the check box next to Log Into Domain (a domain user is not related to any mapped
domain group). The login format depends on your domain type
Windows Active Directory: DOMAIN\username
Linux and ESMC Virtual Appliance LDAP: username@FULL.DOMAIN.NAME

Note
If you experience problems logging in or receive error messages while trying to log in, see Web
Console Troubleshooting for suggestions to resolve your issue.
You can select your language by clicking the drop-down arrow next to currently selected language, for details see
our Knowledgebase article.

Note
Keep in mind that not all elements of the Web Console will change after the language change. Some
of the elements are created during the ESMC installation and cannot be changed.
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Allow Session in Multiple Tabs - Web Console can be open in multiple tabs of a single browser.
• If the check box is selected, each tab with an open Web Console session in one browser will be connected
to the same session. If a new tab is opened, all other tabs connected with the same setting will connect to
this new session. If the session is logged out in one of tabs, all other tabs will be logged out too.
• If the check box is not selected, each new tab opens a new independent ESMC Web Console session.
Change password / Use different account - allows you to change password or switch back to the login screen.

Session management and security measures:
Login IP address lockout
After 10 unsuccessful login attempts from the same IP address, further login attempts from this IP address are
blocked for approximately 10 minutes. The IP address ban on login attempts does not affect existing sessions. This
is indicated by the error message: Login failed: Login from your address was temporarily
blocked.

Wrong session ID address lockout
After using an invalid session ID 15 times from the same IP address, all further connections from this IP address
are blocked for approximately 15 minutes. Expired session IDs are not counted. If there is an expired session ID in
the browser, it is not considered an attack. The 15 minute IP address ban is for all actions (including valid
requests). The ban can be released by restarting Web Console (tomcat service).
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Troubleshooting - Web Console
The table below will give you some insight into the most common Web Console login error massages and
statuses, what they mean and some additional troubleshooting steps:
Error message

Possible cause
Login failed: Invalid username or Make sure that you entered your username and password correctly.
password
Check to see whether the ESMC Server service and your database service
Login failed: Connection has
are running, see our Knowledgebase article for step-by-step instructions.
failed with state 'Not connected'
Verify that the ESMC Server service is running and Apache Tomcat service
is running and working properly. Review the log files for Apache Tomcat.
See our Knowledgebase article for more information on this issue.
Login failed: Connection timeout Check network connection and firewall settings to make sure ESMC Web
Console can reach ESMC Server. Also, ESMC Server may be overloaded,
attempt to reboot it. This issue can also occur if you are using different
versions of ESMC Web Console and ESMC Server.
Login failed: User has no access The user does not have any access rights assigned. Log in as an
administrator and edit the user's account so that they have at least one
rights assigned
Permission Set assigned.
Your version of Web Console and ESMC Server are not compatible. This can
Login failed: Response parsing
happen during or after components upgrade. If the problem persists,
error
deploy the correct version of the Web Console manually.
Using unencrypted connection! For security reasons, we recommend that you set up ESMC Web Console to
use HTTPS.
Please configure the webserver to
use HTTPS
JavaScript is disabled. Please enable Enable JavaScript or update your web browser.
JavaScript in your browser.
Login failed: Communication
error

Error
Possible cause
You do not see the
• Restart the ESET Security Management Center Server service. Once the ESET Security Management Center
login screen or the
Server service is up and running again, restart the Apache Tomcat service. After this, the ESET Security
login screen appears to Management Center Web Console login screen will load successfully. Read also our Knowledgebase article.
be constantly loading. • If Apache Tomcat is not able to extract content from era.war file and Web Console is not accessible, follow the
steps in our Knowledgebase article.
The text is missing in This issue may be caused by an ad-blocking browser extension. To solve this issue, disable ad-blocking browser
the context menu and extension for ESMC Web Console page.
Quick Links menu in
ESMC Web Console.
After login, the Web Make sure you are using a supported web browser.
Console is not
correctly displayed
(missing elements,
etc.).
After login, some Web If some of the ESMC Web Console screens (e.g. Computers) do not load, open the Tomcat9w.exe file located in
Console screens do not C:\Program Files\Apache Software Foundation\[ Tomcat folder ]\
load.
• In the General tab, click Stop to stop the Apache Tomcat service.
• Select the Java tab and add the following code under Java Options:
-Duser.country=US
-Duser.language=en

• In the General tab, click Start to start the Apache Tomcat service.
The Web Console takes The Web Console requires additional memory when handling large object sets. See the Web Console for
a long time to load.
enterprise settings.
When loading a large
number of objects, the
console crashes.
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Error
Possible cause
Some screens in the
This issue occurs if you are using a reverse proxy that prevents some Web Console modules from loading. The URL
Web Console do not strings for individual Web Console modules (loaded in Apache Tomcat) may dynamically change (for example, the
load correctly and you string after era/webconsole/configEngine/ in
see an error. For
era/webconsole/configEngine/02645EFC6A9323B2B449042FB8S63FD3/v0.0/css/001_ce.ltr.css).
example, when editing To solve the issue, make sure to properly configure your reverse proxy.
a policy, you see the
error: "ERROR WHILE
INITIALIZING
CONFIGURATION
EDITOR.: (TYPEERROR)
: ((INTERMEDIATE
VALUE)(INTERMEDIATE
VALUE) ,
K).INITCONFIGEDITOR
IS NOT A FUNCTION"

Note
• After upgrading ESMC, we recommend that you delete the web browser cache and cookies before
logging into the upgraded Web Console.
• Since the Web Console uses secure protocol (HTTPS), you might get a message in your web
browser regarding a security certificate or untrusted connection (exact wording of the message
depends on the browser you are using). This is because your browser wants you to verify the
identity of the site you are trying to access. Click Continue to this website (Internet Explorer) or I
Understand the Risks, click Add Exception... and then click Confirm Security Exception (Firefox) to
allow access to the ESMC Web Console. This only applies when you're trying to access the ESET
Security Management Center Web Console URL. Read our Knowledgebase article for more
information on how to set up HTTPS/SSL connection.

User settings
In this section, you can customize your user settings. Click User account at the top right corner of the ESMC Web
Console (to the left of the Logout button) to display all active users. You can be logged into ESMC Web Console
from different web browsers, computers or mobile devices at the same time. You will see all your sessions here.

Note
User settings only apply to the user who is currently logged on. Each user can have their own
preferred time settings for ESMC Web Console. User-specific time settings are applied to each user
regardless of where they access ESMC Web Console.

Time Settings
All information is stored internally in ESET Security Management Center using the UTC (Coordinated Universal
Time) standard. UTC time is automatically converted to the time zone used by ESMC Web Console (taking daylight
saving into account). ESMC Web Console displays the local time of the system where ESMC Web Console is
running (not the internal UTC time). You can override this setting to set the time shown in ESMC Web Console
manually.
If you want to override the default Use browser local time setting, you can choose the Select manually option,
then specify the console time zone manually and decide whether to use daylight saving time or not.
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Important
In some cases, the option to use a different time zone (for example, the local time of a client on
which ESMC is running) will be made available. This setting is important when configuring triggers.
When this option is available, it is indicated in ESMC Web Console and you will be able to choose
whether to Use local time or not.

Click Save Time Settings to confirm your changes.

Stored User State
You can reset a stored user's UI state to default by clicking Reset Stored User State. This includes Startup Wizard,
table column sizes, remembered filters, pinned side menu, etc.

Active sessions
Information about all active sessions of the current user contain:
• IP address of a client computer or a device from which a user is connected to ESMC Web Console. The IP
address of a web server that runs ESMC Web Console is displayed in brackets. In case ESMC Web Console is
running on the same machine as ESMC Server, via 127.0.0.1 is displayed.
• Date and time when a user logged in.
• Selected language for ESMC Web Console.
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The current session is labeled This session. If you want to disconnect an active session, click Disconnect.

Filters and layout customization
The ESET Security Management Center Web Console allows you to customize the layout of displayed items in the
main sections (e.g. Computers, Tasks, etc.) in several ways:

Add filter and filter presets
To add filtering criteria, click Add filter and select item(s) from the list. Enter the search string(s) into the filter
field(s). Active filters are highlighted in blue.
Filters can be saved to your user profile so that you can use them again in the future. Under Presets, the following
options are available:
Filter sets

Your saved filters, click one to apply it. The applied filter is denoted with a
check mark.
Select Include visible columns, sorting and paging to save these parameters to the preset.
Save your current filter configuration as a new preset. Once the preset is saved, you
Save filter set
cannot edit the filter configuration in the preset.
Manage filter sets Remove or rename existing presets. Click Save to apply the changes to presets.
Clear filter values Click to remove only the current values from the selected filters. Saved presets will remain
unchanged.
Click to remove the selected filters. Saved presets will remain unchanged.
Remove filters

Remove unused
filters

Remove filter fields with no value.

The Access Group filter button allows users to select a static group and filter
viewed objects according to the group where they are contained.
You can use tags for filtering the displayed items.

Side panel layout
Click the icon next to the section name and adjust the side panel layout using the context menu (available
options may vary based on the current layout):
•
•
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Hide side panel
Show side panel

•
•
•

Groups
Groups and Tags
Tags

If Groups are visible, you can select also one of these options:
•
•

Expand All
Collapse All

Manage the main table
For sorting by a single column, click the column header to sort table rows based on data in the selected column.
• One click or two clicks result in ascending (A-Z, 0-9) or descending (Z-A, 9-0) sorting.
• After you apply the sorting, a small arrow before column header indicates the sorting behavior.
• See also multiple sorting below.
Click the

gear icon to manage the main table:

Actions
•
Edit columns - Use the wizard to adjust ( add,
can also use drag-and-drop to adjust the columns.
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remove,

reorder) the displayed columns. You

•

Auto-fit columns - Automatically adjust columns width.

Table Sorting
• Reset Sorting - Reset the column sorting.
• Multiple Sorting - You can sort table data by selecting multiple (up to 4) columns. For each of the columns,
you can adjust its:
osorting priority - change column order by clicking the Move Up or Move Down button (the first column:
primary sorting; the second column - secondary sorting; etc.). After you apply multiple sorting, index
numbers appear before column headers to indicate the sorting priority.
osorting behavior - select Ascending or Descending from the drop down menu.

Example

1 primary sorting - Computer Name column: ascending sorting applied.
2 secondary sorting - Status column: descending sorting applied as secondary sorting.

Reports
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• Export table as - Export the table as a report in your desired format. You can choose from .pdf, .ps or
.csv. CSV is suitable only for table data and uses ; (semicolon) as a delimiter.
• Save a report template - Create a new report template from the table.

Tags
ESMC allows marking all relevant objects (computers, detections, tasks, installers, policies, notifications, licenses,
etc.) with user defined tags, which can be further used for enhanced filtering and search. Tagging is integrated
natively in all major screens of ESMC Web Console.
Tags are user defined key words (labels) that you can add to different objects to make them easier for grouping,
filtering and finding. For example, you can assign a tag 'VIP' for your relevant assets and quickly identify all objects
that are associated with them.
You can create and assign tags manually. MSP objects are tagged automatically with the customer name.

Tags pane
You can see the existing tags in the Tags section visible on the bottom left side of the ESMC Web Console menu
screen:
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Permissions for tags management
In order to manage tags for an object, a user needs to have the sufficient access rights (assigned permission set)
to the object. Additional users can manage tags, i.e. another user can delete a tag that you have created.

Assign tags
You can assign tags to one or more objects.
To assign tags, select the check box(es) next to the object(s) and click Actions >

Tags:

To assign already existing tags, click into the typing field a tag from the list and click Apply.

Create a new tag
To create a new tag, type in the tag name, select Create "tag_name" and then click Apply.
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Filter objects by tags
Click a tag to apply a filter to the listed objects. The selected tags are blue.

Unassign tags
To assign tags, select the check box(es) next to the object(s) and click Actions >
clicking the X and click Apply.

Tags. Remove the tag by

Delete a tag
To delete a tag, hover the mouse over the tag in the Tags pane, click the
want to delete the tag from all objects in the ESMC Web Console.
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icon and click OK to confirm that you

Dashboard
The dashboard is the default page displayed after you log into the ESMC Web Console for the first time. It displays
pre-defined reports about your network. You can switch between dashboards using the tabs in the top menu bar.
Each dashboard consists of several reports.

Dashboard manipulation
• Add - Click the
symbol at the top of the dashboard header to add a new dashboard. Enter a name for
the new dashboard and click Add dashboard to confirm. A new blank dashboard is created.
• Move - Click and drag the name of a dashboard to change its location relative to other dashboards.
• Customize - You can customize your dashboards by adding, modifying, resizing, moving and re-arranging
reports.
• Set as default - Select the dashboard, click the
gear icon next to Dashboard and select Set as default.
Click the

gear icon next to the selected dashboard title to get following options in the drop down menu:

Refresh page

Refresh the report templates in this dashboard.

Remove

Remove the dashboard.

Rename

Rename the dashboard.

Duplicate
Change Layout

Create a copy of the dashboard with the same parameters in user's home group.
Choose a new layout for this dashboard. The change will remove current templates
from the dashboard.

Note
You cannot customize these default dashboards: Status Overview and Security Overview.
The following dashboards come pre-configured in ESET Security Management Center:

Status Overview
The Status Overview dashboard is the default screen you see when you log into ESET Security Management
Center (unless you set another dashboard as the default one). It displays general information about your network.
• Device filters - Displays the number of managed devices based on last reported status. You can click each
of the 4 tiles to open a filtered list of devices.
• Device status - Displays the number of managed devices based on the type security product installed in
respective tabs. If no security product of that group is deployed, the tab will display an option to deploy the
respective installer package.
• Connection status - Displays the list of last connections of managed devices.
• Product version status - Displays the ratio of up-to-date and outdated security product versions based on
platform. By clicking the red graph that represents outdated applications, you can initiate an update by
selecting Update installed ESET products. The ESET product in unknown status is installed, but its version is
not recognized (for example, shortly after a new installation of ESET product).
• Management status - Displays the number of Managed & Protected (client devices with both ESET Agent
and a security product installed), Managed (client devices with only Agent), Unmanaged (client devices in
your network that are known to ESMC but without Agent) and Rogue (client devices unknown to ESMC but
detected by Rogue Detection Sensor).
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• RSS feed - Displays an RSS feed from WeLiveSecurity and the ESET Knowledgebase Portal. When you click
the gear icon in RSS feed, you can choose to Turn off feed autoplay, or turn off individual feed source, or
Turn off RSS feed.

Security Overview
This dashboard provides overview of unresolved detections discovered in the last 7 days, including their severity,
detection method, resolution status and top 10 computers/users with detections.

Computers
This dashboard gives you an overview of client machines, including their protection status, operating systems and
update status.

Security Management Center Server
In this dashboard, you can view information about the ESET Security Management Center server itself, including
server load, clients with problems, CPU load and database connections.

Antivirus detections
Here you can see reports from the antivirus module of client security products, including active detections,
detections in the last 7/30 days, and so on.

Firewall detections
Firewall events of the connected clients arranged according to their severity, time of reporting, etc.

ESET applications
This dashboard lets you view information about installed ESET applications.

Dynamic Threat Defense
If you are using the ESET Dynamic Threat Defense, you can find here an overview of useful ESET Dynamic Threat
Defense reports.

Actions in a dashboard report
Re-size

Click to view a report in fullscreen mode.

Refresh

Refresh the report template.

Download

Click Download to generate and download the report. You can choose from .pdf,
.ps or .csv. CSV is suitable only for table data and uses ; (semicolon) as a delimiter.
Change the report template for another from the list of templates.

Change
Edit report template
Set Refresh Interval
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Edit an existing report template. The same settings and options used for creating a
new report template apply.
Set up custom refresh interval for the template.

Schedule
Remove
Rename
This Cell

Schedule a report - you can modify the schedule trigger, throttling and report
delivery. You can find all scheduled reports in the Scheduled reports tab.
Remove the report template from the dashboard.
Rename the report template.
Choose a new layout for this dashboard. The change will remove current templates
from the dashboard.

Permissions for Dashboard
A user must have the appropriate permission to work with Dashboards. Only report templates contained in a
group where the user has access rights can be used in a Dashboard. If user has no rights assigned for Reports and
Dashboard, user will see no data in the Dashboard section. Administrator can see all data by default.

Important
• Read - User can list report templates and their categories. User can also generate reports based
on report templates. User is able to read his dashboard.
• Use - User can modify his dashboard with available report templates.
• Write - Create / modify / remove templates and their categories.
All default templates are located in the All group.

Drill down
You can use the drill-down dashboard functionality to examine data in greater detail. It lets you interactively
select specific items from a summary and view detailed data about them. Focus on the item of interest by "drilling
down" from summary information in order to get more information about this particular item. There are usually
multiple levels you can drill-down through.
There are several drill-down options:
• Show Detailed information - Computer name and description, Static Group name, etc. Displays original
(not aggregated) data for the clicked row.
• Show Only 'value' - Show only data with the selected level of severity: Information, Critical, Security risk,
Security notification, etc.
• Expand column 'value' - This will show aggregated information (usually for count or sum). For example, if
there is just a number in the column and you click Expand column Computer, it will list all details about
computers.
• Show In Computers page (all) - Redirects you to the Computers page (shows a result of 100 items only).

One-click actions
Reports with information about the discovered problems contain additional drill down options when you click the
item in the table/chart:
• 'task to resolve the selected alert' - You can resolve the alert by selecting the suggested task that will run
ASAP.
If the alert cannot be resolved via a task, but it can be resolved by a policy setting, the following options are
displayed:
oManage Policies
oNew Policy
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• Search the Web - Triggers Google search for the selected alert. You can use this option if there is no
suggested response (task or policy setting) to resolve the selected alert.

Note
The results you get using drill-down of other reports show the first 1,000 items only.
Click the Generate and Download button if you want to generate and download the report. You can choose from
.pdf, .ps or .csv. CSV is suitable only for table data and uses ; (semicolon) as a delimiter.
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Computers
All client devices that have been added to ESET Security Management Center are shown here and are divided into
groups. Each device is assigned to a single static group. Clicking on a group from the list (on the left) will display
the members (clients) of this group in the right pane.
Unmanaged computers
(clients on the network that do not have the ESET Management Agent or an ESET
security product installed) usually appear in the Lost & found group. The status of a client that is shown in the
ESMC Web Console is independent from the settings of the ESET security products on the client. That is why even
if a certain status is not displayed on the client, it is still reported to the ESMC Web Console. You can drag and
drop clients to move them between groups.
Click button Add New and select:
•
•
•

Computers - You can add computers to the selected static group.
Mobile devices - You can add mobile devices to the selected static group.
Synchronize via directory server - You can run Static Group Synchronization task.

Click a device to open a new menu with actions available for that device. You can also select the check box next to
a device and click the Actions button on the bottom bar. The Action menu will display different options depending
on the type of device. Refer to the Icon legend for details about different icon types and statues. Click the number
of alerts in the Alerts column to see the list of alerts in the computer details section.
Last Connected displays the date and time of last connection of the managed device. The Last Connected
information gets highlighted to indicate that the computer is not connecting:
oYellow (error) - computer is not connecting for 2-14 days.
oRed (warning) - computer is not connecting for more than 14 days.
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Filtering the view
There are different ways to filter your view:
• Standard filter: To add filtering criteria, click Add filter and select item(s) from the list. Enter the search
string(s) into the filter field(s). Active filters are highlighted in blue.
• You can filter by severity using the status icons:
red - Errors,
yellow - Warnings,
green - OK and
gray - Unmanaged computers. The severity icon represents the current status of your ESET product on a
particular client computer. You can use a combination of these icons by turning them on or off. For example,
to see only the computers with warnings, leave only the
yellow icon selected (the rest of the icons must
be deselected). To see both,
warnings and
errors, leave only these two icons on.
• Click Add filter > Product Category and using the drop-down menu, you can select the types of devices to
be displayed.
oAll Devices - select this option from the drop-down menu to see all the client computers again, without
limiting (filtering) displayed clients. You can use a combination of filtering options when narrowing down
the view.
oESET Protected - protected by an ESET product
oESET Security Management Center - individual ESMC components such as Agent, RD Sensor, Server, etc.
oOther - Shared Local Cache, Virtual Appliance, Enterprise Inspector Agent, Enterprise Inspector Server.
• Show Subgroups check box - show subgroups of the currently selected group.
• Use Dynamic Groups or Reports for more advanced filtering.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Note
If you are not able to find a particular computer in the list and know it is in your ESMC
infrastructure, make sure that all filters are turned off.

Computer details
To find out details about a computer, select a client computer in a Static or Dynamic Group and click Show
Details.
The information window consists of the following parts:

Overview
There are the following tiles with an overview of the computer's situation.
Computer
• Click the edit icon
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to change the computer's name or description. You can select Allow Duplicate Name

f there is already another managed computer with the same name.
• Click Select tags to assign tags.
• FQDN - fully qualified domain name of the computer

Note
If you have your client computers and ESMC Server running under Active Directory, you can
automate populating Name and Description fields using Static Group Synchronization task.

• Parent Group - Change parent Static group of the computer.
• IP - the IP address of the machine.
• Applied Policies Count - Click the number to see the list of the applied policies.
• Member of Dynamic Groups - The list of Dynamic Groups in which the client computer was present during
the latest replication.

Hardware
This tile contains a list of key hardware parameters, information about operating system and unique identifiers.
Click the tile to view the Details - Hardware tab.

Alerts
• Alerts - Link to list of problems with current computer.
• Unresolved Detections Count - Count of unresolved detections. Click the count to see the list of
unresolved detections.
• Last Connected Time - Last Connected displays the date and time of last connection of the managed
device. The Last Connected information gets highlighted to indicate that the computer is not connecting:
oYellow (error) - computer is not connecting for 2-14 days.
oRed (warning) - computer is not connecting for more than 14 days.
• Last Scan Time - Time information with last scan.
• Detection Engine - Version of detection engine on target device.
• Updated - The update status.

Products & Licenses
List of ESET components installed on the computer. Click the tile to view the Details - Product & Licenses tab.
Encryption
The encryption tile is visible only on workstations that are supported by ESET Full Disk Encryption.
Users
• Logged users (computers only) - Domain and username of users logged on the device.
• Assigned users
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oClick Add user or Assign user to assign a user from Computer Users to this device.
oClick the trash icon
to un-assign current user.
oClick the assigned user's username to display his account details.

Location (mobile devices only). Devices in iOS Apple Business Manager (ABM) can be localized only when "Lost
Mode" is activated.

Hardware button is used to set up the computer for cloning. It is required when computers are cloned or
computers' hardware is changed.
• Mark as Master for Cloning > Match with existing computers - See the Match with an existing computer
every time option. It is recommended to use this option before the VDI pool is created.
• Mark as Master for Cloning > Create new computers - See the Create a new computer every time option.
It is recommended to use this option before the VDI pool is created.
• Disable hardware detection - Disable detection of the hardware changes permanently. This action is
irreversible!
• Unmark as Master for Cloning - Remove the master flag. After this is applied, each new cloning of the
machine results in a question.

Important
Hardware fingerprint detection is not supported on:
• Linux, macOS, Android, iOS
• systems managed via ESET Virtual Agent Hosts (ESET Virtualization Security)
• machines without ESET Management Agent 7

Configuration
Configuration tab - Contains list of configurations of installed ESET products (ESET Management Agent, ESET
endpoint, etc.). Available actions are:
• Click Request configuration to create a task for ESET Management Agent to collect all the managed
product configurations. After the task is delivered to ESET Management Agent, it is executed immediately
and the results are delivered to ESMC Server on the next connection. This will allow you to see the list of all
managed product configurations.
• Open a configuration via context menu and convert it to a policy. Click a configuration to see it in the
viewer.
• Once you open the configuration, you can convert it to a policy. Click Convert to Policy, current
configuration will be transferred to the policy wizard and you can modify and save the configuration as a
new policy.
• Download a configuration for diagnostics and support purposes. Click a selected configuration and click
Download for diagnostics in drop-down menu.
Applied Policies tab - List of policies applied to the device. If you have applied a policy for ESET product or ESET
product feature that is not installed on the computer, the listed policy is grayed out.
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Note
You can see the policies assigned to the selected device as well as policies applied to groups
containing the device.
Click
Manage Policies to manage, edit, assign or delete a policy. Policies are applied based on their order
(Policy Order column). To change policy application priority, select the check box next to a policy and click the
Apply Sooner or Apply Later button.
Applied Exclusions tab - List of exclusions applied to the device.

Logs (computers only)
• SysInspector - Click Request log (Windows only) to run the SysInspector log request task on selected
clients. After the task is completed, a new entry is added in the list of ESET SysInspector logs. Click a log in
the list to explore it.
• Log Collector - Click Run Log Collector to run the Log collector task. After the task is completed, a new
entry is added in the list of logs. Click a log in the list to download it.
• Diagnostic logs - Click the Diagnostics > Turn on to start the Diagnostics mode on the current machine.
Diagnostics mode will make client send all logs to the ESMC Server. You can browse all logs within 24 hours.
Logs are sorted into 5 categories: Spam Log, Firewall Log, HIPS Log, Device Control Log, Web Control Log.

Note
The file size limit for log delivery per device is 150MB. If the logs gathered by the task are bigger, the
task will fail with the "Log collector output exceeded 150MB and will not be transferred." message.
The logs transferred to the server is subject to the following rules.
Logs file size
The task is finished with a progress
Logs can be accessed from the Web
under 15 MB
message: "Command was executed."
console at Computer details > Logs
section.
Logs file size
The task is finished with a progress
Logs can be accessed on the ESMC
bigger than 15
message: "Log collector archive was too server. The path to the logs file
MB but smaller big to be stored in the database. Please location is displayed at Computer
than 150 MB
see log collector entry for its new
details > Logs section.
location. "
Logs file size
The task is finished with a progress
If this situation occurs, either change
bigger than 150 message: "Log collector archive is too big the verbosity of the logs and retry the
MB
to be transferred."
task or gather the logs locally on the
device.

Task Executions
A list of executed tasks. You can filter the view to narrow down the results, view task details, edit, duplicate,
delete or run on/rerun the task.
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Installed Applications
Displays a list of programs installed on a client with details such as version, size, security status, etc. You can turn
on the reporting of non-ESET applications via Policy setting. Select a program and click Uninstall to remove it. You
will be asked to enter Uninstallation parameters. These are optional command line parameters for the installer
(installation package). Uninstallation parameters are unique for each software installer. You can find more
information in the documentation for the particular product.
If an update for the ESET product is available, you can update the ESET product by clicking Update ESET Products
button.

Note
iOS devices report the list of installed software to ESMC once a day. Users cannot force refresh the
list.

Alerts
Shows a list of alerts and their details: Problem, Status, Product, Occurred, Severity, etc. This list can be accessed
directly from Computers section by clicking the alerts count in the Alerts column. You can manage alerts via oneclick actions.

Questions (computers only)
The list of cloning-related question is on the Questions tab. Read more about resolving questions for changed or
cloned computers.

Detections and Quarantine
• Detections - All detection types are displayed, but you can filter them by Detection Category Antivirus,
Blocked files,
Enterprise Inspector,
Firewall,
HIPS, and
Web protection.
• Quarantine - A list of quarantined detections with details such as Detection name, Detection type, Object
name, Size, First occurred, Count, User reason, etc.

Details
• Basic - Information about the device: OS Name, Type, Version, Serial number, FQDN name, etc.
Information whether the device is muted, managed, when it was last time updated and number of applied
policies.
• Hardware - Information about the hardware of the computer, manufacturer and model and information
about networking (IPv4, IPV6, subnet, network adapter...).
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• Products and Licenses - Version of current detection engine, versions of installed ESET Security Products,
used licenses.

Remove computer from management
To remove a device from management, click Computers, select a device and click
display the steps needed to remove the selected computer from management.

Remove. A dialog box will

Important
When proceeding to the next step, make sure that you have successfully competed the previous
step. This is essential for correct device removal.
1.Reset Endpoint settings - Click Manage Policies and remove all applied policies to allow local device
management. See Policy Removal Rules in the Policies section. If a password is set to access the Endpoint
product setup, create a new policy to remove the password (select to set a password, but do not enter any
password). For EFDE clients follow the decryption steps here.
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2.Stop computer management - Run a Stop Managing Task or uninstall the ESET Management Agent or ESET
security product locally on a computer. This suspends the connection between the computer and ESMC.
3.Remove computer from database - After you ensure that the computer is no longer connecting to ESMC,
you can remove it from the list of managed devices.
• Select the check box I want to deactivate installed ESET products to remove the license from all ESET
products installed on the selected computer. See also deactivation of ESET business products.

Groups
Groups can be understood as folders where computers and other objects are categorized.
For computers and devices, you can use pre-defined groups and group templates, or create new ones. Client
computers can be added to groups. This helps you keep the computers structured and arranged to your liking.
You can add computers to a Static Group.
Static Groups are managed manually, while Dynamic Groups are arranged automatically based on specific criteria
in a template. Once the computers are in groups, you can assign policies, tasks or settings to these groups. The
policy, task or setting is then applied to all the members of the group. There are two types of client groups:

Static Groups
Static Groups are groups of selected client computers and other objects. Group members are static and can only
be added/removed manually, not based on dynamic criteria. An object can only be present in one Static Group. A
static group can be deleted only if there are no objects contained in it.

Dynamic Groups
Dynamic Groups are groups of devices (not other objects like tasks or policies) that have become members of the
group by meeting specific criteria. If a client device does not fulfill that criteria, it will be removed from the group.
Computers that satisfy the criteria will be added to the group automatically (hence the name "dynamic").
Click the gear icon

next to the group name to see the available group actions and group details.

Computers that are members of the group are listed on the right pane.

Group Actions
Navigate to More > Groups and select the group you want to manage. Click the Group button or the gear icon
next to the group name. A menu with the following options will be displayed:

Group Action
Show Details

Group Action Description
Provides an overview of the selected group.

Applies to
Static Groups Dynamic
Groups
✔
✔

New Static Group The selected group becomes the default parent group, but you
can change the parent group later when you create a new Static ✔
Group.
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x

Group Action

Group Action Description

Applies to
Static Groups Dynamic
Groups

The selected group becomes the default parent group, but you
✔
can change the parent group later when you create a new
Dynamic Group.
x
New Notification Create a new notification.
Add a new device.
✔
Add New

New Dynamic
Group

Tasks

Reports

Select Client Tasks to be executed on devices in this group:
Scan - Run the On Demand Scan task on all clients in the
selected group.
Update Modules - Run the Modules Update task (triggers an
update manually).
Mobile - See the Anti-Theft Actions for more details.
• Re-enroll - Create new Client Task.
• Find - Request the GPS coordinates of your mobile device.
• Lock - Device will be locked when suspicious activity is
detected or the device is marked as missing.
• Unlock - Device will be unlocked.
• Siren - Triggers a loud siren remotely, the siren will start even
✔
if your device is set to mute.
• Wipe - All data stored in your device will be permanently
erased.
Run Task - Select one or more Client Tasks and run them on
the selected device.
New Task - Create a new Client Task. Select a task and
configure the throttling (optional) for this task. The task will be
queued according to the task settings.
This option immediately triggers an existing task that you select
from a list of available tasks. The trigger is not available for this
task, because it will be executed immediately.
Last used tasks - List of last used Client Tasks for all groups
and computers.
Select and run a report from the selected group.
✔

Manage Policies Manage policies assigned to the selected group.
Edit the selected Group. The same settings apply as when you
Edit
create a new group (static or dynamic).
Select a group and move it as a subgroup of another group.
Move

x

✔

x
✔

✔

✔

✔

✔

✔

✔

x

✔

Remove the selected group.

Apply sooner
Apply later

Change the priority level of a Dynamic Group.

Import

Import a list (usually a text file) of computers, as members of
the selected group. If the computers already exist as members
✔
of this group, the conflict will be solved based on the selected
action.
Export the members of the group (and subgroups, if selected) in
✔
a list (.txt file). This list can be used for review or imported later.
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✔

✔

Delete

Export

✔

x

x

Group Details
When you select the group action

Show Details, you can see an overview of the selected group:

Overview
In Overview, you can edit group settings by clicking
or Add description. You can view information about group
placement and its Parent group and Child groups. If the selected group is a Dynamic Group, you can also see the
operation and rules based on which computers are evaluated and assigned to the group.

Tasks
You can view and edit the Client Tasks assigned to the group.

Policies
You can assign an existing policy to the group or create a new policy. You can view and edit the policies assigned
to the group.

Note
You can see only the policies assigned to the selected group. You cannot see the policies applied to
individual computers in the group.
Policies are applied based on their order (Policy Order column). To change policy application priority, select the
check box next to a policy and click the Apply Sooner or Apply Later button.

Alerts
The list of alerts from computers in the group. You can manage alerts via one-click actions.

Exclusions
The list of exclusions applied to the group.

Static Groups
Static Groups are used to:
• Organize devices and create hierarchy of groups and subgroups
• Organize objects
• Serve as Home Groups for users

Static Groups can only be created manually. Devices can be moved manually into groups. Each computer or
mobile device can belong only to one Static Group. The management of Static Groups is available via group
actions.
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There are two default Static Groups:
• All - This is a main group for all devices in the ESMC Server network. All objects created by the
administrator are (by default) contained in this group. It is always displayed and cannot be renamed. Access
to this group gives users access to all subgroups; therefore it should be distributed carefully.
• Lost & Found - A child group of group All. Each new computer that connects to the ESMC Server for the
first time is automatically displayed in this group. The group can be renamed or copied, but it can't be
deleted or moved.

Important
A static group can be deleted only if:
• The user has write permission for this group
• The group is empty
If there are still some objects in the static group, the delete operation will fail. There is an Access
Group filter button located in each menu (for example, Installers) with objects.
Click Select to choose a static group—only objects contained in this
group will then be listed in the view. With this filtered view, the user can easily manipulate objects
from one group.

Create a new Static Group
To create a new Static Group, click Computers, select the gear icon
Group.
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next to a static group and select New Static

Basic
Enter a Name and a Description for the new group. Optionally, you can change the Parent group. By default, the
parent group is the group you selected when you started creating the New Static Group. If you want to change its
parent group, click Change Parent Group and select a parent group from the tree. The parent of the New Static
Group must be a Static Group. It is not possible for a Static Group to be included in a Dynamic Group. Click Finish
to create the New Static Group.

Import clients from Active Directory
To import clients from AD, create a new server task: Static Group Synchronization.
Select a group to which you want to add new computers from the AD. Also select objects in the AD you want to
synchronize from and what to do with duplicates. Enter your AD server connection settings and set the
Synchronization mode to Active Directory/Open Directory/LDAP.

Export Static Groups
Exporting a list of computers that are in the ESMC structure is simple. You can export the list and store it as a
backup so that you can import the list back in the future, for example if you want to restore the group structure.

Note
Static groups need to contain at least one computer. Exporting empty groups is not possible.
1.Go to Computers and select a Static Group you want to export.
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2.Click the gear icon and select

Export.

3.If the selected Static Group contains subgroups with computers, you can select to export computers from
subgroups as well.

4.The file will be saved in .txt format.

Note
Dynamic Groups cannot be exported because Dynamic Groups are only links to computers
according to the criteria defined in Dynamic Group Templates.

Import Static Groups
Exported files from Static Groups can be imported back into ESMC Web Console and included in your existing
group structure.
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1.Click Computers, select any Static Group.
2.Click the gear icon and select
Import.
3.Click Browse and navigate to the .txt file.
4.Select the group file and click Open. The file name is displayed in the text box.
5.Select one of the following options to resolve conflicts:
• Do not create or move any devices if same entries were found elsewhere.
If the static group exists and computers from the .txt file already exist in this group, those computers are
skipped and are not imported. Information about this is displayed.
• Move existing devices if they do not already exist on imported paths. Keep only managed devices
on same path when possible.
If the static group exists and computers from the .txt file already exist in this group, it is necessary to
move computers to other Static Groups prior to the import, after the import, these computers will be
moved back into original groups from where they had been moved.
• Duplicate existing devices if they do not already exist on imported paths.
If the static group exists and computers from the .txt file already exist in this group, duplicates of these
computers are created in the same Static Group. The original computer is displayed with full information
and the duplicate is displayed with its Computer name only.
6.Click Import to import the static group and computers.

Dynamic Groups
Dynamic Groups can be seen as filters based on computer status. One computer may apply for more than one
filter and, therefore, be assigned to more than one Dynamic Group. This makes Dynamic Groups different from
Static Groups, because a single client cannot belong to more than one static group.
Dynamic Groups are groups of clients selected based on specific conditions. For a computer to become a member
of a specific Dynamic Group, it must meet the conditions defined in a Dynamic Group Template. Each template
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consists of one or several Rules. You can specify these rules when creating a new Template. If a client computer
does not fulfill the criteria, it will be removed from the group. If it fulfills the defined conditions, it will be added
to the group.
Devices are evaluated for inclusion in Dynamic Groups each time they check in to ESET Security Management
Center. When a device meets the values specified in a Dynamic Group template, it is automatically assigned to
this group. Computers are filtered on the Agent side, so no extra information needs to be transferred to server.
The Agent decides on its own which Dynamic Groups a client belongs to, and only notifies the server about this
decision.

Note
If the client device is not connected (for example, it is turned off), its membership in dynamic
groups is not updated. After the device is connected again, its membership in dynamic groups will
be updated.
There are some pre-defined Dynamic Groups available after you have installed ESET Security Management
Center. You can also create custom Dynamic Groups. There are 2 ways to do this:
• Create a template first and then create a Dynamic Group.
• Create a new template when creating a new Dynamic Group.
A user can use Dynamic Groups in other parts of ESMC. It is possible to assign policies to them (policies are
applied as described here) or prepare a task for all computers in the group.
A dynamic group can be inside (under) a static group or dynamic groups. However, static group can not be inside
a dynamic group. All dynamic groups under a certain static group only filter devices of that static group. If a
dynamic group is inside another dynamic group, it filters the results of the superior dynamic group. Once the
group is created, it can be moved freely across the tree.
The management of Dynamic Groups is available via group actions.

Create a new Dynamic Group
Follow the steps below to create a New Dynamic Group.
1.Click Computers, select the gear icon
Dynamic Group Wizard will appear.
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next to any group and select New Dynamic Group. A New

2.Enter a name and description for the new template.
3.You can change the parent group by clicking Change Parent Group.

4.Click Template. Every Dynamic Group is created from a Template that defines how the group filters client
computers. Unlimited number of Dynamic Groups can be created from one template.
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Note
A template is a static object stored in a Static group. Users must have appropriate permissions to
access templates. A user needs access permissions to be able to work with Dynamic Group
templates. All pre-defined templates are located in the static group All and are by default available
only to the Administrator. Other users need to be assigned additional permissions. As a result, users
may be unable to see or use default templates. The templates can be moved to a group where the
users have permissions.
To duplicate a template, the user must be assigned write permissions (for Dynamic Group
templates) for the group where the source template is located, and for the user's home group
(where the duplicate will be stored). See the object duplication example.
• If you want to create the group from pre-defined template, or from a template you have already created,
click Choose existing and select the appropriate template from the list.
• If you have not created any templates and none of the pre-defined templates in the list suit you, click New
and follow the steps to create a new template.
For more use cases how to create new Dynamic Group based on a Dynamic Group template with rules, see
examples.

5.Click Summary. The new group will appear under the parent Group.

Move Static or Dynamic Group
A Dynamic Group can be a member of any other group including Static Groups. A Static Group can not be moved
into a Dynamic Group. Also, it is not possible to move pre-defined Static Groups (for example, the Lost & found
Static Group) to any other group. Other groups can be moved freely.
Click the gear icon
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next to the group name and select Move. A pop-up window will be displayed showing the

group's tree structure. Select the target group (static or dynamic) into which you want to move the selected
group. The target group will become a parent group. You can also move groups by dragging and dropping a group
into the target group of your choice.

Note
The Dynamic Group in a new position starts to filter computers (based on the template) without any
relation to its previous location.

There are 3 methods to move a group:
• Drag and drop - click and hold the group you want to move and release it above the new parent group.
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• Click the gear icon

> Move > select a new parent group from the list and click OK.

• Click the gear icon
click OK.

> Edit > select Change parent group. Select a new parent group from the list and

Assign Client Task to a Group
Click Computers, select Static or Dynamic Group and click the gear icon
Task wizard window will open.
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> Tasks >

New Task. A New Client

Assign Policy to a Group
After a policy is created, you can assign it to a Static or Dynamic Group. There are two ways to assign a policy:

Method I.
Under Policies, select a policy and click Actions > Show Details > Assigned To > Assign Group(s). Select a Static or
Dynamic Group from the list (you can select more groups) and click OK.

Method II.
1.Click Computers, click the gear icon
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next to the group name and select Manage Policies.

2.In the Policy application order window click Add Policy.
3.Select the check box next to the policies that you want to assign to this group and click OK.
4.Click Close.
To see what policies are assigned to a particular group, select that group and click the Policies tab to view a list of
policies assigned to the group.
To see what groups are assigned to a particular policy, select the policy and click Show Details > Applied on.

Note
For more information about policies, see the Policies chapter.

Detections
The Detections section gives you an overview of detections found on managed devices.
Group structure is displayed on the left. You can browse groups and view detections found on members of a given
group. To view all detections found on clients assigned to groups for your account, select the All group and
remove any applied filters.

Detection status
There are two types of detections based on their status:
• Active detections - Active detections are detections that have not been cleaned yet. To clean the
detection, run an In-Depth Scan with cleaning enabled on the folder that contains the detection. The scan
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task must finish successfully to clean the detection and have no more detections. If a user does not resolve
an active detection within 24 hours from its discovery, it loses the Active status but it stays unresolved.
• Resolved detections - These are detections that have been marked by a user as resolved, however they
have not yet been scanned using In-Depth Scan. Devices with detections marked as resolved will still be
displayed in the filtered results list until scanning is performed.

A Detection handled status indicates whether an ESET security product took action against a detection
(depending on detection type and cleaning level settings):
• Yes - The ESET security product took action against the detection (delete, clean, or quarantine).
• No - The ESET security product did not take action against the detection.
You can use Detection handled as a filter in Reports, Notifications, and Dynamic Group Templates.

Note
Not all detections found on client devices are moved to quarantine. Detections that are not
quarantined include:
• Detections that cannot be deleted.
• Detections that are suspicious based on their behavior, but are not identified as malware, for
example, PUAs.

Important
During database cleanup, items in Detections corresponding to the cleaned Incident logs are
deleted as well (regardless of detection status). By default, the cleanup period for Incident logs (and
Detections) is set to 6 months. You can change the interval in Server Settings.

Aggregation of detections
Detections are aggregated by time and other criteria to simplify their resolution. Detections older than 24 hours
are aggregated automatically every midnight. You can identify aggregated detections by the X/Y (resolved
items/total items) value in the Resolved column. You can see the list of aggregated detections in the Occurrences
tab in detection details.

Detections in archives
If one or more detections are found in an archive, the archive and each detection inside the archive are reported
in Detections.

Warning
Excluding the archive file that contains detections does not have any effect anymore. You need to
exclude the individual detections inside the archive.
The excluded detections will not be detected anymore, even if they occur in another archive or unarchived.
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Filtering detections
By default, all detection types from the last seven days are shown, including detections that have been
successfully cleaned. You can filter the detections by several criteria: Computer Muted and Occurred are enabled
by default.

Note
Some filters are enabled by default. If detections are indicated on the Detections button in the main
menu, but you cannot see them in the list of detections, check to see which filters are enabled.
For a more specific view, you can add other filters, such as:
• Detection Category - Antivirus,
Blocked files,
Enterprise Inspector,
Firewall,
HIPS, and
Web protection.
• Detection Type
• IP Address of the client that reported the detection
• Scanner - Select the scanner type that reported the detection. For example, the Anti-Ransomware
scanner shows the detections reported by the Ransomware Shield.
• Action - Select the action performed on the detection. ESET security products report the following actions
to ESMC:
ocleaned - The detection was cleaned.
odeleted / cleaned by deleting - The detection was deleted.
owas a part of a deleted object - An archive that contained the detection was deleted.
oblocked / connection terminated - The access to the detected object was blocked.
oretained - No action was performed due to various reasons, for example:
➢ In the interactive alert, the user manually selected not to perform any action.
➢ In the ESET security product detection engine settings, the Protection level for the detection category
is set lower than the Reporting level.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Manage Detections
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To manage detections, click the item and select one of the available
actions, or select the check box next to one or more items and use the
buttons in the lower part of the Detections screen:
• Scan computers - Run the On-Demand Scan Task on the device that reported the selected detection.
•

Show Details - See Detection details:
oOverview - The Overview section contains the basic information about the detection. From this section,
you can manage the detection with various actions (available actions depend on detection category), or go
to Computer Details to see details about the computer where the detection occurred.
oOccurrences - The Occurrences section is active only when the detection is aggregated and provides the
list of individual occurrences of the detection. You can mark all occurrences of the same detection as
resolved/unresolved.

• Computers - A list of actions you can perform on the computer where the detection was found. This list is
the same as the one in the Computers section.
• Occurrences - The Occurrences section is active only when the detection is aggregated and provides the
list of individual occurrences of the detection. You can mark all occurrences of the same detection as
resolved/unresolved.
• Computers - A list of actions you can perform on the computer where the detection was found. This list is
the same as the one in the Computers section.
•
Mark As Resolved /
or in Computer details.
•
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Mark As Not Resolved - You can mark detections as resolved/not resolved here

Run Task - Run an existing task and create a trigger to complete the task.

The following actions are available only for
•
•

Antivirus detections (files with known paths):

Scan Path - Create the On-Demand Scan Task with pre-defined paths and targets.
Create Exclusion - Create detection exclusions.

The action Show in EI is available only for
Enterprise Inspector items and allows you to open the item details
directly in the ESET Enterprise Inspector Web Console.
The action
Send File to EDTD is available only for
Blocked files. You can send a file for the malware analysis
(ESET Dynamic Threat Defense) from ESMC Web Console. You can see the file analysis details in Submitted Files. If
you want to submit other executable files manually for analysis in ESET Dynamic Threat Defense, you can do it
from the ESET endpoint product (you need to have the ESET Dynamic Threat Defense license).

Create Exclusion
You can exclude selected item(s) from being detected in the future. Click a detection and select
Exclusion. You can exclude only Antivirus detections.

Create

Warning
Use exclusions with caution - they may result in an infected computer.
In ESMC 7.1 and later, there are two exclusion categories:
1.Performance exclusions - Exclusions of files and folders defined by a path. You can create them via a
Policy. See also performance exclusions format and examples.
2.Detection exclusions - Exclusions of files defined by detection name, detection name and its path, or by
object hash (SHA-1). See also examples of detection exclusions by detection name.
ESMC 7.1 and later includes a new
Create Exclusion wizard for management of detection exclusions. You can
create a detection exclusion and apply it to more computers/group(s).
The More > Exclusions section contains all detection exclusions, increases their visibility and simplifies their
management.

131

Warning
• In ESMC 7.1 and later, you cannot create detection exclusions via a Policy anymore.
• In case your policies contained detection exclusions previously, you can migrate exclusions from a Policy to the
Exclusions list.
• By default, detection exclusions replace the local existing exclusions list on the managed computers. To keep
the existing local exclusions list, you need to apply the Policy setting Allow appending detection exclusions to
locally defined list before applying detection exclusions:

Detections in archives
If one or more detections are found in an archive, the archive and each detection inside the archive are reported
in Detections.

Warning
Excluding the archive file that contains detections does not have any effect anymore. You need to
exclude the individual detections inside the archive.
The excluded detections will not be detected anymore, even if they occur in another archive or unarchived.

Settings
You can exclude one or more detections based on the following Exclusion criteria:
• Path & Detection - Exclude each file by its detection name and path, including file name (e.g.
file:///C:/Users/user/AppData/Local/Temp/34e1824e/ggdsfdgfd.pdf.exe).
• Exact files - Exclude each file by its SHA-1 hash.
• Detection - Exclude each file by its detection name.
The recommended option is pre-selected based on the detection type.
Select the check box Resolve matching alerts to automatically resolve the alerts covered by the detection
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exclusion.
Optionally, you can add a Comment.

Target
Warning
You can assign detection exclusions only to computers with a compatible ESET security product
installed. Detection exclusions will not be applied to incompatible ESET security products and will be
ignored on them.
A detection exclusion is by default applied to user's home group.
To change assignments, click Add Computers or Add Groups and select the target(s) where the detection
exclusion will be applied, or select existing assignment(s) and click Remove Targets.

Preview
Allows you to see the overview of created detection exclusions. Make sure all exclusion settings are correct based
on your preferences.

Important
After you create the detection exclusion, you cannot additionally edit it (you can only change
assignment or delete exclusion).
Click Finish to create the detection exclusion.
You can see all the applied detection exclusions in group details and all the created detection exclusions in More >
Exclusions.

ESET security products compatible with detection
exclusions
All manageable ESET security products are compatible with detection exclusions, except for the following:
• ESET Endpoint Security for Android
• ESET Dynamic Threat Defense
• ESET Enterprise Inspector
• ESET Virtualization Security
• ESET Endpoint for MacOS version 6.8.1 and older.

Warning
Detection exclusions will not be applied to incompatible ESET security products and will be ignored
on them.
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Ransomware Shield
ESET business products (version 7 and later) include Ransomware Shield. This new security feature is a part of
HIPS and protects computers from ransomware. When ransomware is detected on a client computer, you can
view the detection details in the ESMC Web Console under Detections. To filter only ransomware detections, click
Add Filter > Scanner > Anti-Ransomware scanner. For more information about Ransomware Shield, see the ESET
Glossary.
You can remotely configure Ransomware Shield from the ESMC Web Console using the Policy settings for your
ESET business product:
• Enable Ransomware Shield - ESET business product automatically blocks all the suspicious applications
that behave like ransomware.
• Enable Audit Mode - When you enable the Audit Mode, potential detections identified by the
Ransomware Shield are not blocked and are reported in the ESMC Web Console. The administrator can
decide to block the potential reported detection or exclude it by selecting Create Exclusion. This Policy
setting is available only via ESMC Web Console.

Important
By default, Ransomware Shield blocks all applications with potential ransomware behavior,
including legitimate applications. We recommend that you Enable Audit Mode for a short period on
a new managed computer, so that you can exclude legitimate applications that are detected as
ransomware based on their behavior (false positives). We do not recommend that you use the Audit
Mode permanently, because ransomware on the managed computers is not automatically blocked
when Audit Mode is enabled.

ESET Enterprise Inspector
ESET Enterprise Inspector is a comprehensive Endpoint Detection and Response system that includes features
such as: incident detection, incident management and response, data collection, indicators of compromise
detection, anomaly detection, behavior detection, policy violations. For more information about ESET Enterprise
Inspector, its installation and functions, see ESET Enterprise Inspector help.

ESET Enterprise Inspector configuration
ESET Enterprise Inspector requires ESMC to:
• Create an ESET Enterprise Inspector user with proper permissions. ESMC 7.2 contains the pre-defined
permission sets for ESET Enterprise Inspector users.
• Create certificates that are used during ESET Enterprise Inspector Server Installation.
• Activate ESET Enterprise Inspector on a device connected to ESMC.

Note
You need to have ESET Enterprise Inspector license to activate ESET Enterprise Inspector.
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Reporting of ESET Enterprise Inspector detections in ESMC
If you add a device that runs the ESET Enterprise Inspector Agent (properly configured and connected to the ESET
Enterprise Inspector Server) to ESMC, ESET Enterprise Inspector reports the discovered detections in the ESMC
Detections section. You can filter these detections by selecting the Enterprise Inspector detection category.
Another detection type reported by ESET Enterprise Inspector are
Blocked files. These are the blocked
attempts to launch executables blacklisted in ESET Enterprise Inspector (blocked hashes).
Send File to EDTD is
available only for
Blocked files. You can send a file for the malware analysis (ESET Dynamic Threat Defense)
from ESMC Web Console. You can see the file analysis details in Submitted Files. If you want to submit other
executable files manually for analysis in ESET Dynamic Threat Defense, you can do it from the ESET endpoint
product (you need to have the ESET Dynamic Threat Defense license).

Managing ESET Enterprise Inspector detections in ESMC
Integration of ESET Enterprise Inspector detections in the ESMC Web Console allows you to manage Enterprise
Inspector detections directly from the ESMC Web Console, without the need to open the ESET Enterprise
Inspector Web Console. For example, if you mark the detection as resolved in the ESMC Web Console, it is also
marked as resolved in the ESET Enterprise Inspector Web Console and vice versa.
Click the detection and select

Show in EI to see detection details in the ESET Enterprise Inspector Web Console.

The following system requirements must be met to enable management of Enterprise Inspector detections in the
ESMC Web Console:
• ESMC version 7 and later.
• ESET Endpoint software (ESET Endpoint Antivirus, ESET Endpoint Security) version 7 and later installed on
the managed computer.

Note
ERA 6.5 displays detections reported by ESET Enterprise Inspector, but it does not provide the
option to manage them (mark them as resolved).

Reports
Reports allow you to access and filter data from the database in a convenient way. The reports window consist of
two tabs:
• Categories & Templates - this is the default tab for the Reports section. It includes an overview of report
categories and templates. You can create new reports and categories or perform other report related
actions here.
• Scheduled Reports - this tab provides an overview of scheduled reports, you can also schedule a new
report here.
Reports are generated from templates which are categorized by report type. A report can be generated
immediately or can be scheduled to generate later. To generate and view the report immediately, click Generate
Now next to the desired report template. You can use pre-defined report templates from the list of Categories &
Templates, or you can create a new report template with custom settings. Click New report template to open a
report template wizard and specify custom settings for the new report. You can also create a new report category
(New Category) or import previously exported report templates (Import Report Templates).
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There is a Search bar on the top of the page. You can search the category
and template names, not descriptions. Click the arrows next to the search bar to compress or expand all report
categories.
You can use tags for filtering the displayed items.

The Access Group filter button allows users to select a static group and filter
viewed objects according to the group where they are contained.

Using the reports templates
Choose a report template and click the gear icon
available:

on the report template tile. The following options are

Generate Now

The report will be generated and you can review the output data.

Download

Delete

Click Download to generate and download the report. You can choose from .pdf,
.ps or .csv. CSV is suitable only for table data and uses ; (semicolon) as a delimiter.
Schedule a report - you can modify the schedule trigger, throttling and report
delivery. You can find all scheduled reports in the Scheduled reports tab.
Edit an existing report template. The same settings and options used for creating a
new report template apply.
Create a new report based on the selected report (a new name is required for the
duplicate).
Remove the selected report template completely.

Export

The report template will be exported to a .dat file.

Schedule
Edit
Duplicate

Using the reports categories
Select the report category and click gear icon
available:
New Category

at the right corner of the category. The following options are

Enter a Name to create a new report template category.

New Report Template Create a new custom report template.
Remove the selected report template category completely.
Delete
Edit

Rename existing report template category.

Export

The report template category and all included templates will be exported to a .dat
file. You can later import the category with all templates by clicking Import Report
Templates. This is useful, for example, when you want to migrate your custom
report templates to another ESMC Server.
Move the report template Category to a different static group. This will make it
accessible for the local admin of target group. Local admin has full access rights in his
group.

Access Group
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Important
The Import Report Templates /
Export feature is designed for importing and exporting report
templates only, not an actual generated report with data.

Permissions for Reports
Reports are static objects which reside in a structure of objects in the ESMC database. Each new report template
is stored in the home group of the user who created it. To be able to access a report you need permissions. You
also need permissions to objects which are inspected by the report. For example, if you generate Computer
statuses overview report, there will be only data from computers where you have Read permission.

Important
• Read - User can list report templates and their categories. User can also generate reports based
on report templates. User is able to read his dashboard.
• Use - User can modify his dashboard with available report templates.
• Write - Create / modify / remove templates and their categories.
All default templates are located in the All group.

Create a new report template
Navigate to Reports and click New Report Template.
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Basic
Edit the Basic information about the Template. Enter a Name, Description and Category. You can only choose
from pre-defined Categories. If you want to create a new category, use the New Category option (described in
the previous chapter). Click Select tags to assign tags.

Chart
In the Chart section, select the Report type. Either a Table, where the information is sorted in rows and columns,
or a Chart that represents data using an X and Y axis.

Note
The selected chart type will be displayed in the Preview section. This way, you can see what the
report will look like in real-time.
Selecting a Chart gives you multiple options:
• Bar Chart - A chart with rectangular bars proportional to the values they represent.
• Dots Chart - In this chart, dots are used to display quantitative values (similar to a bar chart).
• Pie Chart - A pie chart is a circular chart divided into proportional sectors, representing values.
• Doughnut Chart - Similar to a pie chart, but the doughnut chart can contain multiple types of data.
• Line Chart - Displays information as a series of data points connected by straight line segments.
• Simple Line Chart - Displays information as a line based on values without visible data points.
• Stacked Line Chart - This chart type is used when you want to analyze data with different units of
measure.
• Stacked Bar Chart - Similar to a simple bar chart, but there are multiple data types with different units of
measure stacked in the bars.
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Optionally, you can enter a title for the X and Y axis of the chart to make it easier to read the chart and recognize
trends.

Data
In the Data section, select the information you want to display:
a.Table Columns: Information for the table is added automatically based on the selected report type.
You can customize the Name, Label and Format (see below).
b.Chart Axes: Select the data for the X and the Y axis. Clicking the Add Axis opens a window with
options. The choices available for the Y axis always depend on the information selected for the X axis
and vice versa, because the chart displays their relation and the data must be compatible. Select the
desired information and click OK.

Format
Click the
symbol in the Data section to see extended formatting options. You can change the Format in
which the data is displayed. You can adjust formatting for Table Columns and Chart Axes. Not all options are
available for each data type.
Format Column Choose a column according to which the current column will be formatted. For example, when
formatting Name column, choose Severity column to add severity icons next to the names.
Minimal Value Set the minimal limit for the displayed values.
Maximal Value Set the maximum limit for the displayed values.
Color
Choose the color scheme for the column. Color is adjusted according to the value of the
column picked in the Format Column.
Icons
Add icons to the formatted column according to the value of the Format Column.
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Click one of arrows

to change the order of the columns.

Sorting
If the data selected in the Data section contains a sortable symbol, sorting is available. Click Add Sorting to define
the relationship between the selected data. Select the starting information (sorting value) and sorting method,
either Ascending or Descending. This will define the outcome displayed in the chart. Click Up or Down to change
the order of the sorting elements. Click the trash icon
to remove the element from the selection.

Filter
Define the filtering method. Click Add Filter and select the filtering element from the list and its value. This
defines what information will be displayed in the chart. Click the trash icon
to remove the element from the
selection.

Summary
In the Summary, review the selected options and information. Click Finish to create a new report template.

Generate report
There are several ways to generate a report instantly from a report template:
• Navigate to Quick Links on the top bar and click Generate Report. Select an existing report template and
click Generate Now.
• Click Reports and select the Categories & Templates tab. Select a report template from which you want to
generate a report. Click the gear icon and then click edit if you want to make changes to the template.
oYou can click the report tile to generate and view the report in the ESMC Web Console. When the report
is generated, you can click Generate and download to save the report in your desired format. You can
choose from .pdf, .ps or .csv. CSV is suitable only for table data and uses ; (semicolon) as a delimiter.
• Navigate to Tasks > New > Server Task to create a new Generate Report task.
oThe task is now created and displayed in the Task types list. Select this task and click Run Now on the
bottom of the page. The task will be executed immediately.
oConfigure the settings (as described in the Generate Report task) and click Finish.

Note
When you click an item displayed in a report shown in the ESMC Web Console, a drill down menu
appears with additional options.

Schedule a report
There are several ways to schedule a report generation:
• Navigate to Tasks > New > Server Task to create a new Generate Report task.
• Navigate to Reports, select a report template from which you want to generate a report, click the gear
icon on the template tile and select Schedule. You can use and edit a pre-defined report template, or create
a new report template.
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• Click Schedule in the context menu of a report template in a dashboard.
• Navigate to Reports > Scheduled Reports tab > click Schedule.
When scheduling a report you have multiple options, as described in the Generate Report task:
Choose multiple report templates for one report.
• Optionally set the trigger and throttling parameters.
• Set report delivery in an e-mail and/or save it to a file.
After the report is scheduled, click Finish. The task is created and will run on the interval defined in the trigger
(either one time, or repeatedly) and based on the throttling settings (optional).

Scheduled Reports tab
You can review your scheduled reports in Reports > Scheduled Reports. Other actions available in this tab are
shown below:
Schedule
Show Details

Create a new schedule for an existing report.
View detailed information about the selected schedule.

Tags

Edit tags (assign, unassign, create, delete).

Run now

Execute the scheduled report now.

Edit
Duplicate

Edit the schedule of the report. You can add or de-select report templates, modify
schedule settings, or edit the throttling and delivery settings of the report.
Create a duplicate schedule in your home group.

Delete

Delete the schedule. The report template will stay.

Access Group

Move the schedule to a different access group.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Outdated applications
Use the Outdated applications report to see which ESMC components are not up-to-date.
There are two methods to run this report:
• Add a New Dashboard or modify one of existing dashboard panes.
• Navigate to Reports > Computers category > Outdated applications tile > click Generate now.
If you have found outdated application you can:
• Use the Client Task Security Management Center Components Upgrade to upgrade ESET Management
Agent, Server and MDM.
• Use the Client Task Software Install to upgrade your security product.
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SysInspector log viewer
Using SysInspector log viewer, you can view logs from SysInspector after it is run on a client computer. You can
also open SysInspector logs directly from a SysInspector Log Request task after it has been successfully executed.
Log files can be downloaded and viewed in SysInspector on your local machine.

Note
SysInspector logs can only be requested from Windows-based clients.

How to view the SysInspector log
From a dashboard
1.Add a New Dashboard or edit an existing dashboard report.
2.Select the report template Automation > SysInspector snapshot history in last 30 days.
3.Open the report, select a computer and then select
Open SysInspector Log View form the drop
down menu.

From a report
1.Navigate to Reports > Automation category.
2.Select the SysInspector snapshot history in last 30 days template from the list and click Generate now.
3.Open the report, select a computer and then select
Open SysInspector Log View form the drop
down menu.

From the Computers menu
1.Navigate to Computers.
2.Select a computer in a Static or Dynamic Group and click Show Details
3.Navigate to Logs section > SysInspector tab, click a list entry and select
Viewer.
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Open SysInspector Log

Hardware Inventory
ESET Security Management Center has the ability to retrieve hardware inventory details from connected devices
such as details about a device's RAM, storage, and processor.
Click Computers > click a connected device and select Show Details.
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Click Details and select the Hardware tab.

You can filter connected devices based on their hardware parameters. You can select from the following
hardware Inventory categories: Chassis, Device information, Display, Display adapter, Input device, Mass storage,
Network adapter, Printer, Processor, RAM and Sound device.
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Hardware Inventory reports
You can create custom hardware Inventory reports. When creating a New Report Template, under Data select a
sub-category from one of the HW Inventory filters. When you add the first table column or X-axis, only
compatible data will be eligible for selection.

Dynamic Groups based on hardware Inventory
You can create custom dynamic groups based on the hardware Inventory details of connected devices. When
creating a New Dynamic Group Template, select rule(s) from hardware Inventory categories. For example, you
can create a dynamic group with devices filtered by their RAM capacity to get an overview of devices with a
certain amount of RAM.

Hardware inventory on Linux
The tool lshw must be installed on the client/server Linux machine for the ESET Management Agent to report
hardware correctly. If you have upgraded ERA 6.x VA (CentOS) to ESMC 7.x VA, you also need to install lshw on it.
Use the following command (as root or with sudo) to install the lshw tool:
Debian based distributions (Ubuntu)
Red Hat based distributions (CentOS, Fedora, RHEL)

apt-get install -y lshw
yum install -y lshw

Hardware Inventory on macOS
The hardware Inventory feature is available on macOS version 10.9 and higher.

Audit log
The Audit log report contains all actions and changes performed by users on the ESMC Server.
To run this report, click Reports > Audit & Licenses (ESET Security Management Center) category > Audit log.

Important
In ESMC 7.2 and later, a user needs a permission set with the Audit log functionality to view the
Audit log report.
In ESMC 7.1 and older, a user needs a permission set with the Server settings functionality. If you
have upgraded from ESMC 7.1 or older, you must grant the user Audit log functionality.

Tasks
You can use Tasks to manage ESMC Server, client computers and their ESET products. Tasks can automate routine
jobs. There is a set of pre-defined tasks that cover the most common scenarios, or you can create a custom task
with specific settings. Use tasks to request an action from client computers. To run a task successfully, it is
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required to have sufficient access rights for the task and for the objects (devices) that task uses. See the list of
permissions for more information on access rights.
There are two main task categories: Client Tasks and Server Tasks.
• You can assign Client Tasks to groups or individual computers. Once created, a task is executed using a
Trigger. A Client Task can have more triggers configured. Client Tasks are distributed to clients when the ESET
Management Agent on a client connects to the ESMC Server. For this reason, it may take some time for task
execution results to be communicated to the ESMC Server. You can manage your ESET Management Agent
connection interval to reduce task execution times.
• Server tasks are executed by ESMC Server on itself or other devices. Server tasks cannot be assigned to any
specific client or client group. Each Server Task can have one Trigger configured. If the task needs to be run with
various events, there has to be separate server task for each trigger.
You can create a new task in two ways:
• Click New > Client Task or Server Task.
• Select the desired task type on the left and click New >

Client Task or

Server Task.

The following pre-defined tasks are available for your convenience (each task category contains task types):
All Tasks
Client Tasks
ESET Security Product
Diagnostics
End computer isolation from network
Export Managed Products Configuration
Isolate computer from network
Modules Update
Modules Update Rollback
On-Demand Scan
Product Activation
Quarantine Management
Run SysInspector Script
Send File to EDTD
Server Scan
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Software Install
SysInspector Log Request (Windows only)
Upload Quarantined File
ESET Security Management Center
Diagnostics
Reset Cloned Agent
Rogue Detection Sensor Database Reset
Security Management Center Components Upgrade
Stop Managing (Uninstall ESET Management Agent)
Operating System
Display Message
Operating System Update
Run Command
Shutdown computer
Software Install
Software Uninstall
Stop Managing (Uninstall ESET Management Agent)
Mobile
Anti-Theft Actions
Display Message
Export Managed Products Configuration
Modules Update
On-Demand Scan
Product Activation
Software Install
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Stop Managing (Uninstall ESET Management Agent)
Server Tasks
Agent Deployment - distributes the Agent to client computers.
Delete Not Connecting Computers - deletes clients that no longer connect to ESET Security Management Center
from Web Console.
Generate Report - used to generate reports as they are needed.
Rename Computers - this task will periodically rename computers in groups using FQDN format.
Static Group Synchronization - updates group information to display current data.
User Synchronization - updates User or User Group.

Client Tasks
You can assign Client Tasks to groups or individual computers. Once created, a task is executed using a Trigger. A
Client Task can have more triggers configured. Client Tasks are distributed to clients when the ESET Management
Agent on a client connects to the ESMC Server. For this reason, it may take some time for task execution results to
be communicated to the ESMC Server. You can manage your ESET Management Agent connection interval to
reduce task execution times.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.
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Create a new Client Task
1.To create a new Client Task, click Tasks > New > Client Task or select the desired task type and click
New > Client Task.
2. In the Basic section, enter basic information about the task, such as a Name and Description (optional).
Click Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see
the list of all Tasks) defines the settings and the behavior for the task.
3.Configure the task settings in the Settings section.
4.Verify all the settings for this task in the Summary section and then click Finish.
5.Click Create Trigger to create a trigger for the Client Task or click close and create the trigger later.

Client Task Triggers
A Trigger must be assigned to a Client Task for it to be executed. To create a Trigger, click Tasks > click the Client
Task instance in the main table and select Run on from the drop-down menu. Alternatively, you can assign Client
Task to a Group or Computer(s).
To define a Trigger, select the Target computers or groups on which a Client Task should be executed. With your
target(s) selected, set the trigger conditions to execute the task at a particular time or event. Additionally, you
can use Advanced settings - Throttling to further fine-tune the Trigger, if required.

Basic
Enter basic information about the Trigger in the Description field and then click Target.

Target
The Target window allows you to specify the clients (individual computers or groups) that are the recipients of
this task.
• Click Add Computers to display all Static and Dynamic Groups and their members and select devices.
• Click Add Groups to display all Static and Dynamic Groups and their members and select groups.
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After selection, click OK and proceed to the Trigger section.

Trigger
Trigger determines what event triggers the task.
• As Soon As Possible - Executes the task as soon as the client connects to ESET Security Management Center
Server and receives the task. If the task cannot be performed until the Expiration date, the task will be
removed from the queue - the task will not be deleted, but it will not be executed.
• Scheduled - Executes the task at a selected time.
• Event Log Trigger - Executes the task based on events specified here. This trigger is invoked when a certain
event occurs in logs. Define the log type, logical operator and filtering criteria that will trigger the task.
• Joined Dynamic Group Trigger - This trigger executes the task when a client joins the Dynamic Group
selected in the target option. If a Static Group or individual client(s) have been selected, this option will not
be available.
• CRON Expression - You can also set your trigger interval using a CRON Expression.

Note
For more information about triggers, proceed to the Task trigger types chapter.

Advanced settings - Throttling
Throttling is used to restrict a task from being executed if a task is triggered by a frequently occurring event, for
example the Event Log Trigger or the Joined Dynamic Group Trigger (see above). For more information, see the
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Advanced Settings - Throttling chapter.
Click Finish when you have defined the recipients of this task and the triggers that execute the task.

Assign Client Task to a Group or Computer(s)
Read here how to assign Client Task to a Group.
There are two ways to assign a task to computer(s).
1.Dashboard > Computers > Computers with problems > select a computer and click Computer > select
New Task

2.Computer > select computer(s) using check box(es) > select
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New Task

A New Client task wizard window will open.

Anti-Theft Actions
The Anti-Theft feature protects a mobile device from unauthorized access.
If a mobile device (enrolled and managed by ESMC) is lost or stolen, some actions are triggered automatically
while other actions can be performed using a Client Task.
If an unauthorized person replaces a trusted SIM card with an untrusted SIM, the device will automatically be
locked by ESET Endpoint Security for Android and an alert SMS will be sent to user-defined phone number(s). This
message will include the following information:
• the mobile device number of the SIM card currently in use
• the IMSI (International Mobile Subscriber Identity) number
• the mobile device's IMEI (International Mobile Equipment Identity) number
The unauthorized user will not be aware that this message has been sent because it will automatically be deleted
from the device's messaging threads. You can also request the GPS coordinates of the lost mobile device or
remotely erase all data stored on the device using a Client Task.
To create the task, click Tasks > New >
New Task.
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Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Action

Find

Lock

Unlock

Siren

Wipe

Enhanced
Factory Reset
Find (Turn on
lost mode)
Turn off lost
mode
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Behavior Description
on mobile
OS
The device will reply with a text message containing its GPS coordinates. If a more
precise location is available after 10 minutes, the device will re-send the message.
Received information is displayed under Computer details.
Not supported.
The device will be locked. The device can be unlocked using the Administrator
password or the unlock command.
The device will be locked. The device can be unlocked using the iOS passcode or the
unlock command.
The device will be unlocked so it can be used again. The SIM card currently in the
device will be saved as a Trusted SIM.
The device will be unlocked so it can be used again. This task also removes all stored
fingerprints and passcodes and disables Apple Pay, iPhone Unlock and iTunes & App
Store.
The device will be locked and it will play a very loud sound for 5 minutes (or until
unlocked).
Not supported.
All accessible data on the device will be erased (files will be overwritten). ESET
Endpoint Security will remain on the device. This can take up to several hours.
All accessible data on the device will be erased (files will be overwritten). This can
take up to several hours.
All accessible data on the device will be erased (file headers will be destroyed) and
the device will be reset to its default factory settings. This can take several minutes.
This action is not available from the Computers > Mobile context menu.
Not supported.
Supported on iOS ABM only. The device will switch to the "lost mode", lock down and
can only be unlocked by executing the Turn off lost mode task from the ESMC . You
can customize the message that will be displayed on the lost device screen..
Supported on iOS ABM only.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Diagnostics
Use the Diagnostics task to request a diagnostic action from an ESET security product on a client computer.
To create the task, click Tasks > New >
New Task.
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Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Diagnostic action
• Run Log Collector - Collects specific data (such as configuration and logs) from a selected machine in order
to facilitate the collection of information from the customer's machine during a support case resolution.
oLog Collector parameters - You can specify Log Collector parameters on Windows, MacOS or Linux. To
collect all available data, leave Log Collector parameters field blank. If you specify Log Collector
parameters, select only computers running the applicable operating system as Targets for the task.

Note
The file size limit for log delivery per device is 150MB. If the logs gathered by the task are bigger, the
task will fail with the "Log collector output exceeded 150MB and will not be transferred." message.
The logs transferred to the server is subject to the following rules.
Logs file size
The task is finished with a progress
Logs can be accessed from the Web
under 15 MB
message: "Command was executed."
console at Computer details > Logs
section.
Logs file size
The task is finished with a progress
Logs can be accessed on the ESMC
bigger than 15
message: "Log collector archive was too server. The path to the logs file
MB but smaller big to be stored in the database. Please location is displayed at Computer
than 150 MB
see log collector entry for its new
details > Logs section.
location. "
Logs file size
The task is finished with a progress
If this situation occurs, either change
bigger than 150 message: "Log collector archive is too big the verbosity of the logs and retry the
MB
to be transferred."
task or gather the logs locally on the
device.
• Set Diagnostic mode - Diagnostic mode consists of following categories: Spam log, Firewall log, HIPS log,
Device control log and Web control log. The main purpose of Diagnostic mode is to collect logs with all
severity levels when troubleshooting is needed.
oTurn on - Turn on logging of all ESET applications.
oTurn off - You can turn off logging manually or logging will be automatically turned off after a computer
restart.
The following prerequisites are needed for successful creation of Diagnostic logs:
• Diagnostic mode logs can be collected from client computers running Windows and macOS operating
systems.
• Client computer must have ESET security product installed and activated.
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Note
ESET Management Agent only sends logs collected by an ESET product installed on a client
computer. Log category and verbosity depends on product type and configuration. Configure each
product (via Policies) to collect specific logs.
Diagnostic logs older than 24 hours are removed every day during the midnight cleanup. This protects ESMC
database from overload.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.
You can view the created logs in Computer details.

Display Message
The Display Message task enables you send a message to any managed device (client computer, tablet, mobile,
etc.). The message will be displayed on the screen to inform the user.
• Windows - The message is displayed as a notification.

Important
In Windows, the Display Message Client Task uses the command msg.exe which is present only in
Windows Professional/Enterprise editions. As a result, you cannot use this task to display a message
on a client computer running Windows Home edition.
• macOS and Linux - The message is displayed only in a terminal.

Note
To see the message in macOS or Linux, you first need to open the terminal.
To create the task, click Tasks > New >
New Task.
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Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
You can enter a Title and type in your Message.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

End computer isolation from network
The End computer isolation from network task ends the computer isolation from the network and allows
connections of the isolated computer again. Use this Task only when the security issue has been resolved.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
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Note
Settings are not available for this task.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Export Managed Products Configuration
The Export Managed Products Configuration task is used to export the settings of individual ESMC components
or ESET security products installed on the client(s).
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Export managed products configuration settings
• Product - Select an ESMC component or a client security product for which you want to export the
configuration.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
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on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.
When the task completes, you can find the exported configuration in the Configuration tab under computer
details of target computers.

Isolate computer from network
The Isolate computer from network task isolates the selected computers from the network and all connections,
except those needed for correct operation of ESET products, will be blocked. The allowed connections include the
following:
• computer obtains an IP address
• communication of ekrn.exe, ESET Management Agent, ESET Enterprise Inspector Agent
• login to a domain

Warning
• Network isolation is compatible only with ESET security products (Endpoint Antivirus/Security and
server security products) version 7.2 and later.
• Network isolation will likely interrupt the normal operation of the computers and you should use
it in emergency cases only (e.g. if a severe security issue is identified on a managed computer). You
can end the isolation with a client task.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Note
Settings are not available for this task.
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Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Modules Update
The Modules Update task forces the update of all modules of the security product installed on a target device.
This is a general task for all security products on all systems. You can find the list of all modules of the target
security product in the About section of the security product.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• Clear Update Cache - This option deletes the temporary update files in the cache on the client, and can often
be used to repair module update errors.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.
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In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Note
If modules update on the ESET security product fails because of geo-blocking, use a policy to set a
custom server for modules updates:
1.In the ESET security product policy settings, select Update > Profiles > Updates.
2.In Modules Updates, turn off Choose automatically and type the Custom Server address. For
example, to use US update servers for ESET Endpoint Antivirus/Security 8 for Windows, type
http://us-update.eset.com/eset_upd/ep8/ (version 7: http://us-update.eset.com/eset_upd/ep7/).
3.Type your Username (EAV-XXXXXXXX) and the license Password.

Modules Update Rollback
In cases where a module update causes issues, or you do not want to apply the update to all clients (for example,
for testing or when using pre-release updates), you can use the Modules Update Rollback task. When you apply
this task, the modules will be reset to the previous version.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Expand this section to customize modules update rollback settings.
Action
• Enable Updates - Updates are enabled and the client will receive the next module update.
• Rollback and Disable Updates for Next - Updates are disabled for the specific time period in the Disable
interval drop-down menu (24, 36, 48 hours, or until revoked).
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Important
Be careful when using the Until revoked option, as this presents a security risk.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

On-Demand Scan
The On-Demand Scan task lets you manually run a scan on the client computer (separate from a regular
scheduled scan).
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Shutdown computer after scan - If you select this check box, the computer will shut down after scanning is
finished.

Scan profile
You can select the profile you want from the drop-down menu:
• In-Depth Scan - This is a pre-defined profile on the client, it is configured to be the most thorough scan
profile and checks the whole system but also requires the most time and resources.
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• Smart Scan - Smart scan allows you to quickly launch a computer scan and clean infected files with no need
for user intervention. The advantage of Smart scan is that it is easy to operate and does not require detailed
scanning configuration. Smart scan checks all files on local drives and automatically cleans or deletes
detected infiltrations. The cleaning level is automatically set to the default value.
• Scan From Context Menu - Scans a client using a pre-defined scan profile, you can customize the scan
targets.
• Custom Profile - Custom scan lets you specify scanning parameters such as scan targets and scanning
methods. The advantage of a Custom scan is the ability to configure the parameters in detail. Configurations
can be saved to user-defined scan profiles, which make it easy to repeat the scan using the same parameters.
A profile must be created prior to running the task with the custom profile option. Once you select a custom
profile from the drop-down menu, type the exact name of the profile into the Custom profile field.

Cleaning
By default, Scan With Cleaning is selected. This setting enables automatic cleaning of the found infected objects.
If this is not possible, they will be quarantined.

Scan Targets
The option Scan All Targets is also selected by default. Using this setting, all targets specified in the scan profile
are scanned. If you deselect this option, you need to manually specify scan targets in the Add Target field. Type
the scan target into the text field and click Add. The target will be displayed in the Scan targets field below. A scan
target can be a file, location or you can run a pre-defined scan using any of the following strings as a Scan target:
Scan target

Scanned locations
${DriveRemovable}
All removable drives and devices.
${DriveRemovableBoot} Boot sectors of all removable drives.
${DriveFixed}
Hard drives (HDD, SSD).
${DriveFixedBoot}
Boot sectors of hard drives.
${DriveRemote}
Network drives.
${DriveAll}
All available drives.
${DriveAllBoot}
Boot sectors of all drives.
${DriveSystem}
System drives.
${Share}
Shared drives (only for server products).
${Boot}
Main boot sector.
${Memory}
Operating memory.
${Registry}
System Registry (only for ESET Endpoint 8 and later).
${Wmi}
WMI database (only for ESET Endpoint 8 and later).

Example
Below are some examples of how to use On-Demand Scan target parameters:
▪File: C:\Users\Data.dat
▪Folder C:\MyFolder
▪Unix path or file /usr/data
▪Windows UNC location \\server1\scan_folder
▪Pre-defined string ${Memory}
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Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Operating System Update
The Operating System Update task is used to update the operating system of the client computer. This task can
trigger the operating system update on Windows, macOS and Linux operating systems.
macOS - Task installs all updates using command:
/usr/sbin/softwareupdate --install --all

Linux - Task installs all updates. It is checking various package managers, so it covers most distributions.
Windows - The task installs OS updates. It does not install the feature updates, which upgrade your Windows to a
newer version.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• Automatically accept EULA (Windows only) - Select this check box if you want to accept the EULA
automatically. No text will be displayed to the user. If you do not enable accepting EULA, the task skips updates
requiring EULA acceptance.
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• Install optional updates (Windows only) - Updates that are marked as optional will also be installed.
• Allow reboot (Windows and macOS) - Force the client computer to reboot once the updates are installed.

Note
• If the Allow reboot option is not selected, updates that require a reboot will not be installed.
• Settings do not influence the task if the target device is running an unsupported OS type.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Quarantine Management
The Quarantine Management task is used to manage objects in the ESMC Server quarantine - infected or
suspicious objects found during the scan.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Quarantine management settings
Action - Select the action to be taken with the object in Quarantine.
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• Restore Object(s) - Restores the object to its original location, but it will be scanned and if the reasons
for the Quarantine persist, the object will be quarantined again.
• Restore Object(s) and Exclude in Future - Restores the object to its original location and it will not be
quarantined again.
• Delete Object(s) - Deletes the object permanently.
Filter type - Filter the objects in the Quarantine based on the criteria defined below.

Filter settings:
• Hash item(s) - Add hash items into the field. Only known objects can be entered, for example, an object
that has already been quarantined.
• Occurred from/to - Define the time range when the object has been quarantined.
• Minimal/Maximal size (bytes) - Define the size range of the quarantined object (in bytes).
• Detection name - Select a detection from the quarantined items list.
• Object name - Select an object from the quarantined items list.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Product Activation
Use the Product Activation task to activate an ESET security product on a client computer or a mobile device.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
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Settings
Product activation settings - Select a license for the client from the list. This license will be applied to products
already installed on the client. If you do not see any licenses listed, go to More > License Management and add a
license.

Important
The Product Activation task can activate a mobile product, ESET Endpoint For Android, also using an
offline license.
The activation task cannot activate ESET products of version 4 and 5 with the offline license. You
need to activate the product manually or use a supported product version (we recommend using
the latest version).

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Reset Cloned Agent
You can distribute the ESET Management Agent in your network via a pre-defined image, as described in this
Knowledgebase article. Cloned Agents have the same SID, which can cause problems (multiple Agents with the
same SID). To resolve this, use the Reset Cloned Agent task to reset the SID and assign Agents a unique identity.
ESET Management Agent identifies cloned client machines running on Windows automatically, without Reset
Cloned Agent task. Only client machines with Linux and macOS (and Windows clients where hardware detection
was disabled) need the task to divide cloned machines.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
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In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Warning
Run this task with care. After the current ESET Management Agent is reset, all tasks running on it
will be abandoned.

Note
Settings are not available for this task.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Rogue Detection Sensor Database Reset
The Rogue Detection Sensor Database Reset task is used to reset the RD Sensor search cache. The task deletes
the cache and the search results will be stored again. This task does not remove detected computers. This task is
useful when detected computers are still in the cache and are not reported to the server.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
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Note
Settings are not available for this task.

When creating a trigger for this task, target a computer where the RD
Sensor is installed.
Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Run Command
The Run Command task can be used to execute specific command line instructions on the client. The
administrator can specify the command line input to run.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Important
Commands are executed without access to a desktop environment. As a result, the execution of
commands with requirements to the application's GUI may fail.
You can use ecmd commands with the Run Command task. For more information, visit the following
Knowledgebase article.
Operating
System
Windows

Command will
run as user
Local System

Linux or macOS root
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Default working directory Accessible network locations

C:\Windows\Temp

/tmp

Command will be
run in
Command prompt
(cmd.exe)

Only locations in the current
domain and available to user
Local System
Only if location is mounted and Console
available to root user

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• Command line to run - Enter a command line you want to run on the client(s).
• Working directory - Enter a directory where the command line above will be executed.

Important
Maximum command length restrictions:
• Web Console can process up to 32,768 characters. If you copy-paste a longer command, it would
silently cut off the end.
• Linux and Mac are able to process the full length of the command. Windows has restriction for
maximum 8,191 characters (read more here).

Example
To run a local script located on a client at C:\Users\user\script.bat follow these steps:
1.Create a new Client Task and select Run Command.
2.In the Settings section enter:
Command line to run: call script.bat
Working Directory: C:\Users\user
3.Click Finish, create a trigger and choose target clients.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.
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Run SysInspector Script
The Run SysInspector Script task is used to remove unwanted objects from the system. A SysInspector Script
needs to be exported from ESET SysInspector prior to using this task. After you export the script, you can mark
objects you want to remove and run the script with the modified data - the marked objects will be deleted.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Note
Once the task is finished, you can review the results in a report.

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• SysInspector Script - Click Browse to navigate to the service script. The service script needs to be created
prior to running this task.
• Action - You can either Upload to, or Download a script from the ESMC Console.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.
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Security Management Center Components Upgrade
The Security Management Center Components Upgrade task is used to upgrade ESMC components (ESET
Management Agent, ESMC Server, Web Console, and MDM, but not Apache Tomcat and Apache HTTP Proxy). The
upgrade task can be executed only on a machine with ESET Management Agent installed. The Agent is also
required on an ESMC Server.

Important
• You can upgrade to ESMC 7.2 only from ERA version 6.5 and later. If you use an older version of
ERA 6.x, upgrade to ERA 6.5 first. See the Installation guide for detailed instructions.
• When upgrading from ERA 6.x, make sure to upgrade to the ESMC Server before upgrading the
Agents. ESET Management Agents 7.x use a new communication protocol and are not able to
connect to ERA 6.x Server.
To prevent installation failure, ESMC performs the following checks before installing or upgrading ESET products:
• if the repository is accessible
• if there is enough (1 GB) free space on the client machine (not available for Linux)

Note
• ESMC 7 automatically notifies you when a new version of the ESMC Server is available.
• See also other ways how to upgrade ESET Security Management Center to the latest version.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See License Management or EULA for more information.
• Reference Security Management Center Server - Select ESMC Server version from the list. All ESMC
components will be upgraded to versions compatible with the selected server.
Select the check box next to Automatically reboot when needed to force an automatic reboot of the client
computer after installation. Alternatively, you can leave this option deselected and manually restart the client
computer(s).
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Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Send File to EDTD
To run this Task, navigate to Detections.
Send File to EDTD is available only for
Blocked files. You can send a file for the malware analysis (ESET
Dynamic Threat Defense) from ESMC Web Console. You can see the file analysis details in Submitted Files. If you
want to submit other executable files manually for analysis in ESET Dynamic Threat Defense, you can do it from
the ESET endpoint product (you need to have the ESET Dynamic Threat Defense license).

Server Scan
You can use the Server Scan task to scan clients with the installed ESET Server solution. The type of scan run
depends on the ESET solution installed:
Product
Scan
Hyper-V scan
ESET File Security for
Microsoft Windows Server

Description
This type of scan allows you to scan the disks of a
Microsoft Hyper-V Server, which is a virtual machine
(VM), without installing ESET Management Agent on the
VM.
ESET Security for Microsoft SharePoint database scan, This functionality lets ESMC use the appropriate scan
Hyper-V scan
SharePoint Server
target when running the Server Scan Client task on a
server with ESET Security for Microsoft SharePoint.
On-demand mailbox
ESET Mail Security for
This functionality lets ESMC use the appropriate scan
Microsoft Exchange Server database scan, Hyper-V
target. When ESMC runs a Server Scan Client Task, it
scan
will collect the list of targets and you will be asked to
select scan targets for On-demand mailbox database
scan on that particular server.
On-demand
database
scan,
ESET Mail Security for IBM
This functionality lets ESMC use the appropriate scan
Hyper-V scan
Domino
target when running the Server Scan Client task on a
server with ESET Mail Security for IBM Domino.
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To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
• Click Select under Scanned Server and select a computer with version 6 or later server security products
installed. You will be prompted to select specific drives, folders or files to scan on that computer.
• Select a Trigger for this task, you can set throttling if you prefer. By default the task is run ASAP.

Scan Targets
ESMC offers you a list of available targets on the selected server. To use this list, Generate target list must be
enabled in the policy for your server product under Tools > ERA/ESMC Scan Targets:
• Generate target list - Enable this setting to allow ESMC to generate target lists.
• Update period [minutes] - Generating the target list for the first time will take about half of this period.
Select targets for scanning from the list. For more information, see ESMC scan targets.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Shutdown computer
You can use the Shutdown computer task to shutdown or reboot client computers.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
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Settings
• Reboot computer(s) - select this check box if you want to reboot the client computer after task completion. If
you want to shutdown computer(s), deselect this option.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Software Install
The Software Install task is used to install or upgrade software on your client computers. It is primarily intended
to install ESET products, but you can use it to install any software you like.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

To prevent installation failure, ESMC performs the following checks before installing or upgrading ESET products:
• if the repository is accessible
• if there is enough (1 GB) free space on the client machine (not available for Linux)

Note
• Both ESMC Server and ESET Management Agent require access to the internet to access the
repository and perform installations. If you do not have internet access, you must install the client
software locally because remote installation will fail.
• When performing a Software Install task on computers in a domain with ESET Management Agent
running, the user must have read permission for the folder where the installers are stored. Follow
the steps below to grant these permissions if necessary.
1.Add an Active Directory computer account on the computer executing the task (for example
NewComputer$).
2.Grant Read permissions to NewComputer$ by right-clicking the folder where installers are located
and selecting Properties > Sharing > Share from the context menu. Note that the "$" symbol needs
to be present at the end of the computer name string.
Installation from a shared location is only possible if the client machine is in a domain.
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Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• Click <Choose ESET License> and select the appropriate license for the installed product from the list of
available licenses. This will only work for products installed from the repository, not products installed from a
custom URL.
• Click <Choose package> to select an installer package from the repository or specify a package URL. A list of
available packages where you can select the ESET product you want to install (for example, ESET Endpoint
Security) will be displayed. Select your desired installer package and click OK. If you want to specify a URL
where the installation package is located, type or copy and paste the URL (for example
file://\\pc22\install\ees_nt64_ENU.msi) into the text field (do not use a URL that requires authentication).

http://server_address/ees_nt64_ENU.msi - If you are installing from a public web server or from your own HTTP
server.
file://\\pc22\install\ees_nt64_ENU.msi - If you are installing from network path.
file://C:\installs\ees_nt64_ENU.msi - If you are installing from local path.

Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See License Management or EULA for more information.
If you need to, you can specify command-line installation parameters, otherwise leave this field empty.
• Command-line installation parameters are intended for use only with the reduced, basic, and none user
interface settings.
• See documentation for the msiexec version used for the appropriate command line switches.
• For ESET security product command-line installation, read the respective Online Help:
oESET Endpoint products
oESET Server products
Select the check box next to Automatically reboot when needed to force an automatic reboot of the client
computer after installation. Alternatively, you can leave this option deselected and manually restart the client
computer(s).

Installation of third-party software
You can use the Software Install task to install non-ESET (third party) software.
Operating system Supported installation file Support for installation parameters
types
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Windows

.msi

Linux

.deb, .rpm, .sh

macOS

.pkg, .dmg (containing .pkg
file)
Installation parameters are not supported.
.apk
.ipa

Android
iOS

The Software Install task always performs silent installation of the
.msi packages.
You cannot specify msiexec parameters. You can specify only
parameters used by the installation package itself (unique for each
software installation package).
You can use parameters only with .sh files (.deb and .rpm do not
support parameters).

Example
You want to install software on Linux using the file install_script.sh that has two parameters: -a is
the first parameter, -b is the second parameter.
Installation in terminal (as root user in folder where install_script.sh is located):
./install_script.sh -a parameter_1 -b parameter_2

Installation using the Software Install task:
• Enter the file path in Install by direct package URL, for example:
file:///home/user/Desktop/install_script.sh
• Enter the Installation parameters: -a parameter_1 -b parameter_2.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

List of problems when installation fails
• Installation package not found.
• Required newer version of the Windows Installer Service.
• Another version or conflicting product is already installed.
• Another installation is already in progress. Complete that installation before proceeding with this install.
• Installation or uninstallation finished successfully but computer restart is required.
• Task failed - there was an error, you need to look at the Agent trace log and check the return code of the
installer.
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Upgrade ESET software
The Software Install task can be used to upgrade ESET Security Products. Run the task using the latest installer
package to install the latest version over your existing solution.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
ESET license - Do not select a license when upgrading an active product. Only select a license when installing or
upgrading products that are not active, or if you want to change the license currently in use to a different license.
Package to install - Select the latest version available from the repository to upgrade.
Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See License Management or EULA for more information.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.
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Important
Upgrading ESET Security for Microsoft SharePoint
See upgrade instructions for ESET Security for Microsoft SharePoint to complete this upgrade.
Do not use for upgrading ESMC components
Do not use a Software Install task to upgrade ESMC components (Agent, Server, MDM). Use the
Components Upgrade task instead.
Using one-click action
You can run immediate ESET product update from Dashboard. See the Knowledgebase article for
more instructions.

Safetica software
What is Safetica
Safetica is a third-party software company and a member of the ESET Technology Alliance. Safetica provides an IT
security solution for Data Loss Prevention and is complementary to ESET security solutions. Primary Safetica
software features include:
• Data loss prevention - monitoring of all hard drives, USB drives, network file transfers, emails and printers
as well as application file access
• Reporting and activity blocking - for file operations, websites, emails, instant messaging, application usage
and searched keywords

How Safetica works
Safetica deploys an Agent (Safetica Endpoint Client) to your desired endpoints and maintains a regular connection
with them through the server (Safetica Management Service). This server builds a database of workstation activity
and distributes new data protection policies and regulations to each workstation.

Safetica integration in ESMC
ESET Management Agent detects and reports Safetica software as ESET software in Computer details > Installed
Applications. ESMC Web Console will update Safetica Agent if there is a new version available. Safetica Agent can
be updated directly from ESMC Web Console from the ESET software repository using the Software Install task.
You can also install Safetica Agent with Client Task - Run Command:

msiexec /i safetica_agent.msi STSERVER=Server_name
Where "Server_name" is the Hostname / IP address of the server where Safetica Management Service is
installed.
You can use the /silent parameter at the end of the command to run the installation remotely and in a "silent"
mode. e.g. msiexec /i safetica_agent.msi STSERVER=Server_name /silent
For the installation mentioned above the .msi package must be already present on the device. To run the
installation where the .msi package is on a shared location, specify the location in the command as follows:
msiexec /i Z:\sharedLocation\safetica_agent.msi STSERVER=Server_name
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Software Uninstall
The Software Uninstall task is used to uninstall an ESET product from client computers when they are no longer
wanted/needed. Once you uninstall the ESET Management Agent from the client computer, ESET security product
may retain some settings after the ESET Management Agent has been uninstalled.

Important
We recommend that you reset some settings that you do not want to keep (for example, password
protection) to default settings using a policy before the device is removed from management. Also,
all tasks running on the Agent will be abandoned. The Running, Finished or Failed execution status
of this task may not be displayed accurately in ESMC Web Console depending on replication. After
the Agent is uninstalled, you can manage your security product via the integrated EGUI or eShell.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
Software Uninstallation Settings
Uninstall - Application from list
• Package name - Select an ESMC component, a client security product or a third-party application. All
packages that can be uninstalled from the selected client(s) are displayed in this list.
• Package version - You can either remove a specific version (sometimes, a specific version can cause
problems) of the package, or uninstall all versions of a package.
• Uninstallation parameters - You can specify parameters for uninstallation.
• Select the check box next to Automatically reboot when needed to force an automatic reboot of the
client computer after installation. Alternatively, you can leave this option deselected and manually restart
the client computer(s).

Uninstall - Third-party antivirus software (Built with OPSWAT)
For a list of compatible AV Software, see our Knowledgebase article. This removal is different from the Add or
Remove Programs uninstallation. It uses alternative methods to remove third-party antivirus software thoroughly
including any residual registry entries or other traces.
Follow the step-by-step instructions in this article Remove third-party antivirus software from client computers
using ESMC to send a task to remove third-party antivirus software from client computers.

180

If you want to allow uninstallation of password-protected applications, see our Knowledgebase article.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Note
ESET security product uninstallation task may fail with a password-related error, for example:
Product: ESET Endpoint Security -- Error 5004. Enter a valid password to
continue uninstallation. This is due to enabled password protection setting in ESET security

product. Apply a policy to the client computer(s) to remove password protection. You can then
uninstall ESET security product via Software Uninstall task.

Stop Managing (Uninstall ESET Management Agent)
This task will uninstall ESET Management Agent from selected target devices. If a desktop is selected, the task will
remove the ESET Management Agent. If mobile device is selected, the task will cancel MDM enrollment of the
device.
After the device is no longer managed (Agent is removed), some settings may remain in the managed products.

Important
We recommend that you reset some settings that you do not want to keep (for example, password
protection) to default settings using a policy before the device is removed from management. Also,
all tasks running on the Agent will be abandoned. The Running, Finished or Failed execution status
of this task may not be displayed accurately in ESMC Web Console depending on replication. After
the Agent is uninstalled, you can manage your security product via the integrated EGUI or eShell.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
181

Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Note
Settings are not available for this task.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

SysInspector Log Request (Windows only)
The SysInspector Log Request task is used to request the SysInspector log from a client security product, that has
this function.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• Store log on client - Select this if you want to store the SysInspector log on the client as well as on the ESMC
Server. For example, when a client has ESET Endpoint Security installed, the log is usually stored under
C:\Program Data\ESET\ESET Security\SysInspector.
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Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Upload Quarantined File
The Upload Quarantined File task is used to manage files quarantined on clients. You can upload quarantined file
from quarantine to a specific location for advanced investigation.
To create the task, click Tasks > New >
New Task.

Client Task or click the desired client device in Computers and select

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.

Settings
• Quarantined object - Select a specific object from the quarantine.
• Object password - Enter a password to encrypt the object for security reasons. Please note that password
will be displayed in the corresponding report.
• Upload Path - Enter a path to a location where you want to upload the object. Use the following syntax:
smb://server/share
• Upload Username/Password - In case the location requires authentication (network share, etc.), enter the
credentials to access this path. If the user is in a domain, use the format DOMAIN\username.

Summary
Review the summary of configured settings and click Finish. The Client Task is now created and a pop-up window
will open. We recommend that you click Create Trigger to specify when this Client Task should be executed and
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on what Targets. If you click Close, you can create a Trigger later: click the Client Task instance and select Run on
from the drop-down menu.

In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Note
In the Trigger, make sure to select the target where the file is quarantined.
After the quarantined file is uploaded to the selected Upload Path location:
• The file is stored in a password-protected .zip archive. The password is the .zip file name (hash of the
quarantined file).
• The quarantined file is without a file extension. To restore the file, add the original file extension to it.

Server Tasks
Server tasks are executed by ESMC Server on itself or other devices. Server tasks cannot be assigned to any
specific client or client group. Each Server Task can have one Trigger configured. If the task needs to be run with
various events, there has to be separate server task for each trigger.

Server tasks and permissions
The task and trigger both need an executing user. This is the user who modifies the task (and trigger). This user
must have sufficient permissions for the chosen action. During execution, the task always takes the executing user
from the trigger. If the task is run using the Run task immediately after finish setting, the executing user is the
user logged into the ESMC Web Console. A user has permissions (Read, Use, Write) for the selected server task
instance if it has those permissions selected in its permission set (More > Permission Sets) and has these
permissions set for that Static Group where the server task is located. See the list of permissions for more
information on access rights.

Example
John, whose home group is John’s Group, wants to remove Server Task 1: Generate Report. The
task was originally created by Larry, therefore the task is automatically contained in Larry's home
group, Larry's Group. The following conditions must be met for John to remove the task:
• John must be assigned a permission set with write permissions for Server Tasks & Triggers Generate Reports.
• The permission set must contain Larry’s Group under Static Groups.
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Permissions needed for certain server task actions
• To create a new server task, the user needs write permission for the selected task type and proper access
rights for the referenced objects (computers, licenses, groups).
• To modify a server task, the user needs write permission for the selected server task instance and proper
access rights for the referenced objects (computers, licenses, groups).
• To remove a server task, the user needs write permission for the selected server task instance.
• To run a server task, the user needs use permission for the selected server task instance.

Create a new server task
1. To create a new Server Task, click Tasks > New > Server Task or select the desired task type on the left
and click New > Server Task.
2. In the Basic section, enter basic information about the task, such as a Name and Description (optional).
Click Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see
the list of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.
3.Configure the task settings in the Settings section.
4.Set the trigger in the Trigger section, if it is available.
5.Verify all the settings for this task in the Summary section and then click Finish.

Note
It is recommended for users who are regularly using Server tasks to create their own tasks rather
than sharing them with other users. Each time the task is run it uses the permissions of the
executing user. This can confuse some users.

Agent Deployment
Agent Deployment Server Task performs remote deployment of the ESET Management Agent.
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Note
Agent Deployment task executes the installation of ESET Management Agent on target computers
one by one (sequentially). As a result, when you run Agent Deployment task on many client
computers, it may take long time to complete. Therefore, we recommend that you use ESET Remote
Deployment Tool instead. It executes the installation of ESET Management Agent on all target
computers at the same time (in parallel), as well as saves the network bandwidth by using locally
stored installer files; without the need to access the online repository.

Warning
Agent Deployment task uses SSH which is not supported on Windows Server 2003. The task will fail
to install ESET Management Agent on this system.
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.

Agent deployment settings
Automatic resolution of suitable Agent - If you have multiple operating systems (Windows, Linux, macOS) in your
network, select this option and this task will automatically find the appropriate server-compatible Agent
installation package for each system.
Targets - Click this to select the clients that will receive this task.

Note
If target computers were added to ESMC using the Static Group Synchronization task, make sure the
names of computers are their full domain names. These names are used as client's addresses during
deployment, if they are not correct, the deployment fails. Use the dNSHostName attribute as the
Computer Hostname Attribute during synchronization for purposes of Agent deployment.
Server hostname (optional) - You can enter a server hostname if it is different on the client side and the server
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side.

Target computers credentials
Username / Password - The username and the password for the user with sufficient rights to perform a remote
installation of the agent.

Certificate settings
Peer certificate:
• ESMC Certificate - This is the security certificate and certification authority for the Agent installation.
You can select the default certificate and certification authority, or use custom certificates.
• Custom certificate - If you use a custom certificate for authentication, navigate to the certificate and
select it when installing the Agent. For more information, see the Certificates chapter.
Certificate Passphrase - Password for the certificate, either the password you entered during ESMC Server
installation (in the step where you created a certification authority) or the password for your custom certificate.

Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.

Note
• ESMC Server can select the appropriate Agent installation package for operating systems
automatically. To choose a package manually, deselect Automatic resolution of suitable Agent and
then choose the package you want to use from the list of available Agents in ESMC repository.
• For installation on Linux or Mac machine, make sure the target machine has SSH daemon enabled
and running on the port 22 and a firewall is not blocking this connection. Use the following
command (replace the IP address with the IP of your ESMC Server) to add an exception in Linux
firewall:
iptables -A INPUT -s 10.0.0.1 -p tcp --dport 22 -m state --state NEW -j
ACCEPT
• For installation on Linux, choose a user with permission to use the sudo command or root user.
If root is used, the ssh service must allow you to log-in as root.

• To re-deploy an Agent, never remove the current Agent, instead run the Deployment task over
the current Agent. When you remove the Agent, it may start executing old tasks after the new
deployment.

Other settings
Deselect the check box Participate in product improvement program if you do not agree to send crash reports
and telemetry data to ESET. If the check box is left selected, telemetry data and crash reports will be sent to ESET.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
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section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Delete Not Connecting Computers
The Delete not connecting computers task lets you remove computers according to specified criteria. For
example, if the ESET Management Agent on a client computer has not connected for 30 days, it can be removed
from ESMC Web Console.
In Computers, Last Connected displays the date and time of last connection of the managed device. The Last
Connected information gets highlighted to indicate that the computer is not connecting:
oYellow (error) - computer is not connecting for 2-14 days.
oRed (warning) - computer is not connecting for more than 14 days.
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.

Settings
Group name - select a Static Group or create new a Static Group for renamed computers.
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Number of days the computer has not been connected - type number of days after which computers will be
removed.
Deactivate License - select this check box to deactivate licenses on removed computers.
Remove unmanaged computers - select this check box to remove also unmanaged computers.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Generate Report
The Generate Report task is used to generate reports from previously created or pre-defined Report templates.
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.
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Settings
Report templates - Click Add Report Template to choose a report template from the list. User creating the task
will be able to see and choose only from Report Templates which are available in his group. You can choose
multiple report templates for one report.
Select Send email or Save to file to get the generated report.

Report delivery
Send email
To send/receive mail messages, you must configure SMTP settings under Server Settings > Advanced Settings.
• Send to - Enter the email address(-es) of recipients for report emails. Separate multiple addresses with a
comma (,). It is also possible to add CC and BCC fields; these work exactly as they do for mail clients.
• Subject - Subject of the report message. Enter a distinctive subject, so that incoming messages can be
sorted. This is an optional setting, but we recommend that you do not leave it empty.
• Message contents - Define the body of the report message.
• Send mail if report is empty - use this option if you want the report to be sent even though there is no
data in it.
Click Show print options to display the following settings:
• Output format - Select the appropriate file format.
• Output language - Select the language for the message. The default language is based on the language
selected for the ESMC Web Console.
• Page size/Resolution/Paper orientation/Color format/Margin units/Margins - These options are relevant
if you want to print the report. Select the appropriate options based on your print preferences. These
options only apply to the PDF and PS format, not to the CSV format. CSV is suitable only for table data and
uses ; (semicolon) as a delimiter.

Note
The Generate report task allows you to select from several output file formats. Selecting CSV results
in the date and time values in your report to be stored in the UTC format. When you select PDF or
PS, the report will use the local server time.
Save to file
• Relative file path - The report will be generated in a specific directory, for example:
oFor Windows, report are typically placed in
C:\ProgramData\ESET\RemoteAdministrator\Server\EraServerApplicationData\Data\GeneratedReports\
oIn older Windows systems, the path may be C:\Users\All
Users\ESET\RemoteAdministrator\Server\EraServerApplicationData\Data\GeneratedReports\
oFor Linux, report are typically placed in
/var/opt/eset/RemoteAdministrator/Server/GeneratedReports/
• Save file if report is empty - use this option if you want the report to be saved even though there is no
data in it.
Click Show print options to display the following settings:
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• Output format - Select the appropriate file format.
• Output language - Select the language for the message. The default language is based on the language
selected for the ESMC Web Console.
• Page size/Resolution/Paper orientation/Color format/Margin units/Margins - These options are relevant
if you want to print the report. Select the appropriate options based on your print preferences. These
options only apply to the PDF and PS format, not to the CSV format. CSV is suitable only for table data and
uses ; (semicolon) as a delimiter.

Note
The Generate report task allows you to select from several output file formats. Selecting CSV results
in the date and time values in your report to be stored in the UTC format. When you select PDF or
PS, the report will use the local server time.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Rename computers
You can use the Rename Computers task to rename computers to FQDN format in ESMC. You can use existing
server task that came default with your ESMC installation. If a client device name is different from the one
reported in the device details, running this task can restore the proper name.
This task automatically renames synchronized computers located in the Lost & found group every hour.
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
191

You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.

Settings
Group name - Select a Static or Dynamic Group or create a New Static or Dynamic Group for the renamed
computers.
Rename based on:
• Computer name - Each computer is identified on the local network by its unique computer name
• Computer FQDN (Fully Qualified Domain Name) - This starts with hostname and continues with domain
names all the way up to top-level domain name.
Resolution of name conflicts will be performed for computers already present in ESMC (computer name must be
unique) and those added via synchronization. Checks only apply to the names of computers outside the subtree
being synchronized.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Static Group Synchronization
The Static Group Synchronization task will search your network (Active Directory, Open Directory, LDAP, local
network or VMware) for computers and put them into a Static group. If you select Synchronize with Active
Directory during Server Installation, found computers will be added to the All group. To synchronize Linux
computers joined to Windows domain, follow these detailed instructions.
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Note
ESMC supports the secured LDAP signing.
There are 3 Synchronization modes:
• Active Directory/Open Directory/LDAP - Type in the basic Server connection information. Click here for
detailed instructions.
• MS Windows Network - Enter a Workgroup to be used, along with the appropriate user credentials.
Click here for detailed instructions.
• VMware - Type in the VMware vCenter Server connection information. Click here for detailed
instructions.

Synchronization mode - Active Directory / Open
Directory / LDAP
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.

Settings
Common Settings
Click Select under Static Group Name - by default, the executing user's home group will be used for synchronized
computers. Alternatively you can create a New Static Group.
• Object to synchronize - Either Computers and Groups, or Only Computers.
• Computer creation collision handling - If the synchronization adds computers that are already members
of the Static Group, you can select a conflict resolution method:
oSkip (synchronized computers will not be added)
oMove (new computers will be moved to a subgroup)
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oDuplicate (new computer is created with modified name)
• Computer extinction handling - If a computer no longer exists, you can either Remove this computer or
Skip it.
• Group extinction handling - If a group no longer exists, you can either Remove this group or Skip it.

Important
If you set the Group extinction handling to Skip and you delete a group (Organizational Unit)
from Active Directory, computers that belonged to the group in ESMC will not be deleted, even
when you set their Computer extinction handling to Remove.
• Synchronization mode - Active Directory / Open Directory / LDAP
Read our Knowledgebase article on managing computers using Active Directory synchronization in ESMC 7.

Server connection settings
• Server - Type the Server name or IP address of your domain controller.
• Login - Type the Username for your domain controller in the following format:
oDOMAIN\username (ESMC Server running on Windows)
ousername@FULL.DOMAIN.NAME or username (ESMC Server running on Linux).

Important
Be sure to type the domain in capital letters, as this formatting is required in order to properly
authenticate queries to an Active Directory server.
• Password - Type the password used to log on to your domain controller.

Important
ESMC Server 7.2 on Windows uses the encrypted LDAPS (LDAP over SSL) protocol by default for all
Active Directory (AD) connections. You can also configure LDAPS on ESMC Virtual Appliance.
If you upgrade an earlier ESMC version on Windows to ESMC 7.2 and you were using the Active
Directory synchronization, synchronization tasks will fail in ESMC 7.2.
For a successful AD connection over LDAPS, configure the following:
1.The domain controller must have installed a machine certificate. To issue a certificate for your
domain controller, follow the steps below:
a)Open the Server Manager, click Manage > Add Roles and Features and install the Active
Directory Certificate Services > Certification Authority. A new Certification Authority will be
created in Trusted Root Certification Authorities.
b)Navigate to Start > type certmgr.msc and press Enter to run the Certificates Microsoft
Management Console snap-in > Certificates - Local Computer > Personal > right click the empty
pane > All Tasks > Request New Certificate > Enroll Domain Controller role.
c)Verify that the issued certificate contains the FQDN of the domain controller.
d)On your ESMC server, import the CA you generated to the cert store (using certmgr.msc tool) to
the trusted CAs folder.
2.When providing connection settings to the AD server, type the FQDN of the domain controller (as
provided in the domain controller certificate) in the Server or Host field. IP address is no longer
sufficient for LDAPS.
To enable fallback to LDAP protocol, select the check box Use LDAP instead of Active Directory and enter the
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specific attributes to match your server. Alternatively, you can select Presets by clicking Select and the attributes
will be populated automatically:
• Active Directory
• Mac OS X Server Open Directory (Computer Host Names)
• Mac OS X Server Open Directory (Computer IP Addresses)
• OpenLDAP with Samba computer records - For setting up the parameters DNS name in Active Directory.
When using the LDAP and Active Directory preset, you can populate computer details with attributes from your
Active Directory structure. Only attributes of the type DirectoryString can be used. You can use a tool (for
example, ADExplorer) to inspect the attributes on your Domain Controller. See the corresponding fields in the
table below:
Computer details fields Synchronization task fields
Name
Computer Hostname Attribute
Description
Computer Description Attribute

Synchronization Settings
• Distinguished Name - Path (Distinguished Name) to the node in the Active Directory tree. Leaving this option
empty will synchronize the entire AD tree. Click Browse next to Distinguished Name. Your Active Directory tree
will be displayed. Select the top entry to synchronize all groups with ESMC, or select only the specific groups
that you want to add. Only computers and Organizational Units are synchronized. Click OK when you are
finished.
• Excluded distinguished name(s) - You can choose to exclude (ignore) specific nodes in the Active Directory
tree.
• Ignore disabled computers (only in Active Directory) - You can choose to ignore computers disabled in Active
Directory (the task will skip these computers).

Important
If you get the error: Server not find in Kerberos database after clicking Browse, use the
server's AD FQDN instead of the IP address.
Synchronization from Linux server
The ESMC Server running on Linux executes the synchronization differently from Windows machines. The process
is as follows:
1.The domain controller's hostname and credentials must be filled in.
2.The Server verifies the credentials and converts them to a Kerberos ticket.
3.The Server detects the Domain's distinguished name if it is not present.
4.A) If the option Use LDAP instead of Active Directory is not checked:
Multiple calls to ldapsearch enumerate the tree. A simplified example for the process of getting computer
records:
kinit <username>

(This is one command divided into two lines:)
ldapsearch -LLL -Y GSSAPI -h ad.domain.com -b 'DC=domain,DC=com' \
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'(&(objectCategory=computer))' 'distinguishedName' 'dNSHostName'

B) If the option Use LDAP instead of Active Directory is checked:
The same process is called as in option 4A, but the user can configure the parameters.
5.Kerberos uses a handshake mechanism to authenticate the user and generate a ticket that can be used
subsequently with other services for authorization without sending a password in clear text (opposite to
simple authentication choice).
6.ldapsearch utility then uses GSSAPI to authenticate against Active Directory with the obtained Kerberos
ticket.
7.Search results are passed back through a non-encrypted channel.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Synchronization mode - MS Windows Network
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
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To set the trigger later, leave the check boxes deselected.

Settings
Common Settings
Click Select under Static Group Name - by default, the executing user's home group will be used for synchronized
computers. Alternatively you can create a New Static Group.
• Object to synchronize - Either Computers and Groups, or Only Computers.
• Computer creation collision handling - If the synchronization adds computers that are already members
of the Static Group, you can select a conflict resolution method:
oSkip (synchronized computers will not be added)
oMove (new computers will be moved to a subgroup)
oDuplicate (new computer is created with modified name)
• Computer extinction handling - If a computer no longer exists, you can either Remove this computer or
Skip it.
• Group extinction handling - If a group no longer exists, you can either Remove this group or Skip it.
• Synchonization mode - MS Windows Network
In the Microsoft Windows Network synchronization settings section type the following information:
• Workgroup - Type the domain or workgroup that contains the computers that will be synced. If you do not
specify a workgroup, all visible computers will be synchronized.
• Login - Type the login credentials used for synchronization in your Windows network.
• Password - Type the password used to log on to your Windows network.

Note
ESMC Server runs under Network service privileges that may not be enough to read all nearby
computers.
If no user credentials are present, the server reads all nearby computers from Network folders
available in Windows that are populated automatically by the operation system. If there are
credentials present, the server uses them for direct synchronization.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
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In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Synchronization mode - VMware
It is possible to synchronize virtual machines running on VMware vCenter S erver.

Note
To run this task successfully, you need to import the vCenter CA in your ESMC Server. You can
export it via your web browser.
For example, to export the certificate using Firefox, click the icon of the secure connection in the
address bar
and then click Show connection details > More
Information > View certificate > Details > Export > Save.
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.

Settings
Common Settings
Click Select under Static Group Name - by default, the executing user's home group will be used for synchronized
computers. Alternatively you can create a New Static Group.
• Object to synchronize - Either Computers and Groups, or Only Computers.
• Computer creation collision handling - If the synchronization adds computers that are already members
of the Static Group, you can select a conflict resolution method:
oSkip (synchronized computers will not be added)
oMove (new computers will be moved to a subgroup)
oDuplicate (new computer is created with modified name)
• Computer extinction handling - If a computer no longer exists, you can either Remove this computer or
Skip it.
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• Group extinction handling - If a group no longer exists, you can either Remove this group or Skip it.
• Synchonization mode - VMWare

Server connection settings
• Server - Type in the DNS or IP address of the VMware vCenter Server. The address must be exactly the
same as the value CN of the imported vCenter CA. You can find this value in the column Subject of the More
> Certification Authorities window.
• Login - Type in the login credentials for the VMware vCenter Server.
• Password - Type in the password used to log onto your VMware vCenter Server.

Synchronization settings
• Structure view - Select the type of structure view, either Folders or Resource pool.
• Structure path - Click Browse and navigate to the folder you want to synchronize. If the field is left empty,
the entire structure will be synchronized.
• Computer view - Select whether to display computers by Name, Host Name or IP Address following
synchronization.

Important
If you get the error: Server not find in Kerberos database after clicking Browse, use the
server's AD FQDN instead of the IP address.

Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Static Group Synchronization - Linux Computers
Linux computer joined to Windows domain does not display any text in Active Directory Users and Computers
(ADUC) in Computer properties, therefore it is necessary to insert text manually.
Check the Server prerequisites and the following prerequisites:
• The Linux computers are in Active Directory.
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• Domain controller has a DNS server installed.
• ADSI Edit is installed.
1.Open a command prompt and run adsiedit.msc
2.Navigate to Action > Connect to. The connection settings windows will be displayed.
3.Click Select a well known Naming context.
4.Expand the combo box below and select Default naming context.
5.Click OK - the ADSI value on the left should be the name of your domain controller - Default naming context
(your domain controller).
6.Click the ADSI value and expand its subgroup.
7.Click the subgroup and navigate to the CN (Common Name) or OU (Organizational Unit) where Linux
computers are displayed.
8.Click the hostname of the Linux computer and select Properties from the context menu. Navigate to the
dNSHostName parameter and click Edit.
9.Change the value <not set> to valid text (for example, ubuntu.TEST).
10. Click OK > OK. Open ADUC and select the properties of the Linux computer - the new text should be
displayed here.

User Synchronization
This Server Task synchronizes the Users and User Group information from a source such as Active Directory, LDAP
parameters, etc.
To create a new Server Task, click Tasks > New >
click New > Server Task.

Server Task or select the desired task type on the left and

Basic
In the Basic section, enter basic information about the task, such as a Name and Description (optional). Click
Select tags to assign tags.
In the Task drop-down menu, select the task type you want to create and configure. If you have selected a
specific task type before creating a new task, Task is pre-selected based on your previous choice. Task (see the list
of all Tasks) defines the settings and the behavior for the task.
You can also select from the following task trigger settings:
• Run task immediately after finish - Select this option to have the task run automatically after you click
Finish.
• Configure trigger - Select this option to enable the Trigger section, where you can configure trigger
settings.
To set the trigger later, leave the check boxes deselected.
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Settings
Common Settings
User Group Name - by default, the root for synchronized users will be used (by default, this is the All group).
Alternatively, you can create a new User Group.
User Creation Collision Handling - two types of conflict that might occur:
• There are two users with the same name in the same group.
• There is an existing user with the same SID (anywhere in the system).
You can set collision handling to:
• Skip - user is not added to ESMC during synchronization with Active Directory.
• Overwrite - existing user in ESMC is overwritten by the user from Active Directory, in the case of an SID
conflict the existing user in ESMC is removed from its previous location (even if the user was in a different
group).
User Extinction Handling - If a user no longer exists, you can either Remove this user or Skip it.
User Group Extinction Handling - If a user group no longer exists, you can either Remove this user group or Skip
it.

Note
If you use custom attributes for a user set User Creation Collision Handling to Skip. Otherwise the
user (and all details) will be overwritten with the data from Active Directory loosing custom
attributes. If you want to overwrite the user, change User Extinction Handling to Skip.

Server Connection Settings
• Server - Type the Server name or IP address of your domain controller.
• Login - Type the Username for your domain controller in the following format:
oDOMAIN\username (ESMC Server running on Windows)
ousername@FULL.DOMAIN.NAME or username (ESMC Server running on Linux).

Important
Be sure to type the domain in capital letters, as this formatting is required in order to properly
authenticate queries to an Active Directory server.
• Password - Type the password used to log on to your domain controller.
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Important
ESMC Server 7.2 on Windows uses the encrypted LDAPS (LDAP over SSL) protocol by default for all
Active Directory (AD) connections. You can also configure LDAPS on ESMC Virtual Appliance.
If you upgrade an earlier ESMC version on Windows to ESMC 7.2 and you were using the Active
Directory synchronization, synchronization tasks will fail in ESMC 7.2.
For a successful AD connection over LDAPS, configure the following:
1.The domain controller must have installed a machine certificate. To issue a certificate for your
domain controller, follow the steps below:
a)Open the Server Manager, click Manage > Add Roles and Features and install the Active
Directory Certificate Services > Certification Authority. A new Certification Authority will be
created in Trusted Root Certification Authorities.
b)Navigate to Start > type certmgr.msc and press Enter to run the Certificates Microsoft
Management Console snap-in > Certificates - Local Computer > Personal > right click the empty
pane > All Tasks > Request New Certificate > Enroll Domain Controller role.
c)Verify that the issued certificate contains the FQDN of the domain controller.
d)On your ESMC server, import the CA you generated to the cert store (using certmgr.msc tool) to
the trusted CAs folder.
2.When providing connection settings to the AD server, type the FQDN of the domain controller (as
provided in the domain controller certificate) in the Server or Host field. IP address is no longer
sufficient for LDAPS.
To enable fallback to LDAP protocol, select the check box Use LDAP instead of Active Directory and enter the
specific attributes to match your server. Alternatively, you can select Presets by clicking Select and the attributes
will be populated automatically:
• Active Directory
• Mac OS X Server Open Directory (Computer Host Names)
• OpenLDAP with Samba computer records - setting up the parameters DNS name in Active Directory.

Synchronization Settings
• Distinguished Name - Path (Distinguished Name) to the node in the Active Directory tree. Leaving this option
empty will synchronize the entire AD tree. Click Browse next to Distinguished Name. Your Active Directory tree
will be displayed. Select the top entry to synchronize all groups with ESMC, or select only the specific groups
that you want to add. Only computers and Organizational Units are synchronized. Click OK when you are
finished.
• User Group and User Attributes - User's default attributes are specific to the directory to which the user
belongs. If you want to synchronize Active Directory attributes, select the AD parameter from the drop-down
menu in the appropriate fields or enter a custom name for the attribute. Next to each synchronized field is an
ESMC placeholder (for example: ${display_name}) that will represent this attribute in certain ESMC policy
settings.
• Advanced User Attributes - If you want to use advanced custom attributes select Add New. These fields will
inherit the user's information, which can be addressed in a policy editor for iOS MDM as a placeholder.

Important
If you get the error: Server not find in Kerberos database after clicking Browse, use the
server's AD FQDN instead of the IP address.
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Trigger
The Trigger section contains information about the trigger(s) which would run a task. Each Server Task can have
up to one trigger. Each trigger can run only one Server Task. If Configure trigger is not selected in the Basic
section, a trigger is not created. A task can be created without trigger. Such a task can be run afterward manually
or a trigger can be added later.

Advanced Settings - Throttling
By setting Throttling, you can set advanced rules for the created trigger. Setting throttling is optional.

Summary
All configured options are displayed here. Review the settings and click Finish.
In Tasks you can see the progress indicator bar, status icon, and details for each created task.

Task trigger types
Triggers are essentially sensors that react to certain events in a pre-defined way. They are used to execute the
task they are assigned to. They can be activated by the scheduler (time events) or when a certain system event
occurs.

Important
It is not possible to reuse a trigger. Each task must be triggered with a separate trigger. Each trigger
can run only one task.
The trigger does not run newly assigned tasks immediately (except the ASAP trigger) — the task is run as soon as
the trigger is fired. Trigger sensitivity to events can be reduced further using throttling.

Trigger types:
• As soon as possible - Available only for Client Tasks. The task will run as soon as you click Finish. The
Expiration date value specifies the date after which the task will no longer be executed.

Scheduled
Scheduled Trigger will run the task based on date and time settings. Tasks can be scheduled to run once, on a
recurring basis, or on CRON expression.
• Schedule Once - This trigger is invoked once on the scheduled date and time. It can be delayed by
random interval.
• Daily - This trigger is invoked every selected day. You can set the start and end of the interval. For
example, you can run a task for ten consecutive weekends.
• Weekly - This trigger is invoked on a selected day of the week. For example, run a task every Monday and
Friday between July 1 and August 31.
• Monthly - This trigger is invoked on selected days in the selected week of a month, for the selected
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period of time. The Repeat on value sets the weekday in the month (for example, the second Monday) on
which the task should run.
• Yearly - This trigger is invoked every year (or more years, if so configured) on the specified start date.

Note
Random delay interval setting is available for Scheduled type triggers. It defines the range of
maximum delay for task execution. Randomizing can prevent overloading the server.

Example
If John set the task to trigger Weekly on Monday and Start on 2017 Feb 10 8:00:00, with Random
delay interval set to 1 hour and end by set to 2017 Apr 6 00:00:00, the task would run with a
randomized one-hour delay between 8:00 and 9:00 every Monday until the specified end date.

Note
Select the check box Invoke ASAP if Event Missed to run the task immediately if it did not run at the
defined time.
Select the check box Use Local Time to use local timezone on target device instead of ESMC Console
timezone for the trigger.

Dynamic Group
Dynamic Group triggers are available only for Server Tasks:
• Dynamic Group Members Changed - This trigger is invoked when the contents of a Dynamic Group
change. For example, if clients join or leave a specific Dynamic Group.
• Dynamic Group Size Changed According to Threshold - This trigger is invoked when the number of clients
in a Dynamic Group becomes higher or lower than the specified threshold. For example, if more than 100
computers are in a given group.
• Dynamic Group Size Changed Over the Time Period - This trigger is invoked when the number of clients in
a Dynamic Group changes over a defined time period. For example, if the number of computers in a given
group increases by 10% in an hour.
• Dynamic Group Size Changed According to Compared Group - This trigger is invoked when the number of
clients in an observed Dynamic Group change according to a compared group (static or dynamic). For
example, if more than 10% of all computers are infected (the group All compared to the group Infected).

Other
• Server Started - Available only for Server Tasks. Is invoked when the server starts. For example, this trigger
is used for the Static Group Synchronization task.
• Joined Dynamic Group Trigger - Available only for Client Tasks. This trigger is invoked every time a device
joins the dynamic group.

Note
Joined Dynamic Group Trigger is available only if a dynamic group is selected in the Target
section. The trigger will run the task only on devices that join the dynamic group after the trigger
is created. For all the devices already in the dynamic group, you will have to execute the task
manually.
• Event Log Trigger - This trigger is invoked when a certain event occurs in logs. For example, if there is a
detection in the Scan log. This type of trigger provides a set of special settings in the Throttling settings.
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• CRON Expression -This trigger is invoked at a certain time and date.

Cron expression interval
A CRON expression is used to configure specific instances of a trigger. Mostly for scheduled repetitive triggering. It
is a string consisting of 6 or 7 fields that represent individual values of the schedule. These fields are separated by
space and contain any of the allowed values in various combinations.
CRON expression can be as simple as this: * * * * ? * or more complex, like this: 0/5 14,18,3-39,52 * ?
JAN,MAR,SEP MON-FRI 2012-2020

List of values you can use in the CRON expression:
Name
Required
Value
Allowed Special Characters
Seconds
Yes
0-59
,-*/R
Minutes
Yes
0-59
,-*/R
Hours
Yes
0-23
,-*/R
Day of the month Yes
1-31
,-*/?LW
Month
Yes
1-12 or JAN-DEC , - */
Day of the week Yes
0-6 or SUN-SAT , - / ? L #
Year
Yes
1970-2099
,-*/
CRON expression syntax is following:

┌────────── Seconds (0 - 59)
│ ┌────────── Minutes (0 - 59)
│ │ ┌────────── Hours (0 - 23)
│ │ │ ┌────────── Day of the month (1 - 31)
│ │ │ │ ┌────────── Month (1 - 12 or JAN-DEC)
│ │ │ │ │ ┌────────── Day of the week (0 - 6 or SUN-SAT)(for example, 0 is the
same as SUN)
│ │ │ │ │ │ ┌────────── Year
│ │ │ │ │ │ │
* * * * * ? *

• The 0 0 0 means midnight (seconds, minutes, hours).
• Use ? when a value cannot be defined because it was defined in other field (day of the month or day of the
week).
• The * means every (seconds, minutes, hours, day of the month, month, day of the week, year).
• The SUN means on Sunday.

Note
The names of months and days of the week are not case sensitive. For example, MON is equal to
mon, or JAN is equal to jan.
Special characters:
Comma (,)
Commas are used to separate items of a list. For example, using "MON,WED,FRI" in the 6th field (day of the week)
means Mondays, Wednesdays and Fridays.
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Hyphen (-)
Defines ranges. For example, 2012-2020 indicates every year between 2012 and 2020, inclusive.
Wildcard (*)
Used to select all possible values within a field. For example, * in the minute field means every minute. The
wildcard cannot be used in day of the week field.
Question mark (?)
When choosing a specific day, you can specify either day of the month or day of the week. You cannot specify
both. If you specify day of the month, you must use ? for day of the week and vice versa. For example, if you want
the trigger to fire on a particular day of the month (say, the 10th), but don’t care what day of the week that
happens to be, put 10 in the day of the month field and ? in the day of the week field.
Hash (#)
Used to specify "the nth" day of the month. For example, the value of 4#3 in the day of the week field means the
third Thursday of the month (day 4 = Thursday and #3 = the 3rd Thursday in the month). If you specify #5 and
there isn't 5th of the given day of the week in the month, then the trigger will not fire that month.
Slash (/)
Describes increments of a range. For example 3-59/15 in the 2nd field (minutes) indicate the third minute of the
hour and every 15 minutes thereafter.
Last (L)
When used in the day of the week field, it allows you to specify constructs such as the last Friday (5L) of a given
month. In the day of the month field, it specifies the last day of the month. For example, day 31 for January, day
28 for February on non-leap years.
Weekday (W)
The W character is allowed for the day of the month field. This character is used to specify the weekday (MondayFriday) nearest the given day. As an example, if you specify 15W as the value for the day of the month field, the
meaning is the nearest weekday to the 15th of the month. So, if the 15th is a Saturday, the trigger fires on Friday
the 14th. If the 15th is a Sunday, the trigger fires on Monday the 16th. However, if you specify 1W as the value for
day of the month, and the 1st is a Saturday, the trigger fires on Monday the 3rd, as it does not jump over the
boundary of a month's days.

Note
The L and W characters can also be combined in the day of the month field to result in LW, which
translates to last weekday of the month.
Random (R)
The R is a special ERA CRON expression character that allows you to specify randomized time moments. For
example, R 0 0 * * ? * trigger fires every day at 00:00 but at a random second (0-59).
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Important
We recommend you to use randomized time moments to prevent all ESET Management Agents
from connecting at the same time to your ESMC Server.
Real examples that illustrate some variations of the CRON expression:
CRON expression
0 0 12 * * ? *
R00**?*
R R R 15W * ? *

Meaning

Fire at 12 pm (noon) every day.
Fire at 00:00 but at random second (0-59) every day.
Fire at 15th every month at random time (seconds, minutes, hours). If the 15th is a
Saturday, the trigger fires on Friday the 14th. If the 15th is a Sunday, the trigger fires on
Monday the 16th.
0 15 10 * * ? 2016
Fire at 10:15 am every day during the year 2016.
0 * 14 * * ? *
Fire every minute starting at 2 pm and ending at 2:59 pm, every day.
0 0/5 14 * * ? *
Fire every 5 minutes starting at 2 pm and ending at 2:55 pm, every day.
0 0/5 14,18 * * ? *
Fire every 5 minutes starting at 2 pm and ending at 2:55 pm, and fire every 5 minutes
starting at 6pm and ending at 6:55 pm, every day.
0 0-5 14 * * ? *
Fire every minute starting at 2 pm and ending at 2:05 pm, every day.
0 10,44 14 ? 3 WED *
Fire at 2:10 pm and at 2:44 pm every Wednesday in March.
0 15 10 ? * MON-FRI * Fire at 10:15 am every weekday (Monday, Tuesday, Wednesday, Thursday and Friday).
0 15 10 15 * ? *
Fire at 10:15 am on the 15th day of every month.
0 15 10 ? * 5L *
Fire at 10:15 am on the last Friday of every month.
0 15 10 ? * 5L 2016-2020 Fire at 10:15 am on every last Friday of every month from the year 2016 to 2020,
inclusive.
0 15 10 ? * 5#3 *
Fire at 10:15 am on the 3rd Friday of every month.
00***?*
Fire every hour, every day.

Advanced Settings - Throttling
Throttling is used to restrict a task from being executed. Usually throttling is used when a task is triggered by a
frequently occurring event. Under certain circumstances, throttling may prevent a trigger from being fired. Each
time the trigger is triggered, it is evaluated according to the schema below. Only those triggers which meet the
specified conditions would then make the task execute. If no throttling conditions are set, all trigger events would
run the task.
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Time based criteria

Condition 1

Thrott
Task e
Condition 2

Trigger

Statistical criteria

Condition 1

Condition 2
There are three types of conditions for Throttling:
1.Time Based Criteria
2.Statistical Criteria
3.Event Log Criteria
For a task to be executed:
• It has to pass all types of conditions
• Conditions must be set; if a condition is empty, it is omitted
• All time-based conditions must pass as they are evaluated with the AND operator
• All statistical conditions evaluated with the AND operator must pass; at least one statistical condition with
the OR operator must pass
• Statistical and time conditions set together must pass as they are evaluated with the AND operator—only
then is the task executed

If any of the defined conditions are met, stacked information for all observers is reset (the count starts over from
0). This holds for time-based as well as statistical conditions. This information is also reset if the Agent or ESMC
Server is restarted. All modifications made to a trigger reset its status. We recommend that you only use one
statistical condition and multiple time-based conditions. Multiple statistical conditions can cause unnecessary
complications, and can alter trigger results.
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Preset
There are three presets available. When you select a preset, your current throttling settings are cleared and
replaced by the preset values. These values can be further modified and used, however it is not possible to create
a new preset.

Time-based criteria
Time period (T2) - Allow triggering once during the specified time period. If for example, this is set to ten
seconds and during this time ten invocations occur, only the first would trigger the event.
Schedule (T1) - Allows triggering only within the defined time range. Click Add period and pop up window is
displayed. Set a Range Duration in selected time units. Select one option from the Recurrence list and fill in
fields, which change according to selected recurrence. You can define the recurrence also in a form of CRON
Expression. Click OK to save the range. You can add multiple time ranges to the list—they will be sorted
chronologically.

All of the configured conditions must be fulfilled in order to trigger the task.

Statistical criteria
Condition - Statistical conditions can be combined using either:
• Send notification when all statistical criteria are met - AND logical operator is used for evaluation
• Send notification when at least one statistical criteria is met - OR logical operator is used for evaluation
Number of occurrences (S1) - Allows only every x-th trigger hit. For example, if you enter ten, only each tenth
triggering will be counted.

Number of occurrences within a time period
Number of occurrences (S2) - Allows only triggering within the defined time period. This will define the minimum
frequency of events to trigger the task. For example, you can use this setting to allow the execution of the task if
the event is detected 10x in an hour. Firing of the trigger causes a counter reset.
Time period - Define the time period for the option described above.

A third statistical condition is available only for certain trigger types. See:
Trigger.

Trigger > Trigger type > Event Log

Event log criteria
These criteria are evaluated by ESMC as third statistical criteria (S3). The Statistical criteria application operator
(AND / OR) is applied to evaluate all three statistical conditions together. We recommend that you use event log
criteria in combination with the Generate Report task. All three fields are required for the criteria to work. The
buffer of symbols is reset if the trigger is fired and there is a symbol already in buffer.
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Condition - This defines which events or sets of events will trigger the condition. The available options are:
• Received in a Row - The specified number of events must occur in succession. These events must be
unique.
• Received Since Last Trigger Execution - The condition is triggered when the selected number of unique
events is reached in the time since the task was last triggered.
Number of occurrences - Enter the number of unique events with selected symbols to run the task.
Symbol - According to Log type, which is set in the Trigger menu, you can choose a symbol in the log which you
can then search for. Click Select to display the menu. You can remove the selected symbol by clicking Remove.

Note
When in use with a Server Task, all client computers are considered. It is unlikely to receive higher
number of distinctive symbols in a row. Use the Received in a Row setting only for reasonable
cases. A missing value (N/A) is considered as "not unique" and therefore the buffer is reset in this
point.

Additional properties
As stated above, not every event will cause a trigger to fire. Actions taken for non-firing events can be:
• If there is more than one event skipped, group the last N events into one (store data of suppressed ticks)
[N <= 100]
• For N == 0, only the last event is processed (N means history length, where the last event is always
processed)
• All non-firing events are merged (merging the last tick with N historical ticks)

If the trigger fires too often or you want to be notified less often, consider the following suggestions:
• If the user wants to react only if there are more events, not a single one, see statistical condition S1
• If the trigger should fire only when a cluster of events occur, follow statistical condition S2
• When events with unwanted values are supposed to be ignored, refer to statistical condition S3
• When events from outside relevant hours (for example, working hours) should be ignored, see time-based
condition T1
• To set a minimum time between trigger firings, use time-based condition T2

Note
The conditions can also be combined to form more complex throttling scenarios. See the throttling
examples for more details.

Throttling Examples
Throttling examples explain how the throttling conditions (T1, T2, S1, S2, S3) are combined and evaluated.
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Note
"Tick" means impulse from the trigger. "T" stands for time-based criteria, "S" stands for statistical
criteria. "S3" stands for event log criteria.
S1: Criterion for occurrences (allow every third tick)
Time 00 01 02 03 04 05 06 Trigger is modified 07 08 09 10 11 12 13 14 15
Ticks x x x x x x x
x x
x x
x
x
S1
1
1
1
1
S2: Criterion for occurrences within time (allow if three ticks occur within four seconds)
Time 00 01 02 03 04 05 06 Trigger is modified 07 08 09 10 11 12 13
Ticks x
x x x x
x
x
x x x
S2
1
1
S3: Criterion for unique symbol values (allow if three unique values are in a row)
Time 00 01 02 03 04 05 06 Trigger is modified 07 08 09 10 11 12 13
Value A B B C D G H
J K n/a L M N N
S3
1
1
S3: Criterion for unique symbol values (allow if three unique values are since the last tick)
Time 00 01 02 03 04 05 06 07 Trigger is modified 08 09 10 11 12 13 14
Value A B B C D G H I
J K n/a L M N N
S3
1
1
1
T1: Allow a tick in certain time ranges (allow every day starting at 8:10, duration 60 seconds)
Time 8:09:50 8:09:59 8:10:00 8:10:01 Trigger is modified 8:10:59 8:11:00 8:11:01
Ticks x
x
x
x
x
x
x
T1
1
1
1
This criterion has no state; therefore trigger modifications have no effect on the results.
T2: Allow a single tick in a time interval (allow at most once every five seconds)
Time 00 01 02 03 04 05 06 Trigger is modified 07 08 09 10 11 12 13
Ticks x
x x x x
x
x
x x x
T2 1
1
1
1
S1+S2 combination
• S1: every fifth tick
• S2: three ticks within four seconds
Time 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16
Ticks x x x x x
x x x
x
x x
S1
1
S2
1
1
1
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Time 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 16
Result
1
1
1
The result is enumerated as: S1 (logical or) S2
S1+T1 combination
• S1: Allow every third tick
• T1: Allow every day starting at 8:08, duration 60 seconds
Time 8:07:50 8:07:51 8:07:52 8:07:53 8:08:10 8:08:11 8:08:19 8:08:54 8:08:55 8:09:01
Ticks x
x
x
x
x
x
x
x
x
x
S1
1
1
1
T1
1
1
1
1
1
Result
1
1
The result is enumerated as: S1 (logical and) T1
S2+T1 combination
• S2: three ticks within ten seconds
• T1: Allow every day starting at 8:08, for a duration of 60 seconds
Time 8:07:50 8:07:51 8:07:52 8:07:53 8:08:10 8:08:11 8:08:19 8:08:54 8:08:55 8:09:01
Ticks x
x
x
x
x
x
x
x
x
x
S2
1
1
1
1
T1
1
1
1
1
1
Result
1
The result is enumerated as: S2 (logical and) T1.
Note that the state of S2 is reset only when the global result is 1.
S2+T2 combination
• S2: three ticks within ten seconds
• T2: Allow at most once every 20 seconds
Time 00 01
Ticks x x
S2
T2
1 1
Result

02 03 04 05 06 07 … 16 17 18 19 20 21 22 23 24
x x x x x x
x x x x x x x x x
1
1 1 1
1 1 1 1 1
1
1
1
1

The result is enumerated as: S2 (logical and) T2.
Note that the state of S2 is reset only when the global result is 1.

Tasks overview
In Tasks you can see the progress indicator bar, status icon, and details for each created task.
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Important
You must create a Trigger to execute a Client Task.

Click a task to take further task actions:
Show Details
Tags

View Task Details: summary, executions, triggers (trigger details are available only for Client
Tasks).
Edit tags (assign, unassign, create, delete).

Duplicate

Edit the selected Task. Editing existing tasks is useful when you only need to make small
adjustments. For more unique tasks, you might prefer to create a new task.
Create a new task based on the selected task; a new name is required for the duplicate.

Run Now

Server Tasks only: Run the selected Server Task.

Edit

Client Tasks only: Add a new Trigger and select Target computers or groups for the Client
Task.
Rerun on failed Client Tasks only: Create a new Trigger with all computers that failed during previous Task
execution set as targets. You can edit the task settings if you prefer, or click Finish to rerun
the task unchanged.
Remove the selected task(s) completely.
Delete
• If the task is deleted after it was created but before it was scheduled to start, it will be
deleted and it will not run and never start.
• If the task is deleted after it was scheduled to run, the task will be completed but the
information will not be displayed in Web Console.
Client Tasks only: You can select from task execution results and take further actions if
Executions
necessary; see Task details for more details.
Access Group Move the Task to a different static group.
Run on
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Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Progress indicator
The progress indicator is a color bar that shows the execution status of a Task. Each Task has its own indicator
(shown in the Progress row). The execution status of a Task is shown in different colors, and includes the number
of computers in that state for a given task:
Running (blue)

Successfully finished (green)

Failed (orange)

Newly created Task (white) – it might take some time for the indicator to change color, ESMC Server must receive
a response from an ESET Management Agent to show the execution status. The progress indicator will be white if
there is no Trigger assigned.

A combination of the above:

Refer to status icon for details about different icon types and statutes.
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Important
The progress indicator shows the status of a Task when it was last executed. This information comes
from the ESET Management Agent. The progress indicator shows exactly what the ESET
Management Agent is reporting from client computers.

Status icon
The icon next to Progress indicator provides additional information. It shows whether there are any planned
executions for a given Task as well as the result of executions that were completed. This information is
enumerated by ESMC Server. The following statuses can be indicated:
Running
Success
Error
Planned

Task is being executed on at least one target, there are no scheduled and no failed
executions. This applies even if the Task has already finished on some targets.
Task has finished successfully on all targets, there are no scheduled or running
executions.
Task has run on all targets, but has failed on at least one. No further executions are
planned (scheduled).
Task is planned for execution, but no executions are running.

Task has scheduled executions (from the past or in the future). No executions have failed
and at least one execution is currently running.
Planned/Successful Task still has some scheduled executions (from the past or in the future), there are no
failed or running executions and at least one execution has finished successfully.
Task still has some executions scheduled (from the past or in the future), there are no
Planned/Error
running executions and at least one execution has failed. This applies even if some
executions have completed successfully.
Planned/Running

Task details
Click a task and select Show Details to view task details in the following tabs:

Summary
This tab contains an overview of task settings.

Executions
Click the Executions tab to switch view to see each execution result. If there are too many executions, you can
filter the view to narrow down the results.
Executions for Client Tasks displays a list of computers with your selected result (using a filter). Click Add Filter to
filter the selected executions by status:
• Planned - yes (Client Task is planned for execution), no (Client Task execution is completed).
• Last Status: No status, Running, Finished, Failed
Computers with a result other than the one selected will not be shown. You can modify the filter or turn it off to
see all computers regardless of their last status.
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You can also drill down further, for example, by selecting History to see details about the Client Task execution
including the time when it Occurred, current Status, Progress and Trace message (if available). You can click
Computer name or Computer description and take further actions if necessary, or view Computer Details for a
specific client. To take actions on more computers, use the check boxes to select the computers and click the
Actions button.

Note
• If you do not see any entries in the Executions History table, try setting the Occurred filter to a
longer duration.
• When installing older ESET products, the Client Task report will display: Task delivered to the
managed product.

Triggers
The Triggers tab is available only for Client Tasks and it shows the list of Triggers for the selected Client Task. To
manage the trigger, click the trigger and select one of the following items:
Edit

Edit the selected Trigger.

Rerun ASAP Run the Client Task again (ASAP) using an existing Trigger straight away with no modification.
Remove the selected trigger completely. To delete multiple triggers, select the check boxes on
Delete
the left and click the Delete button.
Duplicate Create a new Trigger based on the selected one; a new name is required for the duplicate.
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Installers
This section allows you to create Agent installer packages to deploy ESET Management Agent on client
computers. The installer packages are saved in ESMC Web Console and you can edit and download them again
when necessary.
1.Click
Installers > Create Installer.
2.Select the installer type you want to create. The options are as follows:
•
Agent and ESET security product installer package allows advanced configuration options, including
Policy settings for ESET Management Agent and ESET products, ESMC Server Hostname and Port, and the
ability to select a Parent Group.

Note
After creating and downloading the All-in-one installer package, there are two options for
deploying the ESET Management Agent:
• Locally on a client computer
• Using the ESET Remote Deployment Tool to deploy ESET Management Agents to multiple
client computers at the same time.
•
Agent Live Installer - This type of Agent deployment is useful when the remote and local deployment
options do not suit you. In such cases, you can distribute the Agent Live Installer via email and let the user
deploy it. You can also run the Agent Live Installer from removable media (a USB flash drive, for example).
•
GPO or SCCM script

Filters and layout customization
You can customize the current Web Console screen view:
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• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Installers and permissions
A user can create or edit installers contained in groups where the user has Write permission for Stored Installers.

Note
• Keep in mind that the user will be able to work with Certificates when creating installers. A user
must be assigned Use permission for Certificates with access to the static group where certificates
are contained. If a user wants to deploy ESET Management Agent, that user must have Use
permissions for the Certification Authority that the actual server certificate is signed by. For
information on how to divide access to Certificates and Certification Authority, read this example.
• A user needs to be assigned Use permission for Policies that are selected in Advanced > Initial
installer configuration > Configuration type when creating an All-in-one installer, GPO installer or
SCCM script.
• A user needs to be assigned Use permission for Licenses if the license for static group is specified.

How to allow user to create installers
Example
Administrator wants to allow user John to create or edit new installers in John's Group.
Administrator has to follow these steps:
1.Create new Static Group called John's Group
2.Create a new Permission set
a.name it Permissions for John - Create Installers
b.add the group John's Group in the section Static Groups
c.in the Functionality section, select
• Write for Stored Installers
• Use for Certificates
• Write for Groups & Computers
d.click Finish to save the permission set
3.Create a new Permission set
a.name it Permissions for John - Certificates
b.add the group All in the section Static Groups
c.in Functionality section select Use for Certificates.
d.click Finish to save the permission set
These permissions are the minimal requirements for full (create and edit) installer usage.
4.Create a new User
a.name it John
b.in the Basic section select John's Group as the Home Group
c.set the password to user John
d.in Permission Sets section select Permissions for John - Certificates and Permissions for John Create Installers
e.click Finish to save the user
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How to download installers from the installers menu
1.Click Installers.
2.Select the check box next to the installer you want to download.
3.Click Download and choose the correct version of the installation package.

How to edit installers from the installers menu
1.Click Installers.
2.Select the check box next to the installer you want to edit.
3.Click Actions > Edit to modify the installer package.

Policies
Policies are used to push specific configurations to ESET products running on client computers. This allows you
to avoid configuring each client's ESET product manually. A policy can be applied directly to individual
Computers as well as groups (Static and Dynamic). You can also assign multiple policies to a computer or a
group, unlike in ESET Security Management Center 5 and earlier where it was only possible to apply one policy to
one product or component.

Policies and permissions
The user must have sufficient permissions to create and assign policies. Permissions needed for certain Policies
actions:
• To read the list of policies and their configuration a user needs Read permission.
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• To assign policies to targets, a user needs Use permission.
• To create, modify or edit policies, a user needs Write permission.
See the list of permissions for more information on access rights.

Example
• If user John needs only to read policies created by himself, Read permission for Policies are
needed.
• If user John wants to assign certain policies to computers, he needs Use permission for Policies
and Use permission for Groups and Computers.
• To allow John full access for policies, Administrator must set Write permission for Policies.

Policy application
Policies are applied in the order that Static Groups are arranged. This is not true for Dynamic Groups, where child
Dynamic Groups are traversed first. This allows you to apply policies with greater impact at the top of the Group
tree and apply more specific policies for subgroups. Using flags, an ESMC user with access to groups located
higher in the tree can override the policies of lower groups. The algorithm is explained in detail in How Policies
are applied to clients.

Policy removal rules
When you have a policy in place and decide to remove it later on, the resulting configuration of the client
computers will depend on the version of installed ESET security product on the managed computers:
• ESET security products version 6 and older: The configuration will not automatically revert back to the
original settings once the policy is removed. The configuration will remain according to the last policy that
was applied to the clients. The same thing happens when a computer becomes a member of a Dynamic
Group to which a certain policy is applied that changes the computer's settings. These settings remain even
if the computer leaves the Dynamic Group. Therefore, we recommend that you create a policy with default
settings and assign it to the root group (All) to have the settings revert to defaults in such a situation. This
way, when a computer leaves a Dynamic Group that changed its settings, this computer will revert to default
settings.
• ESET security products version 7: When a policy is removed, the configuration will automatically revert
back to the previous policy that was applied to the clients. When a computer leaves a Dynamic Group where
particular policy setting were in place, these policy settings will be removed from the computer.
Not
apply flag turns individual policy settings to the default state on client computers.

Merging policies
A policy applied to a client is usually the result of multiple policies being merged into one final policy.

Note
We recommend that you assign more generic policies (for example, the update server) to groups
that are higher within the group tree. More specific policies (for example, device control settings)
should be assigned deeper in the group tree. The lower policy usually overrides the settings of the
upper policies when merged (unless defined otherwise using policy flags).
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Policies Wizard
Policies are grouped/categorized by ESET product. Built-in policies contain predefined policies and custom
policies list categories of all the policies you've manually created.
Use policies to configure your ESET product the same way you would from within the Advanced setup window of
the product GUI. Unlike policies in Active Directory, ESMC policies cannot carry any script or series of commands.
Type to search for an item in Advanced setup (for example, HIPS). All HIPS settings will be displayed. When you
click the
icon in the upper right corner, an Online Help page for the particular setting will be displayed.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Create a new policy
1.Click Actions > New.
2.Enter basic information about the policy, such as a Name and Description (optional). Click Select tags to
assign tags.
3.Select the correct product in the Settings section.
4.Use flags to add settings that will be handled by the policy.
5.Specify the clients that will receive this policy. Click Assign to display all Static and Dynamic Groups and
their members. Select the computer that you want to apply a policy on and click OK.
6.Review the settings for this policy and click Finish.
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Flags
When merging policies, you can change the behavior by using policy flags. Flags define how a setting will be
handled by the policy.
For each setting, you can select one of the following flags:
Not apply - Any setting with this flag is not set by policy. Because the setting is not forced, it can be changed
by other policies later on.
Apply - Settings with this flag will be sent to the client. However, when merging policies, it can be overwritten
by a later policy. When a policy is applied to a client computer and a particular setting has this flag, that setting is
changed regardless of what was configured locally on the client. Because the setting is not forced, it can be
changed by other policies later on.
Force - Settings with the Force flag have priority and cannot be overwritten by a later policy (even if the later
policy has a Force flag). This assures that this setting won’t be changed by later policies during merging.
To make navigation easier, all rules are counted. The number of rules you have defined in a particular section will
be displayed automatically. Also, you'll see a number next to the category names in the tree on the left. This
shows a sum of rules in all its sections. This way, you'll quickly see where and how many settings/rules are
defined.
You can also use the following suggestions to make policy editing easier:
• Use
• Use

to set the Apply flag to all items in a current section
to delete rules applied to the items in the current section.

Important
ESET security products version 7:
Not apply flag turns individual policy settings to the default state on client computers.

How can Administrator allow users to see all policies
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Example
Administrator wants to allow user John to create or edit policies in his home group and allow John
to see policies that are created by Administrator. Policies created by Administrator include Force
flags. User John can see all policies, but cannot edit policies created by Administrator because Read
permission for Policies with access to Static Group All is set. User John can create or edit policies in
his Home Group San Diego.
Administrator has to follow these steps:
Create environment
1.Create a new Static Group called San Diego.
2.Create new Permission set called Policy - All John with access to Static Group All and with Read
permission for Policies.
3.Create a new Permission set called Policy John with access to Static Group San Diego, with
functionality access Write permission for Group & Computers and Policies. This permission set
allows John to create or edit policies in his Home Group San Diego.
4.Create new user John and in Permission Sets section select Policy - All John and Policy John.
Create policies
5.Create new policy All- Enable Firewall, expand Settings section, select ESET Endpoint for
Windows, navigate to Network protection > Firewall > Basic and apply all settings by Force flag.
Expand the Assign section and select Static Group All.
6.Create new policy John Group- Enable Firewall, expand Setting section, select ESET Endpoint for
Windows, navigate to Personal Firewall > Basic and apply all settings by
Apply flag. Expand the
Assign section and select Static Group San Diego.
Result
Policies created by Administrator will be applied first because they are assigned to group All.
Settings with the Force flag have priority and cannot be overwritten by a later policy. Then
policies created by user John will be applied.
Navigate to More > Groups > San Diego, click the computer and select Show details. In
Configuration > Applied policies is the final policy application order.

The first policy is created by Administrator and the second created by user John.

Manage Policies
Policies are grouped/categorized by ESET product. Built-in policies contain predefined policies and custom
policies list categories of all the policies you have manually created or modified.
Actions available for policies:
Show Details

Show policy details.

New

Create a new policy.

Tags

Edit tags (assign, unassign, create, delete).

Edit

Modify an existing policy.
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Create a new policy based on an existing policy you have selected. Duplicate policy
requires a new name.
Change Assignment Assign a policy to a group or a client.
Duplicate

Delete

Delete a policy. See also policy removal rules.

Import

Click Policies > Import, click Choose File and browse for the file you want to import. You
can import only a .dat file that contains the policies exported from ESMC Web Console.
You cannot import an .xml file that contains the policies exported from ESET security
product. The imported policies will apppear under Custom Policies.
Select check boxes next to policies you want to export from the list and click Actions >
Export. The policies will be exported to a .dat file. To export all policies from the selected
category, select the check box in the table header.
Move a policy to another group.

Export

Access group

How Policies are applied to clients
Groups and Computers can have several policies assigned to them. Moreover, a Computer can be in a deeply
nested Group, the parents of which have their own policies.
The most important thing for the application of policies is their order. This is derived from the Group order and
order of policies assigned to the Group.
To see all policies applied to a selected computer, see Applied Policies in computer details.
Follow the steps below to determine the active policy for any client:
1.Find the order of groups in which the client resides
2.Replace groups with assigned Policies
3.Merge Policies to get final settings
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Ordering Groups
Policies can be assigned to groups, and are applied in a specific order. Rules written below determine in which
order policies are applied to clients.
Rule 1: Static Groups are traversed from the root Static Group (All).
Rule 2: On every level, the Static Groups of that level are traversed first in the order they appear in the tree (this
is also called "breadth-first" search).
Rule 3: After all Static Groups at a certain level are accounted for, Dynamic Groups are traversed.
Rule 4: In every Dynamic Group, all its children are traversed in the order that they appear in the list.
Rule 5: At any level of a Dynamic Group, any child will be listed and searched for its children. When there are no
more children, the next Dynamic Groups at the parent level are listed (this is also called "depth-first" search).
Rule 6: Traversal ends at a computer.

Important
The policy is applied to the computer. This means that traversal ends at the computer which you
want to apply the policy on.
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Using the rules written above, the order in which policies will be applied on individual computers would be as
follows:

PC1: PC2: PC3: PC4:
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1.ALL 1.ALL 1.ALL 1.ALL
2.SG1 2.SG2 2.SG2 2.SG2
3.PC1 3.DG1 3.SG3 3.SG3
4.DG3 4.PC3 4.DG4
5.PC2
5.DG5
6.DG6
7.PC4

Enumerating Policies
Once the order of Groups is known, the next step is to replace each group with the policies assigned to it. Policies
are listed in the same order as they are assigned to a Group. It is possible to edit the priority of policies for a
group with more policies assigned. Each policy configures only one product (ESET Management Agent, EES, etc.).

Note
A group without a policy is removed from the list.
We have 3 policies applied to both static and Dynamic Groups (see picture below):
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The order in which policies will be applied on the Computer
The list below displays groups and policies applied on them:
1.All -> removed, no Policy here
2.SG 2 -> Policy 1, Policy 2
3.SG 3 -> removed for no Policy
4.DG 1 -> Policy 1, Policy 2
5.DG 3 -> removed, no Policy
6.DG 2 -> Policy 3
7.DG 4 -> removed, no Policy
8.DG 5 -> removed, no Policy
9.DG 6 -> removed, no Policy
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10. Computer -> removed, no Policy

The final list of policies is:
1.Policy 1
2.Policy 2
3.Policy 1
4.Policy 2
5.Policy 3

Merging Policies
When you apply a policy to an ESET security product where another policy is already applied, the overlapping
policy settings are merged. Policies are merged one by one. When merging policies, the general rule is that the
later policy always replaces the settings set by the former one. To change this behavior, you can use policy flags
(available for every setting). Some settings have another rule (replace / append / prepend) that you can configure.
Keep in mind that the structure of the groups (their hierarchy) and the sequence of the policies determines how
the policies are merged. Merging of any two policies may have different results depending on their order.
When creating policies, you will notice that some settings have additional rules that you can configure. These
rules allow you to arrange the same settings in various policies.
• Replace: The default rule which is used when merging policies. It replaces the settings set by the former
policy.
• Append: When applying the same setting in more than one policy, you can append the settings with this
rule. The setting will be placed at the end of the list that was created by merging policies.
• Prepend: When applying the same setting in more than one policy, you can prepend the settings with this
rule. The setting will be placed at the beginning of the list that was created by merging policies.

Merging of local and remote lists
The recent ESET security products (see supported versions in table below) support merging of local settings with
the remote policies in a new way. If the setting is a list (for example, a list of websites) and a remote policy is
conflicting with an existing local setting, the remote policy overwrites it. You can choose how to combine local
and remote lists. You can select different merging rules for:
•
•

Merging settings for remote policies.
Merging of remote and local policies - local settings with the resulting remote policy.

Options are the same as mentioned above: Replace, Append, Prepend.
List of products supporting local and remote lists:
ESET security product
ESET Endpoint for Windows
ESET Server Security for Windows
ESET File Security for Linux
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Version
7+
8+
8.1+

ESET Mail Security for Microsoft Exchange
6+
ESET File Security for Windows Server
6+
ESET Mail Security for IBM Domino
6+
ESET Security for Kerio
6+
ESET Security for Microsoft SharePoint Server 6+

Important
Policy removal in ESET security products version 7
When a policy is removed, the configuration will automatically revert back to the previous policy
that was applied to the clients.
Not apply flag turns individual policy settings to the default state on client computers.

Example scenario of merging policies
This example describes:
• Instructions on how to apply policy settings to ESET Endpoint security products
• How policies are merged when applying flags and rules
In situations where the Administrator wants to:
• Deny access for San Diego Office to the websites www.forbidden.uk, www.deny-access.com,
www.forbidden-websites.uk and www.forbidden-website.com
• Allow access for Marketing Department to the websites www.forbidden.uk , www.deny-access.com
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The Administrator has to follow these steps:
1.Create a new static group San Diego Office and then Marketing Department as a subgroup of static group
San Diego Office.
2.Navigate to Policies and create a new policy as follows:
i.Called San Diego Office
ii.Expand Settings and select ESET Endpoint for Windows
iii.Navigate to Web and Mail > Web access protection > URL Address Management
iv.Click the button to Apply policy and edit Address list by clicking Edit
v.Click List of blocked addresses and select Edit.
vi.Add the following web addresses: www.forbidden.uk, www.deny-access.com,
www.forbidden-websites.uk and www.forbidden-website.com. Save the list of Blocked addresses and
then address list.
vii. Expand Assign and assign the policy to San Diego Office and its subgroup Marketing Department.
viii. Click Finish to save the policy.
This policy will be applied to San Diego Office and Marketing Department and will block the websites as shown
below.
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3.Navigate to Policies and create new policy:
i.Called Marketing Department
ii.Expand Settings and select ESET Endpoint for Windows
iii.Navigate to Web and Mail section > Web access protection > URL Address Management
iv.Click the button to Apply policy, select the Append rule and then edit the Address list by clicking
Edit. Rule Append causes that the Address list will be placed at the end when merging policies.
v.Click List of allowed addresses > Edit.
vi.Add the following web addresses: www.forbidden.uk, www.deny-access.com. Save the list of
allowed addresses and then address list.
vii. Expand Assign and assign the policy to Marketing Department.
viii. Click Finish to save the policy.
This policy will be applied to Marketing Department and will allow access to the websites as shown below.

4.The final policy will include both policies applied to San Diego Office and Marketing Department. Open
Endpoint Security product and navigate to Setup > Web and email > Advanced setup, select the Web and
email tab > Web access protection and expand URL address management. The final Endpoint product
configuration will be shown.
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The final configuration includes:
1. Address list of San Diego Office policy
2. Address list of Marketing Department policy

Configuration of a product from ESMC
You can use policies to configure your ESET product the same way you would from within the Advanced setup
window of the product GUI. Unlike policies in Active Directory, ESMC policies cannot carry any script or series of
commands.
For Version 6 and newer ESET products you can set certain statuses to be reported on the client or in the Web
Console. This can be set in a policy for v6 product under User Interface > User Interface Elements > Statuses:
• Show - status is reported on the client GUI
• Send - status is reported to ESMC
Examples of policy usage to configure ESET products:
• ESET Management Agent policy settings
• ESET Roque Detection Sensor policy settings
• Create a Policy for iOS MDM - Exchange ActiveSync Account
• Create a Policy for MDC to activate APNS for iOS enrollment
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Assign a Policy to a Group
After a policy is created, you can assign it to a Static or Dynamic Group. There are two ways to assign a policy:

Method I.
Under Policies, select a policy and click Actions > Show Details > Assigned To > Assign Group(s). Select a Static or
Dynamic Group from the list (you can select more groups) and click OK.

Method II.
1.Click Computers, click the gear icon
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next to the group name and select Manage Policies.

2.In the Policy application order window click Add Policy.
3.Select the check box next to the policies that you want to assign to this group and click OK.
4.Click Close.
To see what policies are assigned to a particular group, select that group and click the Policies tab to view a list of
policies assigned to the group.
To see what groups are assigned to a particular policy, select the policy and click Show Details > Applied on.

Note
For more information about policies, see the Policies chapter.

Assign a Policy to a Client
To assign a policy to a client workstation, click Policies, select a policy and click Actions > Show Details > Assigned
To > Assign Client(s).
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Select your target client computer(s) and click OK. The policy will be assigned to all computers you have selected.

To see which clients are assigned to a particular policy, select the policy and see the first tab Assigned to.
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ERA 6.x Proxy policy settings
Important
New ESET Management Agents from the version 7 are not able to connect the ERA due to new
replication protocol. Agents of version 6.x can connect to the version 7 Server via ERA Proxy. For
migration follow the proxy migration guidelines.
It is possible to change the behavior of machines with ERA Proxy component via policy. This is mostly used to
change settings like connection interval or the server to which the proxy is connected. Click Policies and expand
Custom Policies to edit an existing policy or create a new one.

Connection
Security Management Center port - This is the port for the connection between the ESET Security Management
Center Server and Proxy. Changing this option requires that you restart the ERA Server service for the change to
take effect.
Servers to connect to - To add ERA Server connection details (hostname/IP and a port number), click Edit server
list. Multiple ERA Servers can be specified. This can be useful if, for example, you've changed the IP address of
your ERA/ESMC Server or are performing a migration.
Data limit - Specify the maximum number of bytes for sending data.
Connection interval - Select Regular interval and specify a time value for the connection interval (or you can use
a CRON expression).
Certificate - You can manage peer certificates for ERA Proxy. Click Change certificate and select which ERA Proxy
certificate should be used by ERA Proxy. For more information, see Peer Certificates.

Advanced Settings
Diagnostics - Enable or disable the submission of anonymous crash report statistics to ESET for the improvement
of customer experience.
Logging - Set the log verbosity to determine the level of information that will be collected and logged, from Trace
(informational) to Fatal (most important critical information).
Assign
Specify the clients that will receive this policy. Click Assign to display all Static and Dynamic Groups and their
members. Select the computer that you want to apply a policy on and click OK.

Summary
Review the settings for this policy and click Finish.
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How to use Override mode
Users with ESET Endpoint products (version 6.5 and above) for Windows installed on their machine can use the
Override feature. Override mode allows users on the client-computer level to change settings in the installed ESET
product, even if there is a policy applied over these settings. Override mode can be enabled for AD users, or it can
be password-protected. The function can not be enabled for more than four hours at once.

Warning
• Override mode can not be stopped from the ESMC Web Console once it is
enabled. Override is disabled only after the time of override expires, or after it
is turned off on the client itself.
• The user who is using the Override mode needs to have Windows admin
rights too. Otherwise, the user can not save the changes in settings of the ESET
product.
• Active Directory group authentication is supported for selected managed
products from version
ESET Endpoint Security
version 7.0.2100.4 and later.
ESET File Security for Microsoft Windows Server version 6.5.12013.0 and later.
ESET Mail Security for IBM Domino
version 6.5.14020.0 and later.
ESET Mail Security for Microsoft Exchange Server version 6.5.10019.1 and later.
To set the Override mode:
1.Navigate to Polices > New Policy.
2.In the Basic section, type in a Name and Description for this policy.
3.In the Settings section, select ESET Endpoint for Windows.
4.Click Override mode and configure rules for override mode.
5.In the Assign section, select the computer or group of computers on which this policy will be applied.
6.Review the settings in the Summary section and click Finish to apply the policy.
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Example
If John has a problem with his endpoint settings blocking some important functionality or web
access on his machine, the Administrator can allow John to override his existing endpoint policy and
tweak the settings manually on his machine. Afterward, these new settings can be requested by
ESMC so the Administrator can create a new policy out of them.
To do so, follow the steps below:
1.Navigate to Polices > New Policy.
2.Complete the Name and Description fields. In the Settings section, select ESET Endpoint for
Windows.
3.Click Override mode, enable the override mode for one hour and select John as the AD user.
4.Assign the policy to John's computer and click Finish to save the policy.
5.John has to enable the Override mode on his ESET endpoint and change the settings manually on
his machine.
6.On the ESMC Web Console, navigate to Computers, select John's computer and click Show
Details.
7.In the Configuration section, click Request configuration to schedule a Client Task to get the
configuration from the client ASAP.
8.After short time, the new configuration will appear. Click the product which settings you want to
save and then click Open Configuration.
9.You can review settings and then click Convert to policy.
10. Complete the Name and Description fields.
11. In the Settings section, you can modify the settings if needed.
12. In the Assign section, you can assign this policy to John's computer (or others).
13. Click Finish to save the settings.
14. Do not forget to remove the override policy once it is no longer needed.
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Computer Users
Computer Users section allows you to manage Users and User Groups. You can pair a user with a device in order
to synchronize some user-specific settings. We recommend that you synchronize Users with Active Directory first.
Upon creation of a new computer, you can pair the computer with a specific user. You can then search for the
user to view details about computers assigned to them and their activity.
You can also manage Users and User Groups for the purpose of iOS Mobile Device Management with the use of
policies assigned to iOS devices. You can modify users or add Custom Attributes.

Important
Computer Users are different from ESMC Web Console users. To manage ESMC Web Console users
and permission sets, navigate to More > Users.
• User highlighted in orange have no device assigned to them. Click the user, select Edit and click
Assigned Computers to view details for that user. Click Add computers to assign device(s) to this user.

• You can also add or remove Assigned users from within Computers details. When you are in Computers,
select a device and click Show Details. The user can be assigned to more than one device. You can also use
Assign User to assign a user directly to selected device(s). If there is a device assigned to a user, you can
click the device name to view details about that device.
• You can Drag & Drop users and user groups. Select the user (or group), hold the mouse button and move it
to another group.

User management actions
Select a user to open a drop-down menu where you can execute actions. Refer to the Icon legend for details
about actions.
Show Details - The menu displays information such as Email Address, Office or Location, and Assigned
Computers. The user can have more than one assigned device. You can change the user's Name, Description or
Parent Group. Custom Attributes shown here are the ones that can be used when creating iOS MDM policies.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.
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Add New Users
Click Computer Users > Add Users to add users. Use this option to add users that were not found or added
automatically during User Synchronization.

Type the name of the user you want to add into the User Name field. Use the Conflict Resolution drop-down
menu to select the action to take if a user you are adding already exists in ESMC:
• Ask when conflicts are detected: When a conflict is detected, the program will ask you to select an
action (see the options below).
• Skip conflicting users: Users with the same name will not be added. This also ensures that an existing
user's custom attributes in ESMC will be preserved (not overwritten with the data from Active Directory).
• Overwrite conflicting users: Existing users in ESMC will be overwritten by users from Active Directory. If
two users have the same SID, the existing user in ESMC is removed from its previous location (even if the
user was in a different group).
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Click + Add to add additional users. If you want to add multiple users at once, click Import CSV to upload a .csv file
containing a list of users to be added. Click Copy & Paste to import a custom list of addresses separated with
custom delimiters (this feature works similarly to CSV import). Optionally, you can enter a Description of the
users for easier identification.
Click Add when you are finished making changes. Users will appear in the parent group that you specified.

Edit Users
You can modify user's details such as Basic information and Assigned Computers.

Note
When performing a User synchronization task for users that have custom attributes defined, set
User creation collision handling to Skip. If you do not, user data will be overwritten by data from
your Active Directory.

Basic
If you have used a User synchronization task to create the user and some fields are blank, you can specify these
manually as required.
Here you can edit user details such as:
• User Name and Description - For informative purposes only.
• Email Address - You can use it as recipient address for delivery of notifications.
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• Phone and Office or Location - For informative purposes only.
• SID - Can be associated with several ESMC functions that require this AD information (for example
Endpoint Policy Override mode).

Custom Attributes
You can edit existing Custom Attributes or add new attributes. To add new ones, click Add New and select from
the categories:
• Wi-Fi Accounts: Profiles can be used to push corporate Wi-Fi settings directly to managed devices.
• VPN Accounts: You can setup a VPN along with the credentials, certificates, and other required
information to make the VPN readily accessible for users.
• Email Accounts: This is used for any email account that uses IMAP or POP3 specifications. If you use an
Exchange server, use the Exchange ActiveSync settings below.
• Exchange Accounts: If your company utilizes Microsoft Exchange, you can create all the settings here to
minimize the setup time for your users' access to mail, calendar, and contacts.
• LDAP (Attribute Alias): This is especially useful if your company utilizes LDAP for contacts. You can map
the contact fields to the corresponding iOS contact fields.
• CalDAV: This contains the settings for any calendar that uses the CalDAV specifications.
• CardDAV: For any contacts that are synced through the CardDAV specification, the information for syncing
can be established here.
• Subscribed Calendar: If any CalDAV calendars are setup, this is where you can define read-only access to
others' calendars.
Some of the fields will become an attribute which can then be used when creating a policy for iOS mobile debvice
as a variable (placeholder). For example, Login ${exchange_login/exchange} or Email Address
${exchange_email/exchange}.
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Assigned Computers
Here you can select individual devices. To do so, click Add Computers - all Static and Dynamic Groups with their
members will be listed. Use check boxes to make your selection and click OK.
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Create New User Group
Click Computer Users >

and select

New User Group

Basic
Enter a Name and Description (optional) for the new User Group. By default, the parent group is the group you
selected when you started creating the new User Group. If you want to change its parent group, click Change
Parent Group and select a parent group from the tree. Click Finish to create the new User Group.

You can assign specific permissions to this User Group from within Access Rights using Permission Sets (see User
Groups section). This way, you can specify which specific ESMC Console users can manage which specific User
Groups. You can even restrict access for such users to other ESMC functions using policies if desired. These users
will then manage User Groups only.

Notifications
Notifications are essential for keeping track of the overall state of your network. When a new event occurs (based
on the notification configuration), you will be notified using a defined method (either an SNMP Trap, email
message or it is sent to syslog server) and you can respond accordingly. You can configure automatic notifications
based on specific events such as detected threats, out-of-date endpoints, and more. See the Notification
Description for more information about a specific notification and its trigger.
• To add filtering criteria, click Add filter and select item(s) from the list. Enter the search string(s) into the
filter field(s). Active filters are highlighted in blue.
oNotification Name
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oNotification Description
oUsername - user who was last to modify the notification.
• To create a new notification, click New notification on the bottom of the page.
• Select an existing notification and click Actions to:
oShow Details: Show notification details, including its configuration, and distribution settings. Click See
message preview to see notification preview.
oTags: Edit tags (assign, unassign, create, delete).
oEdit: change the configuration and distribution of the notification.
oDelete: remove the notification.
oDuplicate: create a duplicate notification with the same parameters in your home group.
oEnable / Disable: set the Status of the notification. Disabled notification is not evaluated.
oAccess Group: Move selected notification to another static group.

Notifications, users and permissions
Similar to Server Tasks, the use of Notifications is restricted by the permissions of the current user. Every time the
notification is executed, there is an executing user whose permissions are taken into account. The executing user
is always the one who edited the notification last. A user can see only notifications that are contained in a group
for which he has Read permissions.

Important
For a notification to work well, it is necessary that the executing user has sufficient permissions for
all referenced objects (devices, groups, templates). Typically, Read and Use permissions are
required. If the user does not have these permissions, or he loses them afterward, the notification
will fail. Failed notifications are highlighted with orange and will trigger an email to notify the user.
Create notification - To create a notification the user must have Write permissions for notifications on his home
group. A new notification is created in the user's home group.
Modify notification - To be able to modify a notification, the user must have Write permissions for notifications
on a group where the notification is located.
Remove notification - To be able to delete a notification, the user must have Write permissions for notifications
on a group where the notification is located.

Cloning and VDI
There are three prepared notifications to notify user about cloning-related events or user can create a custom
new notification.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.
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Example
John, whose Home Group is John’s Group, wants to remove (or modify) Notification 1. The
notification was originally created by Larry, therefore it is automatically contained in Larry's Home
group, Larry's Group. The following conditions must be met for John to remove (or modify)
Notification 1 :
• John must be assigned a permissions set with Write permissions for notifications
• The permissions set must contain Larry’s Group under Static Groups

Manage Notifications
Notifications are managed in the Notifications section. You can perform the following actions:
• Click New Notification to create a new notification.
• Click an existing notification and select an action from the drop-down menu:
Change the status of a notification.
Enable /
Disable
Edit

Change the notification's settings.

Duplicate

Create a duplicate notification in your home group.

Delete

Remove the notification.

Access Group >

Move Move a notification to a different access group.

New Notification
Configure your SMTP server, if you want to send notifications via email.

Basic
• Enter a Name and Description for your notification to make it easier to filter between different
notifications.
• Every new notification is Enabled by default. If you are editing an existing notification and you want to
disable the notification, click the slider
and it will change its status to Disabled
. Notifications
can be enabled or disabled at any time.

Configuration
• Event
There are three basic types of events that can trigger a notification. Each type of event provides different
options in the Settings section. Select one of following event types:
• Events on managed computers
• Status update on Security Management Center
• Dynamic group changes
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Advanced settings - Throttling
Throttling allows you to set up advanced rules that determine when a
notification is triggered. See throttling for more information.
Distribution
Configure the distribution settings for notifications.

Events on managed computers
This option is used for notifications not associated with a Dynamic Group, but based on system events filtered out
from the event log. Select a log category on which the notification will be based and a logical operator for filters.

Category - Choose from the following event categories:
• Firewall detection
• Antivirus detection
• Scan
• HIPS
• Enterprise Inspector alerts
• Blocked Files
• Computer first connected
• Computer identity recovered
• Computer cloning question created
• New MSP customer found
According to the selected category, there is a list of available events under Settings > Filter By. Values in filters are
compared directly with the events sent by the clients. There is no definite list of available values.
Monitored static group - Select a static group with devices which will be monitored.
Settings
Under Settings, select an Operator and values for the filter (Filter By). Only one operator can be selected and all
values will be evaluated together using that operator. Click Add Filter to add a new value for the filter.

Status update on Security Management Center
This option notifies you of object state changes. The notification interval depends on the selected Category. You
can select one of existing settings or set up your own parameters.
Load settings preset - Click Select to choose one from existing settings, or leave blank. Click Clear to clear the
Settings section.
Category - Select a category of objects. According to a selected category, objects are displayed in the in the
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Settings section below.
Monitored static group - For categories where the notification relates to a client (Managed clients, Installed
software) you can select a static group to be monitored. If nothing is selected, all objects where the executing
user has sufficient permissions will be monitored.

Settings
Select an Operator and values for the filter (Filter By). Only one Operator can be selected and all values will be
evaluated together using that Operator. Click Add Filter to add new value for the filter. If more filters are
selected, execution of a notification is evaluated with AND operator (the notification is sent only if all filter fields
are evaluated as true).

Note
Some filters may cause the notification to notify too often. It is recommended to use Throttling to
aggregate the notifications.

List of available filter values
Category
Value
CA certificates
Relative time interval
Peer certificates
Managed clients Not connecting
computers percentage
Licenses
Relative time interval
License usage percent
Client Tasks
Task
Task is valid
Server tasks

Count (Failed)
Last status
Task
Task is valid

Relative time interval
Installed software Application name
Application vendor
Version check status
Network peers
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Peer
Server state

Comment
Select a relative time interval (certificate valid till).
A value between 0 and 100. It can be used only in combination with
Relative time interval filter.
Select a time interval to be monitored for a license expiration.
A value between 0 and 100.
Select tasks for validity filter. If nothing is selected, all are considered.
Select Yes / No. If No is selected, notification triggers when at least
one task from the selection (filter Task) is invalid.
Number of failures of selected tasks.
Last reported status of selected task.
Select tasks for this filter. If nothing is selected, all are considered.
Select Yes / No. If No is selected, notification triggers when at least
one task from the selection (filter Task) is invalid.
Select a time interval to be monitored.
Full application name. If more application are monitored, use the in
operator and add more fields.
Full vendor name. If more vendors are monitored, use the in
operator and add more fields.
If Outdated version is selected, the notification triggers when at least
one application is outdated.
If ESMC Server is overloaded by writing logs, it changes its state:
• Normal - immediate response from server
• Limited - server responds to agent once in an hour
• Overloaded - server is not responding to agents

Category
Notifications

Value
Notification
Notification is enabled
Notification is valid

Comment
Select notification for this filter. If nothing is selected, all are
considered.
Select Yes / No. If No is selected, notification triggers when at least
one notification from the selection (filter Notification) is disabled.
Select Yes / No. If No is selected, notification triggers when at least
one notification from the selection (filter Notification) is invalid.

Dynamic group changes
The notification will be sent when the condition is fulfilled. You can only select one condition to be monitored for
a given dynamic group.
Dynamic group - Select a dynamic group to be evaluated.

Settings - Conditions
Select the type of condition that will trigger a notification.
• Notify everytime the dynamic group content changes
Enable this to be notified when members of the selected group are added, removed or changed.

Important
ESMC checks the Dynamic Group status once every 20 minutes.
For example, if the first check occurs at 10:00, the other checks are performed at 10:20, 10:40,
11:00. If the Dynamic Group content changes at 10:05 and then changes back at 10:13, during the
next check performed at 10:20 ESMC does not recognize the previous change and does not notify
about it.
• Notify when the group size exceeds a specific number
Select the Group size operator and Threshold for the notification:
▪More than - Send a notification when the group size is greater than the threshold.
▪Less than - Send a notification when the group size is less than the threshold.
• Notify when group growth exceeds a specific rate
Define a threshold and time period that will trigger a notification. You can either define a number of clients, or
a percentage of clients (members of the Dynamic Group). Define the time period (in minutes, hours or days) for
the comparison with the new state. For example, seven days ago the number of clients with outdated security
products was 10 and the threshold was set to 20. If the number of clients with an outdated security product
reaches 30, you will be notified.
• Notify when number of clients in dynamic group changes in comparison to another group
If the number of clients in a Dynamic Group changes according to a compared group (either static or dynamic),
a notification will be sent. Threshold - Define a threshold that will trigger the sending of a notification.

Note
You can only assign a notification to a Dynamic Group where you have sufficient permissions. To see
a dynamic group, you must have Read permission for its parent static group.
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Distribution
You have to choose at least one means of distribution.

Send SNMP Trap
Sends an SNMP Trap. The SNMP Trap notifies the Server using an unsolicited SNMP message. For more
information, see How to configure an SNMP Trap Service.

Send email
Sends an email message based on your email settings. By default, the notification email is in HTML form and there
is a logo in the footer. According to your customization settings (Customization > Light background logo) you can
have different logo positions:
• no customization - ESET Security Management Center logo on the left side of the footer
• Co-branding - ESET Security Management Center logo on the left and your logo on the right side of the
footer
• White-labeling - no ESET Security Management Center logo, only your logo on the left side of the footer
If Send email is selected, insert at least one email recipient.
• Email address - Enter the email address of the recipients of the notification messages.
• Click
to add a new address field.
• To add multiple users at once, click More > Add user (add address of the user from the Computer Users),
or More > Import CSV (Import a custom list of addresses from a CSV file structured with delimiters).
• More > Paste from clipboard - Import a custom list of addresses separated with custom delimiters. This
feature works similarly to CSV import.

Send Syslog
You can use ESMC to send notifications and event messages to your Syslog server. Also, it is possible to export
logs from a client's ESET product and send them to the Syslog server. Syslog severity - Choose the severity level
from the drop-down menu. Notifications will then appear with selected severity on the Syslog server.

Basic fields in the Distribution
• Message preview - A preview of the message that will appear in the notification. The preview contains
configured settings in text form. You can customize both content and the subject of the message and use
variables that will be converted to actual values when the notification is generated. This is optional, but it is
recommended for better filtering of notifications and overview.
oSubject - The subject of a notification message. Click the
icon to edit the content. An accurate subject
can improve message sorting and filtering.
oContent - Click the
icon to edit the content.
• General
oLocale - Language of the default message. Message content is not translated.
251

oTimezone - Set the time zone for the Time of occurrence ${timestamp} variable, which can be used in
the customized message.

Example
If the event happens at 3:00 of local time, local time is UTC+2, selected timezone is UTC+4, the time
reported in the notification would be 5:00.
Click Finish to create a new template based on the template you are editing.

How to configure an SNMP Trap Service
To successfully receive SNMP messages, the SNMP trap service needs to be configured. Follow the configuration
steps below as appropriate for your operating system:

WINDOWS
Prerequisites
• The Simple Network Management Protocol service must be installed on the machine where ESMC Server
is installed, as well as on the machine where the SNMP trap software will be installed.
• Both computers (above) should be in the same subnet.
• The SNMP Service must be configured on the ESMC Server computer.

SNMP Service configuration (ESMC Server)
1.Press the Windows key + R to open a run dialog box, type Services.msc into the Open field and press
Enter. Search for the SNMP Service.
2.Open the Traps tab, type public into the Community name field and click Add to list.
3.Click Add, type the Hostname, IP or IPX address of the computer where the SNMP trapping software is
installed into the appropriate field and click Add.
4.Proceed to the Security tab. Click Add to display the SNMP Service Configuration window. Type public
into the Community name field and click Add. Rights will be set to READ ONLY, this is ok.
5.Make sure that Accept SNMP packets from any hosts is selected and click OK to confirm. The SNMP
service is not configured.

SNMP Trap Software configuration (Client)
1.Ensure that the SNMP Service is installed on the client machine.
2.Install a trap receiver application.
3.Configure the trap receiver application to receive SNMP traps from the ESMC Server (this can include
ESMC Server IP address and port settings).
4.Make sure that the firewall on client machines allows network communication for SNMP communication
set in the previous step.
5.The trap receiver application now allows you to receive messages from the ESMC Server.
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Note
SNMP Trap is not supported in the ESMC Virtual Appliance.

LINUX
1.Install the snmpd package by running one of the following commands:
apt-get install snmpd snmp (Debian, Ubuntu distributions)
yum install net-snmp (Red Hat, Fedora distributions)
2.Open the /etc/default/snmpd file and make the following attribute edits:
#SNMPDOPTS='-Lsd -Lf /dev/null -u snmp -g snmp -I -smux -p /var/run/snmpd.pid'
Adding # will disable this line completely.
SNMPDOPTS='-Lsd -Lf /dev/null -u snmp -I -smux -p /var/run/snmpd.pid c /etc/snmp/snmpd.conf'
Add this line to the file.
TRAPDRUN=yes
Change the trapdrun attribute to yes.

3.Create a backup of the original snmpd.conf file. The file will be edited later.
mv /etc/snmp/snmpd.conf /etc/snmp/snmpd.conf.original

4.Create a new snmpd.conf file and add these lines:
rocommunity public
syslocation "Testing ESMC6"
syscontact admin@ERA6.com

5.Open the /etc/snmp/snmptrapd.conf file and add the following line at the end of the file:
authCommunity log,execute,net public

6.Type the following command to start the SNMP manager services and logging of incoming traps:
/etc/init.d/snmpd restart

or
service snmpd restart

7.To check if the trap is working and catching the messages, run the following command:
tail -f /var/log/syslog | grep -i TRAP

Status Overview
The ESMC Server performs periodic diagnostics checkups. Use the
Status Overview to see usage statistics and
general status of your ESET Security Management Center. It can also help you with the initial configuration of
ESET Security Management Center. Click Status Overview to see detailed status information about ESET Security
Management Center. Click a section tile to display a task bar on the right with actions. Each section tile can have
one of several colors, which are based on the highest severity status of included items:
Color Icon
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Icon meaning

Description

Green
Yellow
Red
Gray

Blue

OK
All items in the section are without any issues.
Warning
At least one item in the section is marked with a warning.
Error
At least one item in the section is marked with an error.
Content unavailable Content is unavailable due to insufficient access rights of the ESMC
Console user. An administrator needs to set additional permissions for the
user or you need to log in as another user with proper access rights.
Information
There is a question related to connected computer(s) (see Questions
section description below).

Status Overview contains the following sections:
Users

Create different users and configure their permissions to allow different levels of management
in ESET Security Management Center. The default ESMC Administrator account was created
during installation. We do not recommend that you use the default ESMC Administrator account
as a normal user account. Click Add Native User to create a new native user account and use it
as the default account in ESET Security Management Center.
Certificates
If you want to use different certificates than the default ones provided by ESMC, you can create
Certification Authorities and Peer certificates for individual ESET Security Management Center
components to allow communication with ESMC Server.
Licenses
ESET Security Management Center uses the ESET licensing system. Select the method you want
to use to add License(s) for activation of ESMC components and ESET security products on client
computers.
Computers
• Add Computer - Add computers on your network to the ESMC structure. You can Add
Computers and Mobile devices manually or import a list of devices.
• Add Rogue Computers - Automatically import computers detected using ESET RD Sensor.
• New Synchronization Task - Run Static Group Synchronization with Active Directory, LDAP,
VMware, etc.
Mobile devices • Download - If MDC is not installed, you can download the Mobile Device Connector installer
from the ESET web.
• Add Mobile Devices - Enroll mobile devices via email, via link or OR code, or as a Device
Owner.
Agents
• New Policy - Create a new policy for the ESET Management Agent to change the connection
interval.
• Deploy Agent - There are multiple ways to deploy the ESET Management Agent to client
computers in your network.
Products
• New Policy - Create a new policy to change the configuration of the ESET security product
installed on the client computers.
• Configure Repository - Change Server Settings.
• Install Software - With the ESET Management Agent deployed, you can install software
directly from the ESET repository or specify an installation package location (URL or a shared
folder).
Invalid Objects Contains the list of client and server tasks, triggers, notifications or installers with references to
unreachable or invalid objects. Click any of the result fields to view a menu with the selected list
of objects.
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External
Services

Questions
MSP Status

ESET Security Management Center can be configured to connect to external services to provide
full functionality.
• Configure Repository - The repository contains installer files for other ESET security products
that you can install using the install task. The repository is configured in the server settings. If
needed, you can create an offline repository.
• Configure Updates - Updates are necessary for ESET Security Management Center to stay up
to date. Updates are available only if ESET Security Management Center has imported a nonexpired business product license. You can change your update settings in the server settings.
• Configure SMTP - Set up ESET Security Management Center to use your existing SMTP server
to send email messages, for example Notifications, mobile device enrollment emails, Reports,
etc.
When a cloned device or change of hardware is detected on a client device, a question is listed.
Read more about resolving cloned computers.
If you import an MSP account, there is a tile with MSP statuses available.

More
The More section is the advanced configuration component of ESET Security Management Center. This section
contains tools that administrator can use to manage client security solutions, as well as the ESMC Server settings.
You can use these tools to configure your network environment in such a way that it won't require a lot of
maintenance.

In this section
• Dynamic Group Templates
• Submitted Files
• Quarantine
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• License Management
• Exclusions
• Access Rights
• Certificates
• Server Settings

Dynamic Group Templates
Dynamic group templates establish the criteria computers must meet to be placed in a Dynamic group. When
these criteria are met by a client, a client will automatically be moved into the appropriate Dynamic Group.

Note
A template is a static object stored in a Static group. Users must have appropriate permissions to
access templates. A user needs access permissions to be able to work with Dynamic Group
templates. All pre-defined templates are located in the static group All and are by default available
only to the Administrator. Other users need to be assigned additional permissions. As a result, users
may be unable to see or use default templates. The templates can be moved to a group where the
users have permissions.
To duplicate a template, the user must be assigned write permissions (for Dynamic Group
templates) for the group where the source template is located, and for the user's home group
(where the duplicate will be stored). See the object duplication example.
• Create New Dynamic Group Template
• Rules for a Dynamic Group Template
• Dynamic Group Template - examples

Manage Dynamic Group Templates
Templates can be managed from More > Dynamic Group Templates.
New Template
Show Details

Click to create a New Template in your home group.
See the summary of information about selected template.

Tags

Edit tags (assign, unassign, create, delete).

Edit

Edit selected template. Click Save as if you want to keep your existing template and
create a new one based on the template you are editing. When prompted, specify
the name for your new template.
Create a new Dynamic Group Templates based on the selected template. A new
name will be required for the duplicate task. The duplicated template will be stored
in your home group.
Remove the template permanently.

Duplicate

Delete
Import
Export
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Import Dynamic Group Templates from a file. During import, file structure is being
verified to ensure file is not corrupted.
Export the selected Dynamic Group Templates to a file for backup or migration
purposes. We do not recommend any edits to the file - they may make the data
unusable.

Access Group

Move selected template to another static group. This is useful when solving access
issues with other users.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

New Dynamic Group Template
Click New Template under More > Dynamic Group Templates.

Basic
Enter a Name and a Description for the new Dynamic Group template.
Click Select tags to assign tags.

Expression
See our examples with illustrated step-by-step instructions for samples of how to use Dynamic Groups on your
network.
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Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.

Rules for a Dynamic Group template
When you set rules for a Dynamic Group template, you can use different operators for different conditions to
achieve your desired scenario.
The following chapters explain rules and operations used in Dynamic Group templates:
• Operations
• Rules and logical connectors
• Template rules evaluation
• How to create automation in ESET Security Management Center
• Dynamic Group Templates
• Use cases - create a specific Dynamic Group template

Operations
If you specify multiple rules (conditions), you must select which operation should be used to combine the rules.
Depending on the result, a client computer will or will not be added to a Dynamic Group which uses this
Template.

Note
• The selected Operation works not only when combining more rules, but also when there is only
one rule.
• It is not possible to combine operations. Only one operation is used per Dynamic Group Template
and applies to all its rules.
AND (All conditions have to be Checks if all conditions are evaluated positively – computer must meet all
true)
required parameters.
OR (At least one condition has to Checks if at least one of the conditions is evaluated positively – computer must
be true)
meet at least one of the required parameters.
NAND (At least one condition
Checks if at least one of the conditions cannot be evaluated positively –
has to be false)
computer must not meet at least one parameter.
NOR (All conditions have to be Checks if all conditions cannot be evaluated positively – computer doesn't
false)
meet any of required parameters.

Rules and logical connectors
A rule consists of an item, logical connector (logical operator) and defined value.
When you click + Add Rule a pop-up window will open with a list of items divided into categories. For example:
Installed software > Application name
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Network adapters > MAC address
OS edition > OS name
You can browse the list of all available rules in this ESET Knowledgebase article.
To create a rule, select an item, choose a logical operator and specify a value. The rule will be evaluated according
to the value you've specified and the logical operator used.
Acceptable value types include number(s), string(s), enum(s), IP address(es), product masks and computer IDs.
Each value type has different logical operators associated with it and ESMC Web Console will automatically show
only supported ones.
• "= (equal)" - Symbol value and template value must match. Strings are compared without case sensitivity.
• "> (greater than)" - Symbol value must be greater than template value. Can also be used to create a range
comparison for IP address symbols.
• "≥ (greater or equal)" - Symbol value must be greater or equal to template value. Can also be used to
create a range comparison for IP address symbols.
• "< (less than)" - Symbol value must be less than template value. Can also be used to create a range
comparison for IP address symbols.
• "≤ (less or equal)" - Symbol value must be less than or equal to template value. Can also be used to create
a range comparison for IP address symbols.
• "contains" - Symbol value contains template value. In case of strings, this searches for a sub-string. Search
is done without case sensitivity.
• "has prefix" - Symbol value has the same text prefix as template value. Strings are compared without case
sensitivity. Set the first characters from your search string, for example, for "Microsoft Visual C++ 2010 x86
Redistributable - 10.0.30319", the prefix is "Micros" or "Micr" or "Microsof"etc.
• "has postfix" - Symbol value has same text postfix as template value. Strings are compared without case
sensitivity. Set the first characters from your search string, for example, for "Microsoft Visual C++ 2010 x86
Redistributable - 10.0.30319", the postfix is "319" or "0.30319", etc.
• "has mask" - Symbol value must match a mask defined in a template. Mask formatting allows any
characters, the special symbols '*' - zero, one or many characters and '?' exactly one character, e.g.: "6.2.*"
or "6.2.2033.?".
• "regex" - Symbol value must match the regular expression (regex) from a template. Regex must be written
in Perl format.

Note
A regular expression, regex or regexp is a sequence of characters that define a search pattern. For
example, gray|grey and gr(a|e)y are equivalent patterns which both match these two words:
"gray", "grey".
• "is one of" - Symbol value must match any value from a list in a template. To add an item, click + Add.
Each line in a new item in the list. Strings are compared without case sensitivity.
• "is one of (string mask)" - Symbol value must match any mask from a list in a template. Strings are
compared with case sensitivity. Examples: *endpoint-pc*, *Endpoint-PC*.
• "has value"

Negated operators:
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Important
Negated operators must be used with care, because in the case of multiple line logs such as
"Installed application", all lines are tested against these conditions. Please consult the included
examples (Template rules evaluation and Dynamic Group template - examples) to see how negated
operators or negated operations must be used to get expected results.
• "≠ (not equal)" - Symbol value and template value must not match. Strings are compared without case
sensitivity.
• "doesn't contain" - Symbol value does not contain template value. Search is done without case sensitivity.
• "doesn't have prefix" - Symbol value does not have the same text prefix as template value. Strings are
compared without case sensitivity.
• "doesn't have postfix" - Symbol value does not have text postfix as template value. Strings are compared
without case sensitivity.
• "doesn't have mask" - Symbol value must not match a mask defined in a template.
• "not regex" - Symbol value must not match a regular expression (regex) from a template. Regex must be
written in Perl format. Negation operation is provided as a helper to negate matching regular expressions
without rewrites.
• "is not one of" - Symbol value must not match any value from the list in a template. Strings are compared
without case sensitivity.
• "is not one of (string mask)" - Symbol value must not match any mask from a list in a template.
• "has no value"

Template rules evaluation
Template rules evaluation is handled by ESET Management Agent, not ESMC Server (only the result is sent to
ESMC Server). The evaluation process happens according to the rules that are configured in a Template. Below
are a few examples of template rules evaluation process.

Example
You need to distinguish between test for existence (something does not exist at all with that value)
and test for difference (something exists but has different value). Here are some basic rules to make
this distinction:
• To verify existence: Operation without negation (AND, OR) and operator without negation (=, >, <,
contains,...).
• To verify existence of a different value: Operation AND and operators including at least one
negation (=, >, <, contains, does not contain,...).
• To verify non-existence of a value: Operations with negation (NAND, NOR) and operators without
negation (=, >, <, contains,...).
To verify presence of a list of items (for example, a specific list of applications installed on a
computer), you need to create a separate Dynamic Group template for each item in the list and
assign the template to a separate Dynamic Group, each Dynamic Group being a sub-group of
another. Computers with the list of items are in the last sub-group.

Status is a cluster of various information. Some sources provide more than one dimensional status per machine
(for example, Operating System, RAM size, etc.), others provide multidimensional status information (for
example, IP Address, Installed Application, etc).
Below is a visual representation of the status of a client:
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MB
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ESET Endpoint
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PDF Reader
Office Suite
Weather Forecast

Status is made of information groups. One group of data always provides coherent information organized into
rows. The number of rows per group may vary.
Conditions are evaluated per group and per row - if there are more conditions regarding the columns from one
group, only the values on the same row are considered.

Example 1:
For this example consider the following condition:
Network Adapters.IP Address = 10.1.1.11 AND Network Adapters.MAC Address = 4A-64-3F10-FC-75

This rule matches no computer, as there is no such row where both conditions hold true.
Network Adapters - IP
Address

Network Adapters - MAC
Address

192.168.1.2

4A-64-3F-10-FC-75

10.1.1.11
124.256.25.25

2B-E8-73-BE-81-C7
52-FB-E5-74-35-73

OS Name

Windows 7
Enterprise

OS Version HW - Installed Application
RAM
size in
MB
6.1.7601 2048
ESET Endpoint
Security
PDF Reader
Office Suite
Weather Forecast

Example 2:
For this example consider the following condition:
Network Adapters.IP Address = 192.168.1.2 AND Network Adapters.MAC Address = 4A-64-3
F-10-FC-75

This time, both conditions match cells on the same row and therefore, the rule as a whole is evaluated as TRUE.
The computer is selected.
Network Adapters - IP
Address

Network Adapters - MAC
Address

192.168.1.2

4A-64-3F-10-FC-75

10.1.1.11

2B-E8-73-BE-81-C7
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OS Name

Windows 7
Enterprise

OS Version HW - Installed Application
RAM
size in
MB
6.1.7601 2048
ESET Endpoint
Security
PDF Reader

Network Adapters - IP
Address

124.256.25.25

Network Adapters - MAC
Address

OS Name

OS Version HW RAM
size in
MB

52-FB-E5-74-35-73

Installed Application

Office Suite
Weather Forecast

Example 3:
For conditions with the OR operator (at least one condition must be TRUE), such as:
Network Adapters.IP Address = 10.1.1.11 OR Network Adapters.MAC Address = 4A-64-3F-1
0-FC-75

The rule is TRUE for two rows, as only either of the conditions must be satisfied. The computer is selected.
Network Adapters - IP
Address

Network Adapters - MAC
Address

192.168.1.2

4A-64-3F-10-FC-75

10.1.1.11
124.256.25.25

2B-E8-73-BE-81-C7
52-FB-E5-74-35-73

OS Name

Windows 7
Enterprise

OS Version HW - Installed Application
RAM
size in
MB
6.1.7601 2048
ESET Endpoint
Security
PDF Reader
Office Suite
Weather Forecast

Dynamic Group template - examples
You can find useful pre-defined Dynamic Group templates in More > Dynamic Group Templates.

The sample Dynamic Group templates and examples of their use in this guide demonstrate some of the ways you
can use Dynamic Groups to manage your network:
Dynamic Group that detects if a security product is installed
Dynamic Group that detects if a specific version of a software is installed
Dynamic Group that detects if a specific version of software is not installed
Dynamic Group that detects if a specific version of software is not installed but another version exists
Dynamic Group that detects if a computer is in a specific subnet
Dynamic Group that detects installed but not activated versions of server security products
Automatically deploy ESET products on newly connected Windows desktops
Enforce location-based policy

See also our Knowledgebase articles with examples of Dynamic Group templates and their use:
Useful Dynamic Group template examples in ESET Security Management Center 7 - examples how you can use
HW Inventory details to create rules for a Dynamic Group containing the devices that meet the selected HW
criteria.
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Configure ESET Security Management Center to automatically deploy ESET endpoint products to unprotected
computers (7.x)
Configure endpoints to use different update settings depending on the network they are connected to using ESET
Security Management Center (7.x)
Create a new certificate for new workstations to automatically join a Dynamic Group in ESET Security
Management Center (7.x)

Note
Knowledgebase articles may not be available in your language.
There are many other objectives that can be achieved using Dynamic Groups Templates with a combination of
rules. The possibilities are almost endless.

Dynamic Group - a security product is installed
This Dynamic Group can be used to execute task immediately after ESET security product is installed on a
machine: Activation, Custom scan, etc.
You can create a New Template under More > Dynamic Group Templates and create new Dynamic Group with
template.

Basic
Enter a Name and a Description for the new Dynamic Group template.

Expression
1.Select a logical operator in the Operation menu: AND (All conditions have to be true).
2.Click + Add Rule and select a condition. Select Computer > Managed products mask > is one of > ESET
protected: Desktop. You can also choose different ESET products.

Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.

Dynamic Group - a specific software version is installed
This Dynamic Group can be used to detect installed ESET security software on a machine. Then you will be able to
execute for example upgrade task or run custom command on those machines. Different operators like
"contains" or "has prefix" can be used.
You can create a New Template under More > Dynamic Group Templates and create new Dynamic Group with
template.
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Basic
Enter a Name and a Description for the new Dynamic Group template.

Expression
1.Select a logical operator in the Operation menu: AND (All conditions have to be true).
2.Click + Add Rule and select a condition:
• Installed software > Application name > = (equal) > ESET Endpoint Security
• Installed software > Application version > = (equal) > 6.2.2033.0

Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.

Dynamic Group - a specific version of a software is not
installed at all
This Dynamic Group can be used to detect missing ESET security software on a machine. The settings from this
example will include machines that do not contain the software at all or machines with different versions than
one specified.
This group is useful because you will be able to execute software installation task on those computers to either
install or upgrade. Different operators like "contains" or "has prefix" can be used.
Click New Template under More > Dynamic Group Templates.

Basic
Enter a Name and a Description for the new Dynamic Group template.

Expression
1.Select a logical operator in the Operation menu: NAND (At least one condition has to be false).
2.Click + Add Rule and select a condition:
• Installed software > Application name > = (equal) > ESET Endpoint Security
• Installed software > Application version > = (equal) > 6.2.2033.0

Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.
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Dynamic Group - a specific version of a software is not
installed but other version exists
This Dynamic Group can be used to detect software that is installed but with different version than you are
requesting. This group is useful because you will be able to execute upgrade tasks on those machines where the
required version is missing. Different operators can be used but make sure that version testing is done with
negated operator.
Click New Template under More > Dynamic Group Templates.

Basic
Enter a Name and a Description for the new Dynamic Group template.

Expression
1.Select a logical operator in the Operation menu: AND (All conditions have to be true).
2.Click + Add Rule and select a condition:
• Installed software > Application name > = (equal) > ESET Endpoint Security
• Installed software > Application version > ≠ (not equal) > 6.2.2033.0

Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.

Dynamic Group - a computer is in specific subnet
This Dynamic Group can be used to detect specific subnet. Then it can be used to apply custom policy for web
control or update. You can specify different ranges.
Click New Template under More > Dynamic Group Templates.

Basic
Enter a Name and a Description for the new Dynamic Group template.

Expression
1.Select a logical operator in the Operation menu: AND (All conditions have to be true).
2.Click + Add Rule and select a condition:
• Network IP addresses > Adapter IP address > ≥ (greater or equal) > 10.1.100.1
• Network IP addresses > Adapter IP address > ≤ (less or equal) > 10.1.100.254
• Network IP addresses > Adapter subnet mask > = (equal) > 255.255.255.0
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Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.

Dynamic Group - installed but not activated version of
server security product
This Dynamic Group can be used to detect inactive server products. Once these products are detected, you can
assign a Client Task to this group to activate client computers with proper license. In this example only ESET Mail
Security for Microsoft Exchange Server is specified, but you can specify multiple products.
Click New Template under More > Dynamic Group Templates.

Basic
Enter a Name and a Description for the new Dynamic Group template.

Expression
1.Select a logical operator in the Operation menu: AND (All conditions have to be true).
2.Click + Add Rule and select a condition:
• Computer > Managed products mask > is one of > ESET protected: Mail Server
• Functionality/Protection problems > Source > = (equal) > Security product
• Functionality/Protection problems > Problem > = (equal) > Product not activated

Summary
Review the configured settings and click Finish to create the template. This new template will be added to the list
of all templates, and can be used later to create a new Dynamic Group.

How to automate ESET Security Management Center
By using techniques like the example shown below, you can automate a variety of actions, from product and OS
updates, scanning, and automatic activations of newly added products with preselected licenses, to solving
sophisticated incidents.

Automatically deploy ESET products on newly connected Windows
desktops
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Warning
This example should be performed only on clients without third-party security software or ESET
security software from home segment (e.g. ESET Smart Security). The installation of ESET products
on clients with third-party security software is not recommended. You can use ESET AV Remover to
remove other antivirus programs from your computer.

Example
1.Create a Dynamic Group, called Without security product.
a.Make it a child group of the pre-defined group Windows computers > Windows (desktops).
b.Click New Template.
c.Add the following rule: Computer > Managed products mask.
d.As operator select not equal.
e.Select the mask
ESET protected: Desktop
f.Click Finish to save the group.
2.Navigate to Client Tasks > ESET Security Product > Software Install.
a.Click New and give the task a Name.
b.Choose the package in the Settings section and set other parameters if needed.
c.Click Finish > Create Trigger.
d.In the Target section, click Add Groups and select Without security product.
e.In the Trigger section, select Joined Dynamic Group Trigger.
f.Click Finish to save the task and the trigger.
This task will be executed on clients connected to the dynamic group since this moment. You will
need to execute this task manually on clients which were in the dynamic group before the task was
created.

Enforce location-based policy
Example
1.Create a Dynamic Group called Subnetwork 120.
a.Make it a child group of the All group.
b.Click New Template.
c.Add rule: Network IP addresses > IP subnetwork.
d.As operator select equal.
e.Enter the subnetwork you want to filter, for example, 10.1.120.0 (the last number has to be 0 to
filter all the IP addresses from the 10.1.120. subnetwork).
f.Click Finish to save the group.
2.Navigate to Policies.
a.Click New policy and give the policy a Name.
b.In the
Settings section, select ESET Management Agent.
c.Make the policy change; for example, change the Connection interval to 5 minutes.
d.In the
Assign section, click Assign and select the check box
next to your group Subnetwork
120 and click OK to confirm.
e.Click Finish to save the policy.
This policy will be applied on clients connected to the dynamic group since this moment.

Warning
See policy removal rules to verify what happens to the applied policy settings when the client
machine leaves the dynamic group (conditions matching the dynamic group membership are not
valid anymore).
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See other examples listed here.

Submitted Files
ESET Dynamic Threat Defense is a service that provides advanced protection from never-before-seen detections.
ESMC user can submit files for malware analysis in the cloud environment and receive a report about sample
behavior. See the ESET Dynamic Threat Defense User guide for step-by-step instructions. You can remotely submit
a file directly from ESMC Web Console under Detections - click an item from the
Blocked files category >
Send File to EDTD.
The Submitted files window provides a list of all files submitted to ESET servers. These include files automatically
sent to ESET LiveGrid® from client computers (in case ESET LiveGrid® is enabled in their ESET security product)
and files sent to ESET Dynamic Threat Defense manually from ESMC Web Console.

Submitted files window
You can see the list of submitted files and information related to those files, like the user who submitted the file
and submission date. Click the submitted file and select an action from the drop-down menu.
Show Details

Click to view the latest submission tab.

View Behavior

View the behavioral analysis report for a given sample.

Create Exclusion

Select one or more files and click Create Exclusion to add a detection exclusion
for the selected files to an existing policy.

File Details Window
File Details window contains a list of file details for the selected file. It a file is submitted multiple times, details for
the last submission are displayed.
Status

State
Last processed on
Sent on
Behaviors

Computer
User
Reason
Sent to
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Result of malware analysis.
Unknown - the file was not analyzed.
Clean - none of the detection engines evaluated file as malware.
Suspicious, Highly suspicious - the file displays suspicious behavior but may not be
malware.
Malicious - the file displays dangerous behavior.
State of the analysis. The status Re-analyzing means the result is available, but it
may change after further analysis.
A file can be submitted for analysis many times, from more computers. This is the
time of the last analysis.
The time of submission.
Click View behavior to see the analysis from ESET Dynamic Threat Defense. This is
only valid if the computer which submitted the file has an active ESET Dynamic
Threat Defense license.
The name of the computer from which the file was submitted.
Computer user who submitted the file.
The reason the file was submitted.
Part of the ESET cloud that has received the file. Not every submitted file is analyzed
for malware.

Hash
Size
Category

SHA1 hash of the submitted file.
Size of the submitted file.
Category of the file. Category may not follow the file extension.

For more information about ESET Dynamic Threat Defense behavioral reports see the documentation.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Quarantine
This section shows all files quarantined on client devices. Files should be quarantined if they cannot be cleaned, if
it is not safe or advisable to delete them, or if they are being falsely detected by an ESET product.

Note
Not all detections found on client devices are moved to quarantine. Detections that are not
quarantined include:
• Detections that cannot be deleted.
• Detections that are suspicious based on their behavior, but are not identified as malware, for
example, PUAs.

You can Delete the quarantined file or Restore it to its previous location. You can use Restore and Exclude the
quarantined file to prevent it from being reported by the ESET product again.
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You can use various filters to filter the list of files in quarantine.
There are two ways to access Quarantine:
1. More > Quarantine.
2. Computer details > Detections and quarantine > Quarantine tab.
If you click an item in the Quarantine section you will open Quarantine Management menu.
Show Details - Displays the source device, detection name and type, object name with full file path, hash, size,
etc.
Computers - Opens Computers section with filtered devices connected with the quarantined file.
Delete - Removes the file from quarantine and the affected device.
Restore - Restores the file to its original location.
Restore and Exclude - Restores the file to its original location and excludes it from scanning.
Upload - Opens Upload Quarantined File task. This action is available after you click Show Details.

Important
The Upload function is recommended only for experienced users. If you want to investigate the
quarantined file more, you can Upload it to a shared directory.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Exclusions
In this section you can see the list of all created detection exclusions. This new section contains all detection
exclusions, increases their visibility and simplifies their management.
Click a detection exclusion or select more detection exclusions and click the Actions button to manage the
detection exclusions:
•
•
•
•
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Change Assignment - Change the target computers where the detection exclusion will be applied.
Show Affected Computers - See computers where the detection exclusion is applied.
Delete - Delete the detection exclusion.
Access Group >
Move - Move the detection exclusion to a different static group.

Migrate exclusions from a Policy
In ESMC 7.1 and later, you cannot create detection exclusions via a Policy anymore. In case your policies
previously contained exclusions, follow the steps below to migrate exclusions from Policies to the Exclusions list
in ESMC 7.2:
1.Navigate to Policies and click the policy that contains exclusions and select Show Details.
2.Click Settings > Detection Engine.
3.Click View next to Detection exclusions.

4.Click the Export button and then click the button next to Download exported data and save the
export.txt file. Click OK.
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5.In the ESMC Web Console, navigate to More > Exclusions.
6.Click the Import button to import detection exclusions from a file. Click Choose file to upload and
navigate to the export.txt file or drag and drop the file.

7.Click the Import button to import the detection exclusions. Imported detection exclusions will appear in
the exclusions list.

272

Warning
• The original exclusion assignments are not preserved. Imported detection exclusions are by
default assigned to computers in your home group. To change the exclusion assignment, click the
exclusion and select Change assignment.
• You can assign detection exclusions only to computers with a compatible ESET security product
installed. Detection exclusions will not be applied to incompatible ESET security products and will be
ignored on them.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

License Management
By purchasing licensing for any ESET business product, you automatically receive access to ESET Security
Management Center. You can easily manage your licenses via ESET Security Management Center from the main
menu under More > License Management.
If you already have an ESET-issued Username and Password that you want to convert to a License Key, see
Convert legacy license credentials. The Username and Password have been replaced by a License Key/Public ID.
• A License Key is a unique string used to identify the license owner and the activation itself.
You can activate your ESET business product using ESET Security Management Center.

Permissions for license management
Each user can be assigned a permission for Licenses. Permissions are valid only for licenses contained in the static
group where that permission set is assigned. Each type of permission allows a user to perform different actions.
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Important
Only Administrators whose home group is set to All, with Write permission for licenses in the home
group can add or remove licenses. Each license is identified by its Public ID and can contain one or
more units. Licenses can only be distributed by the Administrator to other users with sufficient
permissions. A license is not reducible.
When you import an MSP account, all licenses are stored in one license pool. You cannot move a license out of
the pool. You can move the whole license pool. To move the pool, select the pool > Actions > Access Group >
Move and select the new access group. If you synchronize the MSP account afterwards, any new licenses appear
in the pool's actual location.

License Management in Web Console

Licenses from the same ESET Business Account user or the same company are grouped into license pools. Click
to expand the license pool and see license details.
In ESET Business Account and ESMC, each license is identified by:
• Public ID
• License Type - Business (paid license), Trial (trial license), MSP (Managed Services Provider license), and
NFR (Not For Resale license).
The additional license information includes:
• The security Product name for which its license is intended.
• License Status (if the license is expired, overused, or at risk of expiration or overuse, a warning message
will be displayed here).
• The number of Units that can be activated with this license and number of offline units.
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• The number of Subunits of ESET server products (mailboxes, gateway protection, connections).
• The license Expiration date.
oSubscription licenses might not have an expiration date.
• The license Owner name and Contact.
You can filter licenses by their Status:
OK - Green

Your license is activated successfully.

Erorr(s) - Red

The license is not registered, or the license has expired.

Warning(s) - Orange

Your license is still depleted or is about to expire (expiration is due in 30 days).

Deactivated or suspended Your license is deactivated or suspended.
Your license has expired.
Obsolete
Click the Actions button to manage the selected license pool(s):
Tags

Edit tags (assign, unassign, create, delete).

Click Add Licenses and then select the method you want to use to add your new license(s):
1.ESET Business Account or ESET MSP Administrator - Connect an ESET Business Account
or EMA 2 and all its licenses to the License Management section. ESMC is also backward
compatible with ESET License Administrator and ESET MSP Administrator so you can use
your Security Admin credentials instead of ESET Business Account.
2.License Key - Enter a license key for a valid license and click Add Licenses. The license key
will be verified against the activation server and added to the list.
3.Offline License File - Add a license file (.lf) and click Add License. The license file will be
verified and the license added to the list.
You can see how the license was added based on the icon in the Owner Name column:
Offline License File,
License Key or
ESET Business Account or ESET MSP
Administrator.
Remove Licenses Remove the selected license pool(s). You will be asked to confirm this action. Removal of
the license does not trigger deactivation of the product. Your ESET product will remain
activated even after the license has been deleted in ESMC License Management.
Move the selected license pool(s) to another Static Group.
Access Group
Refresh license information in ESMC immediately. Licenses synchronize automatically once
Synchronize
a day with ESET license servers. If you are using ESET Business Account, ESET License
Licenses
Administrator, or ESET MSP Administrator licenses synchronize automatically once a day
also with these services.
Open the ESET MSP Administrator portal.
Open EMA
Add Licenses

Open EBA

Open the ESET Business Account portal.

Expand a license pool and click a license to perform the following actions:
Use License For Activation Run Product Activation task using this license.
Create all-in-one installer Use the selected license in the All-in-one Agent installer.
Tags

Edit tags (assign, unassign, create, delete).

Subscription licenses
ESMC supports management of subscription licenses. You can add such a license using ESET Business Account or a
License Key. You can check your subscription's validity under License Management in the Validity column or
Computers > Computer details. It is not possible to create an offline license file from a subscription license.
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ESET Business Account – Site Accounts
Site accounts are not supported in the ESMC. If an ESET Business Account user has Read or Write permission for
Company Access in the ESET Business Account, all licenses are imported when the account is synchronized. If an
ESET Business Account user has No Access set in Company Access, no licenses are imported.

Activation of ESET business products
You can distribute licenses to ESET products from ESMC using two tasks:
• The software installation task
• The product activation task

Deactivation of ESET business products
You can deactivate the ESET business product (remove the license from the product) in several ways using the
ESMC Web Console:
• in Computers, select the computer(s) and select
Deactivate Products - Remove license from all
selected devices via ESET license server. Product is deactivated even if it was not activated from ESMC or
license is not managed by ESMC.

Note
If you select only one computer with more ESET products installed (for example ESET endpoint
product and ESET Enterprise Inspector Agent), you can select to deactivate individual products.
• Remove computer from management
• Create the Delete Not Connecting Computers Task with the Deactivate License option.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Sharing licenses among branch admins
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Example
There are three users and Administrator, each user has their own home group:
• John, San Diego
• Larry, Sydney
• Makio, Tokyo
The administrator imports 3 licenses. These are contained in the static group All and other users
cannot use them.
To assign a license to another user, the administrator can select the check box next to the license
pool they want to assign to another user, click the Actions button and then click
Access Group >
Move and select group where that user has permission. For the user John, select the group San
Diego. John needs to have Use permission for Licenses in the group San Diego to use the license.
When the user John logs in, he can only see and use the license that was moved to his group. The
administrator should repeat the process for Larry and Makio, afterward, users can see only their
license, while Administrator can see them all.

ESET Business Account or ESET MSP Administrator
Important
Only Administrators whose home group is set to All, with Write permission for licenses in the home
group can add or remove licenses. Each license is identified by its Public ID and can contain one or
more units. Licenses can only be distributed by the Administrator to other users with sufficient
permissions. A license is not reducible.

ESET Business Account or ESET MSP Administrator 2 credentials
Enter the ESET Business Account or ESET MSP Administrator 2 credentials (ESMC will display all delegate licenses
in ESMC License Management) and click Add licenses.
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ESET License Administrator, Security Administrator
ESMC is backward compatible with ESET License Administrator and ESET MSP Administrator. You can enter your
Security Admin credentials (as they were in ERA 6.x) instead of your ESET Business Account Login. Licenses that
were imported using Security Admin in ERA 6.x work correctly after migration / upgrade to ESMC.

Add License - License Key
Important
Only Administrators whose home group is set to All, with Write permission for licenses in the home
group can add or remove licenses. Each license is identified by its Public ID and can contain one or
more units. Licenses can only be distributed by the Administrator to other users with sufficient
permissions. A license is not reducible.
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License Key
Type or copy and paste the License Key you received when you purchased your ESET security solution in to the
License Key field and click Add licenses.
If you are using legacy license credentials (a Username and password), convert the credentials to a license key. If
the license is not registered, it will trigger the registration process, which will be done on the EBA portal (ESMC
will provide the URL valid for registration based on the origin of the license).

Offline activation
You can use a license file from the ESET Business Account portal to activate ESMC and other ESET security
products. Each offline license file is generated only for one product, e.g. ESET Endpoint Security. Offline license
shall be used only for clients that will never have access to ESET License servers (even if a client is connected to
internet via proxy with access limited only to ESET services, do not use offline license). It is not possible to create
an offline license file from a subscription license.
To replace an existing offline license, you have to
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1.Remove the old license in ESMC and license file in ESET Business Account.
2.Create new offline license in ESET Business Account.
3.Import the new license to ESMC
4.Reactivate products with the new license.

Important
Only Administrators whose home group is set to All, with Write permission for licenses in the home
group can add or remove licenses. Each license is identified by its Public ID and can contain one or
more units. Licenses can only be distributed by the Administrator to other users with sufficient
permissions. A license is not reducible.

Offline license file
To create and import an offline license file, follow this procedure:
1.Open the ESMC License Management and click Actions > Add Licenses.
2.Select Offline License File and copy a specific License File Token.

3.Log in to your ESET Business Account where you have imported your license.
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4.Select the license you want to export and select Create offline files.
5.Select a product for this license file, enter the Name of the file and its Units count (number of seats
exported to the license file).
6.Select the check box next to Allow management with ESET management console and enter the ESET
management console token (License File Token from ESMC).

7.Click Generate.

To download the file follow this procedure:
1.Select the license and click Show details.
2.Select the tab Offline files.
3.Click the license file you have created, you can distinguish it by name and select Download.
Go back to ESMC License Management:
1.Click Choose File and select the offline license file you have exported in ESET Business Account.
2.Click Upload and then click Add licenses.
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Access Rights
Access rights let you manage ESMC Web Console users and their permissions.

The security model
These are key terms used in the security model:
Term
Explanation
Home Group Home Group is the group where all objects (devices, tasks, templates, etc.) a user creates are
automatically stored. Each user must only have one home group.
Object
Objects are located in Static Groups. Access to objects is by groups, not users (providing access by
group makes it easy to accommodate multiple users, for example, if one user is on holiday).
Server tasks and notifications are exceptions that require an "executing" user.
Access Group Access Group functions as a static group which allows users to filter the location of the object
based on access rights.
Administrator A user that has home group All with a full Permission Set over the group is effectively an
administrator.
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Access Right

The right to access an object or to execute a task is assigned with a Permission Set. See the list of
all access rights and their functions for more details.
Permission Set A Permission Set represents the permissions for users that access ESMC Web Console. They
define what the user can see or do in ESMC Web Console. A user can be assigned multiple
Permission Sets. Permission sets are applied only over objects in defined groups. These Static
Groups are set in the Static Groups section when creating or editing a permission set.
Functionality A functionality is one type of object or action. Typically, functionalities get these values: Read,
Write, Use. The combination of functionalities applied to an Access Group is called a Permission
Set.

List of Access Rights related examples
There are various examples across Administration guide concerning access rights. This is a list of them:
• How to duplicate policies
• Difference between Use and Write
• How to create a solution for branch office admins
• How to share objects via duplication
• How to divide access to certificates and authorities
• How to allow user to create installers
• How to remove notifications
• How to create policies
• Allow users to see all policies
• Share licenses among branch admins

Users
User management is part of the More section of the ESMC Web Console. There are two user types:
• Native Users - User accounts created and managed from the ESMC Web Console.
• Mapped Domain Security Groups - User accounts managed and authenticated by Active Directory.

Important
A fresh ESMC setup has the Administrator (Native User with home group All and access to
everything) as the only user.
• We do not recommend using this user account on a regular basis. We strongly advise that you
create another administrator account or use Administrators from Mapped Domain Security Groups
with the Administrator Permission Set assigned to them. Use the default administrator account only
as a backup option.
• You can also create additional users with narrower access rights based on your desired
competences.
• Optionally, you can set up Two-Factor Authentication for Native Users and Mapped Domain
Security Groups. This will increase security when logging into and accessing ESMC Web Console.
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Branch office admins solution
Example
If a company has two offices, each with local admins, they need to be assigned with more
permission sets for different groups.
Let's say there are admins John in San Diego and Larry in Sydney. Both of them need to take care
only of their local computers, use Dashboard, Policies, Reports and Dynamic Groups Templates
with their machines. The main Administrator has to follow these steps:
1.Create new Static Groups: San Diego office, Sydney office.
2.Create new Permission sets:
a.Permission set called Sydney permission set, with Static Group Sydney office, and with full access
permissions (exclude Server Settings).
b.Permission set called San Diego permission set, with Static Group San Diego office, and with full
access permissions (exclude Server Settings).
c.Permission set called All Group / Dashboard, with Static Group All, with the following permissions:
• Read for Client Tasks
• Use for Dynamic Group Templates
• Use for Reports and Dashboard
• Use for Policies
• Use for Send Email
• Use for Send SNMP Trap
• Use for Export report to file
• Use for Licenses
• Write for Notifications
3.Create new user John with home group San Diego office, assigned with the permission sets San
Diego permission set and All Group / Dashboard.
4.Create new user Larry with home group Sydney office, assigned with the permission sets Sydney
permission set and All Group / Dashboard.
If permissions are set like this, John and Larry can use same tasks and policies, reports and
dashboard, use dynamic group templates without restrictions; however each can only use
templates for machines contained in their home groups.

Sharing objects
If an Administrator wants to share objects, such as dynamic group templates, report templates, or policies, the
following options are available:
• Move those objects into shared groups
• Create duplicate objects and move them into static groups which are accessible to other users (see the
example below)
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Example
For an object duplication the user needs to have Read permission on the original object and Write
permission on his Home Group for this type of action.
Administrator, whose home group is All, wants to share Special Template with user John. The
template was originally created by Administrator, therefore it is automatically contained in the
group All. Administrator will follow these steps:
1.Navigate to More > Dynamic Group Templates.
2.Select the Special Template and click Duplicate, if needed, set name and description and click
Finish.
3.The duplicated template will be contained in the home group of Administrator, group All.
4.Navigate to More > Dynamic Group Templates and select the duplicated template, click Access
Group >
Move and select the destination static group (where John has permission). Click OK.

How to share objects among more users via Shared Group
To better understand how the new security model works, see the scheme below. There is a situation where there
are two users created by the administrator. Each user has his own home group with objects he has created. San
Diego permission set gives John rights to manipulate Objects in his home group. The situation is similar for Larry.
If these users need to share some objects (for example, computers), these objects should be moved to Shared
Group (a static Group). Both users should be assigned with Shared permission set which has Shared Group listed
in the Static Groups section.

San Diego office

Objects I.

San Diego permission set

John

Obje

Shared permis
Larry

Ob

Shared Group

Sydney pe
Filters and layout customization
You can customize the current Web Console screen view:
• Add filters and filter presets.
285

Sydney office

• You can use tags for filtering the displayed items.

Create a Native User
To create a new native user, click More > Users > Add New > New Native User.

Note
In order to create the user properly, we recommend you follow these steps:
1.Decide which static group will be the user's home group. If needed, create the group.
2.Decide what permission set would be best for the user. If needed, create new permission set.
3.Follow this chapter and create the user.

Basic
Enter a User name and an optional Description for the new user.
Click Select tags to assign tags.
Select Home Group. This is static group where all objects created by this user will be automatically contained.

Set Password
The password for the user should have at least 8 characters. The password should not contain the username.
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Account
Enabled - Select this option unless you want the account to be inactive (you intend to use it later).
Password change required - Select this option to force the user to change their password the first time they log
into the ESMC Web Console.
Password expiration (days) - This option defines the number of days the password is valid (you need to change
the password after it expires).
Autologout (min) - This option defines the idle time period (in minutes) after which the user is logged out of Web
Console. Type 0 (zero) to disable autologout for the user.
Full Name, Email contact and Phone contact can be defined to help identify the user.

Permission Sets
You can assign multiple permission sets to a user.
You can select a pre-defined competence (listed below) or you can use a custom permission set.
• Reviewer permission set - Read-only rights for the All group.
• Administrator permission set - Full access to the All group.
• Server assisted installation permission set - Minimum access rights required for server assisted
installation.
• Enterprise Inspector reviewer permission set - Minimum read-only access rights (for the All group)
required for an ESET Enterprise Inspector user.
• Enterprise Inspector server permission set - Access rights (for the All group) required for ESET Enterprise
Inspector installation process and further automatic synchronization between ESET Enterprise Inspector and
ESMC.
• Enterprise Inspector user permission set - Write access rights (for the All group) required for an ESET
Enterprise Inspector user.
Each permission set provides permissions only for objects contained in the Static Groups selected in the
permission set.
Users without any permission set will not be able to log in to the Web Console.

Warning
All pre-defined permission sets have the All group in the Static Groups section. Be aware of this
when assigning it to a user. Users will have these permissions over all objects in ESMC.

Summary
Review the settings configured for this user and click Finish to create the user.
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User actions and user details
To manage a user, select the applicable user and select one of the available actions:
Actions
•
•
•
•
•

Show Details - View user details.
Tags - Edit tags (assign, unassign, create, delete).
Assign permission sets - Assign a permission set to the user.
Edit - Edit user settings.
Delete - Delete the user.

Two-Factor Authentication
•
•
•
•

Enable - Enable the Two-Factor Authentication for the user.
Disable - Disable the exisitng Two-Factor Authentication for the user.
Reset - Reset the Two-Factor Authentication settings for the user.
Unlock - If the user has been locked, you can unlock the user using this setting.

Access Rights
•
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Access Group >

Move - Move the user to another Static Group.

User details
There are two sections in user details:
• Overview - Basic information about the user. You can manage the user using the Actions and Two-Factor
Authentication buttons at the bottom.
• Permission Sets - The list of permission sets assigned to the user. Click a permission set to manage it.

Change user password
You can change the password for any user to whom you have access rights. You need the Write permission for the
static group, where the user is stored. The user is stored in the home group of the parent user.
1.Navigate to Access rights > Users.
2.Select the user and click Edit in the menu.
3.In the Basic section, scroll to Set Password.
4.If you are editing the signed-in user, you need to fill in Current password. When editing other users, it is
pre-filled.
5.Enter the new password to Password and Confirm Password fields.
6.Click Finish.
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Map Domain Security Group users
You can map a domain security group to the ESMC Server and allow existing users (members of these domain
security groups) to become ESMC Web Console users.

Note
This feature is only available for systems with Active Directory. It cannot be used with LDAP.
To access the Mapped Domain Security Group Wizard, navigate to More > Users > Add New > New Mapped
domain security group.

Basic
Domain group
Enter a Name for the group. You can also enter a group Description.
Click Select tags to assign tags.
Select Home Group. This is static group where all objects created by users from this domain group will be
automatically contained.
This domain group will be defined by a Group SID (security identifier). Click Select to select a group from the list
and then click OK to confirm. Your ESMC Server must be joined in the domain, otherwise there will be no groups
in the list. If you are using Virtual Appliance, see the related chapter.
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Note
If you keep getting an error message after clicking Select and you have AD set up well, the
background process might be time outed. You can:
• enter the SID manually to bypass the issue
• enter your AD credentials to Server Settings > Advanced Settings > Active Directory. ESMC then
uses a different, faster way to retrieve the list of SIDs.

Account
Enabled - Select this option unless you want the account to be inactive (if you intend to use it later).
Autologout (min) - This option defines the idle time period (in minutes), after which the user is logged out of Web
Console.
Email contact and Phone contact can be defined to help identify the group.

Permission Sets
Assign competences (rights) for the users from this group.

Note
The permission sets are set for the Active Directory domain security group (instead of for individual
users, as in the Native User case).
You can assign multiple permission sets to a domain security group.
You can select a pre-defined competence (listed below) or you can use a custom permission set.
• Reviewer permission set - Read-only rights for the All group.
• Administrator permission set - Full access to the All group.
• Server assisted installation permission set - Minimum access rights required for server assisted
installation.
• Enterprise Inspector reviewer permission set - Minimum read-only access rights (for the All group)
required for an ESET Enterprise Inspector user.
• Enterprise Inspector server permission set - Access rights (for the All group) required for ESET Enterprise
Inspector installation process and further automatic synchronization between ESET Enterprise Inspector and
ESMC.
• Enterprise Inspector user permission set - Write access rights (for the All group) required for an ESET
Enterprise Inspector user.
Each permission set provides permissions only for objects contained in the Static Groups selected in the
permission set.
Users without any permission set will not be able to log in to the Web Console.

Warning
All pre-defined permission sets have the All group in the Static Groups section. Be aware of this
when assigning it to a user. Users will have these permissions over all objects in ESMC.
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Summary
Review the settings configured for this user and click Finish to create the group.
Users will appear in the Mapped Domain Security Groups after they first log in.

Assign a Permission Set to a User
1.There a two ways to assign a permission set to a user:
a)Click More > Users > click a user and select
Assign Permission Sets to assign specific permission sets
to the user.
b)In the Users section, edit a specific user by clicking Edit.

2.Select the check box next to a specific Permission Set in the Unassigned (Available) Permission Sets section.
See Manage Permission Sets for more details.
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Two-Factor Authentication
• Two-Factor Authentication (2FA) provides a more secure method to log into and access ESMC Web
Console.
• 2FA is provided by ESET using ESET Secure Authentication technology. You do not need to deploy or install
ESET Secure Authentication within your environment, as ESMC automatically connects to ESET servers to
authenticate users who log into your ESMC Web Console.
• Users with 2FA enabled will be required to log into ESET Security Management Center using ESET Secure
Authentication.
• For more information about product features and benefits, visit the ESET Secure Authentication product
page.
• There is no limit to the number of users who can log into ESMC via ESA 2FA.
• HTTP Proxy settings are not applied for communication with Secure Authentication servers (2FA).
• In ESMC 7.1 and later, you can enable 2FA also for the Administrator account.

Prerequisites
• To enable 2FA for another user's account, one needs to have Write permission over that user. Once
enabled, a user needs to configure 2FA themselves before they can log in. Users will receive a link via text
message (SMS), which they can open in their phone's web browser to view instructions for configuring 2FA.
• 2FA does not work without direct network access to ESET 2FA servers. Allowing at least specific 2FA
servers in the firewall is necessary. If the proxy is set-up in the More > Server Settings > Advanced Settings >
HTTP Proxy, it does not apply for the 2FA.

Note
You cannot use users with 2FA for server assisted installations.
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How to enable Two-Factor Authentication for a Web Console user?
1.Create a new user or use an existing one.
2.Navigate to More > Users in the ESMC Web Console.
3.Click the user and select Two-Factor Authentication > Enable.
4.Upon the user's next login, enter the user's phone number when prompted.
5.Install ESET Secure Authentication mobile app on the user's mobile phone using the link from SMS or QR
code.
6.When the app is installed using the token, your ESMC instance is added in the app.
7.Proceed to login and enter the one-time password from the mobile app to the Web Console when
prompted. A new password is generated in the mobile app for each login.

Permission Sets
A permission set represents the permissions for users that access ESMC Web Console. They define what the user
can do or see in the Web Console. Native users have their own permissions while domain users have the
permissions of their Mapped security group. Each permission set has its domain of application (static groups).
Permissions which are selected in the Functionality section will apply over objects in the groups which are set in
the Static Groups section for each user assigned by this permission set. Having access to certain Static Group
automatically means access to every one of its subgroups. With proper setting of static groups it is possible to
build separated branches for local admins (see the example).
A user can be assigned a permission set even without being able to see it. A permission set is also an object which
is automatically stored in the home group of the user who created it. When a user account is created, the user is
stored as object in the home group of the creating user. Usually the Administrator creates users, so they are
stored in the group All.
Permission sets are additive. If you assign more permission sets to a single user, the sum of all permission sets is
the resulting access that the user has.

Combining of more permission sets
The final access user has to an object is the result of the combination of all permission sets assigned to the user.
For example, a user has two permission sets, one for homegroup with full permissions and another one for a
group with computers, only with permissions Read, Use for Computer & Groups. This user can run all tasks from
homegroup on computers in the other group.
In general, a user can run objects from one static group over objects in another static group, if the user has
permissions for certain object type in the certain group.

The Access Group filter button allows users to select a static group and filter
viewed objects according to the group where they are contained.
You can use tags for filtering the displayed items.
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Important
Good practice for working with permissions:
• Never give access to Server Settings to inexperienced users - only Administrator should have this
access.
• Consider restricting access to Client Tasks > Run Command - it is a very powerful task that could
be abused.
• Non-admin level users should not have permissions for Permission Sets, Native Users, Server
Settings.
• If a more complex model of permissions is needed, do not hesitate to create more permission
sets and assign them accordingly.
After setting permissions to ESMC functionality, you can also assign Read, Use, Write access to User Groups.

Duplication
Example
For an object duplication the user needs to have Read permission on the original object and Write
permission on his Home Group for this type of action.
John, whose home group is John’s Group, wants to duplicate Policy 1, which was originally created
by Larry, therefore the policy is automatically contained in Larry's home group, Larry's Group.
1.Create a new static group. Name it, for example, Shared policies.
2.Assign both John and Larry with Read permissions for Policies in the group Shared policies.
3.Larry moves Policy 1 to the Shared policies group.
4.Assign John with Write permissions for Policies in his home group.
5.John can now Duplicate the Policy 1 - duplicate will appear in his home group.
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Difference between Use and Write
Example
If Administrator does not want to allow user John to modify policies in the Shared policies group, he
would create a permission set with:
• Functionality Policies: Read and Use permissions selected
• Static Groups: Shared Policies
With these permissions assigned to John, John is able to run those policies but he cannot edit them,
create new, nor delete them. If an administrator were to add Write permission, John could create
new, edit and delete policies within the selected static group (Shared policies).

Manage Permission Sets

To manage a permission set, click the permission set and select one of the available actions:
Permission Set
•
Show Details - View permission set details.
•
Tags - Edit tags (assign, unassign, create, delete).
•
Edit - Edit the permission set.
•
Duplicate - Create a duplicate permission set which you can modify and assign to a specific user. The
duplicate will be stored in the home group of the user who duplicated it.
•
Delete - Delete the permission set.

Assignments
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•
•

Show native users - Show the list of assigned native users.
Show mapped security groups - Show the list of assigned mapped domain security groups.

Access Rights
•

Access Group >

Move - Move the permission set to another Static Group.

Warning
All pre-defined permission sets have the All group in the Static Groups section. Be aware of this
when assigning it to a user. Users will have these permissions over all objects in ESMC.

Create or edit a permission set
To create a new permission set, click New. To edit an existing permission set, select the applicable permission set
and click Edit.

Basic
Enter a Name for the set (mandatory setting). You can also enter a Description and Tags.
Click Select tags to assign tags.

Static Groups
You can Add static group (or multiple Static Groups) that will take this competence. Permissions that are checked
in the Functionality section will apply over objects contained in groups selected in this section.

Functionality
Select individual modules for which you want to grant access. The user with this competence will have access to
these specific tasks. It is also possible to set different permissions for each type of Server Task and Client Task.
There are available four pre-defined functionality sets. Select one of the four or select manually functionality
check boxes.
Granting Write permission automatically grants Use and Read rights; granting Use rights automatically grants
Read rights.

User Groups
You can add a User Group (or multiple User Groups) whose user parameters can be used inside a policy (for
example ESET Mobile Device Management for iOS or Override Mode).

297

Users
Choose a user to be assigned by this permission set. All available users are listed on the left. Select specific users
or select all users using the Add All button. Assigned users are listed on the right. It is not mandatory to assign a
user, you can do it later.

Summary
Review the settings configured for this competence and click Finish. The permission set is stored in the Home
Group of the user who created it.
Click Save as to create a new permission set based on the permission set you are editing. You will be required to
enter a name for the new permission set.

List of permissions
Permission types
When creating or editing a permission set in More > Permission Sets > New / Edit > Functionality there is a list of
all available permissions. ESMC Web Console permissions are divided into categories; for example, Groups &
Computers, Native Users, Certificates, Policies and so on. A given permissions set can allow for Read, Use or
Write access. In general:
Read permissions are good for auditing users. They can view data but cannot make changes.
Use permissions allow users to use objects, run tasks, but not modify or delete.
Write permissions allow users to either modify respective objects and/or duplicate them.
Certain types of permissions (listed below) control a process, not an object. That is why they work on a global
level, so it does not matter which static group is the permission applied on, it will work regardless. If the process is
allowed to a user he can use it only over objects for which he has sufficient permissions. For example, the Export
report to file permission enables the exporting functionality, however data contained in the report are
determined by other permissions.

Example
Read our Knowledgebase article with example tasks and permission sets that user needs to
successfully perform the tasks.
Users can be assigned permissions for the following processes:
• Agent Deployment
• Reports and Dashboard (only the functionality of the Dashboard will be available, the usable report
templates are still dependent on accessible static groups)
• Send Email
• Export report to file
• Send SNMP Trap
• Server Settings
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• Enterprise Inspector Administrator
• Enterprise Inspector User

Functionality types:
Groups & Computers
Read - List computers, groups and computers within a group.
Use - Use a computer/group as a target for a policy or task.
Write - Create, modify and remove computers. This also includes renaming a computer or a group.

Enterprise Inspector Administrator
Write - Perform administrative functions in Enterprise Inspector.

Enterprise Inspector User
Read - Read only access to Enterprise Inspector.
Write - Read and write access to Enterprise Inspector.

Permission Sets
Read - Read the list of permission sets and the list of access rights within them.
Use - Assign/remove existing permission sets for users.
Write - Create, modify and remove permission sets.

Important
When assigning (or un-assigning) a permission set to a user, Use permission is required for
Permission Sets and Native Users.

Domain Groups
Read - List domain groups.
Use - Allows granting/revoking of permission sets.
Write - Create/modify/remove domain groups.
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Native Users
Read - List native users.
Use - Allows granting and revoking of permission sets.
Write - Create/modify/remove native users.

Agent Deployment
Use - Allow access to deploy Agent via Quick Links or to add client computers manually in ESMC Web Console.

Stored Installers
Read - List stored installers.
Use - Export stored installer.
Write - Create/modify/remove stored installers.

Certificates
Read - Read the list of peer certificates and Certification Authorities.
Use - Export Certification Authorities and peer certificates and use them in installers or tasks.
Write - Create new peer certificates or Certification Authorities and revoke them.

Server Tasks & Triggers
Read - Read the list of tasks and their settings (except of sensitive fields like passwords).
Use - Execute an existing task with Run Now (as the user currently logged to the Web Console).
Write - Create, modify and remove server tasks.
Categories can be expanded by clicking the sign

and single or multiple types of server tasks can be selected.

Client Tasks
Read - Read the list of tasks and their settings (except of sensitive fields like passwords).
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Use - Schedule execution of existing Client Tasks or cancel their execution. Note that for assignment of tasks (or
assignment cancellation) to targets (computers or groups) additional Use access is required for the affected
targets.
Write - Create, modify or remove existing Client Tasks. Note that for assignment of tasks (or assignment
cancellation) to targets (computers or groups) additional Use access is required for the affected target objects.
Categories can be expanded by clicking the sign

and single or multiple types of Client Tasks can be selected.

Dynamic Groups Templates
Read - Read the list of Dynamic Groups templates.
Use - Use existing templates for dynamic groups.
Write - Create, modify and remove Dynamic Group templates.

Encryption recovery
Read
Use

Reports and Dashboard
Read - List report templates and their categories. Generate reports based on report templates. Read your own
dashboards based on default dashboards.
Use - Modify your own dashboards with available report templates.
Write - Create, modify, remove existing report templates and their categories. Modify default dashboards.

Policies
Read - Read the list of policies and configuration within them.
Use - Assign existing policies to targets (or cancel their assignment). Note, that for the affected targets additional
Use access is necessary.
Write - Create, modify and remove policies.

Send Email
Use - Send emails. (Useful for Notifications and Generate Report server tasks.)
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Send SNMP Trap
Use - Allows to send SNMP trap (useful for Notifications).

Export report to file
Use - Allows you to store reports on the ESMC Server machine file system. Useful with the Generate Report server
tasks.

Licenses
Read - Read the list of licenses and their usage statistics.
Use - Use the license for activation.
Write - Add and remove licenses. (The user must have home group set to All. By default only the Administrator
can do it.)

Notifications
Read - Read the list of notifications and their settings.
Write - Create, modify, remove notifications. For proper notification handling additional Use access rights may be
required for Send SNMP Trap or Send Email depending on the notification configuration.

Server Settings
Read - Read server settings.
Write - Modify server settings.

Audit log
Read - Read the Audit log report.

Certificates
Certificates are an important part of ESET Security Management Center, they are required for ESMC components
to communicate with ESMC Server. To make sure all components can communicate correctly, all Peer Certificates
need to be valid and signed by the same Certification Authority. Read more about certificates in ESMC in our
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Knowledgebase article.
You have a few options when it comes to certificates:
• You can use certificates that were automatically created during ESMC installation.
• You can create new Certification Authority (CA) or Import Public Key which you will use to sign the Peer
Certificate for each of the components (ESET Management Agent, ESMC Server, ESMC MDM or Virtual Agent
Host).
• You can use your custom Certification Authority and certificates.

Note
If you plan to migrate from ESMC Server to a new server machine, you must export/back up all
Certification Authorities you are using, as well as ESMC Server Certificate. Otherwise none of the
ESMC components will be able to communicate with your new ESMC Server.
You can create a new Certification Authority and Peer Certificates in ESMC Web Console, follow the instructions
in this guide to:
• Create a new Certification Authority
oImport a Public Key
oExport a Public Key
oExport a Public Key in BASE64 format
• Create a new Peer Certificate
oCreate a Certificate
oExport a Certificate
oCreate an APN/ABM certificate
oRevoke a certificate
oCertificate usage
oSet new ESMC Server certificate
oCustom certificates with ESET Security Management Center
oExpiring Certificate - reporting and replacement

Important
macOS / OS X does not support Certificates with expiry date January 19, 2038 and later. ESET
Management Agent running on macOS / OS X will not be able to connect to ESMC Server.
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Note
• For all Certificates and Certification Authorities created during installation of ESMC components,
the Valid from value is set to 2 days before certificate creation.
• For all Certificates and Certification Authorities created in the ESMC Web Console, the Valid from
value is set to 1 day before certificate creation. The reason for this is to cover all possible time
discrepancies between affected systems.
For example, a Certification Authority and Certificate, created 2017 Jan 12 during installation will
have a pre-defined Valid from value of 2017 Jan 10 00:00:00, and a Certificate Authority and
Certificate created 2017 Jan 12 in ESMC Web Console will have a pre-defined Valid from value of
2017 Jan 11 00:00:00.

Peer Certificates
If a Certification Authority is present on you system, you should create a peer certificate for individual ESET
Security Management Center components. Each component (ESET Management Agent and ESMC Server) requires
a specific certificate.
New
This option is used to create a new certificate. These certificates are used by the ESET Management Agent and
ESMC Server.
APN/ABM Certificate
This option is used to create a new APN/ABM certificate. This certificate is used by the MDM. This action requires
a valid license.
Certificate usage
You can also check which clients are using this ESMC certificate.
Tags
Edit tags (assign, unassign, create, delete).
Edit
Select this option to edit a description of an existing certificate from the list.
Export
This option is used to export a certificate as a file. This file is necessary if you install the ESET Management Agent
locally on a computer or when installing MDM.
Export as Base64
This option is used to export a certificate as a .txt file.
Revoke
If you no longer want to use a certificate, select Revoke. This option invalidates the certificate permanently, the
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certificate is effectively blacklisted. This information is sent to ESET Management Agents during the next
connection. Revoked certificates will not be accepted by ESET Security Management Center.

Important
Make sure there are no ESET Management Agents (or other components) left using the certificate
before you revoke it. Once the certificate is revoked, components will not be able to connect to
ESMC Server. Reinstall components using a valid certificate to restore functionality.
Access Group
A certificate or a authority can be moved to other group. Then it becomes available to users who have sufficient
rights for this group. To easily find a certificate's home group select the certificate and click
Access Group in
the drop down menu. The home group of the certificate is displayed in the first line of the pop up menu (for
example, /All/San Diego. See our sample scenario to learn more about sharing certificates).

Important
You will see only those certificates located in your home group (assuming you have read permission
for certificates). Certificates which are created during the ESMC installation are located in the All
group and only administrators have access to them.
Show Revoked - shows you all revoked certificates.
Agent certificate for server assisted installation - This certificate is generated during server installation if you
select the Generate certificates option.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.

Create a new Certificate
As part of the installation process, ESET Security Management Center requires that you create a Peer certificate
for Agents. These certificates are used to authenticate communication between the Agent on client device and
ESMC Server.

Note
There is one exception, an Agent certificate for server assisted installation cannot be created
manually. This certificate is generated during server installation, provided that Generate certificates
is selected.
To create a new certificate in the ESMC Web Console, navigate to More > Peer Certificates and click Actions >
New.
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Basic
Description - Enter description for the certificate.
Click Select tags to assign tags.
Product - Select the type of certificate you want to create from the drop-down menu.
Host - Leave the default value (an asterisk) in the Host field to allow for distribution of this certificate with no
association to a specific DNS name or IP address.

Important
When creating the MDM certificate, fill in the IP address or Hostname of the MDM Host device. The
default value (an asterisk) is not valid for this type of certificate.
Passphrase - We recommend that you leave this field blank, but you can set a passphrase for the certificate that
will be required when clients attempt to activate.

Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.

Attributes (subject)
These fields are not mandatory, but you can use them to include more detailed information about this certificate.
Common name - This value should contain the string "Agent" or "Server", according to the selected Product. If
you want, you can enter descriptive information about the certificate. Enter the Valid from and Value to values to
ensure that the certificate is valid.

Note
• For all Certificates and Certification Authorities created during installation of ESMC components,
the Valid from value is set to 2 days before certificate creation.
• For all Certificates and Certification Authorities created in the ESMC Web Console, the Valid from
value is set to 1 day before certificate creation. The reason for this is to cover all possible time
discrepancies between affected systems.
For example, a Certification Authority and Certificate, created 2017 Jan 12 during installation will
have a pre-defined Valid from value of 2017 Jan 10 00:00:00, and a Certificate Authority and
Certificate created 2017 Jan 12 in ESMC Web Console will have a pre-defined Valid from value of
2017 Jan 11 00:00:00.

Sign
Select from two signing methods:
• Certification authority - If you would like to sign using the ESMC Certification Authority (created CA
during ESMC installation).
oSelect the ESMC Certification Authority from the list of certification authorities
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oCreate a new certification authority
• Custom pfx file - To use a custom .pfx file, click Browse, navigate to your custom .pfx file and click OK.
Select Upload to upload this certificate to the Server. You can not use the custom made certificate.

Note
If you would like to sign a new certificate using the ESMC CA (created during ESMC installation) in
ESMC Virtual Appliance, it is necessary to enter a Certification Authority Passphrase. This is the
password you specified during ESMC VA configuration.

Summary
Review the certificate information you entered and click Finish. The certificate is now successfully created and will
be available in the Certificates list to use when installing the Agent. The certificate will be created in your home
group.

Note
As an alternative to creating a new certificate, you can Import a Public Key, Export a Public Key or
Export a Peer Certificate.

Export Peer Certificate
Export Peer Certificates
1.Select the Peer Certificates you want to use from the list and select the check box next to it.
2.From the context menu select Export. The certificate will be exported (including private key) as a .pfx
file. Type a name for your certificate and click Save.

Export as Base64 from Peer Certificates
Certificates for ESMC components are available in Web Console. To copy the contents of a certificate in Base64
format, click More > Peer Certificates, select a certificate and then select Export as Base64. You can also
download the Base64 encoded certificate as a file. Repeat this step for other component certificates as well as for
your Certification Authority.
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Note
To export a certificate a user is required to have Use rights over Certificates. See the full list of
access rights for more information.

APN/ABM certificate
An APN (Apple Push Notification) / ABM (Apple Business Manager) certificate is used by ESMC MDM for iOS
device enrollment. You must create an Apple-provided push certificate and get it signed by Apple before you can
enroll iOS devices in ESMC. Also make sure you have a valid license for ESMC.
Click the More tab > Peer Certificates, click New and then select APN/ABM Certificate.

Note
To acquire an APN certificate, you will need an Apple ID. This ID is required for Apple to sign the
certificate.
APN Certificate has 1-year validity. If your certificate is close to expiring, follow the steps below and
in the Certificate part step 2, select Renew.
To acquire a ABM enrollment token, you will need an Apple ABM Account.

Create Request
Specify the certificate attributes (Country code, Organization name, etc.) and click Submit Request.
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Download
Download your CSR (Certification Signing Request) and Private Key.

Certificate
1.Open the Apple Push Certificates Portal and log in using your Apple ID.
2.Click Create a Certificate.
3.Fill in the note (optional). Click Choose File, upload the CSR file you downloaded in the previous step and
then click Upload.
4.After some time, you will see a new confirmation screen with the notification that your APNS certificate
for ESET Mobile Device Management server was successfully created.
5.Click Download and save the .pem file to your computer.
6.Close the Apple Push Certificate Portal and continue to the Upload section below.
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Important
APNS certificate is required for both ABM and non-ABM MDC policy.
If you are creating a ABM Enrollment certificate, continue here.

Upload
Once you have completed the steps above, you can create a Policy for MDC to activate APNS for iOS enrollment.
You can then Enroll any iOS device by visiting https://<mdmcore>:<enrollmentport>/unique_enrollment_token
from the device's browser.

Show revoked
This list displays all certificates that have been created and then invalidated by the ESMC Server. Revoked
certificates will automatically be removed from the main Peer certificate screen. Click Show Revoked to view
certificates that have been revoked from the main window.
To revoke a certificate, follow the steps below:
1.Go to More > Peer Certificates > select a certificate and click Revoke.
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2.Specify the Reason for revocation and click Revoke.
3.Click OK. The certificate will disappear from the list of Peer Certificates. To see previously revoked
certificates, click Show revoked button.

Set new ESMC Server certificate
Your ESMC Server certificate is created during installation and distributed to ESET Management Agents and other
components to allow communication to the ESMC Server. If necessary, you can configure ESMC Server to use a
different peer certificate. You can use ESMC Server certificate (generated automatically during installation) or a
Custom certificate. The ESMC Server certificate is required for a secure TLS connection and authentication. The
Server certificate is used to make sure that ESET Management Agents and ESMC Proxies do not connect to an
illegitimate server.
1.Click More > Server Settings > expand section Connection, select Change certificate.
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2.Choose from the two Peer certificate types:
• Security Management Center certificate - click Open certificate list and select the certificate to use.
• Custom certificate - browse to your custom certificate and then click OK and Save. If you are performing a
migration, select the ESMC Server certificate .pfx file you exported from your old ESMC Server.

3.Restart the ESMC Server service, see our Knowledgebase article.
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Custom certificates with ESMC
If you have your own PKI (public key infrastructure) and want ESET Security Management Center to use your
custom certificates for communication between components, see the example below. This example is performed
on Windows Server 2012 R2. Screen shots may vary on other versions of windows, however the general
procedure is unchanged.

Note
You can use OpenSSL to create new certificates. For more information, see our Knowledgebase
article.
Required server roles:
• Active Directory Domain Services.
• Active Directory Certificate Services with the Stand-Alone Root CA installed.

1.Open Management Console and add Certificates Snap-ins:
a)Log on to the server as a member of the local Administrator group.
b)Run mmc.exe to open Management Console.
c)Click File and select Add/Remove Snap-in… (or press CTRL+M).
d)Select Certificates in the left pane and click Add.
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e)Select Computer Account and click Next.
f)Make sure Local Computer is selected (default) and click Finish.
g)Click OK.
2.Create a Custom Certificate Request:
a)Double-click Certificates (Local Computer) to expand it.
b)Double-click Personal to expand it. Right-click Certificates and select All Tasks > Advanced Operations
and choose Create Custom Request.

c)The Certificate Enrollment wizard window will open, click Next.
d)Select Proceed without enrollment policy and click Next to continue.
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e)Choose (No Template) Legacy Key from the drop-down list and make sure that the PKCS #10 Request
format is selected. Click Next.
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f)Click the arrow to expand the Details section and then click Properties.
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g)In the General tab, type in a Friendly name for your certificate, you can also type a Description (optional).
h)In the Subject tab, do the following:
In Subject name section, select Common Name from the drop-down list under Type, enter era server in the
Value field and then click Add. CN=era server will appear in the information box on the right. If you are creating
a certificate request for ESET Management Agent type era agent in the Common name value field.

Important
The Common Name must contain one of these strings: "server"or "agent", depending on which
Certificate Request you want to create.
i)In the Alternative name section, choose DNS from the drop-down list under Type and enter * (asterisk)
into the Value field, then click the Add button.

Important
Subject Alternative Name (SAN) should be defined as "DNS:*" for ESMC Server and for all the
Agents.

j)In the Extensions tab, expand the Key usage section by clicking the arrow. Add the following from the
Available options: Digital signature, Key agreement, Key encipherment. Deselect Make these key usages
critical.
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Important
Make sure to select these 3 options under Key usage > Key certificate signing:
• Digital signature
• Key agreement
• Key encipherment

k)In the Private Key tab, do the following:
Expand the Cryptographic Service Provider section by clicking the arrow. A list of all cryptographic service
providers (CSPs) will be displayed. Make sure that only Microsoft RSA SChannel Cryptographic Provider
(Encryption) is selected.

Note
Deselect all CSPs other than Microsoft RSA SChannel Cryptographic Provider (Encryption).
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l)Expand the Key Options section. In the Key size menu, set a value of at least 2048. Select Make private
key exportable.
m)Expand the Key Type section and select Exchange. Click Apply and check your settings.
n)Click OK. Certificate information will be displayed. Click the Next button to continue. Click Browse to
select the location where the certificate signing request (CSR) will be saved. Type the file name and make
sure that Base 64 is selected.
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o)Click Finish to generate the CSR.
3.To import your custom certificate request, follow the steps below:
a)Open Server Manager and click Tools > Certification Authority.
b)In the Certification Authority (Local) tree, select Your Server (usually FQDN) > Properties and then select
the Policy Module tab. Click Properties and select Set the certificate request status to pending. The
administrator must explicitly issue the certificate. Otherwise, it will not work properly.You must restart
Active Directory certificate services if you need to change this setting.
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c)In the Certification Authority (Local) tree, select Your Server (usually FQDN) > All Tasks > Submit new
request and navigate to your previously generated CSR file from step 2.
d)The certificate will be added under Pending Requests. Select the CSR in the right navigation pane. In the
Action menu, select All Tasks > Issue.
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4.Export Issued Custom Certificate to .tmp file.
a)Select Issued Certificates in the left pane. Right-click the certificate you want to export and click All Tasks
> Export Binary Data.
b)In the Export Binary Data dialog, choose Binary Certificate from the drop-down list. In Export options,
click Save binary data to a file and then click OK.

c)In the Save Binary Data dialog box, move to the file location where you want to save the certificate and
then click Save.
5.Import the .tmp file.
a)Navigate to Certificate (Local Computer) > right-click Personal and select All Tasks > Import.
b)Click Next.
c)Locate your saved .tmp binary file using Browse and click Open. Select Place all certificates in the
following store > Personal. Click Next.
d)Click Finish to import the certificate.
6.Export the Certificate including a private key to .pfx file.
a)In Certificates (Local Computer) expand Personal and click Certificates, select your new certificate that
you want to export, on the Action menu, point to All Tasks > Export.
b)In the Certificate Export Wizard, click Yes, export the private key. (This option will appear only if the
private key is marked as exportable and you have access to the private key.)
c)Under Export File Format, select Personal Information Exchange -PKCS #12 (.PFX), select the check box
next to Include all certificates in the certification path if possible and then click Next.
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d)Password, type a password to encrypt the private key you are exporting. In the Confirm password field,
type the same password again and then click Next.

Important
The certificate passphrase must not contain the following characters: " \ These characters cause a
critical error during the initialization of the Agent.
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e)File name, type a file name and path for the .pfx file that will store the exported certificate and private
key. Click Next and then click Finish.

Note
The above example shows you how to create an ESET Management Agent certificate. Repeat the
same steps for ESMC Server certificates.
You can not use this certificate to sign another new certificate in the Web Console.
7.Export Certification Authority:
a)Open Server Manager and click Tools > Certification Authority.
b)In the Certification Authority (Local) tree, select the Your Server (usually FQDN) > Properties > General
tab and click View Certificate.
c)In the Details tab, click Copy to File. The Certificate Export Wizard will open.
d)In the Export File Format window, select DER encoded binary X.509 (.CER) and click Next.
e)Click Browse to select the location where the .cer file will be saved and then click Next.
f)Click Finish to export the certification authority.
For step-by-step instructions to use custom certificates in ESMC, see the next chapter.
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How to use custom certificate with ESMC
To continue from the previous chapter:
1.Import your 3rd party Certification Authority to ESMC Web Console.
2.Set new custom server certificate in ESMC Web Console.

Important
If you already have ESET Management Agents connecting to ESMC Server, apply a policy to change
the custom certificate for ESET Management Agents:
1.Open ESMC Web Console.
2.Click Policies > New. Type a name for the policy.
3.Expand Settings and select ESET Management Agent from the drop-down menu.
4.Expand Connection and click Change certificate next to Certificate.
5.Click Custom certificate and select the custom certificate for ESET Management Agent.
6.Type a certificate password and click OK.
7.Assign this policy to all clients.

3.Navigate to Start > Programs and Features, right-click ESET Management Agent and select Change.
4.Click Next and run Repair.
5.Leave the settings for Server host and Server port unchanged and then click Next.
6.Click Browse next to Peer certificate and locate the custom .pfx certificate file.
7.Type in the certificate password you specified in step 6.
8.Click Browse next to Certification authority and select .der file (public key) exported from Web Console.
It must be a public key that the custom certificate is signed by.
9.Click Next and complete the repair.
10. ESET Management Agent is now using a custom .pfx certificate.
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Expiring Certificate - reporting and replacement
ESMC is able to notify you about a Certificate or a Certification Authority that is going to expire. There are predefined Notifications for both ESMC Certificate and ESMC Certification Authority in the Notifications tab.
To activate this feature, click Edit Notification and specify details in the Distribution section, such as email address
or SNMP trap. Each user is able to see notifications only for those certificates which are in their home group
(given the user has assigned Read permissions for Certificates).

Note
Make sure you have configured SMTP connection settings in Server settings first. Once done, you
can edit notification to add Distribution email address.
If a computer has a certificate that is about to expire, its status information will automatically change. The status
will be reported to Dashboard, Computers list, Status Overview and Certificate tab:

To replace an expiring Certification Authority or Certificate, follow these steps:
1.Create new Certification Authority with a new validity period (if the old one is going to expire), ideally
setting it to be valid immediately.
2.Create a new Peer Certificates for ESMC Server and other components (Agent/MDM) within the validity
period of your new Certification Authority.
3.Create policies to set new Peer Certificates. Apply the policies to ESMC components, MDM and to ESET
Management Agent on all client computers in your network.
4.Wait until the new Certification Authority and Peer Certificates are applied and the clients were
replicated.
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Note
We recommend that you wait 24 hours or check if all of your ESMC components (Agents) have
replicated at least twice.
5.Replace Server certificate in ESMC Server Settings so that clients are able to authenticate using their new
Peer Certificates.
6.Once you have completed all the steps above, every client is connecting to ESMC and all is working as
expected, revoke old Peer Certificates and delete the old Certification Authority.

Certification Authorities
Certification Authorities are listed and managed in the Certification Authorities section. If you have multiple
Certification Authorities, you can apply a filter to sort them.

Note
Certification Authorities and certificates are accessed using the same permissions for the
Certificates function. Certificates and authorities created during installation, and those created
afterward by the administrator, are contained in the All static group. See the list of permissions for
more information on access rights.
Click Actions to manage the selected Certification Authority:
• New - Create a new Certification Authority
•
Tags - Edit tags (assign, unassign, create, delete).
•
Delete - Delete the selected certification authority
•
Import Public Key
•
Export Public Key
•
Access Group - A certification authority can be moved to another group to become available to users
who have sufficient rights for this group.

Filters and layout customization
You can customize the current Web Console screen view:
• Manage the side panel and main table.
• Add filters and filter presets. You can use tags for filtering the displayed items.
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Example
How to divide access to certificates and authorities
If Administrator does not want to allow the user John to access ESMC Certification Authorities, but
needs him to be able to work with certificates, the administrator has to follow these steps:
1.Create a new Static Group called Certificates.
2.Create new Permission set.
a.Name this permission set Permissions for certificates.
b.Add a group named Certificates in section Static Groups.
c.In the Functionality section, select Write for Certificates.
d.In the Users section, click
Native Users and select John.
e.Click Finish to save the permission set.
3.Move certificates from the All group to the newly created Certificates group:
a.Navigate to More > Peer Certificates.
b.Select the check boxes
next to the certificates you want to move.
c.Click Actions >
Access Group, select the Certificates group and then click OK.
Now, John is able to modify and use moved certificates. However, Certification Authorities are
safely stored out of this user's reach. John will not be able even to use existing authorities (from
group All) for signing any certificates.

Create a new Certification Authority
To create a new authority, navigate to More > Certification Authorities and click Action >
of the page.

New at the bottom

Certification Authority
Enter a Description of the Certification Authority and select a Passphrase. This Passphrase should contain at least
12 characters.

Attributes (Subject)
1.Enter a Common name (name) of the Certification Authority. Select a unique name to differentiate
multiple Certificate Authorities. Optionally, you can enter descriptive information about the Certification
Authority.
2.Enter the Valid from and Valid to values to ensure that the certificate is valid.

Note
• For all Certificates and Certification Authorities created during installation of ESMC components,
the Valid from value is set to 2 days before certificate creation.
• For all Certificates and Certification Authorities created in the ESMC Web Console, the Valid from
value is set to 1 day before certificate creation. The reason for this is to cover all possible time
discrepancies between affected systems.
For example, a Certification Authority and Certificate, created 2017 Jan 12 during installation will
have a pre-defined Valid from value of 2017 Jan 10 00:00:00, and a Certificate Authority and
Certificate created 2017 Jan 12 in ESMC Web Console will have a pre-defined Valid from value of
2017 Jan 11 00:00:00.
3.Click Save to save your new Certification Authority. It will now be listed in the Certification Authority list
under More > Certification Authorities, and is ready to be used. Certification authority is created in the
home group of the user who has created it.
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To manage the Certification Authority, select the check box next to the Certification Authority in the list and use
the context menu (left-click the Certification Authority) or the Action button on the bottom of the page. Available
options are Import Public Key and Export a Public key or Edit the Certification Authority.

Export a Public Key
To export a Certification Authority, click More > Certification Authorities.

Export a public key from a Certification Authority:
1.Select the Certification Authority you want to use from the list and select the check box next to it.
2.Select Actions >
Export Public Key. Select this option if you want to import the Public key to another
ESMC installation (migration from one server to another). The public key will be exported as a .der file.
Type a name for the public key and click Save.

Note
If you delete the default ESMC Certification Authority and create a new one, it will not work. Before
replacing the CA, you need to create and distribute Peer Certificates signed by the new CA. You also
need to change Server certificate in Server Settings and then restart the ESMC Server service.
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Export a public key as Base64 from a Certification Authority:
1.Select the Certification Authority you want to use from the list and select the check box next to it.
2.Select Actions >
Export Public Key as Base64. You can also download the Base64 encoded certificate
as a file.

Note
To export a public key a user is required to have Use rights over Certificates. See the full list of
access rights for more information.

Import a Public Key
To import a 3rd party Certification Authority, click More > Certification Authorities.
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1.Click Actions button and then select
Import Public Key.
2.Choose file to upload: click Browse and navigate to the file you want to import. You can import only a
.der file.
3.Enter a Description for the certificate and click Import. The Certification Authority is now successfully
imported.

Server Settings
In this section, you can configure specific settings for the ESET Security Management Center Server itself. These
settings are similar to Policies, but they are applied directly on the ESMC Server.

Connection
Security Management Center port (requires a restart) - This is the port for the connection between the ESET
Security Management Center Server and Agent(s). Changing this option requires restarting the ESMC Server
service for the change to take effect. A change of the port may require changes in firewall settings.
Web Console port (requires a restart) - Port for the connection between the ESMC Web Console and the ESMC
Server. A change of the port may require changes in firewall settings.
Advanced security (requires a restart) - This setting enables advanced security of network communication of the
ESMC components.
Certificate (requires a restart) - Here you can manage ESMC Server certificates. Click Change certificate and select
which ESMC Server certificate should be used by your ESMC Server. For more information, see Peer Certificates.

Important
These changes require a restart of the ESET Security Management Center Server service.
See our Knowledgebase article for instructions.

Updates
Update interval - Interval at which updates will be received. You can select a regular interval and configure the
settings or you can use a CRON expression.
Update server - Update server from which the ESMC Server receives updates for ESET product versions and ESMC
components. To update the ESMC 7.2 from a mirror (Mirror tool) set the full address of the era6 update folder
(according to your HTTP server root location). For example:
http://your_server_address/mirror/eset_upd/era6

Update type - Select the type of ESMC Server module updates you want to receive. You can find the current
version of installed ESMC Server modules in Help > About.
Regular update
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ESMC Server module updates will automatically be downloaded from the ESET
server with the least network traffic. Default setting.

Pre-release update

Delayed update

These updates have gone through thorough internal testing and will be available to
the general public soon. You can benefit from enabling pre-release updates by
having access to the most recent updates of ESMC Server modules. Pre-release
updates may help resolve an issue with ESMC Server in some cases. However, prerelease updates might not be stable enough at all times and should not be used on
production servers where maximum availability and stability are required. Prerelease updates are only available with AUTOSELECT defined in the Update server
parameter.
This option allows updating from special update servers providing updates with a
delay of several hours (i.e., databases tested in a real environment and therefore
considered as stable). These servers are the exact opposite of the pre-release
servers. Delayed updates minimize the risk of issues caused by updates. However,
delayed updates may have a negative impact when critical ESMC Server component
updates need to be quickly delivered via the update mechanism. Delayed updates of
ESMC Server modules are only available with AUTOSELECT defined in the Update
server parameter.

Advanced Settings
HTTP Proxy - Use a proxy server to facilitate internet traffic to clients on your network. If you install ESMC using
the All-in-one installer, HTTP proxy is enabled by default. HTTP Proxy settings are not applied for communication
with Secure Authentication servers (2FA).
Wake-Up Call - The ESMC Server can run instant replication of the ESET Management Agent on a client machine
via EPNS. This is useful when you do not want to wait for the regular interval when the ESET Management Agent
connects to the ESMC Server. For example, when you want a Task to be run immediately on client(s) or if you
want a Policy to be applied right away.
Wake on LAN - Set up Multicast Addresses if you want to send Wake on LAN calls to one or more IP addresses.
SMTP server - Use an SMTP Server to let the ESMC Server send email messages (for example, email notifications
or reports). Specify details of your SMTP server.
Active Directory - You can pre-set your AD settings. ESMC uses your credentials by default in Active Directory
synchronization tasks (user synchronization, static group synchronization). When the related fields are left blank
in the task configuration, ESMC uses the pre-set credentials. Use a read-only AD user, ESMC does not make any
changes to the AD structure.
If you are running the ESMC Server on Linux (or Virtual Appliance), you need to have a Kerberos configuration file
set up properly. You can set up Kerberos to synchronize with multiple domains.
It the ESMC Server is running on a Windows machine connected to a domain, only the Host filed is necessary.
Synchronization among more domains is possible if domains have established trust.
• Host - Type the Server name or IP address of your domain controller.
• Username - Type the Username for your domain controller in the following format:
oDOMAIN\username (ESMC Server running on Windows)
ousername@FULL.DOMAIN.NAME or username (ESMC Server running on Linux).

Important
Be sure to type the domain in capital letters, as this formatting is required in order to properly
authenticate queries to an Active Directory server.
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• Password - Type the password used to log on to your domain controller.
• Root container - enter the full identifier of an AD container, for example: CN=John,CN=Users,DC=Corp.
It serves as a pre-set Distinguished Name. We recommend you to copy and paste this value from a server
task to make sure you have the correct value (copy the value from the Distinguished Name field once it is
selected).

Important
ESMC Server 7.2 on Windows uses the encrypted LDAPS (LDAP over SSL) protocol by default for all
Active Directory (AD) connections. You can also configure LDAPS on ESMC Virtual Appliance.
If you upgrade an earlier ESMC version on Windows to ESMC 7.2 and you were using the Active
Directory synchronization, synchronization tasks will fail in ESMC 7.2.
For a successful AD connection over LDAPS, configure the following:
1.The domain controller must have installed a machine certificate. To issue a certificate for your
domain controller, follow the steps below:
a)Open the Server Manager, click Manage > Add Roles and Features and install the Active
Directory Certificate Services > Certification Authority. A new Certification Authority will be
created in Trusted Root Certification Authorities.
b)Navigate to Start > type certmgr.msc and press Enter to run the Certificates Microsoft
Management Console snap-in > Certificates - Local Computer > Personal > right click the empty
pane > All Tasks > Request New Certificate > Enroll Domain Controller role.
c)Verify that the issued certificate contains the FQDN of the domain controller.
d)On your ESMC server, import the CA you generated to the cert store (using certmgr.msc tool) to
the trusted CAs folder.
2.When providing connection settings to the AD server, type the FQDN of the domain controller (as
provided in the domain controller certificate) in the Server or Host field. IP address is no longer
sufficient for LDAPS.
To enable fallback to LDAP protocol, select the check box Use LDAP instead of Active Directory in
the Static Group Synchronization or User Synchronization task.
Syslog server - You can have ESMC send notifications and event messages to your Syslog server. Also, it is possible
to export logs from a client computer's ESET product and send them to the Syslog server.
Static Groups - Enables automatic pairing of found computers to computers already present in Static Groups.
Pairing works on reported hostname by ESET Management Agent and if it can not be trusted then it should be
disabled. If pairing fails, the computer will be placed into the Lost and Found group.
Repository - Location of the repository where all installation files are stored.

Important
• The default ESET repository is set to AUTOSELECT (it points to: http://repository.eset.com/v1). It
automatically determines the repository server with the best connection based on the geographic
location (IP address) of ESMC Server (by using CDN - Content Delivery Network). Therefore, you do
not need to change the repository settings.
• Optionally, you can set a repository that uses only ESET servers:
http://repositorynocdn.eset.com/v1
• Never use an IP address to access the ESET repository.
• It is possible to create and use an offline repository.
Diagnostics - Enable or disable the submission of anonymous crash report statistics to ESET for the improvement
of customer experience.
333

Logging - Set the log verbosity to determine the level of information that will be collected and logged, from Trace
(informational) to Fatal (most important critical information).
The latest ESMC Server log files can be found here:
• Windows: C:\ProgramData\ESET\RemoteAdministrator\Server\EraServerApplicationData\Logs
• Linux: /var/log/eset/RemoteAdministrator/Server/
You can setup exporting logs to Syslog here.
Database cleanup - To prevent a database overload, you can use this option to regularly clean logs. The database
cleanup automatically deletes these types of logs: SysInspector logs, Diagnostics logs, logs that are not collected
anymore (logs from removed devices, logs from removed report templates). The database cleanup process runs
every night at midnight by default. Changes to this setting take effect following the next cleanup. You can set the
cleaning interval for each of these types of logs:
Log type
Incident logs

Example of log type
Detection logs with high
severity.
See the list of logs.
Incident logs
ActiveThreats
BlockedFiles
EESEvent_
EnterpriseInspectorAlert
Firewall_
FirewallAgregated
Functionality_Computer
Functionality_ProblemsDetails
Functionality_Product
Functionality_Products
Hips_
Quarantine_UploadedFile
Scan
Spam_
SubmittedFiles
SysInspector_SysInspector
Threat
ThreatsFlag
ThreatsMute
ThreatsMute2
WebControl_Link

Management logs Data about Quality of Service.
See the list of logs.
Management logs
Audit logs
Audit logs
Audit log reports.
See the list of logs
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Monitoring logs

Web Control logs, Device
control logs, HIPS logs with
low severity.
See the list of logs.
Monitoring logs

Diagnostic logs are cleaned every day. The user cannot change the cleaning interval.

See the list of logs.

Diagnostics logs
Diagnostics_DeviceControl_Device
Diagnostics_DiagnosticZip
Diagnostics_Firewall
Diagnostics_Hips
Diagnostics_Spam
Diagnostics_WebControl_Link
Performance_DiskIO
Performance_Machine
Performance_Memory
Performance_NetworkIO
Performance_Processor
Performance_User

Important
During database cleanup, items in Detections corresponding to the cleaned Incident logs are
deleted as well (regardless of detection status). By default, the cleanup period for Incident logs (and
Detections) is set to 6 months. You can change the interval in Server Settings.
Customization
Customize UI - It is possible to add a custom logo to the ESMC Web Console and the reports generated via Server
Task.
• None - Basic design, no custom logo
• Co-branding - Allows custom logo for Web Console and in the footer of reports
• White-labeling (requires MSP license) - Allows custom logo for Web Console and in the footer or header
of reports
Company logo
• Dark background logo (Web Console header) - This logo will be displayed in the top left corner of Web
Console.
• Light background logo - This logo will be displayed in the header (for MSP license owners) or footer (cobranding setting) of reports generated via Server Task.
Click

to select a logo. Click

to download current logo. Click

to remove current logo.

Reports & Notifications
• Customize reports - Enable this option to use the selected logo in reports and/or to add a footer text.
• Report footer text - Type the text that will be added to the right bottom corner of reports generated in
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PDF format.

Important
A custom logo can not be used together with custom footer text. Logo has the same position as
footer text. If logo and footer are used simultaneously, only logo will be visible. When using the
White-labeling setting, the custom logo will appear in the upper left corner of the report; a smaller
powered by ESET logo is placed in bottom right corner, instead of footer text.

Advanced security
Turn on Advanced security to enable this setting for network communication of ESMC components.
Advanced security includes these features:
• Newly created certificates and certification authorities use SHA-256 (instead of SHA-1). To apply Advanced
security in the existing ESMC infrastructure, you need to replace the existing certificates.
• ESMC Server uses TLS 1.2 for communication with Agents.
• Enabled Advanced security enforces using the TLS 1.2 for Syslog and SMTP communication.

Important
• When you enable Advanced security, you need to restart the ESMC Server to begin using the
feature.
• Advanced security does not influence the already existing CAs and certificates, only new CAs and
certificates created after Advanced security is enabled.
• If you want to use the Advanced security, we strongly recommend to set it up before importing
the MSP account.
Minimum compatibility requirements include the following:
• Windows: Windows XP and later, Windows Server 2003 and later.

Note
ESET Management Agent 7.x contains its own SSL module that enables the usage of TLS 1.2 even
with older operating systems (Windows XP and Windows Server 2003).
• Linux: Ubuntu 12.04 and later, RHEL/CentOS 6 and later, Debian 7.0 and later.

Important
The minimum supported version of OpenSSL for Linux is openssl-1.0.1e-30. We recommend that
you use the latest OpenSSL version (1.1.1). You can verify if your Linux client is compatible using
the following command:
openssl s_client -connect google.com:443 -tls1_2

• OS X 10.9 and later.

How to enable and apply Advanced security on your network
Before enabling this feature, make sure all your client computers can communicate via TLS 1.2 (see the note
above). The procedure contains two restarts of the ESMC Server service.
Follow this procedure to enable and apply Advanced security:
336

1.Navigate to More > Server Settings > Connection and click the slider next to Advanced security (require
restart!).
2.Click Save to apply the setting.
3.Close the Console and restart the ESMC Server service.
4.Wait a few minutes after the service is started and log in to the Web Console.
5.Check if all computers are still connecting and no other problems have occurred.
6.Navigate to More > Certification Authorities > New and create a new CA. The new CA is automatically
sent to all client computers during the next Agent - Server connection.
7.Create new peer certificates signed with this new CA. Create a certificate for Agent and for Server (you
can select it in the Product drop-down menu in the wizard).
8.Change your current ESMC Server certificate for the new one.
9.Create a new ESET Management Agent policy to set up your Agents to use the new Agent certificate.
a.In the Connection section, click Certificate > Open certificate list and select the new peer certificate.
b.Assign the policy to computers where you want to use the Advanced security.
c.Click Finish to apply.
10. When all devices are connecting with the new certificate, you can delete your old CA and revoke old
certificates.

Important
Do not delete your old CA or revoke old certificates if you applied Advanced security only on some
(and not all) of the connected client computers.

Advanced security on systems with installed MDM
This setting will affect only communication between ESMC Server and MDM Server. Communication between
MDM Server and Mobile Devices will not be affected. To apply advanced security to the MDM component, create
new MDM and Proxy certificates signed by the new CA and assign them via policy to the MDM server as follows:
• ESET Mobile Device Connector Policy > General > HTTPS certificate. Import the new MDM Certificate.
• ESET Mobile Device Connector Policy > Connection > Certificate = Proxy certificate.

SMTP server
ESET Security Management Center can automatically send email reports and notifications. Enable Use SMTP
server, navigate to More > Server Settings > Advanced Settings > SMTP Server and specify the following:
• Host - Hostname or an IP address of your SMTP server.
• Port - SMTP uses port 25 by default, but you can change it in case your SMTP server uses a different port.
• Username - If your SMTP server requires authentication, specify the SMTP user account name (do not
include the domain as this will not work).
• Password - The password associated with the SMTP user account.
• Connection security type - Specify connection type, the default is Not secured, but if your SMTP server
allows for secure connections, choose TLS or STARTTLS. If you want to make your connection more secure, it
is a good choice to use a STARTTLS or a SSL/TLS extension, since they employ a separate port for encrypted
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communication.
• Authentication type - The default is set to No authentication, however, you can select appropriate
Authentication type from the drop-down list (for example Login, CRAM-MD5, CRAM-SHA1, SCRAM-SHA1,
NTLM or Automatic).
• Sender address - Specify the sender address that will be displayed in the header of notification emails
(From:).
• Test SMTP server - This is to make sure the SMTP settings are correct. Press Send test email button and a
pop-up window will open. Enter the recipient's email address and the test email message will be sent via
SMTP server to this address. Check the recipient's mailbox to verify that the test email was delivered.

Example
You can use Gmail as the SMTP server, if you have a
Gmail account. Use the settings below:
Setting
Value
Use SMTP server
True
smtp.gmail.com
Host
Port
465 (TLS) or 587 (STARTTLS)
Username
your Gmail address
Password
your Gmail password
Connection security type TLS or STARTTLS
Automatic
Authentication type
Sender address
your Gmail address
If sending of emails fails, you may need to allow less
secure apps in your Gmail account or unlock your Gmail
account.

Automatically pair found computers
If there is an occurrence of multiple instances of the same computer in ESMC (for example if ESET Management
Agent is reinstalled on a client computer that is already managed), Automatically pair found computers feature
takes care of this and pairs these instances into one. This should eliminate the need for manual verification and
sorting of found computers.
Pairing works on reported hostname by ESET Management Agent and if it can not be trusted, we recommend you
to disable Automatically pair found computers. If pairing fails a computer will be placed into Lost and Found
group. The idea is that whenever ESET Management Agent is reinstalled on an already managed computer, it
would be automatically paired and thus correctly placed into ESMC without your intervention. Also, new ESET
Management Agent will immediately get its policies and tasks.
• When disabled, computers that should be placed into Lost & found group will be paired with the first
found unmanaged computer (placeholder, circle icon) located anywhere in ESMC tree. If there isn't any
placeholder with the same name, the computer would be placed into Lost & found.
• When enabled (default), computers that should be placed into Lost & found will be paired with the first
found unmanaged computer (placeholder, circle icon) located anywhere in ESMC tree. If there isn't any
placeholder with the same name, the computer will be paired to the first found managed computer (alert or
check icon) located anywhere in ESMC tree. If this pairing also fails, the computer will be placed into Lost &
found.
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Note
If you consider automatic pairing unwanted, disable it. You can always verify and sort computers
manually.

Syslog server
If you have a Syslog server running in your network, you can configure ESMC Server to send Notifications to your
Syslog server. You can also enable Export logs to Syslog in order to receive certain events (Detection Event,
Firewall Aggregated Event, HIPS Aggregated Event, etc.) from client computers running ESET Endpoint Security,
for example.
To enable Syslog server:
1.Navigate to More > Server Settings > Advanced Settings > Syslog Server and click the slider bar next to
Use Syslog server.
2.Specify the following mandatory settings:
a.Host (IP address or hostname of the destination for Syslog messages)
b.Port number (default value is 514).
c.Format of the log: BSD (specification), Syslog (specification)
d.Transport protocol for sending messages to Syslog (UDP, TCP, TLS)
After making changes, click Save.
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Note
The regular application log file is constantly being written to. Syslog only serves as a medium to
export certain asynchronous events, such as notifications or various client computer events.

Export logs to Syslog
ESET Security Management Center is able to export certain logs/events and send them to your Syslog server.
Events from the following log categories are being exported to Syslog server: Detection, Firewall, HIPS, Audit and
Enterprise Inspector. Events are generated on any managed client computer running an ESET product (for
example, ESET Endpoint Security). These events can be processed by any Security Information and Event
Management (SIEM) solution capable of importing events from a Syslog server. Events are written to the Syslog
server by ESET Security Management Center.
1.To enable Syslog server, click More > Server Settings > Advanced Settings > Syslog server > Use Syslog
server.
2.To enable exporting, click More > Server Settings > Advanced Settings > Logging > Export logs to Syslog.
3.Choose one of the following formats for event messages:
a.JSON (JavaScript Object Notation)
b.LEEF (Log Event Extended Format) - format used by IBM's application QRadar.

Events exported to LEEF format
LEEF format is a customized event format for IBM® Security QRadar®. Events have standard and custom
attributes. ESMC uses some of standard attributes described in official IBM documentation. Custom attributes are
the same as in JSON format. There are five categories of events:
• Detection
• Firewall
• HIPS
• Audit
• Enterprise Inspector Alerts

Note
More information about Log Event Extended Format (LEEF) can be found at official IBM website.

Events exported to JSON format
JSON is a lightweight format for data exchange. It is built on collection of name / value pairs and an ordered list of
values.

Exported events
This section contains details on the format and meaning of attributes of all exported events. The event message is
in the form of a JSON object with some mandatory and some optional keys. Each one exported event will contain
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the following key:
event_type string

Type of exported events: Threat_Event, FirewallAggregated_Event,
HipsAggregated_Event, Audit_Event, EnterpriseInspectorAlert_Event,
BlockedFiles_Event, FilteredWebsites_Event.
ipv4
string optional IPv4 address of the computer generating the event.
ipv6
string optional IPv6 address of the computer generating the event.
source_uuid string
UUID of the computer generating the event.
occurred
string
UTC time of occurrence of the event. Format is %d-%b-%Y %H:%M:%S
severity
string
Severity of the event. Possible values (form least severe to most severe) are:
Information Notice Warning Error CriticalFatal

Custom keys according to event_type:

1. ThreatEvent
All Detection events generated by managed endpoints will be forwarded to Syslog. Detection event specific key:
threat_type string optional
Type of detection
threat_name string optional Name of detection
threat_flags
string optional Detection related flags
scanner_id
string optional Scanner ID
scan_id
string optional Scan ID
engine_version string optional Version of the scanning engine
object_type
string optional Type of object related to this event
object_uri
string optional Object URI
action_taken string optional Action taken by the Endpoint
action_error string optional Error message in case the "action" was not successful
threat_handled bool optional Indicates whether or not the detection was handled
need_restart bool optional Whether or not the restart is needed
username
string optional Name of the user account associated with the event
processname string optional Name of the process associated with the event
circumstances string optional Short description of what caused the event
hash
string optional SHA1 hash of the (detection) data stream.
firstseen
string optional Time and date when the detection was found for the first time at that machine.
ESMC employs different date-time formats for the firstseen attribute (and any
other date-time attribute) depending on log output format (JSON or LEEF):
• JSON format: "%d-%b-%Y %H:%M:%S"
• LEEF format: "%b %d %Y %H:%M:%S"

2. FirewallAggregated_Event
Event logs generated by ESET Personal Firewall are aggregated by the managing ESET Management Agent to
avoid wasting bandwidth during ESET Management Agent/ ESMC Server replication. Firewall event specific key:
event
string optional
Event name
source_address
string optional Address of the event source
source_address_type string optional Type of address of the event source
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event
source_port
target_address
target_address_type
target_port
protocol
account
process_name
rule_name
rule_id
inbound
threat_name
aggregate_count

string optional
Event name
number optional Port of the event source
string optional Address of the event destination
string optional Type of address of the event destination
number optional Port of the event destination
string optional Protocol
string optional Name of the user account associated with the event
string optional Name of the process associated with the event
string optional Rule name
string optional Rule ID
bool
optional Whether or not the connection was inbound
string optional Name of the detection
number optional How many exact same messages were generated by the endpoint
between two consecutive replications between ESMC Server and
managing ESET Management Agent

3. HIPSAggregated_Event
Events from Host-based Intrusion Prevention System are filtered on severity before they are sent further as
Syslog messages. Only events with severity levels Error, Critical and Fatal are sent to Syslog. HIPS specific
attributes are as follows:
application
string optional
Application name
operation
string optional Operation
target
string optional Target
action
string optional Action
rule_name
string optional Rule name
rule_id
string optional Rule ID
aggregate_count number optional How many exact same messages were generated by the endpoint between
two consecutive replications between ESMC Server and managing ESET
Management Agent

4. Audit_Event
ESMC forwards Server's internal audit log messages to Syslog. Specific attributes are as follows:
domain string optional
Audit log domain
action string optional Action taking place
target string optional Target action is operating on
detail string optional Detailed description of the action
user
string optional Security user involved
result string optional Result of the action

5. EnterpriseInspectorAlert_Event
ESMC forwards ESET Enterprise Inspector alarms to Syslog. Specific attributes are as follows:
processname string optional
Name of the process causing this alarm
username
string optional Owner of the process
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processname string optional
Name of the process causing this alarm
rulename
string optional Name of the rule triggering this alarm
count
number optional Number of alerts of this type generated since last alarm
hash
string optional SHA1 hash of the alarm
eiconsolelink string optional Link to the alarm in ESET Enterprise Inspector console
eialarmid
string optional ID sub-part of the alarm link ($1 in ^http.*/alarm/([0-9]+)$)

6. BlockedFiles_Event
ESMC forwards ESET Enterprise Inspector Blocked Files to Syslog. Specific attributes are as follows:
hostname
string optional Hostname of the computer with the event
processname string optional Name of the process associated with the event
username
string optional Name of the user account associated with the event
resolved
bool optional Indicates whether or not the blocked file was handled
hash
string optional SHA1 hash of the blocked file
object_uri string optional Object URI
action
string optional Action taken
firstseen
string optional Time and date when the detection was found for the first time at that machine
(date and time format).
cause
string optional
description string optional Description of the blocked file

7. FilteredWebsites_Event
ESMC forwards the filtered websites (Web Protection detections) to Syslog. Specific attributes are as follows:
hostname
string optional Hostname of the computer with the event
processname
string optional Name of the process associated with the event
username
string optional Name of the user account associated with the event
resolved
bool optional Indicates whether or not the event was handled
hash
string optional SHA1 hash of the filtered object
event
string optional Event type
rule_id
string optional Rule ID
action_taken
string optional Action taken
scanner_id
string optional Scanner ID
object_uri
string optional Object URI
target_address
string optional Address of the event destination
target_address_type string optional Type of address of the event destination (25769803777 = IPv4;
25769803778 = IPv6)

Import CSV
Importing of a list can be done using custom .csv file with a proper structure. This function is used at various
menus across ESET Security Management Center user interface. Depending on what shall be imported, columns
are changed.
1.Click Import CSV.
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2.Upload - click Choose File, browse for the .csv file you would like to upload and then click Upload.
3.Delimiter - a delimiter is a character that is used to separate text strings. Select an appropriate delimiter
(Semicolon, Comma, Space, Tab, Dot, Vertical bar) to match what your .csv file uses. If your .csv file
uses different character as delimiter, select the check box next to Other and enter the character. Data
preview shows the contents of your .csv file which can help you identify the type of delimiter used to
separate strings.
4.Column mapping - once the .csv file has been uploaded and parsed, you can map each desired column
in the imported .csv file to a ESMC column displayed in the table. Use the drop-down lists to select
which CSV column should be associated with a specific ESMC column. If your .csv file does not have a
header row, deselect First line of CSV contains headings.
5.See the Table preview to make sure the column mapping is set correctly and the import operation will
work the way you want.
6.Once you have successfully mapped each of the columns and the table preview looks correct, click
Import to begin the operation.

Mobile Device Management
The following diagram demonstrates communication between ESET Security Management Center components
and a mobile device:
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Click here to view the image larger

Note
Security recommendation for MDM: MDM host device requires internet access. We recommend
that the MDM host device be behind a firewall and only the required ports for the MDM are be
open. You can also deploy an IDS/IPS to monitor the network for anomalies.

Mobile Device Connector (MDC) is a ESMC component that allows for Mobile Device Management with ESET
Security Management Center; permitting management of Android and iOS mobile devices and administration of
mobile security.
MDC provides an agent-less solution where Agents are not running directly on mobile devices (to save battery
and performance of mobile device). MDC serves as a host of these virtual agents. MDC store data for/from mobile
devices in its dedicated SQL database.
HTTPS certificate is required to authenticate communication between mobile device and MDC. To authenticate
communication between ESMC Server and MDC, a Proxy certificate is used.
Managing Apple devices has some additional requirements. Using ESMC MDC to manage iOS devices requires
Apple Push Notification service certificate. APN service enables ESET MDC to securely communicate to Apple
mobile devices. This certificate must be signed directly by Apple (using Apple Push Certificates Portal) and
delivered to the MDC via policy. Subsequently, iOS devices might be enrolled to ESMC MDC.
In certain countries, Apple Business Manager (ABM) is available. ABM is a new powerful method for enrollment of
corporate iOS devices. With ABM you can enroll devices automatically to MDC without any direct contact with the
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device and also with minimal interaction from the user. ABM extends the capabilities of iOS MDM dramatically
and allows complete customization of the device setup.
After successful installation and setup of the Mobile Device Connector, mobile devices can be enrolled. After
successful enrollment, the mobile device can be managed from ESMC Web Console.

MDM Setup and Settings
In order to take advantage of the Mobile Device Management component in ESET Security Management Center,
perform the following steps after the installation of MDM to be able to enroll and manage mobile devices.
1.Install Mobile Device Connector (MDC) using the All-In-one installer or perform a component installation for
Windows or Linux. Make sure that you have met the prerequisites prior to the installation.

Note
If you are installing MDC using the All-in-one installer, HTTPS certificates signed by ESMC CA are
created during the installation process. (this certificate is not visible in More > Peer Certificates)
To install ESMC with the All-in-one installer and use a 3rd party HTTPS certificate, install ESET
Security Management Center first, then change your HTTPS certificate using Policy (in the ESET
Mobile Device Connector Policy > General > Change certificate > Custom certificate).
If you are installing the MDC component by itself, you can use :
a) certificate signed by ESMC CA (Basic > Product: Mobile Device Connector; Host: Hostname/IP
Adress of MDC; Sign > Sign Method: Certification Authority; Certification Authority: ESMC
Certification Authority)
b) 3rd party HTTPS certificate chain signed by a CA trusted by Apple (list of CA trusted by Apple).
2.Activate ESMC MDC using a Product Activation Client Task. The procedure is the same as when activating
any ESET security product on a client computer (a license unit will not be used).
3.Run a User Synchronization Server Task (Recommend). This lets you automatically synchronize users with
Active Directory or LDAP for the purpose of Computer Users.

Note
If you are planning to manage Android based devices only (no iOS devices will be managed), skip to
step 7.
4.Create an APN/ABM certificate. This certificate is used by ESMC MDM for iOS device Enrollment. Certificates
that will be added to your enrollment profile must be also added to your ABM profile.
5.Create a new policy for ESET Mobile Device Connector in order to activate APNS.

Note
If you are performing iOS Device enrollment with the Apple Business Manager (ABM) continue here.
6.Enroll mobile devices using a Device Enrollment task. Configure the task to enroll devices for Android and/or
iOS. This can also be done from Computers or Group tab by clicking Add new > Mobile devices while having
selected a Static Group (Add new cannot be used in Dynamic Groups).
7.If you have not provided license during Device Enrollment, activate Mobile devices using a Product
Activation Client Task - choose an ESET Endpoint Security license. A license unit will be used for each mobile
device.
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Important
The Product Activation task can activate a mobile product, ESET Endpoint For Android, also using an
offline license.
The activation task cannot activate ESET products of version 4 and 5 with the offline license. You
need to activate the product manually or use a supported product version (we recommend using
the latest version).
8.You can edit Users in order to configure Custom attributes and Assign Mobile devices if you've not assigned
users during Device Enrollment.
9.Now you can start applying policies and managing mobile devices. For example, Create a Policy for iOS MDM
- Exchange ActiveSync Account which will automatically configure your Mail account, Contacts and Calendar
on iOS devices. You can also apply restrictions on an iOS device and/or add a Wi-Fi connection.
10. You can use Re-enroll on a mobile device which was corrupted or wiped. Re-enroll link will be sent via
email.
11. Stop Managing (Uninstall ESET Management Agent) task will cancel MDM enrollment of a mobile device
and remove it from ESMC.

Device Enrollment
Mobile devices can be managed via ESMC and an ESET security product running on the mobile device. To start
managing mobile devices, you need to enroll them in ESMC (it is no longer necessary to enter IMEI or other
identification numbers into the mobile device).
The diagram below illustrates how a Mobile Device communicates with Mobile Device Connector during the
enrollment process:
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This diagram explains when enrollment, re-enrollment and unenrollment can be used and explains the difference
between managed and unmanaged devices.
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• Enrollment: Enrollment can only be used when the device is not managed by MDM. In this case, the device
does not exist in the Computers section. Deleting a device from the Web Console does not make it unmanaged
and the device will appear in the Web Console after a successful replication. Only the unenrollment process can
remove a device from managed status. Each enrollment token is unique and one-time-only so it can be used
only once. Once the token is used it cannot be used again.
• Re-enrollment: Re-enrollment can only be used if the device is managed. The re-enrollment token is always
different from the enrollment token and it can also be used only once.
To re-enroll a device, open the Computers section and select the mobile device you want to re-enroll. Open the
Actions menu and select Mobile > Re-enroll.
• Unenrollment: Unenrollment is the correct way to stop managing a device. Unenrollment is performed using
a Stop managing Client Task. If the device is not responding, it can take up to 3 days until the device is actually
removed. If you want to remove the device just to enroll it again, use re-enrollment instead.

Note
If you are performing iOS Device enrollment with the Apple Business Manager (ABM) continue here.
You can enroll mobile devices in the Computers section or under More > Groups. Select the Static Group that you
want to add mobile devices to, click Add new > Mobile devices and then select one of the following enrollment
methods:
• Enrollment via email - mass enrollment of mobile devices via email. This option is best suited if you need to
enroll a large number of mobile devices or if you have existing mobile devices that you do not have physical
access to. Using this option requires active participation from the user/owner of the mobile device.
• Individual enrollment via link or QR code - single mobile device enrollment. You will be able to enroll one
mobile device at a time and will need to repeat the same process for each device. We recommend that you use
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this option only when you have a smaller number of mobile devices to enroll. This option is suitable if you do
not want users/mobile device owners to do anything and must perform all enrollment tasks yourself. Also, you
can use this option if you have new mobile devices which will be handed over to users once the devices are all
set up.
• Individual enrollment as a Device Owner (Only Android 7 and above) - single mobile device enrollment for
Android devices only. You will be able to enroll one mobile device at a time and will need to repeat the same
process for each mobile device. This enrollment process is possible only on mobile devices that are new (out-ofthe-box) or after wipe/factory reset. This enrollment process will provide elevated management rights to the
administrator over the management rights of the mobile device user.

Device Enrollment Android
There are two scenarios for enrollment when ESET Endpoint Security for Android (EESA) is activated on the
mobile device. You can activate EESA on the mobile device using a Product Activation task (recommended). The
other scenario is for mobile devices with the ESET Endpoint Security for Android app already activated.
EESA already activated - follow the steps below to enroll your device:
1.Tap the enrollment link URL (including the port number) received via email, or type it into the browser
manually (for example, https://eramdm:9980/<token>). You might be asked to accept an SSL certificate, click
Accept if you agree and then click Connect.

Important
If you do not have ESET Endpoint Security installed on the mobile device, you will automatically be
redirected to the Google Play store, where you can download the app.

Note
If you receive the notification Couldn't find an app to open this link, try opening the enrollment link
in the default Android web browser.
2.Check your connection details (Mobile Device Connector server address and port) and click Connect.
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3.Type the ESET Endpoint Security admin mode password into the blank field and tap Enter.
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4.This mobile device is now being managed by ESMC, tap Finish.
EESA not activated yet - Follow the steps below to activate the product and enroll your Device:
1.Tap the enrollment link URL (including the port number) and type it into the browser manually (for example,
https://esmcmdm:9980/<token>) or you can use provided QR Code. You might be asked to accept an SSL
certificate, click Accept if you agree and then click Connect.

Important
If you do not have ESET Endpoint Security installed on the mobile device, you will automatically be
redirected to the Google Play store, where you can download the app.
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Note
If you receive the notification Couldn't find an app to open this link, try opening the enrollment link
in the default Android web browser.

2.Type in the name of the mobile device. (This name is not visible in ESMC. It is only relevant for Anti-Theft
and for diagnostic log purposes.)
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3.Tap Enable to enable uninstall protection.
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4.Tap Activate to activate device administrator.
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5.At this point, you can exit the ESET Endpoint Security for Android app on the mobile device and open ESMC
Web Console.
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6.In ESMC Web Console, go to Client Tasks > Mobile > Product Activation and click New.
It might take some time for the Product Activation Client Task to run on the mobile device. Once the task is
successfully executed, the ESET Endpoint Security for Android app is activated and the mobile device can be
managed by ESMC. The user will now be able use the ESET Endpoint Security for Android app. When the ESET
Endpoint Security for Android app is open, the main menu will be displayed:
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Device Enrollment Android as a Device Owner
Note
This type of enrollment is available only for Android devices with Android v7 and above.
The Android device must be after wipe/factory reset or out-of-the-box for it to be able to perform
the following enrollment steps.
1.Turn on the mobile device.
2.Enter the SIM card pin.
3.On the Welcome screen, select the preferred language and then tap on the screen six (6) times somewhere
around the "Welcome" text to start the QR code setup.
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4.If you performed the previous step correctly, a QR code setup screen will display. Tap NEXT to continue.
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Note
Some devices may require you to perform an encryption of the device's storage (sometimes it is
required also to connect the charger). Select the type of encryption you want and proceed
according to the instructions on the screen.
5.Select an internet connection. This will be used to download the QR code reader that is required for the next
step.
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6.Now the QR code reader will be installed. After the installation finishes, scan the QR code that was
generated in the ESMC Web Console.
7.You will be requested to confirm that you understand you are granting elevated Device Owner rights to the
Administrator. Tap OK to proceed.
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8.The ESET Endpoint Security for Android application will now be installed and the required permissions will be
applied.
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9.Tap Agree to all to allow the EULA, Privacy Policy and diagnostic and marketing data transfer.
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10. The device is now enrolled in the Device Owner mode.

Device Enrollment iOS
Note
If you are performing iOS Device enrollment with Apple Business Manager (ABM) continue here.
1.Tap the enrollment link URL (including the port number) and type it into the browser manually (for example,
https://eramdm:9980/<token>) or you can use the provided QR Code.
2.Tap Install to continue at the MDM Enrollment Install Profile screen.
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3.Tap Trust to allow installation of the new profile.
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4.After installing the new profile, the Signed by field will display that the profile is Not Signed. This is because
iOS does not recognize the certificate. To have a signed enrollment profile, use HTTPS certificate signed by
Apple trusted CA. Or you can use your own HTTPS enrollment certificate to sign the enrollment.
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5.This enrollment profile allows you to configure devices and set security policies for users or groups.

Important
Removing the enrollment profile removes all company settings (Mail, Calendar, Contacts, etc.) and
the iOS mobile device will not be managed. If a user removes the enrollment profile, ESMC will not
be aware of this and the device's status will change to
and then to
after 14 days because the
device is not connecting. No other indication that the enrollment profile has been removed will be
given.
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Device Enrollment iOS with ABM
The Apple Business Manager (ABM) is Apple's new method for enrolling corporate iOS devices. With ABM you can
enroll the iOS devices without any direct contact with the device and also with minimal interaction from the user.
The Apple ABM enrollment provides administrators the option to customize the complete device setup process. It
also provides the option to prevent users from removing the MDM profile from the device. You can enroll your
existing iOS devices (if they meet the iOS devices ABM requirements) and all iOS devices that you will buy in the
future. For further information about Apple ABM see the Apple ABM Guide and Apple ABM Documentation.
Connect your ESMC MDM Server with Apple ABM server:
1.Verify that all Apple ABM Requirements are met for both account requirements and device requirements.
• ABM Account:
oThe program is only available in certain countries. Visit the Apple ABM webpage to see if ABM is
available in your country.
oApple ABM Account requirements can be found on these websites: Apple deployment program
requirements and Apple Device Enrollment Program requirements.
oDetailed ABM device requirements can be found here.
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2.Log in to your Apple ABM Account (If you do not have an Apple ABM account you can create one here).
3.From the Device Enrollment Program section on the left side select Manage Servers.

4.Click Add MDM Server to open the Add MDM Server window.
5.Enter your MDM Server Name, for example: "MDM_Server," and then click Next.

6.Upload your public key into the ABM portal. Click Choose File and select the public key file (this is the
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APNS certificate you downloaded from Apple Push Certificate Portal) and click Next.

7.Now you can download your Apple ABM Token. This file will be uploaded into the ESMC MDC policy
under Apple Business Manager (ABM) -> Upload authorization token.
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Add iOS Device into Apple ABM:
The next step is to assign iOS devices to your virtual MDM Server inside Apple ABM portal. You can assign your
iOS devices by serial number, order number or by uploading a list of Serial numbers for target devices in CSV
format. Either way, you must Assign the iOS device to the virtual MDM Server (you created in the previous steps).

Warning
Once a device is removed from the ABM portal, it is removed permanently, you cannot add it back.
After that you can leave the Apple ABM portal and continue in ESMC Web Console.

Warning
If you are enrolling iOS devices that are currently in use (and that meet the device requirements)
new policy settings will be applied to them after a factory reset of target device.
In order to complete the enrollment process you need to upload the APNS certificate into the MDC Policy that will
be assigned to the MDM Server. (This MDC Policy will fulfill the role of MDM Server Settings).

Note
If your iOS device displays the message that it is not able to download the profile from ESET during
enrollment, verify that the MDM server inside ABM is correctly configured (has the correct
certificates) and that you assigned the correct iOS device to your selected ESMC MDM Server inside
Apple ABM.
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Enrollment via email
This method is ideal for mass enrollment of mobile devices. You can send an enrollment link to any number of
devices via email. Each mobile device will receive a unique one-time token based on the email address.

Important
It is mandatory to configure an SMTP server for mass enrollment via email. Go to Server Settings,
expand Advanced Settings and specify the SMTP server details.
1.To add new mobile devices, go to the Computers section or More > Groups. Select the Static Group that
you want to add mobile devices to and click Add new > Mobile devices > Enrollment via email.

2.Mobile Device Connector - will automatically be selected. If you have more than one MDC, select the
FQDN of the MDC you want to use. If you do not have Mobile Device Connector installed yet, refer to the
Mobile Device Connector installation - Windows or Linux chapters for installation instructions.
3.License (optional) - click Select and choose the license that will be used for activation. A Product
Activation Client Task will be created for the mobile device. A license unit will be taken (one per each
mobile device).
4.Parent group - if you do not have a specific Static group for mobile devices, we recommend that you
create a New Static Group (called Mobile Devices, for example). If you already have an existing group, click
the /All/, a pop-up window will open where you can choose the Static group.
5.List of Devices - specify mobile devices for enrollment, you can use the following functions to add mobile
devices:
• Add device - single entry, you need to manually type an email address associated with the mobile
device to which the enrollment email will be sent. If you also assign a user to the mobile device by
clicking Pair and selecting the user, the email address will be overwritten with the one specified within
Computer Users. If you want to add another mobile device, click Add device again submit the required
information.
• Add User - you can add devices by selecting the appropriate user check boxes listed in Computer
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Users. Click Unpair to make corrections to the list of mobile devices for enrollment. Once you've
unpaired an assigned user, that user will be noted as not paired. Click Pair to select the desired user for
an unpaired device. Click the Trash can icon to delete an entry.
• Import CSV - a method that makes it easy to add a large number of mobile devices. Upload a .csv file
containing a list of devices to add, see Import CSV for more details.
• Copy & Paste - import a custom list of addresses separated with custom delimiters (this feature works
similarly to CSV import).
6.Select the check box I accept the terms of the application End User License Agreement and acknowledge
the Privacy Policy. See License Management or EULA for more information.

Note
We recommend that you specify a Device name in each entry when using the Import CSV method.
This is the device name shown in the Computers section. If you leave the Device name field empty,
email address will be used instead and appear as Device name in Computers and Groups. This may
cause some confusion, especially in case you use the same email address to enroll multiple devices.
This email address will appear multiple times and prevent you from being able to distinguish
between the devices.

Important
We recommend that you assign at least one user to a mobile device. If you want to use personalized
policies on iOS a user must be assigned to a device.

7.Enrollment email message - a predefined message template contains details that are usually sufficient,
but you can customize Subject and Content by including further information for your users. Instructions
are shown below the Content in the enrollment email and will contain a Device name (or an email address)
with enrollment link (URL). If you use one email address to enroll multiple mobile devices, a list of devices
will be shown, each with its own enrollment link (URL) assigned. There are also instructions that mobile
device (iOS and Android) user must perform in order to complete enrollment.
8.When you click Enroll, an email will be sent to each email address with appropriate enrollment link(s) and
instructions.
9.To complete mobile device enrollment, follow these steps or let the users/owners of the mobile devices
perform the steps themselves:
• Device Enrollment Android
• Device Enrollment iOS

Individual enrollment via link or QR code
When enrolling a mobile device using an enrollment link or QR code, you will need physical access to the device.
Also, in order to use the QR code, you will need to have QR code Reader/Scanner application installed on the
mobile device.

Note
For large numbers of mobile devices, we recommend you to use Enrollment via email.
1.To add a new mobile device, go to Computers section or More > Groups. Select Static Group that you
want to add mobile device to and click Add new > Mobile devices > Individual enrollment via link or QR
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code.

2.Device name - type the Name of the mobile device (this name will be shown in the list of Computers),
optionally enter a Description.
3.User (optional) - we recommend you to assign a user with mobile device, it is required for iOS devices,
but optional for Android.
4.Mobile Device Connector - will automatically be selected. If you have more than one MDC, choose from
the list by clicking the FQDN. If you do not have Mobile Device Connector installed yet, refer to the Mobile
Device Connector installation - Windows or Linux chapters for installation instructions.
5.License (optional) - click Select and choose license that will be used for activation. A Product Activation
Client Task will be created for the mobile device. A license unit will be taken (one per each mobile device).
6.Parent group - if you do not have a specific Static group for mobile devices, we recommend you to create
a New Static Group (called Mobile Devices for example ). If you already have an existing group, click the
/All, a pop-up window will open where you can choose the Static group.
7.Select the check box I accept the terms of the application End User License Agreement and
acknowledge the Privacy Policy. See License Management or EULA for more information.
8.After you click Next, the enrollment Link (URL) and QR code will be displayed. Type the whole URL into
the mobile device's web browser manually (for example https://eramdm:9980/token, the token will be
different for each mobile device), or send this URL to the mobile device by other means. Alternatively, you
can use provided QR Code, which might be more convenient than typing the URL, but requires QR code
Reader/Scanner on the mobile device.
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9.To add another mobile device, click Enroll Another. A new Add mobile device page will open which
remembers previous selections in the General section, you will only need to enter Device name and assign
a User, click Next and follow instructions in step 7. Once you have completed generating enrollment URLs
and QR codes, click Close to return to the previous window.
10.To perform the actual enrollment of the mobile devices, follow these step-by-step instructions:
oDevice Enrollment Android
oDevice Enrollment iOS

Individual enrollment as a Device Owner
When enrolling an Android mobile device using an enrollment QR code, you will need physical access to the
device. Also, this enrollment is possible only on a device that is after a wipe/factory reset or is fresh out-of-thebox.

Note
It is not possible to use Enrollment via email for mass enrollment of Android devices as a Device
Owner.
1.To add a new mobile device, go to the Computers section or More > Groups. Select the Static Group that
you want to add mobile device to and click Add new > Mobile devices > Individual enrollment as a Device
Owner (only Android 7 and above).
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2.Device name - type the Name of the mobile device (this name will be shown in the list of Computers).
3.User (optional) - we recommend you to assign a user with mobile device, it is required for iOS devices,
but optional for Android.
4.Mobile Device Connector - will automatically be selected. If you have more than one MDC, choose from
the list by clicking the FQDN. If you do not have Mobile Device Connector installed yet, refer to the Mobile
Device Connector installation - Windows or Linux chapters for installation instructions.
5.License (optional) - click Select and choose a license that will be used for activation. A Product Activation
Client Task will be created for the mobile device. A license unit will be taken (one per each mobile device).
6.Parent group - if you do not have a specific Static group for mobile devices, we recommend that you
create a New Static Group (named "Mobile Devices" for example). If you already have an existing group,
click the /All, a pop-up window will open where you can choose the Static group.
7.Select the check box I accept the terms of the application End User License Agreement and
acknowledge the Privacy Policy. See License Management or EULA for more information.
8.After you click Next, the enrollment QR code will be displayed.
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9.Follow these steps on the Android device to perform the enrollment process.
10.To add another mobile device, click Enroll Another. A new Add mobile device page will open that will
include all the previous selections in the General section, and you will only need to enter Device name and
assign a User, click Next and follow instructions in step 7. Once you have completed generating enrollment
QR codes, click Close to return to the previous window.

Create a Policy for iOS MDM - Exchange ActiveSync
Account
This policy governs all settings for iOS device. These settings apply for both ABM and non-ABM iOS devices.
• The ABM-only settings are denoted with a ABM icon
. These settings will only apply to iOS devices
enrolled in the Apple ABM portal. We recommend that you do not customize these ABM-only settings when
creating a policy for non-ABM iOS devices.
• Some settings can only be applied to an iOS device with a certain version of iOS. These settings are marked
by an icon representing the iOS version.
o iOS version 9.0 and higher
o iOS version 9.3 and higher
o iOS version 8.1.3 and higher
oiOS version 11.0 and higher
• If both of the icons (ABM icon and iOS version icon) are present next to a specific setting, the device must
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meet both requirements or management of the setting will fail.
See the sample scenario below which explains how to use the iOS MDM policy when you want to set up a
Microsoft Exchange Mail account:
You can use this policy to configure a Microsoft Exchange Mail account, Contacts and Calendar on user's iOS
mobile devices. The advantage of using such a policy is that you only need to create one policy which you can
then apply to many iOS mobile devices without the need to configure each separately. This is possible using
Active Directory user attributes. You need to specify a variable, for example ${exchange_login/exchange}
and this will be replaced with a value from the AD for a particular user.
If you do not use Microsoft Exchange or Exchange ActiveSync, you can manually configure each service (Mail
Accounts, Contacts Accounts, LDAP Accounts, Calendar Accounts and Subscribed Calendar Accounts).
The following is an example of how to create and apply a new policy to automatically set up Mail, Contacts and
Calendar for each user on iOS mobile device using Exchange ActiveSync (EAS) protocol to synchronize these
services.

Note
Before you begin setting this policy up, make sure you've already performed the steps described
under Mobile Device Management.

Basic
Enter a Name for this policy. The Description field is optional.

Settings
Select ESET Mobile Device Management for iOS from the drop-down list, click Others to expand categories and
then click Edit next to Exchange ActiveSync Accounts.
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Click Add and specify the details of your Exchange ActiveSync account. You can use variables for certain fields
(select from the drop-down list), such as User or Email Address. These will be replaced with actual values from
Computer Users when a policy is applied.

• Account name - Enter the name of the Exchange account.
• Exchange ActiveSync Host - Specify the Exchange Server hostname or its IP address.
• Use SSL - This option is enabled by default. It specifies whether the Exchange Server uses Secure Sockets
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Layer (SSL) for authentication.
• Domain - This field is optional. You can enter the domain this account belongs to.
• User - Exchange login name. Select the appropriate variable from the drop-down list to use attribute from
your Active Directory for each user.
• Email Address - Select the appropriate variable from the drop-down list to use an attribute from your
Active Directory for each user.
• Password - Optional. We recommend that you leave this field empty. If it is left empty users will be
prompted to create their own passwords.
• Past Days of Mail to Sync - Select the number of past days of mail to sync from the drop-down list.
• Identity certificate - Credentials for connection to ActiveSync.
• Allow messages to be moved - If enabled, messages can be moved from one account to another.
• Allow recent addresses to be synced - If this option is enabled, the user is allowed to sync recently used
addresses across devices.
• Use Only in Mail - Enable this option if you want to allow only the Mail app to send outgoing email
messages from this account.
• Use S/MIME - Enable this option to use S/MIME encryption for outgoing email messages.
• Signing Certificate - Credentials for signing MIME data.
• Encryption Certificate - Credentials for encryption MIME data.
• Enable per-message encryption switch - Allow the user to choose whether to encrypt each message.

Note
If you do not specify a value and leave the field blank, mobile device users will be prompted to enter
this value. For example a Password.

• Add certificate - You can add specific Exchange certificates (User Identity, Digital Signature or Encryption
Certificate) if required.
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Note
Using the steps above, you can add multiple Exchange ActiveSync Accounts, if desired. This way,
there will be more accounts configured on one mobile device. You can also edit existing accounts if
necessary.

Assign
Specify the clients (individual computers/mobile devices or whole groups) that are the recipients of this policy.

Click Assign to display all Static and Dynamic Groups and their members. Select your desired clients and click OK.
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Summary
Review the settings for this policy and click Finish. The policy gets applied on the targets after their next
connection to ESMC Server (depending on the Agent connection interval).

Create a Policy for MDC to activate APN/ABM for iOS
enrollment
Important
When changing the https certificate used in your policy for MDC, follow the steps below to avoid
disconnecting mobile devices from your MDM:
1. Create and apply the new policy that uses the new https certificate.
2. Allow devices to check in to the MDM server and receive the new policy.
3. Verify that devices are using the new https certificate (the https certificate exchange is
completed).
4. Allow at least 72 hours for your devices to receive the new policy. After all devices have received
the new policy (MDM Core alert "HTTPS certificate change still in progress. The old certificate is still
being used " is no longer displayed in the Alerts tab), you can delete the old policy.
This is an example of how to create a new policy for ESET Mobile Device Connector to activate APNS (Apple Push
Notification Services) and iOS Device Enrollment Program feature. This is required for iOS device Enrollment.
Before configuring this policy, create a new APN certificate and have it signed by Apple on the Apple Push
Certificates Portal so that it becomes a signed certificate or APNS Certificate. For step-by-step instructions, see
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the APN certificate section.

Basic
Type in a Name for this policy. The Description field is optional.

Settings
Select ESET Mobile Device Connector from the drop-down list.

Important
If you installed MDM Server with All-in-One Installer (Not as a standalone and not as a component),
the HTTPS certificate was generated automatically during the installation. This only applies for ERA
6.5 Installer and later. For all other cases, you need to apply a custom HTTPS certificate. You can
find more information annotated following step one of Mobile Device Management topic.
You can use the ESMC certificate (signed by ESMC CA) or your custom certificate. You can also
specify the date for Force certificate change. Click the tooltip next to this setting for more
information.

Note
Type your actual organization's name over the Organization string. This is used by the enrollment
profile generator to include this information in the profile.

Under General, you can optionally upload your HTTPS certificate for enrollment into the Enrollment profile
signing certificate (this affects only non-ABM enrollment). This will allow the enrollment page for iOS devices they
visit during enrollment process to be signed and that they will be visible in the Signed by filed based on the
certificate.
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Upload the Apple certificates for iOS enrollment – navigate to the Apple Push Notification Service and upload
the APNS Certificate and a APNS Private Key.
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APNS Certificate (signed by Apple) - click the folder icon and browse for the APNS Certificate to upload it. The
APNS Certificate is the file you downloaded from Apple Push Certificates Portal.
APNS Private Key - click the folder icon and browse for the APNS Private Key to upload it. The APNS Private Key is
the file you downloaded during APN/ABM Certificate creation.

Product Improvement Program - Enable or disable transmission of crash reports and anonymous telemetry data
to ESET.
Logging - Set the log verbosity to determine the level of information that will be collected and logged, from Trace
(informational) to Fatal (most important critical information).
If you are creating this policy for iOS enrollment with Apple ABM, navigate to the
(ABM).
Apple Business Manager (ABM) - these settings are ABM-only.
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Apple Business Manager

Warning
After the initial configuration, if any of these settings will be changed, in order to apply the changes,
you will need to factory-reset and re-enroll all the affected iOS devices.
Upload authorization token - click the folder icon and browse for the ABM server token. The ABM server token is
the file you downloaded when you created the virtual MDM server on the Apple ABM portal.
Mandatory Installation - the user will not be able to use the device without installing the MDM profile.
Allow user to remove MDM profile - device must be in supervised mode to prevent the user from removing the
MDM profile.
Require domain login - user must use valid domain credentials in the device setup wizard.
Skip Setup Items - this setting allows you to choose which of the initial setup steps during the initial iOS setup will
be skipped. You can find more information about each of these steps in the Apple Knowledgebase Article.

Assign
Select the device that is hosting the MDM server the policy is targeted on.

Click Assign to display all Static and Dynamic Groups and their members. Select the Mobile Device Connector
instance that you want to apply the policy on and click OK.

Summary
Review the settings for this policy and click Finish.
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Create a Policy to enforce restrictions on iOS and add
Wi-Fi connection
You can create a policy for iOS mobile devices to enforce certain restrictions. You can also define multiple Wi-Fi
connections so that, for example, users will automatically be connected to the corporate Wi-Fi network at
different office locations. The same applies to VPN connections.
Restrictions that you can apply to iOS mobile device are listed in categories. For example, you can disable
FaceTime and the use of camera, disable certain iCloud features, fine-tune Security and Privacy options or disable
selected applications.

Note
Restrictions that can or cannot be applied depend on the version of iOS used by client devices. iOS
8.x and newer are supported.
The following is an example of how to disable the camera and FaceTime apps and add Wi-Fi connection details to
the list in order to have the iOS mobile device connect to a Wi-Fi network whenever the network is is detected. If
you use the auto Join option, iOS mobile devices will connect to this network by default. The policy setting will
override a user's manual selection of a Wi-Fi network.

Basic
Enter a Name for this policy. The Description field is optional.

Settings
Select ESET Mobile Device Management for iOS, click Restrictions to see categories. Use the switch next to Allow
use of camera to disable it. Since the camera is disabled, FaceTime will automatically be disabled as well. If you
wish to disable FaceTime only, leave the camera enabled and use the switch next to Allow FaceTime to disable it.
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After you've configured Restrictions, click Others and then click Edit next to Wi-Fi connection list. A window with
the list of Wi-Fi connections will open. Click Add and specify connection details for the Wi-Fi network you want to
add. Click Save.

• Service Set Identifier (SSID) - SSID of the Wi-FI network to be used.
• Auto Join - Optional (enabled by default), device automatically joins this network.
388

Security settings:
• Encryption Type - Select appropriate encryption from the drop-down list, make sure this value exactly
matches the capabilities of the Wi-Fi network.
• Password - Enter the password that will be used to authenticate when connecting to the Wi-Fi network.
Proxy settings - Optional. If your network uses a Proxy, specify values accordingly.

Assign
Specify the clients (individual computers/mobile devices or whole groups) that are the recipients of this policy.

Click Assign to display all Static and Dynamic Groups and their members. Select your desired clients and click OK.
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Summary
Review the settings for this policy and click Finish. The policy gets applied on the targets after their next
connection to ESMC Server (depending on the Agent connection interval).

MDM configuration profiles
You can configure the profile to impose policies and restrictions on the managed mobile device.
Profile Name
Passcode

Short Description
Requires end-users to protect their devices with passcodes each time they return from
idle state. This ensures that any sensitive corporate information on managed devices
remains protected. If multiple profiles enforce passcodes on a single device, the most
restrictive policy is enforced.
Restrictions
Restriction profiles limit the features available to users of managed devices by restricting
the use of specific permission related to Device functionality, Application, iCloud, Security
and Privacy.
Wi-Fi connection list Wi-Fi profiles push corporate Wi-Fi settings directly to managed devices for instant access.
VPN connection list VPN profiles push corporate virtual private network settings to corporate devices so that
users can securely access corporate infrastructure from remote locations. Connection
Name - View the name of the connection displayed on the device.
Connection type - Choose the type of connection enabled by this profile. Each connection
type enables different capabilities.
Server - Enter the hostname or IP address of the server being connected to.
Mail Accounts
Allows the administrator to configure IMAP/POP3 email accounts.
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Exchange ActiveSync Exchange ActiveSync profiles allow end-users to access corporate push-based email
Accounts
infrastructure. Please note that there are pre-populated look-up value fields and options
that only apply to iOS 5+ .
CalDAV - Calendar
CalDAV provides configuration options to allow end-users to sync wirelessly with the
Accounts
enterprise CalDAV server.
CardDAV - Contacts This section allows for specific configuration of CardDAV services.
Accounts
Subscribed Calendars Subscribed Calendars provides calendar configuration.
Accounts

MDM Troubleshooting
1.What should I do if I get error message: "The Enrollment token is already being used or is not valid."?
It is likely that you are attempting to re-enroll with an old enrollment token. Create a new re-enrollment token in
the Web Console and use that one instead. It is also possible that you are attempting a second re-enrollment too
soon after the first one. Verify that the re-enrollment token is different from the first one. If it is not, then wait a
few minutes and try to generate a new re-enrollment token again.
2.What should I do if I get error message:"service certificate validation failed"?
This error message indicates that there is a problem with your APNS or FCM service certificate. This is announced
in ESMC Web Console as one of the following warnings under MDM Core alerts:
• FCM service certificate validation failed (0x0000000100001002)
• APNS service certificate validation failed (0x0000000100001000)
• APNS Feedback service certificate validation failed (0x0000000100001004)
Make sure you have the correct certificate authority available on your system:
• APNS certificate authority: Entrust Certification Authority, need to validate certificate from
gateway.push.apple.com:2195;
• APNS Feedback certificate authority: Entrust Certification Authority, need to validate certificate from
feedback.push.apple.com:2196;
• FCM certificate authority: GeoTrust Global CA, need to validate certificate from
android.googleapis.com:443.
The desired certificate authority should be included in the certificate store on the MDM host machine. In a
Windows system, you can search for "Manage Trusted Root Certificates". In a Linux system, the certificate
location is dependent on the distribution you are using. Some examples of certificate store destinations include:
• on Debian, CentOS: /usr/lib/ssl/cert.pem, /usr/lib/ssl/certs;
• on Red Hat: /usr/share/ssl/cert.pem, /usr/share/ssl/certs;
• command openssl version -d usually returns desired path.
If the desired certification authority is not installed on the system the MDM Core is running on, install it.
Following installation, restart the ESMC MDC service.

391

Warning
Use caution, certificate validation is a security feature, so if the warning occurs in web console it
could also indicate a security threat.

ESMC for Managed Service Providers
Who is an MSP
The abbreviation MSP stands for "Managed Service Provider". MSP users usually provide IT services to their
customers, for example, the management of security products (e. g. ESET Endpoint Antivirus). MSP users have
different requirements and ways of using ESMC than, for example, enterprise or SMB users. See the
recommended deployment scenarios for MSP.For more information about the ESET MSP program, contact your
local ESET partner or visit the ESET Managed Service Provider Program page.

The structure of entities in the MSP

• Distributor - A distributor is an ESET partner and an MSP or MSP Manager partner.
• MSP Manager - Manages multiple MSP companies. An MSP Manager can also have direct customers.
• MSP - The target audience for this guide. An MSP provides services to its customers. For example, MSPs:
remotely manages customers' computers, installs, and manages ESET products.
• Managed MSP - Similar to MSP, however, Managed MSP is managed by an MSP Manager.
• Customer - The end-user for ESET product licenses. The customer should not interact with ESET products.

MSP environment specifics
The MSP business model uses a different infrastructure setup than an enterprise or SMB. In the MSP
environment, customers are typically located outside of MSP company network. The ESMC Server itself can be
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often hosted outside the MSP company too. ESET Management Agents need to have direct connectivity to the
ESMC Server over public internet. The recommended setups of ESMC Server for MSPs are:
• Hosted in a public cloud.
• Hosted on an MSP's private cloud. (You need to open certain ports to make the ESMC visible from the
Internet.)
• Hosted in an MSP private network. (Use the HTTP Proxy to forwarding the connections from the internet,
if the Server is not directly visible.)

Basic setups
• Centralized setup - Customers access the ESMC Server via the internet. The ESMC Web Console may only
be accessible from the MSP company network.

• Distributed setup - Customers access the ESMC Server via the internet. The ESMC Web Console is
accessible to the MSP via the internet. If you make the Web Console accessible from the internet, make sure
to enable 2FA.

393

Migration from ERA 6.5 and ESMC 7.x
If you have been using your MSP licenses before you installed ESMC 7.2, the MSP tree is synchronized after you
upgrade your ESMC Server to version 7.2. All your static and dynamic groups are unchanged and there is also a
new MSP tree set up for you. You do not have to use the new MSP tree. However, it is recommended to migrate
(move) your devices and groups to the new MSP tree.

Synchronization with EMA 1
The ESMC MSP features are not available for EMA 1 accounts. You can only import licenses from your EMA 1
account using the Security Admin account (same as with ERA 6.x).

New features of ESET Security Management Center for
MSP users
ESMC 7.2 offers a set of improvements focused on MSP users. All MSP related features are enabled after you
import an EMA 2 account to ESMC.

Customer Setup Wizard
The key MSP feature in the ESMC is the MSP customer setup. This feature helps you create a user and customized
ESET Management Agent installer for your customer.

394

MSP Tree
After importing the EMA 2 account, ESMC synchronizes with ESET MSP Portal (EMA 2) and
creates the MSP Tree. The MSP Tree is a structure in the Computers menu, which represents
the structure of companies in your EMA 2 account. Items in the MSP Tree uses different icons
than standard ESMC devices and groups. You can not modify the MSP Tree structure. Only
after you remove the EMA 2 account from the License Management can you start editing and
removing customers from the tree. Suspending a company in EMA 2 does not remove the
company from the MSP Tree in ESMC.

Shared Objects Group
After the synchronization of the MSP account, ESMC creates the MSP tree. There is one Shared Objects static
group for each MSP and MSP manager. MSPs can share objects like policies and tasks via the Shared Objects
group.
Each MSP user created using the company setup wizard has read and use access to all Shared Objects groups
above the user. You can inspect the Permission Sets assigned to the user to see the list of access groups. Users
can access only upstream Shared Object groups, not groups from parallel MSP managers.

ESMC certificates and MSP
When you import the EMA 2 account in ESMC, your ESMC Server creates a new MSP Certification Authority (CA).
The MSP CA is stored in the Shared Objects static group under MSP root group. There is only one MSP CA, even if
you import multiple accounts. If you remove the MSP CA, ESMC creates a new MSP CA after the next
synchronization with the license servers. The synchronization occurs automatically once a day.
ESMC creates a new peer Agent certificate after a company is set up using the customer setup wizard. The MSP
CA signs these peer certificates. Each certificate is tagged with the company name. Creating a separate certificate
for each company improves the overall security.

Important
If you want to use the Advanced security, we strongly recommend to set it up before importing the
MSP account.
If you remove a CA, all computers using certificates signed by that CA would not able to connect to the ESMC
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Server anymore. Manual re-deployment of the ESET Management Agent would be necessary.

MSP in the Status Overview
You get the access to the new MSP tile in the Status Overview after importing the EMA 2 account. The MSP tile
displays basic information about your account.

Deployment process for MSP
If you do not have ESMC installed, we recommend to use the Windows All in one installer and follow the
installation guide, while taking into account the following recommendations:
• Do not choose the option to install the Apache HTTP Proxy. Your customers will contact ESET servers
directly (for downloads, activations, updates). Larger customers may have their own local HTTP Proxy
solution. You can set it up later.
• ESMC Server must have connectivity also to ESET server (to synchronize with EMA 2, download updates,
and others).
After installing the ESMC Server, follow the process below:
1.Make sure you have an eligible EMA 2 account. Create customers with at least one license. You can also
use an existing customer.
2.Import your EMA 2 account to ESMC.
3.Complete the MSP Customer Setup. When prompted, select the Agent only installer.
4.Distribute and install the ESET Management Agent installer locally or remotely.
5.Install ESET Security products and set up policies.

The scheme below is a high-level description of the MSP customer enrollment process.

Local deployment of Agent
Local deployment of Agent-only installer
The Agent-only installer is a script (.bat for Windows, and .sh for Linux and macOS) which contains all
necessary information for a client machine to download and install the ESET Management Agent. If you are
installing on Linux machine, make sure the Linux machine meets the prerequisites.
You can run the installer locally or from removable media (a USB flash drive, for example).
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Important
• The client machine needs to have an internet connection to download the Agent installation
package.
• Make sure that the client machine has an internet connection and can connect to the ESMC
Server.
You can manually edit the script to adjust certain settings if necessary. We recommend it only to advanced users.
Local deployment of All-in-one installer
The All-in-one installer contains an ESET Security product of your choice and a pre-configured ESET Management
Agent installer. Make sure that the client machine has an internet connection and can connect to the ESMC
Server.
See the installer manual for detailed instructions.

Remote deployment of Agent
Remote deployment of Agent-only installer
The Agent-only installer is a script (.bat for Windows, and .sh for Linux and macOS) which contains all
necessary information for a client machine to download and install the ESET Management Agent. If you are
installing on Linux machine, make sure the Linux machine meets the prerequisites. You can distribute the installer
via email and let the user deploy it. If available, use a 3rd party remote management tool to distribute and
execute the script.

Important
• The client machine needs to have an internet connection to download the Agent installation
package.
• Make sure that the client machine has an internet connection and can connect to the ESMC
Server.

Remote deployment of All-in-one installer
The All-in-one installer can be installed remotely, within a local network, using ESET Remote Deployment Tool.
See the ESET Remote Deployment Tool documentation for detailed instructions.

MSP Licenses
Eligible accounts
To enable the MSP features in ESMC 7.2 you need to import your MSP account in ESMC License Management.
You can import following types of EMA 2 accounts: MSP, Managed MSP and MSP Manager. Any account needs to
have at least read permission to at least one company, which can be its parent company or one customer. Access
to the parent company is not required. The distributor account cannot be imported.
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More information on licenses and companies
• Licenses imported from your MSP account are tagged with the company name. If the company is renamed
later, the tags are not renamed automatically. You can edit them manually.
• All licenses are imported in a way compatible with the ESMC security model. Each user created using the
MSP Customer setup can only see and use its licenses.
• If there is a company in your MSP structure which has no licenses by the time of synchronization, that
company is synchronized only to the computer MSP Tree, not to the MSP Tree inside License Management.
• If you add a new company in ESET MSP Administrator 2, ESMC adds the company to the MSP tree after the
next license synchronization.
• When you import an MSP account, all licenses are stored in one license pool. You cannot move a license
out of the pool. You can move the whole license pool. To move the pool, select the pool > Actions > Access
Group > Move and select the new access group. If you synchronize the MSP account afterwards, any new
licenses appear in the pool's actual location.
• You can display the column MSP customer name in the License Management view. This column is hidden
by default, but you can enable it in the menu: click the gear icon
> Edit columns. You can use the MSP
customer name data when creating a report.
• If you have licenses both in ESET Business Account and ESET MSP Administrator 2 under the same
credentials, ESMC synchronizes all licenses from both accounts. All ESET Business Account licenses are saved
in one license pool. Licenses from ESET MSP Administrator 2 are divided into one pool for each company.

Important
If you upgrade from ERA 6.5 or ESMC 7.0 with a synchronized ESET MSP Administrator 2 account,
license pools remain in their original Access Groups. You need to move individual license pools to
MSP customer groups before you can create installers. To move the license pool, navigate to
License Management, select a license pool and select Access Group > Move. Keep in mind that
moving licenses to a different static group affects existing installers and user security.
• When removing any license pool, you automatically remove all other license pools associated with the
same account. Read more about how to remove a company.
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On-demand synchronization
The ESMC Server synchronizes with the license servers once a day. If you have made changes in your MSP account
and you want to update the license screen and MSP tree, navigate to License Management > Actions and click
Synchronize Licenses.
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Importing an MSP account
Important
If you want to use the Advanced security, we strongly recommend to set it up before importing the
MSP account.

1.Log in to the Web Console and navigate to More > License Management.
2.Click Actions > Add Licenses.
3.Select ESET Business Account or ESET MSP Administrator option. Enter your MSP credentials (EMA 2 login)
to Login and Password fields below.
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4.Click Add Licenses to confirm.

5.ESMC now synchronizes your structure from the MSP portal to the Computers menu in the Web Console.
The synchronized structure is called MSP Tree.

Note
Importing an MSP account with a large number of customers (thousands) can take a very long time,
even hours.
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Start MSP customer setup
After you import your MSP account and the MSP tree is synchronized, you can start setting up companies. The
MSP customer setup creates:
• A custom ESET Management or bundled Agent and ESET security product installer. The MSP customer
setup does not support creating ESET Full Disk Encryption installers.
• An MSP user which can manage company computers using the Web Console.
You can also skip the MSP customer setup, but we recommend that you complete the MSP setup.

Important
You can setup only a company with at least 1 valid license seat.
1.In the Computers window, click the gear icon next to the company you want to set up and select Start MSP
customer setup.

2.If you want to save this configuration as default setup, select the check box under Remember settings. Click
Continue.
3.If you want to create a custom installer during the setup (recommended), select the check box under Create
installer.
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4.You can create two types of installers:
• Agent-only installer (all platforms) - You can install this agent live installer on Windows, macOS and Linux
computers.
• All-in-one installer - The installer consists of ESET Management Agent and selected ESET Business security
product (Windows).
If you do not see the All-in-one installer option, make sure a license is assigned to the company.
I have selected All-in-one installer
Product - Select an ESET security product that will be installed together with ESET Management Agent.
Language - Select the language version of the ESET security product installer.
Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See License Management or EULA for more information.
To save the installer in Installers for future use, select the check box next to Save installer in installers section.
Advanced installer settings (recommended)
Server hostname is the address where ESET Management Agents connect to the ESMC Server. Select a different
port for Agent - Server communication if necessary. If you change the port, you have to change it for all
connecting agents and also in the server settings.

Make sure that all client devices that will use the installer can reach the Server hostname address. See the
MSP environment recommendations.
Enable HTTP Proxy settings
Select the check box Enable HTTP Proxy settings and specify the Proxy settings (Server, Port, Login and
Password) to set ESET Management Agent connection to Proxy to enable communication forwarding between
ESET Management Agent and ESMC Server. The Server field is the address of the machine where the HTTP Proxy
is running. HTTP Proxy uses the port 3128 by default. You can set a different port if needed. Make sure to set the
same port also in the HTTP Proxy configuration.
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Important
The communication protocol between Agent and ESMC Server does not support authentication. Any
proxy solution used for forwarding Agent communication to ESMC Server that requires
authentication will not work.
oWhen you select Enable fallback, ESET Management Agent will use a direct connection to ESMC Server if
HTTP Proxy is not available.

5.Click Continue to move to the User section.
6.If you want to create a new user for the company (recommended), select the check box next to the Create
native user. The user can log in to the Web Console and manage the company devices. Enter a valid username
(not containing following characters , ; " ) and password for the new user.
a.Require password change - the user has to change their password after their first login.
b.Access rights - select if user has Read and Use or Write access to the company objects (computers,
policies, tasks).
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Note
The AD synchronization is not available for users created using the MSP company setup.

Click Finish to prepare the installer. Click the link and download the installer you need. You can also re-download
the installer from the Installers menu if you have selected to save the installer.
Read how to deploy the ESET Management Agent locally or remotely.

Skip MSP customer setup
You can Skip the MSP customer setup if you do not want to set it up. Optionally, you can create an installer and a
new user later. We do not recommend to skip the setup.

After skipping the setup, the icon of the company is changed as if it has been set up:
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Warning
If you skip the setup, you cannot run the setup wizard for the company again on the same ESMC
instance.

Create custom installer
1.In the ESMC Web Console navigate to the Computers menu.
2.Click the gear icon
installer.
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next to the company you want to create the installer for and select Download

3.You can create two types of installers:
• Agent-only installer (all platforms) - You can install this agent live installer on Windows, macOS and Linux
computers.
• All-in-one installer - The installer consists of ESET Management Agent and selected ESET Business security
product (Windows).
If you do not see the All-in-one installer option, make sure a license is assigned to the company.
I have selected All-in-one installer
Product - Select an ESET security product that will be installed together with ESET Management Agent.
Language - Select the language version of the ESET security product installer.
Select the check box I accept the terms of the application End User License Agreement and acknowledge the
Privacy Policy. See License Management or EULA for more information.
To save the installer in Installers for future use, select the check box next to Save installer in installers section.
Advanced installer settings (recommended)
Server hostname is the address where ESET Management Agents connect to the ESMC Server. Select a different
port for Agent - Server communication if necessary. If you change the port, you have to change it for all
connecting agents and also in the server settings.

Make sure that all client devices that will use the installer can reach the Server hostname address. See the
MSP environment recommendations.
Enable HTTP Proxy settings
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Select the check box Enable HTTP Proxy settings and specify the Proxy settings (Server, Port, Login and
Password) to set ESET Management Agent connection to Proxy to enable communication forwarding between
ESET Management Agent and ESMC Server. The Server field is the address of the machine where the HTTP Proxy
is running. HTTP Proxy uses the port 3128 by default. You can set a different port if needed. Make sure to set the
same port also in the HTTP Proxy configuration.

Important
The communication protocol between Agent and ESMC Server does not support authentication. Any
proxy solution used for forwarding Agent communication to ESMC Server that requires
authentication will not work.
oWhen you select Enable fallback, ESET Management Agent will use a direct connection to ESMC Server if
HTTP Proxy is not available.
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4.Click Create to create the installer.
5.Click the link and download the installer you need.

MSP Users
If you set up your company using the MSP customer setup, you can create a special type of native user (MSP
User). You can review and edit the user in the More > Access Rights > Users menu.
You can also create a custom MSP user, for example for an MSP or a reseller.
MSP User features:
• They can log in to the ESMC Web console and manage devices and other objects they has access rights for.
• They can create another native user with the same or lesser permissions.
• They cannot create Computer Users. If creating a Computer User is required, an administrator needs to
do so.

Important
The AD synchronization is not available for users created using the MSP company setup.
ESMC has the following settings for each new MSP user:
• Description - Native user created via the MSP customer setup wizard
• Tags - The user is tagged with the company name
• Home group - Static group of the company
• Autologout - 15 minutes
• The account is enabled and password change is not required
• Permission sets - each MSP User has 2 permission sets. One for its home group and one for Shared
Objects groups.
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Create a custom MSP user
You can create native Web Console users to manage customers, for example, for an MSP or a reseller.
1.You need to have the MSP company created in EMA 2.
2.Verify that the MSP company is synchronized in the MSP tree.
3.Create a native user. Critical settings for a custom MSP user are:
a.The Home Group of the user is set to the corresponding MSP static group.
b.Create and assign following permission sets to the user:
i.Write permissions for the Home group.
ii.Use or Write permissions for the Shared Objects groups.
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Note
The top Shared Objects group contains the MSP CA. The access to the MSP CA is necessary for the
user to create an installer.

The access scheme for a custom MSP user.
Custom MSP user created using these steps is eligible to manage customer devices and create installers, however,
the user can not manage ESMC Server or import licenses.

Tagging of MSP objects
If you import a valid MSP account to ESMC, you enable automatic tagging of MSP objects. The following objects
are tagged automatically:
• Licenses imported via MSP account
• Installers
• Users and their Permission Sets created using the MSP customer setup

The tag is a form of label used to improve the filtering of objects. The automatic tag name is the same as the MSP
Customer Name (Company name in EMA 2, except characters , " which ESMC drops from the tag). If you rename
the Customer in EMA 2 later, tags are not updated. You can add more custom tags to any object if you want to.
Click the
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expand icon to view the Tags tab.

MSP Status overview
The Status overview section provides complex information about your ESMC status. If you import an MSP
account, there is an MSP tile available with MSP-related information.

MSP statuses
Account synchronized
Your account is synchronized and no action is needed.

Ongoing synchronization
There is ongoing synchronization of MSP account running in the background. The synchronization can take up to
several hours for large accounts. The tile turns white after the synchronization.

Disconnected account
There are some MSP groups (parts of MSP tree) in your Static groups structure, but there is no corresponding
MSP account imported. This can occur if you remove your MSP account from License Management.
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Available actions
Click the MSP tile to see more details.
• Check for new MSP customers - Run on-demand license synchronization (update the MSP tree).

• New clients - If you have some not set companies, you can click them and follow the customer setup
wizard.
• Skip setup for all new MSP customers - Skip setup wizards for all companies that are not set.

• Connect MSP Administrator - You can add your MSP account to import your MSP licenses and structure.
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Removing a company
The MSP tree is synchronized with the MSP account. You need to remove the MSP account from the License
Management to unlock the MSP tree. Once you remove the account, all companies managed by that account are
unlinked from the MSP tree.

Important
• If you stop managing a company, remove ESET Management Agents from that company
computers. You cannot remove the company from the MSP tree without removing the whole MSP
account from your license management.
• The MSP static group is persistent. Once you import an MSP license, you can never remove the
MSP root group, only its child groups.

Removing the MSP account and companies from the MSP tree
1.Log in to ESMC Web Console and navigate to More > License Management.
2.Click the license you want to remove > Remove Licenses. Keep in mind, that if you remove any license linked
to an MSP account, the whole account and its linked licenses are removed from ESMC.

3.Confirm your choice to remove (unlink) the listed licenses from the License Management.
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Warning
When removing any license pool, you automatically remove all other license pools associated with
the same account.
For example, Company X licenses were imported using credentials of joe@test.me from EMA 2. If a
user removes licenses of the Company X, all the licenses imported from joe@test.me EBA and EMA
2 accounts get removed from the License Management.

4.Wait a few moments after the action and navigate to the Computers menu.
5.Now you can click and Delete any company that was previously a part of the MSP Tree. You can only remove
a company (its static group) if it is empty.

Note
After you remove the MSP account from the License Management, you get the MSP Administrator
is not connected status in the Status Overview. You need to remove all groups from your former
MSP tree (in the Computers menu) to turn off that status.
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Update ESMC
ESET Security Management Center Server regularly checks for available updates to ESMC infrastructure.
When an update is available, a popup window appears:

You can read about the changes in the available ESMC update by clicking read a changelog.
If you do not select to update, you can display the update popup window by clicking Help > Update Product:
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Note
Only the users who can run Security Management Center Components Upgrade client task can see
the update notification.
1.Click the Open Certification Authorities button and back up all your CAs.
2.Click the Open Peer Certificates button and back up all your certificates.
3.Click the Open Documentation button and back up the ESMC database.
4.Click the Update button. An update of your ESMC Server is scheduled - in Tasks you can find a new client
task that upgrades ESMC components on the computer where ESMC Server is installed. To update other ESMC
components on the devices connected to ESMC Server to the latest version, you can trigger Security
Management Center Components Upgrade task directly from the update popup window.

FAQ
List of questions
1.How do you resolve the error Login Failed, Connection has failed with the state of 'Not connected'?
2.What is the group "Lost and Found" used for?
3.How do you create a dual update profile?
4.How do you refresh the information on a page or in a section of the page without refreshing the entire
browser window?
5.How do you perform a silent installation of the ESET Management Agent?
6.RD Sensor does not detect all clients on network.
7.How do I reset the Active detections count shown in ESMC after cleaning detections?
8.How do I set up CRON expression for the ESET Management Agent connection interval?
9.How do I create new Dynamic Group for automatic deployment?
10. When importing a file containing a list of computers to add to ESMC, what is the format required for
the file?
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11. Which 3rd party certificates can be used to sign ESMC certificates?
12. How do I reset the Administrator password for Web Console (The password entered during set up on
Windows Operating Systems)?
13. How do I reset the Administrator password for Web Console (Linux, entered during set up)?
14. How to troubleshoot if RD Sensor is not detecting anything?
15. I can not see items in the Dynamic Groups Templates window—why?
16. I can not see any information in the Dashboard window—why?
17. How can I upgrade my ESET security product?
18. How can I change the suffix in the address of the Web Console

Q: How do you resolve the error Login Failed, Connection has failed with the state of 'Not connected'?
A: Check if ESMC Server service is running or MS SQL Server service. If not, start it. If it is running, restart the
service, refresh web console and then try to log in again. For more information see Troubleshooting login.

Q: What is the group "Lost and Found" used for?
A: Each computer that connects to ESMC server and is not a member of any static group is automatically
displayed in this group. You can work with the group and the computers inside it as with computers in any other
static group. The group can be renamed or moved under another group but it can't be deleted.

Q: How do you create a dual update profile?
A: See our ESET Knowledgebase article for step-by-step instructions.

Q: How do you refresh the information on a page or in a section of the page without refreshing the entire
browser window?
A: Click Refresh in the context menu at the top right of a section of the page.

Q: How do you perform a silent installation of the ESET Management Agent?
A: Following methods allow you to perform silent installation:
• GPO or SCCM script
• Agent deployment task
• ESET Remote Deployment Tool

Q: RD Sensor does not detect all clients on network.
A: RD sensor passively listens to network communication on the network. If PCs are not communicating, they are
418

not listed by RD Sensor. Check your DNS settings to make sure that issues with DNS lookup are not preventing
communication.

Q: How do I reset the Active detections count shown in ESMC after cleaning detections?
A: To reset the number of active detections, a full (In-depth scan) needs to be started via ESMC on the target
computer(s). If you have cleaned a detection manually, you can mark it as solved.

Q: How do I set up CRON expression for the ESET Management Agent connection interval?
A: P_REPLICATION_INTERVAL accepts a CRON expression.
Default is "R R/20 * * * ? *" which means connecting at random second (R=0-60) every random 20th minute (for
example 3, 23, 43 or 17,37,57). Random values should be used for load balancing in time. So every ESET
Management Agent is connecting in different random time. If an accurate CRON is used, for example "0 * * * * ?
*", all Agents with this setting will connect at the same time (every minute at :00 second) there will be load peaks
on server in this time. For more information see Cron expression interval.

Q: How do I create new Dynamic Group for automatic deployment?
A: See our Knowledgebase article for step-by-step instructions.

Q: When importing a file containing a list of computers to add to ESMC, what is the format required for the file?
A: File with following lines:

All\Group1\GroupN\Computer1
All\Group1\GroupM\ComputerX
All is the required name of root group.

Q: Which 3rd party certificates can be used to sign ESMC certificates?
A: The certificate has to be CA (or intermediate CA) certificate with the 'keyCertSign' flag from 'keyUsage'
constraint. This means that it can be used for signing other certificates.

Q: How do I reset the Administrator password for Web Console (The password entered during set up on
Windows operating systems)?
A: It is possible to reset the password by running the server installer and choosing Repair. Note that you may
require the password for the ESMC database if you did not use Windows Authentication during creation of the
database. See the Knowledgebase article on this topic.
419

Important
• Please be careful, some of the repair options can potentially remove stored data.
• Password reset disables the 2FA.

Q: How do I reset the Administrator password for Web Console (Linux, entered during set up)?
A: If you have another user in ESMC with sufficient rights, you should be able to reset the administrator account
password. However, if administrator is the only account (as it is created upon installation) in the system, you
cannot reset this password. See the Knowledgebase article on this topic.

Q: How to troubleshoot if RD Sensor is not detecting anything?
A: If your OS is detected as a network device, it won't be sent to ESMC as a computer. Network devices (printers,
routers) are filtered out. RD Sensor was compiled with libpcap version 1.3.0, please verify that you have this
version installed on your system. The second requirement is a bridged network from your virtual machine where
RD Sensor is installed. If these requirements are met, run nmap with OS detection
(http://nmap.org/book/osdetect-usage.html) to see whether it can detect the OS on your computer.

Q: I cannot see items in the Dynamic Groups Templates window—why?
A: Most likely, your users do not have sufficient permissions. Users can see templates only if they are contained in
a static group where the user has been assigned at least Read permissions for Dynamic Group Templates.

Q: I cannot see any information in the Dashboard window—why?
A: Most likely, your users do not have sufficient permissions. Users need to have permissions over computers and
also for Dashboard to have the data displayed. See the example permission set.

Q: How can I upgrade my ESET security product?
A: Use the Software install task and select the product to upgrade.

Q: How can I change the suffix in the address of the Web Console
A: If your Web Console address is, for example, 10.1.0.5/era and you would like to change the suffix era, never
rename the folder itself. Changing the address is not recommended, but if you need to do that, create a link in the
webapps folder with a different name.
For example, on Linux or Virtual Appliance you can use the following command:
ln -sf /var/lib/tomcat/webapps/era/ /var/lib/tomcat/webapps/esmc

420

After executing this command in the terminal, your Web Console is accessible also at 10.1.0.5/esmc (change the
IP address for your own).

About ESET Security Management Center
To open the About window, navigate to Help > About. This window provides details about the version of ESET
Security Management Center. The top of the window contains information about the number of connecting client
devices and number of active licenses. Also, you will see the list of installed program modules, your operating
system, and a license which is used by ESMC to download module updates (the same license used to activate
ESMC). Information about your database, such as name, version, size, hostname and user are displayed in this
window.

Note
For instructions to find out which version an ESMC component is, see our Knowledgebase article.

End User License Agreement
IMPORTANT: Please read the terms and conditions of product application set out below carefully prior to
download, installation, copy or use. THROUGH DOWNLOADING, INSTALLING, COPYING OR USING THE
SOFTWARE YOU ARE EXPRESSING YOUR CONSENT TO THESE TERMS AND CONDITIONS AND YOU
ACKNOWLEDGE PRIVACY POLICY.
End User License Agreement
Under the terms of this End User License Agreement (hereinafter referred to as "the Agreement") executed by
and between ESET, spol. s r. o., having its registered office at Einsteinova 24, 851 01 Bratislava, Slovak Republic,
registered in the Commercial Register administered by Bratislava I District Court, Section Sro, Entry No 3586/B,
Business Registration Number: 31333532 (hereinafter referred to as "ESET" or "the Provider") and you, a physical
person or legal entity (hereinafter referred to as "You" or "the End User"), You are entitled to use the Software
defined in Article 1 of this Agreement. The Software defined in Article 1 of this Agreement can be stored on a data
carrier, sent via electronic mail, downloaded from the Internet, downloaded from the Provider's servers or
obtained from other sources, subject to the terms and conditions specified below.
THIS IS AN AGREEMENT ON END USER RIGHTS AND NOT AN AGREEMENT FOR SALE. The Provider continues to
own the copy of the Software and the physical media contained in the sales package and any other copies that
the End User is authorized to make pursuant to this Agreement.
By clicking on "I Accept" or "I Accept…" while installing, downloading, copying or using the Software, You agree to
the terms and conditions of this Agreement. If You do not agree to all of the terms and conditions of this
Agreement, immediately click on the canceling option, cancel the installation or download, or destroy or return
the Software, installation media, accompanying documentation and sales receipt to the Provider or the outlet
from which You acquired the Software.
YOU AGREE THAT YOUR USE OF THE SOFTWARE ACKNOWLEDGES THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
1. Software. As used in this Agreement the term "Software" means: (i) computer program accompanied by this
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Agreement and all components thereof; (ii) all the contents of the disks, CD-ROMs, DVDs, e-mails and any
attachments, or other media with which this Agreement is provided, including the object code form of the
Software supplied on a data carrier, via electronic mail or downloaded via the Internet; (iii) any related
explanatory written materials and any other possible documentation related to the Software, above all any
description of the Software, its specifications, any description of the Software properties or operation, any
description of the operating environment in which the Software is used, instructions for use or installation of the
Software or any description of how to use the Software (hereinafter referred to as " Documentation "); (iv) copies
of the Software, patches for possible errors in the Software, additions to the Software, extensions to the
Software, modified versions of the Software and updates of Software components, if any, licensed to You by the
Provider pursuant to Article 3 of this Agreement. The Software shall be provided exclusively in the form of
executable object code.
2. Installation, Computer and a License key. Software supplied on a data carrier, sent via electronic mail,
downloaded from the Internet, downloaded from the Provider's servers or obtained from other sources requires
installation. You must install the Software on a correctly configured Computer, complying at least with
requirements set out in the Documentation. The installation methodology is described in the Documentation. No
computer programs or hardware which could have an adverse effect on the Software may be installed on the
Computer on which You install the Software. Computer means hardware, including but not limited to personal
computers, laptops, workstations, palmtop computers, smart phones, hand-held electronic devices, or other
electronic devices for which the Software is designed, on which it will be installed and/or used. License key means
the unique sequence of symbols, letters, numbers or special signs provided to the End User in order to allow the
legal use of the Software, its specific version or extension of the term of the License in compliance with this
Agreement.
3. License. Subject to the condition that You have agreed to the terms of this Agreement and You comply with all
the terms and conditions stipulated herein, the Provider shall grant You the following rights (hereinafter referred
to as "License"):
a) Installation and use. You shall have the non-exclusive, non-transferable right to install the Software on the
hard disk of a Computer or other permanent medium for data storage, installation and storage of the Software in
the memory of a computer system and to implement, store and display the Software.
b) Stipulation of the number of licenses. The right to use the Software shall be bound by the number of End
Users. One End User shall be taken to refer to the following: (i) installation of the Software on one computer
system; or (ii) if the extent of a license is bound to the number of mail boxes, then one End User shall be taken to
refer to a computer user who accepts electronic mail via a Mail User Agent (hereinafter referred to as "MUA"). If
MUA accepts electronic mail and subsequently distributes it automatically to several users, then the number of
End Users shall be determined according to the actual number of users for whom the electronic mail is
distributed. If a mail server performs the function of a mail gate, the number of End Users shall equal the number
of mail server users for which the said gate provides services. If an unspecified number of electronic mail
addresses are directed to and accepted by one user (e.g., through aliases) and messages are not automatically
distributed by the client to a larger number of users, a License for one computer shall be required. You must not
use the same License at the same time on more than one Computer. The End User is entitled to enter the License
key to the Software only to the extent in which has the right to use the Software in accordance the limitation
arising from the number of Licenses granted by Provider. The License key is deemed confidential, You must not
share the License with third parties or allow third parties to use the License key unless permitted by this
Agreement or Provider. If your License key is compromised, notify Provider immediately.
c) Business Edition. A Business Edition version of the Software must be obtained to use the Software on mail
servers, mail relays, mail gateways or Internet gateways.
d) Term of the License. Your right to use the Software shall be time-limited.
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e) OEM Software. OEM Software shall be limited to the Computer You obtained it with. It cannot be transferred
to a different Computer.
f) NFR, TRIAL Software. Software classified as "Not-for-resale", NFR or TRIAL cannot be assigned for payment and
must only be used for demonstration or testing the Software's features.
g) Termination of the License. The License shall terminate automatically at the end of the period for which
granted. If You fail to comply with any of the provisions of this Agreement, the Provider shall be entitled to
withdraw from the Agreement, without prejudice to any entitlement or legal remedy open to the Provider in such
eventualities. In the event of cancellation of the License, You must immediately delete, destroy or return at your
own cost, the Software and all backup copies to ESET or to the outlet from which You obtained the Software.
Upon termination of the License, the Provider shall be also entitled to cancel the End User's entitlement to use
the functions of the Software, which require connection to the Provider's servers or third-party servers.
4. Functions with data collection and internet connection requirements. To operate correctly the Software
requires connection to the Internet and must connect at regular intervals to the Provider's servers or third-party
servers and applicable data collection in compliance with Privacy Policy. Connection to the Internet and applicable
data collection is necessary for the following functions of the Software:
a) Updates to the Software. The Provider shall be entitled from time to issue updates to the Software
("Updates"), but shall not be obliged to provide Updates. This function is enabled under the Software's standard
settings and Updates are therefore installed automatically, unless the End User has disabled automatic
installation of Updates. For the purpose of provisioning of Updates, License authenticity verification is required
including information about Computer and/or the platform on which the Software is installed in compliance with
Privacy Policy.
b) Forwarding of Information to the Provider. The Software contains functions which collect data about the
installation process, the Computer and/or the platform on which the Software is installed, information about the
operations and functionality of the Software and information about managed devices (hereinafter referred to as
"Information") and then send them to the Provider. The Information may contain data (including randomly or
accidentally obtained personal data) concerning managed devices. By activating this function of the Software,
Information may be collected and processed by the Provider as specified in Privacy Policy and in compliance with
relevant legal regulations.
The Software requires a component installed on managed computer, which enables transfer of information
between managed computer and remote management software. Information, which are subject to transfer
contains management data such as hardware and software information of managed computer and managing
instructions from the remote management software. Other content of data transferred from managed computer
shall be determined by the settings of software installed on managed computer. The content of instructions from
management software shall be determined by settings of remote management software.
For the purpose of this Agreement, it is necessary to collect, process and store data enabling the Provider to
identify You in compliance with Privacy Policy. You hereby acknowledge that the Provider checks using its own
means whether You are using the Software in accordance with the provisions of this Agreement. You hereby
acknowledge that for the purpose of this Agreement it is necessary for your data to be transferred, during
communication between the Software and the Provider's computer systems or those of its business partners as
part of Provider’s distribution and support network to ensure functionality of Software and authorization to use
the Software and to protection of the Provider’s rights.
Following conclusion of this Agreement, the Provider or any of its business partners as part of Provider’s
distribution and support network shall be entitled to transfer, process and store essential data identifying You for
billing purposes, performance of this Agreement and transmitting notifications on your Computer. You hereby
agree to receive notification and messages including but not limited to marketing information.
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Details about privacy, personal data protection and Your rights as a data subject can be found in Privacy Policy
which is available on Provider’s website and accessible directly from the installation process. You can also visit
it from Software’s help section.
5. Exercising End User rights. You must exercise End User rights in person or via your employees. You are only
entitled to use the Software to safeguard your operations and protect those Computers or computers systems for
which You have obtained a License.
6. Restrictions to rights. You may not copy, distribute, extract components or make derivative works of the
Software. When using the Software, You are required to comply with the following restrictions:
(a) You may make one copy of the Software on a permanent storage medium as an archival back-up copy,
provided your archival back-up copy is not installed or used on any Computer. Any other copies You make of the
Software shall constitute breach of this Agreement.
(b) You may not use, modify, translate or reproduce the Software or transfer rights to use the Software or copies
of the Software in any manner other than as provided for in this Agreement.
(c) You may not sell, sub-license, lease or rent or borrow the Software or use the Software for the provision of
commercial services.
(d) You may not reverse engineer, reverse compile or disassemble the Software or otherwise attempt to discover
the source code of the Software, except to the extent that this restriction is expressly prohibited by law.
(e) You agree that You will only use the Software in a manner that complies with all applicable laws in the
jurisdiction in which You use the Software, including, but not limited to, applicable restrictions concerning
copyright and other intellectual property rights.
(f) You agree that You will only use the Software and its functions in a way which does not limit the possibilities of
other End Users to access these services. The Provider reserves the right to limit the scope of services provided to
individual End Users, to enable use of the services by the highest possible number of End Users. Limiting the
scope of services shall also mean complete termination of the possibility to use any of the functions of the
Software and deletion of Data and information on the Provider's servers or third-party servers relating to a
specific function of the Software.
(g) You agree not exercise any activities involving use the License key, contrary to the terms of this Agreement or
leading to provide License key to any person who is not entitled to use the Software, such as the transfer of used
or unused License key in any form, as well as the unauthorized reproduction, or distribution of duplicated or
generated License keys or using the Software as a result of the use of a License key obtained from the source
other than the Provider.
7. Copyright. The Software and all rights, without limitation including proprietary rights and intellectual property
rights thereto are owned by ESET and/or its licensors. They are protected by international treaty provisions and
by all other applicable national laws of the country in which the Software is being used. The structure,
organization and code of the Software are the valuable trade secrets and confidential information of ESET and/or
its licensors. You must not copy the Software, except as set forth in Article 6(a). Any copies which You are
permitted to make pursuant to this Agreement must contain the same copyright and other proprietary notices
that appear on the Software. If You reverse engineer, reverse compile, disassemble or otherwise attempt to
discover the source code of the Software, in breach of the provisions of this Agreement, You hereby agree that
any information thereby obtained shall automatically and irrevocably be deemed to be transferred to and owned
by the Provider in full, from the moment such information comes into being, notwithstanding the Provider's rights
in relation to breach of this Agreement.
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8. Reservation of rights. The Provider hereby reserves all rights to the Software, with the exception of rights
expressly granted under the terms of this Agreement to You as the End User of the Software.
9. Multiple language versions, dual media software, multiple copies. In the event that the Software supports
multiple platforms or languages, or if You receive multiple copies of the Software, You may only use the Software
for the number of computer systems and for the versions for which You obtained a License. You may not sell,
rent, lease, sub-license, lend or transfer versions or copies of the Software which You do not use.
10. Commencement and termination of the Agreement. This Agreement shall be effective from the date You
agree to the terms of this Agreement. You may terminate this Agreement at any time by permanently
uninstalling, destroying and returning, at your own cost, the Software, all back-up copies and all related materials
provided by the Provider or its business partners. Irrespective of the manner of termination of this Agreement,
the provisions of Articles 7, 8, 11, 13, 19 and 21 shall continue to apply for an unlimited time.
11. END USER DECLARATIONS. AS THE END USER YOU ACKNOWLEDGE THAT THE SOFTWARE IS PROVIDED "AS
IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, AND TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW. NEITHER THE PROVIDER, ITS LICENSORS OR AFFILIATES, NOR THE COPYRIGHT HOLDERS MAKE
ANY REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR THAT THE SOFTWARE WILL
NOT INFRINGE ANY THIRD-PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS. THERE IS NO
WARRANTY BY THE PROVIDER OR BY ANY OTHER PARTY THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE
WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR
ERROR-FREE. YOU ASSUME ALL RESPONSIBILITY AND RISK FOR THE SELECTION OF THE SOFTWARE TO ACHIEVE
YOUR INTENDED RESULTS AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM IT.
12. No other obligations. This Agreement creates no obligations on the part of the Provider and its licensors other
than as specifically set forth herein.
13. LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
THE PROVIDER, ITS EMPLOYEES OR LICENSORS BE LIABLE FOR ANY LOST PROFITS, REVENUE, SALES, DATA OR
COSTS OF PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, PROPERTY DAMAGE, PERSONAL INJURY,
INTERRUPTION OF BUSINESS, LOSS OF BUSINESS INFORMATION OR FOR ANY SPECIAL, DIRECT, INDIRECT,
INCIDENTAL, ECONOMIC, COVER, PUNITIVE, SPECIAL OR CONSEQUENTIAL DAMAGES, HOWEVER CAUSED AND
WHETHER ARISING UNDER CONTRACT, TORT, NEGLIGENCE OR OTHER THEORY OF LIABILITY, ARISING OUT OF THE
USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF THE PROVIDER OR ITS LICENSORS OR AFFILIATES ARE
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME COUNTRIES AND JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OF LIABILITY, BUT MAY ALLOW LIABILITY TO BE LIMITED, IN SUCH CASES, THE LIABILITY
OF THE PROVIDER, ITS EMPLOYEES OR LICENSORS OR AFFILIATES SHALL BE LIMITED TO THE SUM THAT YOU PAID
FOR THE LICENSE.
14. Nothing contained in this Agreement shall prejudice the statutory rights of any party dealing as a consumer if
running contrary thereto.
15. Technical support. ESET or third parties commissioned by ESET shall provide technical support at their own
discretion, without any guarantees or declarations. The End User shall be required to back up all existing data,
software and program facilities prior to the provision of technical support. ESET and/or third parties
commissioned by ESET cannot accept liability for damage or loss of data, property, software or hardware or loss
of profits due to the provision of technical support. ESET and/or third parties commissioned by ESET reserve the
right to decide that resolving the problem is beyond the scope of technical support. ESET reserves the right to
refuse, suspend or terminate the provision of technical support at its own discretion. License information,
Information and other data in compliance with Privacy Policy may be required for the purpose of technical
support provision.
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16. Transfer of the License. The Software can be transferred from one Computer to another, unless contrary to
the terms of the Agreement. If not contrary to the terms of the Agreement, the End User shall only be entitled to
permanently transfer the License and all rights ensuing from this Agreement to another End User with the
Provider's consent, subject to the condition that (i) the original End User does not retain any copies of the
Software; (ii) the transfer of rights must be direct, i.e. from the original End User to the new End User; (iii) the
new End User must assume all the rights and obligations incumbent on the original End User under the terms of
this Agreement; (iv) the original End User has to provide the new End User with documentation enabling
verification of the genuineness of the Software as specified under Article 17.
17. Verification of the genuineness of the Software. The End User may demonstrate entitlement to use the
Software in one of the following ways: (i) through a license certificate issued by the Provider or a third party
appointed by the Provider; (ii) through a written license agreement, if such an agreement was concluded; (iii)
through the submission of an e-mail sent by the Provider containing licensing details (user name and password).
License information and End User identification data in compliance with Privacy Policy may be required for the
purpose of Software genuineness verification.
18. Licensing for public authorities and the US Government. The Software shall be provided to public authorities,
including the United States Government, with the license rights and restrictions described in this Agreement.
19. Trade control compliance.
(a) You will not, directly or indirectly, export, re-export, transfer or otherwise make available the Software to any
person, or use it in any manner, or be involved in any act, that could result in ESET or its holding companies, its
subsidiaries, and the subsidiaries of any of its holding companies, as well as entities controlled by its holding
companies (hereinafter referred to as "Affiliates") being in violation of, or being subject to negative consequences
under, Trade Control Laws which includes
i. any laws that control, restrict, or impose licensing requirements on export, re-export or transfer of goods,
software, technology, or services, issued or adopted by any government, state or regulatory authority of the
United States of America, Singapore, the United Kingdom, the European Union or any of its Member States, or
any country in which obligations under the Agreement are to be performed, or in which ESET or any of its
Affiliates are incorporated or operate (hereinafter referred to as "Export Control Laws") and
ii. any economic, financial, trade or other, sanction, restriction, embargo, import or export ban, prohibition on
transfer of funds or assets or on performing services, or equivalent measure imposed by any government, state or
regulatory authority of the United States of America, Singapore, the United Kingdom, the European Union or any
of its Member States, or any country in which obligations under the Agreement are to be performed, or in which
ESET or any of its Affiliates are incorporated or operate (hereinafter referred to as "Sanction Laws").
(b) ESET shall have the right to suspend its obligations under, or terminate, these Terms with immediate effect in
the event that:
i. ESET determines that, in its reasonable opinion, the User has breached or is likely to breach provision of Article
19.a of the Agreement; or
ii. the End User and/or the Software become subject to Trade Control Laws and, as a result, ESET determines that,
in its reasonable opinion, the continued performance of its obligations under the Agreement could result in ESET
or its Affiliates being in violation of, or being subject to negative consequences under, Trade Control Laws.
(c) Nothing in the Agreement is intended, and nothing should be interpreted or construed, to induce or require
either party to act or refrain from acting (or to agree to act or refrain from acting) in any manner which is
inconsistent with, penalized, or prohibited under any applicable Trade Control Laws.

426

20. Notices. All notices and return of the Software and Documentation must be delivered to: ESET, spol. s r. o.,
Einsteinova 24, 851 01 Bratislava, Slovak Republic.
21. Applicable law. This Agreement shall be governed by and construed in accordance with the laws of the Slovak
Republic. The End User and the Provider hereby agree that the principles of the conflict of laws and the United
Nations Convention on Contracts for the International Sale of Goods shall not apply. You expressly agree that any
disputes or claims ensuing from this Agreement with respect to the Provider or any disputes or claims relating to
use of the Software shall be settled by Bratislava I District Court and You expressly agree to the said court
exercising jurisdiction.
22. General provisions. Should any of the provisions of this Agreement be invalid or unenforceable, this shall not
affect the validity of the other provisions of the Agreement, which shall remain valid and enforceable under the
conditions stipulated therein. In case of a discrepancy between language versions of this Agreement, the English
version shall prevail. This Agreement may only be modified in written form, signed by an authorized
representative of the Provider, or a person expressly authorized to act in this capacity under the terms of a power
of attorney.
This is the entire Agreement between the Provider and You relating to the Software and it supersedes any prior
representations, discussions, undertakings, communications or advertising relating to the Software.
EULA ID: BUS-ESMC-20-01

Privacy policy
ESET, spol. s r. o., having its registered office at Einsteinova 24, 851 01 Bratislava, Slovak Republic, registered in
the Commercial Register administered by Bratislava I District Court, Section Sro, Entry No 3586/B, Business
Registration Number: 31333532 as a Data Controller ("ESET" or "We") would like to be transparent when it comes
to processing of personal data and privacy of our customers. To achieve this goal, We are publishing this Privacy
Policy with the sole purpose of informing our customer ("End User" or "You") about following topics:
• Processing of Personal Data,
• Data Confidentiality,
• Data Subject's Rights.

Processing of Personal Data
Services provided by ESET implemented in our product are provided under the terms of End User License
Agreement ("EULA"), but some of them might require specific attention. We would like to provide You with more
details on data collection connected with the provision of our services. We render various services described in
the EULA and product documentation such as update/upgrade service, ESET LiveGrid®, protection against misuse
of data, support, etc. To make it all work, We need to collect the following information:
• Management of ESET Security products requires and locally stores information such as seat ID and name,
product name, license information, activation and expiration information, hardware and software information
concerning managed computer with ESET Security product installed. Logs concerning activities of managed
ESET Security products and devices are collected and available in order to facilitate managing and supervising
features and services without automated submission to ESET.
• Information concerning installation process, including platform on which our product is installed and
information about the operations and functionality of our products such as hardware fingerprint, installation
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IDs, crash dumps, license IDs, IP address, MAC address, configuration settings of product which may also
include managed devices.
• Licensing information such as license ID and personal data such as name, surname, address, email address is
required for billing purposes, license genuineness verification and provision of our services.
• Contact information and data contained in your support requests may be required for service of support.
Based on the channel You choose to contact us, We may collect your email address, phone number, license
information, product details and description of your support case. You may be asked to provide us with other
information to facilitate service of support such as generated log files.
• Data concerning usage of our service are completely anonymous by the end of session. No personally
identifiable information is stored after the session ends.

Data Confidentiality
ESET is a company operating worldwide via affiliated entities or partners as part of our distribution, service and
support network. Information processed by ESET may be transferred to and from affiliated entities or partners for
performance of the EULA such as provision of services or support or billing. Based on your location and service
You choose to use, We might be required to transfer your data to a country with absence of adequacy decision by
the European Commission. Even in this case, every transfer of information is subject to regulation of data
protection legislation and takes place only if required. Standard Contractual Clauses, Binding Corporate Rules or
another appropriate safeguard must be established without any exception.
We are doing our best to prevent data from being stored longer than necessary while providing services under
the EULA. Our retention period might be longer than the validity of your license just to give You time for easy and
comfortable renewal. Minimized and pseudonymized statistics and other data from ESET LiveGrid® may be
further processed for statistical purposes.
ESET implements appropriate technical and organizational measures to ensure a level of security which is
appropriate to potential risks. We are doing our best to ensure the ongoing confidentiality, integrity, availability
and resilience of processing systems and Services. However, in case of data breach resulting in a risk to your rights
and freedoms, We are ready to notify supervisory authority as well as data subjects. As a data subject, You have a
right to lodge a complaint with a supervisory authority.

Data Subject’s Rights
ESET is subject to regulation of Slovak laws and We are bound by data protection legislation as part of European
Union. Subject to conditions laid down by applicable data protection laws, You are entitled to following rights as a
data subject:
• right to request access to your personal data from ESET,
• right to rectification of your personal data if inaccurate (You also have the right to have the incomplete
personal data completed),
• right to request erasure of your personal data,
• right to request restriction of processing your personal data,
• right to object to processing,
• right to lodge a complaint as well as,
• right to data portability.
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If You would like to exercise your right as a data subject or You have a question or concern, send us a message at:
ESET, spol. s r.o.
Data Protection Officer
Einsteinova 24
85101 Bratislava
Slovak Republic
dpo@eset.sk
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